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Regulatory Requirements

Conformance Standards

EC | REP

The following classifications are in accordance with the IEC/
EN 60601-1:6.8.1:

According to 93/42/EEC Medical Device Directive, this is
Class lla Medical Device.

According to IEC/EN 60601-1,

+ Equipmentis Class |, INTERNALLY POWERED ME
EQUIPMENT, Type BF or CF Applied Parts.

According to CISPR 11,
* Equipmentis Group 1, Class A ISM Equipment.

According to IEC 60529,

+ The footswitch rate IPX8 is suitable for use in surgical

rooms.
* Probe head (immersible portion) and cable are IPX7

Probe connector is not waterproof.

This product complies with the regulatory requirement of the
following:

Council Directive 93/42/EEC concerning medical devices:

the CE label affixed to the product testifies compliance to
the Directive.

The location of the CE marking is shown in the Safety
chapter of this manual.

Authorized EU Representative

European registered place of business:

GE Medical Systems SCS

283 rue de la Miniére

78530 BUC, France

Tel: +33 (0) 1 30 70 4040
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Conformance Standards (continued)

Classified to ANSI/AAMI ES60601-1 2005 R1 2012 Medical
Electrical Equipment, Part 1: General Requirements for
Safety by a Nationally Recognized Test Lab

Certified to CSA CAN/CSA-C22.2 No60601-1 :14 General
requirements for safety

CE Marked to Council Directive 93/42/EEC on Medical
Devices Conforms to the following standards for safety:

IEC/EN 60601-1 3.1 Edition. Medical electrical equipment -
Part 1: General requirements for basic safety and essential
performance

IEC/EN 60601-1-2 Medical electrical equipment - Part 1-2:
General requirements for safety - Collateral Standard:
Electromagnetic compatibility - requirements and tests

IEC/EN 60601-1-6 Medical electrical equipment Part 1-6:
General requirements basic safety and essential
performance - Collateral Standard: Usability

IEC/EN 60601-2-37 Medical electrical equipment - Part
2-37: Particular requirements for the safety of ultrasonic
medical diagnostic and monitoring equipment

IEC 61157 (Standard means for the reporting of the acoustic
output of medical diagnostic ultrasonic equipment)

IEC/EN 62366 Application of usability engineering to
medical devices

IEC/EN 62304 Software Life Cycle Processes

IEC/EN 62359 Ultrasonic - Field characterization - Test
methods for the determination of thermal and mechanical
indices related to medical diagnostic ultrasonic fields

EN ISO 15223-1 : Symbols to be used with medical device
labels, labelling and information to be supplied

ISO 10993-1 Biological evaluation of medical devices - Part
1 Evaluation and testing

ISO 14971:2012 (Medical devices - Application of risk
management to medical devices)

EMC Emissions Group 1, Class A device requirements as
per Sub clause 4.2 of CISPR 11

WEEE (Waste Electrical and Electronic Equipment)
ROHS according to 2011/65/EU Including national
deviations

Wireless equipment shall be certified to FCC, RED and
Japan Radio Law.

Medical Device Good Manufacturing Practice Manual
issued by the FDA (Food and Drug Administration,
Department of Health, USA)
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Certifications

*  General Electric Medical Systems is ISO 13485 certified.

Original Documentation

* The original document was written in English.

Country Specific Approval

DANGER The following optional features ARE NOT available in the USA
and its territories:

+ Elastography Quantification

Importer Information

*  Turkish Importer

GE Medical Systems Turkiye Ltd. Sti.
Esentepe Mah. Harman Sok. No: 8
34394 Sisli istanbul Turkiye
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Chapter 1

Introduction

This chapter consists of information concerning
indications for use/contraindications, contact
information and how this documentation is organized.
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Introduction

Attention

1-2

NOTE:

NOTE:

System Overview

This manual contains necessary and sufficient information to
operate the system safely. Advanced equipment training may be
provided by a factory trained Applications Specialist for the
agreed-upon time period.

Read and understand all instructions in this manual before
attempting to use the LOGIQ P8/P9/P10 system.

Keep this manual with the equipment at all times. Periodically
review the procedures for operation and safety precautions.

Disregarding information on safety is considered abnormal use.

Not all features, products, probes, or peripherals described in
this document may be available or cleared for sale in all
markets. Please contact your local GE Ultrasound
representative to get the latest information.

Please note that orders are based on the individually agreed
upon specifications and may not contain all features listed in this
manual.

All references to standards / regulations and their revisions are
valid at the time of publication of the user manual.
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System Overview

Documentation

f CAUTION

Safety instructions must be reviewed before operating the unit.

LOGIQ P8/P9/P10 documentation consists of various manuals:

* The Basic User Manual, User Guide, and Online Help
(TRANSLATED) provides information needed by the user to
operate the system safely. It describes the basic functions of
the system, safety features, operating modes,
measurements/calculations, probes, and user care and
maintenance.

* The Advanced Reference Manual (ENGLISH ONLY)
contains data tables, such as OB and Acoustic Output
tables.

*  AIUM Booklet (USA Only)

* The Service Manual (ENGLISH ONLY) supplies block
diagrams, lists of spare parts, descriptions, adjustment
instructions or similar information which helps qualified
technical personnel in repairing those parts of the system
which have been defined as repairable.

The LOGIQ P8/P9/P10 manuals are written for users who are
familiar with basic ultrasound principles and techniques. They
do not include sonographic training or detailed clinical
procedures.

NOTE: The Service manual is only provided in electronic format on the
eDoc USB.

NOTE: The eDoc USB includes English and all translations.

NOTE:  Dates on screenshots are represented in MM/DD/YYYY format
throughout the manual. Information on how to change the
system’s date can be found in Customizing Your System.

NOTE: The screen graphics in this manual are only for illustrational
purposes. Actual screen output may differ.
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Introduction

Principles of Operation

1-4

Medical ultrasound images are created by computer and digital
memory from the transmission and reception of mechanical
high-frequency waves applied through a transducer. The
mechanical ultrasound waves spread through the body,
producing an echo where density changes occur. For example,
in the case of human tissue, an echo is created where a signal
passes from an adipose tissue (fat) region to a muscular tissue
region. The echoes return to the transducer where they are
converted back into electrical signals.

These echo signals are highly amplified and processed by
several analog and digital circuits having filters with many
frequency and time response options, transforming the
high-frequency electrical signals into a series of digital image
signals which are stored in memory. Once in memory, the image
can be displayed in real-time on the image monitor. All signal
transmission, reception and processing characteristics are
controlled by the main computer. By selection from the system
control panel, the user can alter the characteristics and features
of the system, allowing a wide range of uses, from obstetrics to
peripheral vascular examinations.

Transducers are accurate, solid-state devices, providing multiple
image formats. The digital design and use of solid-state
components provides highly stable and consistent imaging
performance with minimal required maintenance. Sophisticated
design with computer control offers a system with extensive
features and functions which is user-friendly and easy to use.
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System Overview

Indications for Use

The LOGIQ P8/P9/P10 is intended for use by a qualified
physician for ultrasound evaluation.

United States Indications for Use Statement

The LOGIQ P8/P9/P10 is intended for use by a qualified
physician for ultrasound evaluation of Fetal/Obstetrics;
Abdominal; Pediatric; Small Organ (breast, testes, thyroid);
Neonatal Cephalic; Adult Cephalic; Cardiac (adult and
pediatric); Peripheral Vascular; Musculo-skeletal Conventional
and Superficial; Urology (including prostate); Transrectal;
Transvaginal; Transesophageal and Intraoperative (abdominal,
vascular).

Modes of operation include: B, M, PW, Doppler, CW Doppler,
Color Doppler, Color M Doppler, Power Doppler, Harmonic
Imaging, Coded Pulse, 3D/4D Imaging mode, Elastography,
Shear Wave Elastography, Attenuation Imaging and Combined
modes: B/M, B/Color, B/PWD, B/Color/PWD, B/Power/PWD.

Frequency of Use

Daily (Typically 8 hours)

Operator Profile

* Qualified and trained physicians or sonographers with at
least basic ultrasound knowledge.

* The operator must have read and understood the user
manual.
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Introduction

Clinical Applications

Specific clinical applications and exam types include:

Fetal/Obstetrics

Abdominal (includes renal, GYN/Pelvic)
Pediatric

Small Organ (breast, testes, thyroid)
Neonatal Cephalic

Adult Cephalic

Cardiac (adult and pediatric)

Peripheral Vascular

Musculo-skeletal Conventional and Superficial
Urology (including prostate)

Transrectal

Transvaginal

Intraoperative (abdominal, vascular)
Transesophageal

Image Acquisition is for diagnostic purposes, including
measurements on acquired images.

jurisdictions restrict certain uses, such as gender

f CAUTION This machine should be used in compliance with law. Some

determination.

Contraindication

The LOGIQ P8/P9/P10 ultrasound system is not intended for
ophthalmic use or any use causing the acoustic beam to pass
through the eye.

Prescription Device

CAUTION: United States law restricts this device to sale or use
RH D nl y by, or on the order of a physician.
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Contact Information

Contact Information

Contacting GE Ultrasound

INTERNET

Clinical Questions

Service Questions

Information
Requests

Placing an Order

For additional information or assistance, please contact your
local distributor or the appropriate support resource listed on the
following pages:

http://www.gehealthcare.com

http://www3.gehealthcare.com/en/Products/Categories/
Ultrasound/Ultrasound_Probes

For information in the United States, Canada, Mexico and parts
of the Caribbean, call the Customer Answer Center.
TEL: (1) 800-682-5327 or (1) 262-524-5698

In other locations, contact your local Applications, Sales, or
Service Representative.

For service in the United States, call GE CARES.
TEL: (1) 800-437-1171
In other locations, contact your local Service Representative.

To request technical product information in the United States,
call GE.

TEL: (1) 800-643-6439

In other locations, contact your local Applications, Sales, or
Service Representative.

To order accessories, supplies, or service parts in the United
States, call the GE Technologies Contact Center.

TEL: (1) 800-558-5102

In other locations, contact your local Applications, Sales, or
Service Representative.
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Introduction

Contacting GE Ultrasound (continued)

Table 1-1:  Americas

AMERICAS
ARGENTINA GE Healthcare Argentina TEL: (+54) 11-5298-2200
Nicolas de Vedia 3616 piso 5
Buenos Aires - 1307
BRAZIL GE Healthcare do Brasil Comércio e Servigos TEL:_ 3067-8010
para Equipamentos Medico- Hospitalares Lida FAX: (011) 3067-8280
Av. Magalhées de Castro, 4800, Andar 11 )
Conj. 111 e 112, Andar 12 Conj. 121 e 122, Registro ANVISA No:
Torre 3 - Cidade Jardim - CEP; 05676-120 - 80071260351
Sé&o Paulo/SP - Brasil
C.N.P.J.:00.029.372/0001-40.
CANADA GE Ultrasound TEL: (1) 800-668-0732

9900 Innovation Drive
Wauwatosa, WI 53226

Customer Answer Center
TEL: (1) 262-524-5698

LATIN & SOUTH

GE Ultrasound

TEL: (1) 262-524-5300

AMERICA 9900 Innovation Drive
Wauwatosa, WI 53226 Customer Answer Center
TEL: (1) 262-524-5698
MEXICO GE Sistemas Medicos de Mexico S.A. de C.V. TEL: (5) 228-9600
Rio Lerma #302, 1°y 2° Pisos FAX: (5) 211-4631
Colonia Cuauhtemoc
06500-Mexico, D.F.
USA GE Ultrasound TEL: (1) 800-437-1171
9900 Innovation Drive FAX: (1) 414-721-3865
Wauwatosa, W1 53226
Table 1-2:  Asia
ASIA
ASIA PACIFIC GE Healthcare Asia Pacific TEL: +81 42 585 5111
JAPAN 4-7-127, Asahigaoka
Hinoshi, Tokyo
191-8503, Japan
AUSTRALIA 32 Phillip Street TEL: 1300 722 229
Parramatta 2150
Sydney, Australia
CHINA GE Healthcare - Asia TEL: (8610) 5806 8888
No. 1, Yongchang North Road FAX: (8610) 6787 1162
Beijing Economic & Technology Development Area Service: 4008108188
Beijing 100176, China (24h)
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Contact Information

Table 1-2:  Asia (Continued)

ASIA
INDIA Wipro GE Healthcare Pvt Ltd TEL: +(91)
No. 4, Kadugodi Industrial Area 1-800-425-8025
Sadaramangala, Whitefield
Bangalore, 560067
KOREA 15F, 416 Hangang Dae ro, TEL: +82 2 6201 3114
Chung-gu
Seoul 04637, Korea
NEW ZEALAND 8 Tangihua Street TEL: 0800 434 325
Auckland 1010
New Zealand
SINGAPORE ASEAN TEL: +65 6291 8528
1 Maritime Square #13-01
HarbourFront Center
Singapore 099253
Table 1-3: Europe
EUROPE
AUSTRIA General Electric Austria GmbH & Co OG TEL: (+43) 1972720
EURO PLAZA, Gebaude E FAX: (+43) 1 97272 2222
Technologiestrasse 10
A-1120 Vienna
BELGIUM & GE Healthcare BVBA/SPRL TEL: (+32) 2 719 7204
LUXEMBURG Kouterveldstraat 20 FAX: (+32) 2 719 7205

1831 DIEGEM

CZECH REPUBLIC

GE Medical Systems
Ceska Republika, s.r.o
Vyskocilova 1422/1a
140 28 Praha 4

TEL: (+420) 224 446 162
FAX: (+420) 224 446 161

DENMARK GE Healthcare TEL: (+45) 43 295 400
Park Alle 295 FAX: (+45) 43 295 399
DK-2605 Brendby, Denmark

ESTONIA & GE Healthcare Finland Oy TEL: (+358) 10 39 48 220

FINLAND Kuortaneenkatu 2, 000510 Helsinki FAX: (+358) 10 39 48 221
P.O.Box 330, 00031 GE Finland

FRANCE GE Medical Systems SCS TEL: (+33) 1344952 70
Division Ultrasound FAX: (+33) 13 44 95 202
24 Avenue de 'Europe - C520529
78457 Veélizy Villacoublay Cedex

GERMANY GE Healthcare GmbH TEL: (+49) 212-28 02-0

Beethovenstrasse 239
42655 Solingen

FAX: (+49) 212-28
02-380
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Table 1-3:  Europe (Continued)

EUROPE

GREECE GE Healthcare TEL: (+30) 210 8930600
8-10 Sorou Str. Marousi FAX: (+30) 210 9625931
Athens 15125 Hellas

HUNGARY GE Hungary Zft. TEL: (+36) 23 410 314
Division, Akron u. 2. FAX: (+36) 23 410 390
Budadrs 2040 Hungary

IRELAND NORTHERN IRELAND TEL: (+44) 028 90229900
GE Healthcare
Victoria Business Park
9, Westhank Road
Belfast BT3 9JL.
REPUBLIC OF IRELAND TEL: 1800 460 550
GE Healthcare FAX: (+353) 1 686 5327
3050 Lake Drive
Citywest Business Campus
Dublin 24

ITALY GE Medical Systems Italia spa TEL.: (+39) 02 2600 1111
Via Galeno, 36, 20126 Milano FAX: (+39) 02 2600 1417

LUXEMBORG See Belgium.

NETHERLANDS GE Healthcare TEL: (+31) 33 254 1290
De Wel 18 B, 3871 MV Hoevelaken FAX: (+31) 33 254 1292
PO Box 22, 3870 CA Hoevelaken

NORWAY GE Vingmed Ultrasound AS TEL: (+47) 23 18 50 50
Sandakerveien 100C FAX: (+47) 23 18 60 35
0484 Oslo, Norway
GE Vingmed Ultrasound TEL: (+47) 33 02 11 16
Strandpromenaden 45
P.O. Box 141, 3191 Horten

POLAND GE Medical Systems Polska TEL: (+48) 22 330 83 00
Sp. z 0.0., ul. Woloska 9 FAX: (+48) 22 330 83 83
02-583 Warszawa, Poland

PORTUGAL General Electric Portuguesa SA TEL: (+351) 21 425 1300
Avenida do Forte 6 - 6A FAX: (+351) 21 425 1343
Edificio Ramazzotti
2790-072 CARNAXIDE

RUSSIA GE Healthcare TEL: (+7) 4957 396931
Presnenskaya nab. 10 FAX: (+7) 4957 396932
Block C, 12 floor
123317 Moscow, Russia

SPAIN GE Healthcare Espafia TEL: (+34) 91 663 2500
C/ Gobelas 35-37 FAX: (+34) 91 663 2501
28023 Madrid
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Table 1-3:  Europe (Continued)
EUROPE

SWEDEN GE Healthcare Sverige AB TEL: (+46) 08 559 500 10
FE 314, 182 82 Stockholm FAX: (+46) 08 559 500 15
Besoksadr: Vendevagen 89 Service Center (+46)
Danderyd, Sverige 020-120 14 36

SWITZERLAND GE Medical Systems (Schweiz) AG TEL: (+41) 1 809 92 92
Europastrasse 31 FAX: (+41) 1 809 92 22
8152 Glattbrugg

TURKEY GE Healthcare Tiirkiye TEL: +90 212 398 07 00
Istanbul Office FAX: +90 212 284 67 00
Levent Ofis
Esentepe Mah. Harman Sok.
No:8 Sisli-Istanbul

UNITED ARAB GE Healthcare TEL: (+971) 4 429 6101

EMIRATES (UAE)

Dubai Internet City, Building No. 18
First Floor, Dubai - UAE

or 44296161
FAX: (+971) 4 429 6201

UNITED KINGDOM

GE Medical Systems Ultrasound
Pollards Wood

Nightingales Lane

Chalfont St Giles
Buckinghamshire HP8 4SP

TEL: (+44) 1494 544000
FAX: (+44) 1707 289742

For all other European countries not listed, please contact your local GE distributor or the appropriate
support resource listed on www.gehealthcare.com.
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Contacting GE Ultrasound (continued)

Manufacturer
GE Ultrasound Korea, Ltd.
9, Sunhwan-ro 214beon-gil, Jungwon-gu, Seongnam-si,
Gyeonggi-do,
KOREA
1-12 LOGIQ P8/P9/P10 — Basic User Manual

Direction 5841298-1EN Rev. 2



Chapter 2

Safety

Describes the safety and regulatory information
pertinent for operating this ultrasound system.

LOGIQ P8/P9/P10 — Basic User Manual 2-1
Direction 5841298-1EN Rev. 2



Safety

Owner Responsibility

Owner requirements

é CAUTION

2-2

It is the responsibility of the owner to ensure that anyone
operating the system reads and understands this section of the
manual. However, there is no representation that the act of
reading this manual renders the reader qualified to operate,
inspect, test, align, calibrate, troubleshoot, repair or modify the
system. The owner should make certain that only properly
trained, fully-qualified service personnel undertake the
installation, maintenance, troubleshooting, calibration and repair
of the equipment.

The owner of the ultrasound unit should ensure that only
properly trained, fully qualified personnel are authorized to
operate the system. Before authorizing anyone to operate the
system, it should be verified that the person has read, and fully
understands, the operating instructions contained in this
manual. It is advisable to maintain a list of authorized operators.

Should the system fail to operate correctly, or if the unit does not
respond to the commands described in this manual, the
operator should contact the nearest field GE Ultrasound Service
Office.

For information about specific requirements and regulations
applicable to the use of electronic medical equipment, consult
the local, state and federal agencies.

For USA only:

Federal law restricts this device to use by, or on the orders of, a
physician.
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Safety Precautions

Safety Precautions

Precaution Levels

Various levels of safety precautions may be found on the
equipment and different levels of concern are identified by one
of the following flag words and icons which precede the
precautionary statement.

WARNING _Indicates fthat a spe_gific hazard_ is known to exist which through
inappropriate conditions or actions may cause:

»  Severe personal injury
+  Substantial property damage.

CAUTION Indicates that a potential hazard may exist which through
inappropriate conditions or actions will or can cause:

e Minor injury
*  Property damage.

NOTE: Indicates precautions or recommendations that should be used
in the operation of the ultrasound system, specifically:

* Maintaining an optimum system environment
*  Using this Manual
* Notes to emphasize or clarify a point.
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Safety

Hazard Symbols
Icon Description

Potential hazards are indicated by the following icons:

Table 2-1:  Potential Hazards

Icon Potential Hazard Usage Source
Biological Hazard « Cleaning and care ISO 7000
Describes precautions necessary to instructions No. 0659
prevent the risk of disease transmission » Sheath and glove
or infections. guidelines
* Patient/user infection due to

contaminated equipment.
Electrical Hazard * Probes
.

Describes precautions necessary to

prevent the risk of injury through electric

hazards.

* Electrical micro-shock to patient, e.g.,
ventricular

« ECG, if applicable
« Connections to back
panel

Moving Hazard

Describes precautions necessary to

prevent the risk of injury through moving

or tipping hazard!

» Console, accessories or optional
storage devices that can fall on patient,
user, or others.

+ Collision with persons or objects may
result in injury while maneuvering or
during system transport.

* Injury to user from moving the console.

* Moving
*» Using brakes
* Transporting

11 =

Acoustic Output Hazard
« Patient injury or tissue damage from
ultrasound radiation.

* ALARA, the use of
Power Output following
the ‘as low as
reasonably achievable’
principle

Explosion Hazard

Describes precautions necessary to

prevent the risk of injury through

explosion hazard!

* Risk of explosion if used in the
presence of flammable anesthetics.

* Flammable anesthetic

Fire and Smoke Hazard

« Patient/user injury or adverse reaction
from fire or smoke.

« Patient/user injury from explosion and
fire.

* Replacing fuses
* QOutlet guidelines

2-4

LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2




Safety Precautions

Important Safety Considerations

f CAUTION

é CAUTION

The following topic headings (Patient Safety, and Equipment
and Personnel Safety) are intended to make the equipment user
aware of particular hazards associated with the use of this
equipment and the extent to which injury can occur if
precautions are not observed. Additional precautions may be
provided throughout the manual.

Improper use can result in serious injury. The use of the system
outside the described conditions or intended use, and
disregarding safety related information is considered abnormal
use. The user must be thoroughly familiar with the instructions
and potential hazards involving ultrasound examination before
attempting to use the device. Training assistance is available
from GE if needed.

Disregarding information on safety is considered abnormal use.

The use of the system outside the described conditions or
intended use, and disregarding safety related information is
considered as abnormal use. The manufacturer is not liable for
damage caused by abnormal use of the device.
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Safety

Patient Safety

é WARNING

The concerns listed can seriously affect the safety of patients
undergoing a diagnostic ultrasound examination.

Patient identification

2-6

Always include proper identification with all patient data and
verify the accuracy of the patient's name and ID numbers when
entering such data. Make sure correct patient ID is provided on
all recorded data and hard copy prints. Identification errors could
result in an incorrect diagnosis.

The ultrasound system is not meant to be long term storage for
patient data or images. The customers are responsible for the
data on the system and a regular backup is highly
recommended.

It is advisable to back up system data prior to any service
repairs to the hard drive. It is always possible during system
failure and repair to lose patient data. GE will not be held
responsible for the loss of this data.
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Safety Precautions

Diagnostic information

f CAUTION

f CAUTION

é CAUTION

The images and calculations provided by the system are
intended for use by competent users, as a diagnostic tool. They
are explicitly not to be regarded as the sole, irrefutable basis for
clinical diagnosis. Users are encouraged to study the literature
and reach their own professional conclusions regarding the
clinical utility of the system.

The user should be aware of the product specifications and of
the system accuracy and stability limitations. These limitations
must be considered before making any decision based on
quantitative values. If in doubt, the nearest GE Ultrasound
Service Office should be consulted.

Equipment malfunction or incorrect settings can result in
measurement errors or failure to detect details within the image.
The equipment user must become thoroughly familiar with the
equipment operation in order to optimize its performance and
recognize possible malfunctions. Applications training is
available through the local GE representative. Added
confidence in the equipment operation can be gained by
establishing a quality assurance program.

The system provides calculations (e.g. estimated fetal weight)
and charts based on published scientific literature. The
selection of the appropriate chart and clinical interpretation of
calculations and charts is the sole responsibility of the user.
The user should consider contraindications for the use of a
calculation or chart as described in the scientific literature. The
diagnosis, decision for further examination, and medical
treatment must be performed by qualified personnel following
good clinical practice.

Features that facilitate measurements such as SonoAVC™,
VOCAL or SonoNT must be used with extreme care. The
measurement results are a suggestion of the system, if in
doubt verify with manual measurement methods.

The user is responsible for the diagnostic interpretation of the
measurement results.

Be certain to ensure privacy data of patient information.
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Safety

Mechanical hazards

« Electrical

?'\. Hazard

ALARA

f CAUTION

Training

2-8

The use of damaged probes can result in injury or increased risk
of infection. Inspect probes often for sharp, pointed, or rough
surface damage that could cause injury or tear protective
barriers.

Never use excessive force when manipulating intracavity
probes. Become familiar with all instructions and precautions
provided with special purpose probes.

A damaged probe can also increase the risk of electric shock if
conductive solutions come in contact with internal live parts.
Inspect probes often for cracks or openings in the housing and
holes in and around the acoustic lens or other damage that
could allow liquid entry. Become familiar with the probe's use
and care precautions outlined in Probes and Biopsy.

Ultrasound can produce harmful effects in tissue and
potentially result in patient injury. Always minimize exposure
time and keep ultrasound levels low when there is no medical
benefit. Use the principle of ALARA (As Low As Reasonably
Achievable), increasing output only when needed to obtain
diagnostic image quality. Observe the acoustic output display
and be familiar with all controls affecting the output level. See
the Bioeffects section of the Acoustic Output chapter in the
Advanced Reference Manual for more information.

It is recommended that all users receive proper training in
applications before performing them in a clinical setting. Please
contact the local GE representative for training assistance.

ALARA training is provided in the Medical Ultrasound Safety
booklet shipped in the eDOCs kit. The ALARA education
program for the clinical end-user covers basic ultrasound
principles, possible biological effects, the derivation and
meaning of the indices, ALARA principles, and examples of
specific applications of the ALARA principle.
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Safety Precautions

Equipment and Personnel Safety

Related Hazards

é WARNING

-~ = Electrical

2"'\ Hazard

Smoke &

aﬁ Fire Hazard

The concerns listed below can seriously affect the safety of
equipment and personnel during a diagnostic ultrasound
examination.

Do not use this equipment if a safety problem is known to exist.
Have the unit repaired and performance verified by qualified
service personnel before returning to use.

This equipment contains dangerous voltages that are capable
of serious injury or death.

If any defects are observed or malfunctions occur, stop
operating the equipment and perform the proper action for the
patient. Inform a qualified service person and contact a Service
Representative for information.

There are no user serviceable components inside the console.
Refer all servicing to qualified service personnel only.

Ensure that unauthorized personnel do not tamper with the
unit.

To avoid injury:

+ Do not remove protective covers. No user serviceable
parts are inside. Refer servicing to qualified service
personnel.

+ To assure adequate grounding, connect the attachment
plug to a reliable (hospital grade) grounding outlet (having
equalization conductor v ).

* Never use any adaptor or converter of a
three-prong-to-two-prong type to connect with a mains
power plug. The protective earth connection will loosen.

* Do not place liquids on or above the console. Spilled liquid
may contact live parts and increase the risk of shock.

* Plug any peripherals into the AC power outlet.

The system must be supplied from an adequately rated
electrical circuit. The capacity of the supply circuit must be as
specified.
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Safety

Related Hazards (continued)

Explosion
Hazard

é CAUTION

f CAUTION
f CAUTION

f CAUTION

2-10

Never operate the equipment in the presence of flammable or
explosive liquids, vapors or gases. Malfunctions in the unit, or
sparks generated by fan motors, can electrically ignite these
substances. Operators should be aware of the following points
to prevent such explosion hazards.

» If flammable substances are detected in the environment,
do not plug in or turn on the system.

+ If flammable substances are detected after the system has
been turned on, do not attempt to turn off the unit, or to
unplug it.

+ If flammable substances are detected, evacuate and
ventilate the area before turning off the unit.

This equipment provides no special means of protection from
high frequency (HF) burns that may result from using an
electrosurgical unit (ESU). To reduce the risk of HF burns,
avoid contact between the patient and ultrasound transducer
while operating the ESU. Where contact cannot be avoided, as
in the case of TEE monitoring during surgery, make sure the
transducer is not located between the ESU active and
dispersive electrodes and keep the ESU cables away from the
transducer cable.

To avoid skin burns in surgical use, do not place ECG
electrodes in the current path between the Electrosurgical Unit
(ESU) active and dispersive electrodes. Keep ESU cables
away from ECG leads.

DO NOT touch the patient and any of the connectors on the
ultrasound unit simultaneously, including ultrasound probe
connectors.

DO NOT touch the conducting parts of the USB, Ethernet,
Video, Audio cables when connecting equipment to the unit.

DO NOT load non-system software on the system computer.
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Safety Precautions

Related Hazards (continued)

Biological
/Q\ Hazard

f CAUTION

f CAUTION

Moving Hazard

é CAUTION

For patient and personnel safety, be aware of biological
hazards while performing invasive procedures. To avoid the
risk of disease transmission:

+ Use protective barriers (gloves and probe sheaths)
whenever possible. Follow sterile procedures when
appropriate.

+ Thoroughly clean probes and reusable accessories after
each patient examination and disinfect or sterilize as
needed. Refer to Probes and Biopsy for probe use and
care instructions.

* Follow all infection control policies established by your
office, department or institution as they apply to personnel
and equipment.

Pacemaker hazard

The possibility of the system interfering with pacemakers is
minimal. However, as this system generates high frequency
electrical signals, the operator should be aware of the potential
hazard this could cause.

Be cautious to avoid contacting with the needle tip in biopsy
procedure.

Take extra care when moving the system.

The equipment weighs approximately 67 kg (148 Ibs) (69 kg
with HD Display (152 Ibs)). To avoid possible injury and
equipment damage when transporting from one area of use to
another:

* Be sure the pathway is clear.

* Limit movement to a slow careful walk.

+ Use two or more persons to move the equipment on
inclines or long distance.
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Safety

Allergic reactions to latex-containing medical devices

containing latex (natural rubber), the FDA advises health-care
professionals to identify latex-sensitive patients, and be
prepared to treat allergic reactions promptly. Latex is a
component of many medical devices, including surgical and
examination gloves, catheters, incubation tubes, anesthesia
masks and dental dams. Patient reaction to latex has ranged
from contact urticaria, to systemic anaphylaxis.

f CAUTION Due to reports of severe allergic reactions to medical devices

For more details regarding allergic reaction to latex, refer to
FDA Medical Alert MDA91-1, March 29.

Transesophageal probe safety

CAUTION Never use excessive force when manipulating the
transesophageal probe. The detailed operator manual
enclosed with the transesophageal probe must be read
carefully.
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Safety Precautions

Classifications

NOTE:

Type of protection against electric shock
Class | (*1) & Internally powered ME (*4)
Degree of protection against electric shock

Type BF Applied part (*2) (for Probes marked with BF symbol)

Type CF (Defibrillation-proof CF) Applied part (*3) (tor ECG marked
with CF symbol)
Continuous Operation

System is Ordinary Equipment (IPX0)

Footswitch is IPX8

Probe head (immersible portion) and cable are IPX7
Probe connector is not waterproof.

*1. Class | Equipment

EQUIPMENT in which protection against electric shock does not
rely on BASIC INSULATION only, but includes an earth ground.
This additional safety precaution prevents exposed metal parts

from becoming LIVE in the event of an insulation failure.

*2. Type BF Applied Part

TYPE BF APPLIED PART providing a specified degree of
protection against electric shock, with particular regard to
allowable LEAKAGE CURRENT.

*3. Type CF (Defibrillation-proof CF) Applied part

TYPE CF APPLIED PART providing a degree of protection
higher than that for Type BF Applied Part against electric shock
particularly regarding allowable LEAKAGE CURRENTS.

*4. Internally powered

Term referring to electrical equipment that is able to operate
from an INTERNAL ELECTRICAL POWER SOURCE

Table 2-2:  Type BF Equipment

Normal Mode Single fault condition

Patient leakage current

Less than 100 microA Less than 500 microA

Table 2-3: Type CF Equipment

Normal Mode Single fault condition
Patient leakage current Less than 10 microA Less than 50 microA
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Safety

EMC (Electromagnetic Compatibility)

NOTE:

NOTE:

NOTE:

NOTE:

2-14

This equipment generates, uses and can radiate radio
frequency energy. The equipment may cause radio frequency
interference to other medical and non-medical devices and radio
communications. To provide reasonable protection against such
interference, this product complies with emissions limits for a
Group 1, Class A Medical Devices Directive as stated in IEC/EN
60601-1-2. However, there is no guarantee that interference will
not occur in a particular installation.

If this equipment is found to cause interference (which may be
determined by turning the equipment on and off), the user (or
qualified service personnel) should attempt to correct the
problem by one or more of the following measure(s):

* reorient or relocate the affected device(s)

* increase the separation between the equipment and the
affected device

»  power the equipment from a source different from that of the
affected device

« consult the point of purchase or service representative for
further suggestions.

The manufacturer is not responsible for any interference caused
by using other than recommended interconnect cables or by
unauthorized changes or modifications to this equipment.
Unauthorized changes or modifications could void the users’
authority to operate the equipment.

To comply with the regulations on electromagnetic interference
for a Class A FCC Device, all interconnect cables to peripheral
devices must be shielded and properly grounded. Use of cables
not properly shielded and grounded may result in the equipment
causing radio frequency interference in violation of the FCC
regulations.
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Safety Precautions

EMC (Electromagnetic Compatibility) (continued)

NOTE:

é WARNING

é WARNING
f CAUTION

f CAUTION

Do not use devices which intentionally transmit RF Signals
(cellular phones, transceivers, or radio controlled products)
other than those supplied by GE (wireless microphone,
broadband over power lines, for example) in the vicinity of the
equipment as it may cause performance outside the published
specifications. Keep the power to these type devices turned off
when near this equipment.

The medical staff in charge of this equipment is required to
instruct technicians, patients, and other people who maybe
around this equipment to fully comply with the above
requirement.

Portable RF communication equipment (including peripherals
such as antenna cables and external antennas) should be
used no closer than 30 cm (12 inches) to any part of the LOGIQ
P8/P9/P10 including cables specified by the manufacturer.
Otherwise, degradation of the performance of this equipment
could result.

Use of this equipment adjacent to or stacked with other
equipment should be avoided because it could result in
improper operation. In such use is necessary, this equipment
and the other equipment should be observed to verify that they
are operating normally.

Do not operate the system in the vicinity of a heat source, of
strong electric or magnetic fields (e.g. close to a transformer),
or near instruments generating high-frequency signals, such as
HF surgical equipment or magnetic resonance imaging
equipment or similar. These can affect the ultrasound images
adversely.

Typically an ESD/EMC event results in an intermittent
ultrasound image degradation for the time the ESD/EMC event
is present. In rare cases the ultrasound system might show an
error message that can be confirmed by the operator. In other
cases the ultrasound system might stop to perate and require a
re-boot to re-establish the functionality.
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Safety

EMC Performance

2-16

All types of electronic equipment may characteristically cause
electromagnetic interference with other equipment, either
transmitted through air or connecting cables. The term EMC
(Electromagnetic Compatibility) indicates the capability of
equipment to curb electromagnetic influence from other
equipment and at the same time not affect other equipment with
similar electromagnetic radiation from itself.

Proper installation following the service manual is required in
order to achieve the full EMC performance of the product.

The product must be installed as stipulated in 4.2, Notice upon
Installation of Product.

In case of issues related to EMC, please call your service
personnel.

The manufacturer is not responsible for any interference caused
by using other than recommended interconnect cables or by
unauthorized changes or modifications to this equipment.
Unauthorized changes or modifications could void the users’
authority to operate the equipment.
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Safety Precautions

EMC Performance (continued)

f CAUTION

Table 2-4:

Do not use devices which intentionally transmit RF signals
(cellular phones, transceivers, or radio controlled products),
other than those supplied by GE (wireless microphone,
broadband over power lines, for example) unless intended for
use with this system, in the vicinity of this equipment as it may
cause performance outside the published specifications.

Keep power to these devices turned off when near this
equipment.

Medical staff in charge of this equipment is required to instruct
technicians, patients and other people who may be around this
equipment to fully comply with the above regulation.

Portable and mobile radio communications equipment (e.g.
two-way radio, cellular/cordless telephones, wireless computer
networks) should be used no closer to any part of this system,
including cables, than determined according to the following
method:

Portable and mobile radio communications equipment distance

requirements

Frequency Range:

Calculation Method:

Where: d= separation distance in meters, P = rated power of the transmitter, V,=compliance value for
conducted RF, E = compliance value for radiated RF

150 kHz - 80 MHz 80 MHz - 800 MHz 800 MHz - 2.5 GHz

d=[3.5/V4] square root d = [3.5/E4] square root d = [7/E4] square root of
of P of P P

If the maximum
transmitter power in
watts is rated

The separation distance in meters should be

5 2.6 2.6 52
20 5.2 5.2 10.5
100 12.0 12.0 24.0
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Safety

EMC Performance (continued)
Notice upon Installation of Product

Separation distance and effect from fixed radio communications
equipment: field strengths from fixed transmitters, such as base
stations for radio (cellular/cordless) telephones and land mobile
radios, amateur radio, AM and FM radio broadcast, and TV
broadcast transmitter cannot be predicted theoretically with
accuracy. To assess the electromagnetic environment due to
fixed RF transmitters, an electromagnetic site survey should be
considered. If the measured field strength in the location in
which the ultrasound system is used exceeds the applicable RF
compliance level as stated in the immunity declaration, the
ultrasound system should be observed to verify normal
operation. If abnormal operation is observed, additional
measures may be necessary, such as re-orienting or relocating
the ultrasound system or using an RF shielded examination
room may be necessary.

1. Use either power supply cords provided by GE or ones
designated by GE. Products equipped with a power source
plug should be plugged into the fixed power socket which
has the protective grounding conductor. Never use any
adaptor or converter to connect with a power source plug
(e.g. three-prong-to-two-prong converter).

2. Locate the equipment as far away as possible from other
electronic equipment.

3. Be sure to use only the cables provided by or designated by
GE. Connect these cables following the installation
procedures (e.g. wire power cables separately from signal
cables).

4. Lay out the main equipment and other peripherals following
the installation procedures described in the Option
Installation manuals.
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Safety Precautions

General Notice

é WARNING

1. Designation of Peripheral Equipment Connectable to This
Product.
The equipment indicated in the Supplies/Accessories
section can be hooked up to the product without
compromising its EMC performance.

Avoid using equipment not designated in the list. Failure to
comply with this instruction may result in poor EMC
performance of the product.

2. Notice against User Modification

The user should never modify this product. User
modifications may cause degradation in EMC performance.

Modification of the product includes changes in:

a. Cables (length, material, wiring, etc.)

b. System installation/layout

c. System configuration/components

d. Securing system parts (cover open/close, cover
screwing)

3. Operate the system with all covers closed. If a cover is
opened for some reason, be sure to shut it before starting/
resuming operation.

4. Operating the system with any cover open may affect EMC
performance.

Use of accessories, transducers and cables other than those
specified or provided by the manufacturer of this equipment
could result in increased electromagnetic emissions or
decreased electromagnetic immunity of this equipment and
result in improper operation.

Table 2-5: Main Power Cable

Max. Length

No Type Cable Construction / Manufacturer (m) Type of Cable

1 AC cable HO5VV-F 3G1.0mm2 4 Non-Shielded
Manufactured by VOLEX / FELLER

2 AC cable RVV 3G1.0mm2 4 Non-Shielded
Manufactured by VOLEX / FELLER

3 AC cable | VCTF 3GG2.00mm2 4 Non-Shielded
Manufactured by VOLEX / FELLER

LOGIQ P8/P9/P10 — Basic User Manual 2-19

Direction 5841298-1EN Rev. 2



Safety

Table 2-5: Main Power Cable

Max. Length
No Type Cable Construction / Manufacturer (m) Type of Cable
4 AC cable | SJT 3/14AWG 4 Non-Shielded
Manufactured by VOLEX / FELLER
Table 2-6: External Interface Cable (Patient Cable without Probes)
Max.
No Type Parts No. / Manufacturer Length (m) Type of Cable
1 ECG Cable Multi-Link ECG Care Cable_AHA Type | 3.6 Shielded
Manufactured by Vyaire Medical Oy
2 ECG Cable Multi-Link ECG Care Cable_IEC Type | 3.6 Shielded
Manufactured by Vyaire Medical Oy
Table 2-7:  List of all cables and maximun length of cables
Max. Type of
No Type Model name Length (m) Cable Remark
1 Convex array C1-5-RS 2.2 Shielded
probe Manufactured by GE
Healthcare
2 IC9-RS 2.2 Shielded
Manufactured by GE
Healthcare
3 8C-RS 1.6 Shielded
Manufactured by GE
Healthcare
4 E8C-RS 215 Shielded
Manufactured by GE
Healthcare
5 E8Cs-RS 21 Shielded
Manufactured by GE
Healthcare
6 BE9CS-RS 21 Shielded
Manufactured by GE
Healthcare
7 C1-6-D 2.2 Shielded LP9/LP10
Manufactured by GE only
Healthcare
8 C3-10-D 2.0 Shielded LP10 only
Manufactured by GE
Healthcare
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Safety Precautions

Table 2-7:  List of all cables and maximun length of cables

Max. Type of
No Type Model name Length (m) Cable Remark

9 C2-7-D 2.2 Shielded
Manufactured by
Humanscan Co.,Ltd

10 10C-D 22 Shielded
Manufactured by Ueda
Japan Radio Co., Ltd

11 Linear array 9L-RS 1.95 Shielded
probe Manufactured by GE
Healthcare

12 12L-RS 1.95 Shielded
Manufactured by GE
Healthcare

13 ML6-15-RS 2.25 Shielded
Manufactured by GE
Healthcare

14 L8-18i-RS 2.1 Shielded
Manufactured by GE
Healthcare

15 L6-12-RS 2 Shielded
Manufactured by GE
Healthcare

16 L4-12t-RS 1.95 Shielded
Manufactured by GE
Healthcare

17 L10-22-RS 1.85 Shielded LP9/LP10
Manufactured by GE only
Healthcare

18 L3-9i-RS 3.05 Shielded LP9/LP10
Manufactured by GE only
Healthcare

19 L3-12-RS 2.2 Shielded
Manufactured by GE
Healthcare
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Safety

Table 2-7:  List of all cables and maximun length of cables

Max. Type of
No Type Model name Length (m) Cable Remark

20 Sector phased 3Sc-RS 1.95 Shielded
arrary probe Manufactured by GE
Healthcare

21 125-RS 2.15 Shielded
Manufactured by PDI,
Phoenix

22 6S-RS 2.1 Shielded
Manufactured by Parallel
Design SAS

23 M5Sc-RS 2.2 Shielded LP10 only
Manufactured by GE
Healthcare

24 volume convex RIC5-9A-RS 24 Shielded
array probe Manufactured by GE
Healthcare

25 RAB2-6-RS 2.1 Shielded
Manufactured by GE
Healthcare

26 Pencil probe P2D 1.9 Shielded
Manufactured by
Humanscan Co., Ltd

27 P6D 1.9 Shielded
Manufactured by
Humanscan Co., Ltd

28 P8D 1.9 Shielded
Manufactured by
Humanscan Co., Ltd

29 Tee probe 6Tc-RS 21 Shielded
Manufactured by GE
Healthcare

Table 2-8:  Accessories for LOGIQ P8/P9/P10 R4

Max.
No Type Parts No. / Manufacturer Length (m) Type of Cable

1 Foot Switch Foot Switch FSU-3000G 2.9 Shielded
Manufactured by WHANAM
Electronics

2 USB Isolator Isolator UH401 0.9 Shielded
Manufactured by B&B Electronics

3 USB Barcode 1900GHD-2USB 2.7 Shielded
scanner Manufactured by Honeywell
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Safety Precautions

Peripheral Update for EC countries

The following is intended to provide the users in EC countries
with updated information concerning the connection of the
LOGIQ P8/P9/P10 to image recording and other devices or
communication networks.

Peripherals used in the patient environment
The LOGIQ P8/P9/P10 has been verified for overall safety,
compatibility and compliance with the following image recording
devices:

«  SONY B/W Printer UP-D898
«  SONY Color Printer UP-D25MD

The LOGIQ P8/P9/P10 has also been verified for compatibility,
and compliance for connection to a local area network (LAN) via
the rear panel Ethernet connection, provided the LAN
components are IEC/EN 60950 or IEC/EN 62368-1 compliant.

The LOGIQ P8/P9/P10 may also be used safely while
connected to devices other than those recommended above if
the devices and their specifications, installation, and
interconnection with the system conform to the requirements of
IEC/EN 60601-1.
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Safety

Peripheral Update for EC countries (continued)

Accessory equipment connected to the analog and digital
interfaces must be certified according to the respective IEC/EN
standards (i.e., IEC/EN 60950 or IEC/EN 62368-1 for data
processing equipment and IEC/EN 60601-1 for medical
equipment). Furthermore, all complete configurations shall
comply with the valid version of the system standard IEC/EN
60601-1. Everyone who connects additional equipment to the
signal input part or signal output part of the LOGIQ P8/P9/P10
system configures a medical system, and is therefore
responsible to ensure that the system complies with the
requirements of the valid version of IEC/EN 60601-1. If in doubt,
consult the technical service department or your local GE
representative.

General precautions for installing an alternate off-board, remote
device or a network would include:

1. The added device must have appropriate safety standard
conformance and CE Marking.

2. The total power consumption of the added devices, which
connect to the LOGIQ P8/P9/P10 and are used
simultaneously, must be less than or equal to the rated
supply of the LOGIQ P8/P9/P10.

3. There must be adequate heat dissipation and ventilation to
prevent overheating of the device.

4. There must be adequate mechanical mounting of the device
and stability of the combination.

5. Risk and leakage current of the combination must comply
with IEC/EN 60601-1.

6. Electromagnetic emissions and immunity of the combination
must conform to IEC/EN 60601-1-2.

General precautions for installing an alternate off-board, remote
device or a network would include:

1. The added device(s) must have appropriate safety standard
conformance and CE Marking.

2. The added device(s) must be used for their intended
purpose having a compatible interface.
3. Signal or mains isolation devices and additional protective

earth may be needed to assure compliance with IEC/
EN 60601-1.
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Safety Precautions

Peripheral Update for EC countries (continued)

Peripheral used in the non-patient environment

The LOGIQ P8/P9/P10 has also been verified for compatibility,

and compliance for connection to a USB HDD/USB memory via
the system USB port, provided the USB HDD/USB memory are
IEC/EN 60950 or IEC/EN 62368-1 compliant.

than as specified in the user instructions can result in an
electric shock hazard or equipment malfunction. Substitute or
alternate equipment and connections requires verification of
compatibility and conformity to IEC/EN 60601-1 by the installer.
Equipment modifications and possible resulting malfunctions
and electromagnetic interference are the responsibility of the
owner.

f CAUTION The connection of equipment or transmission networks other

LOGIQ P8/P9/P10 — Basic User Manual 2-25
Direction 5841298-1EN Rev. 2



Safety

Declaration of Emissions

This system is suitable for use in the following environment. The
user must assure that it is used only in the electromagnetic
environment as specified.

Table 2-9:

Declaration of Emissions

Guidance and manufacturer’s declaration - electromagnetic emissions

The system is intended for use in the electromagnetic environment specified below. The
user of the system should assure that it is used in such an environment.

IEC/EN 61000-3-3

Emission Type Compliance Electromagnetic Environment
CISPR 11/EN55011 Group 1 This system uses RF energy only for its internal function.
Conducted and Therefore, its RF emissions are very low and are not likely to
radiated RF cause any interference in nearby electronic equipment.
EMISSIONS
Class A This system is suitable for use in all establishments, other than
domestic establishments and those directly connected to the
Harmonic Class A public low-voltage power supply network that supplies buildings
Emissions used for domestic purposes, provided the following warning is
IEC/EN 61000-3-2 heeded:
) WARNING: This system is intended for use by healthcare
Voltage ) ) Complies professionals only. This system may cause radio interference or
Eﬁci;;:;a::]c;nslﬂlcker may disrupt the operation of nearby equipment. It may be

necessary to take mitigation measures, such as re-orienting or
relocating the system or shielding the location.

NOTE

The EMISSION characteristics of this equipment make it suitable for use in industrial areas and hospitals
(CISPR 11 class A). If it is used in a residential environment (for which CISPR 11 class B is normally
required) this equipment might not offer adequate protection to radio-frequency communication services.
The user might need to take mitigation measures, such as relocating or re-orienting the equipment.
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Safety Precautions

Declaration of Immunity

This system is suitable for use in the following environment. The
user must assure that the system is used according to the

specified guidance and only in the electromagnetic environment
listed.
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Safety

Declaration of Immunity (continued)

Table 2-10:

Declaration of Immunity

Guidance and manufacturer’s declaration - electromagnetic immunity

The system is intended for use in the electromagnetic environment specified below. The
customer or the user of this system should assure that it is used in such an environment.

Electromagnetic

Elecrical fast
transients /

frequency
+ 1 kV for input/output lines

5kHz repetition frequency
+ 1 kV for input/output lines

Immunity Regulatory Acceptable environment -
Type Equipment Capability Level guidance
IEC/EN + 6, + 8 kV contact Edition 3 Floors should be wood,
61000-4-2 + 6 kV contact concrete, or ceramic tile.
ELECTROST +2,+4,+8,+15kV air +2,+4,+8kV air If floors are covered with
ATIC synthettic material, the
DISCHARGE Edition 4 relative humidity should
(ESD) + 8 kV contact be at least 30%.
+2,+4,+8,+15kV air
IEC/EN + 2 KV for power supply lines Edition 3 Main power quality
61000-4-4 5 kHz and 100 kHz repetition + 2 kV for power supply lines should be that of a

typical commercial and/
or hospital environment.

magnetic field

30A/m, 50/60Hz

bursts 5 kHz and 100 kHz repetition 5kHz repetition frequency
frequency

Edition 4

+ 2 kV for power supply lines

100 kHz repetition frequency

+ 1 kV for input/output lines

100kHz repetition frequency
IEC/EN +0.5kV, £1KkV line to line Edition 3 and 4 Main power quality
61000-4-5 +0.5kV, £1kV, £2kV Line +0.5kV, £ 1KV line to line should be that of a
Surge to earth +0.5kV, £ 1kV, +£2kV Line typical commercial and/
Immunity to earth or hospital environment.
IEC/EN 3 A/m, 50/60Hz Edition 3 Power frequency
61000-4-8 30 A/m, 50/60Hz 3A/m, 50/60Hz magnetic fields should
Power be at levels
frequency Edition 4 characteristic of a typical

location in a typical
commercial and/or
ospital environment.
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Safety Precautions

Table 2-10:

Declaration of Immunity

Guidance and manufacturer’s declaration - electromagnetic immunity

The system is intended for use in the electromagnetic environment specified below. The
customer or the user of this system should assure that it is used in such an environment.

Electromagnetic

Immunity Regulatory Acceptable environment -
Type Equipment Capability Level guidance
IEC/EN < 5%U+ (> 95% dip) for 0.5 Edition 3 Mains power quality
61000-4-11 cycle; < 5%Ur (> 95% dip) for 0.5 should be that of a
Voltage dips 40%U+ (60% dip) for 5 cycle; typical commercial and/
and cycles; 40%U+ (60% dip) for 5 or hospital environment.
interruptions 70%U7 (30% dip) for 25 cycles: If the user requires
cycles: 70%Ur (30% dip) for 25 gon_ﬁnued operation
< 5%U7 (>95% dip) for 5 sec cycles; uring power mains

0% Ut; 0.5 cycle, Phase:
0,45,90,135,180,225,270,315
degree

0% U+; 1 cycle, Phase: 0
degree

70% U+; 25/30 cycle, Phase:
0 degree

0% U; 250/300 cycle

*Applicable deviations
standard IEC 60601-2-37
(202.6.2.7)

< 5%U+ (>95% dip) for 5 sec

Edition 4

0% U~; 0.5 cycle, Phase:
0,45,90,135,180,225,270,315
degree

0% Ur; 1 cycle, Phase: 0
degree

70% U+; 25/30 cycle, Phase:
0 degree

0% Ur; 250/300 cycle

interruptions, it is
recommended that the
system be powered from
a UPS or a battery
option.

NOTE: UT is the a.c. mains voltage prior to application of the test level
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Safety

Table 2-10:

Declaration of Immunity

Guidance and manufacturer’s declaration - electromagnetic immunity

The system is intended for use in the electromagnetic environment specified below. The
customer or the user of this system should assure that it is used in such an environment.

Immunity
Type

Equipment Capability

Regulatory Acceptable
Level

Electromagnetic
environment -
guidance

IEC/EN
61000-4-6
Conducted
RF

3Vrms at 0.15MHz - 80 MHz,
80% AM at 1 kHz

6 Vrm in ISM bands between
0.15 MHz - 80 MHz

80 % AM at 1kHz

Edition 3
3 Vrms at 0.15MHz - 80 MHz,
80% AM at 1 kHz

Edition 4
3 Vrms at 0.15MHz - 80 MHz

80 % AM at 1kHz

IEC/EN
61000-4-3
Radiated RF
EM fields

3Vim

80MHz - 2.7GHz
80 % AM at 1 kHz

Edition 3
3V/m, 80 MHz - 2.5 GHz,
80% AM 1 kHz

Edition 4

3Vim,

80MHz - 2.7GHz
80% AM at 1kHz

Portable and mobile RF
communications
equipment should be
used no closer to any
part of this system,
including cables, than
the recommended
separation distance
calculated from the
equation applicable to
the frequency of the
transmiter.
Recommended
separation distance

I=2E
I

d= [EHF 80 MHz to 800 MHz
|

7
d=[—WP 800 MHz 02,5 GHz
£

where P is the maximun
output power rating of
the transmitter in watts
(W) according to the
transmitter manufacturer
and d is the
recommended
separaion distance in
meres (m). Field
strengths from fixed RF
transmiters, as
determined by an
electromagnetic site
survey, a) should be
lessthan the compliance
level in each frequency
range. b) Interference
may occur in the vicinity
of equipment marked
with the following
symbol:

()
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Safety Precautions

Table 2-10:

Declaration of Immunity

Guidance and manufacturer’s declaration - electromagnetic immunity

The system is intended for use in the electromagnetic environment specified below. The
customer or the user of this system should assure that it is used in such an environment.

Electromagnetic

1720 MHz: 28 V/m, PM at
217 Hz

1845 MHz: 28 V/m, PM at
217 Hz

1970 MHz: 28 V/m, PM at
217 Hz

2450 MHz: 28 V/m, PM at
217 Hz

5240 MHz: 9 V/Im, PM at 217
Hz

5500 MHz: 9 V/Im, PM at 217
Hz

5785 MHz: 9 V/m, PM at 217
Hz

50 % Duty cycle

1720 MHz: 28 V/m, PM at
217 Hz

1845 MHz: 28 V/m, PM at
217 Hz

1970 MHz: 28 V/m, PM at
217 Hz

2450 MHz: 28 V/Im, PM at
217 Hz

5240 MHz: 9 V/im, PM at 217
Hz

5500 MHz: 9 V/im, PM at 217
Hz

5785 MHz: 9 Vim, PM at 217
Hz

50 % Duty cycle

Immunity Regulatory Acceptable environment -
Type Equipment Capability Level guidance
IEC/EN 385 MHz: 27 V/m, PM at 18 385 MHz: 27 V/m, PM at 18 Portable RF
61000-4-3 Hz Hz communications
Proximity 450 MHz: 28 V/im, FM at+ 5 450 MHz: 28 V/im, FM at £ 5 equipment (including
fields from RF | kHz kHz peripherals such as
wireless deviation 1 kHz sine or PM at | deviation 1 kHz sine or PM at | antenna cables and
communicatio | 18 Hz 18 Hz external antennas)
ns equipment 710 MHz: 9 V/Im, PM at 217 710 MHz: 9 V/m, PM at 217 should be used no
Hz Hz closer than 30 cm (12
745 MHz: 9 V/m, PM at 217 745 MHz: 9 V/Im, PM at 217 inches) to any part of the
Hz Hz system, including cables
780 MHz: 9 V/m, PM at 217 780 MHz: 9 V/m, PM at 217 specified by the
Hz Hz manufacturer.
810 MHz: 28 V/m, PM at 18 810 MHz: 28 V/m, PM at 18 Otherwise, degradation
Hz Hz of the performance of
870 MHz: 28 V/m, PM at 18 870 MHz: 28 V/m, PM at 18 this equipment could
Hz Hz result.
930 MHz: 28 V/m, PM at 18 930 MHz: 28 V/m, PM at 18
Hz Hz Minimum separation

distances for higher
IMMUNITY TEST
LEVELS shall be
calculated using the
following equation:

E= L2 P
d\V

Where P is the
maximum power in W, d
is the minimum
separation distance in
m, and E is the
IMMUNITY TEST
LEVEL in V/m.
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Safety

Declaration of Immunity (continued)

Table 2-11:  Declaration of Immunity

Equipment Regulatory EMC Environment
Immunity Type Capability Acceptable Level and Guidance

NOTE: This guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption
and reflection from structures, objects, and people.

a) Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and
land mobile radios, amateur radio, AM and FM radio broadcast, and TV broadcast cannot be predicted
theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, and
electromagnetic site survey should be considered. If the measured field strength in the location in which this
system is used exceeds the applicable RF compliance level above, this system should be observed to verify
normal operation. If abnormal performance is observed, additional measures may be necessary, such as
re-orienting or relocating this system.

b) Over the frequency range 150 kHz to 80 MHz field strengths should be less than 3 V/m.
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Safety Precautions

Declaration of Immunity (continued)

Table 2-12:  Test specifications for IEC/EN 61000-4-3 proximity fields from RF wireless
communications equipment
IMMUNI
Test TYTEST
frequency Maximum | Distance LEVEL
(MHz) Band Service Modulaion | power (w) (m) (V/im)
385 380-390 TETRA 400 Pulse 1.8 0.3 27
modulation
18 Hz
450 430-470 GMRS, 460, FM 2 0.3 28
FRS 460 + 5 kHz
deviation
1 kHz sine
710 704-787 LTE Band 13, | Pulse 0.2 0.3 9
17 modulation
745 217 Hz
780
810 800-960 GSM 800/ Pulse 2 0.3 28
900, TETRA modulation
870 800, 18Hz
iDEN 820,
930 CDMA 850,
LTE Band 5
1720 1700-1990 | GSM 1800; Pulse 2 0.3 28
CDMA 1900; modulation
1845 GSM 1900; 217Hz
DECT:
1970 LTE Band
1,3,4,25;
UMTS
2450 2400-2570 | Bluetooth, Pulse 2 0.3 28
WLAN, modulation
802.11 b/g/n, 217 Hz
RFID 2450,
LTE Band 7
5240 5100-5800 | WLAN 802.11 | Pulse 0.2 0.3 9
a/n modulation
5500 217 Hz
5785
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Safety

Essential performance

The essential performance of the ultrasound unit is:

+ The ability to display B-mode image as input for diagnosis.

* The ability to display M-mode image as input for diagnosis.

+ The ability to display Doppler-mode image as input for
diagnosis.

* The ability to display Color Flow-mode image as input for
diagnosis.

* The display of acoustic power indexes as an aid for safe use
of ultrasound diagnostic (MI, TIS, TIB, TIC).
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Safety Precautions

Patient Environmental Devices

Figure 2-1. Patient Environmental Devices

1. Power On/Off 5. Signals I/O Port (USB Ports, Network
2. USB Port Connector, Audio In/Out, HDMI)

2-1 > USB Port (additional option with HD 6. Imaging probe ports

Display) 7. ECG Connector
3. CW pencil probe port 8. Articulating arm

4. Power In/Out (Signal I/O port, Power line (AC~),
Ground line, Power cable with Protective earth)

CAUTION DO NOT place a PC printer and a card reader inside the
patient environment.
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Safety

Acceptable Devices

The Patient Environmental devices shown on the previous page
are specified to be suitable for use within the PATIENT
ENVIRONMENT.

by GE within the PATIENT ENVIRONMENT.

See ‘Peripheral Update for EC countries’ on page 2-23 for
more information.

f CAUTION DO NOT connect any probes or accessories without approval

Unapproved Devices

f CAUTION DO NOT use unapproved devices.

If devices are connected without the approval of GE, the
warranty will be INVALID.

Any device connected to the LOGIQ P8/P9/P10 must conform
to the requirements for IEC or equivalent standards appropriate
to devices.

Accessories, Options, Supplies

accessories, options and supplies approved or recommended

f CAUTION Unsafe operation or malfunction may result. Use only the
in these instructions for use.
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Safety Precautions

Acoustic Output

probe not in use (or in its holder) can cause the transducer to
build up heat. Always lower the acoustic power or freeze the
image when not in use.

f CAUTION Allowing the machine to transmit acoustic output when the

Located on the upper right section of the system display monitor,
the acoustic output display provides the operator with real-time
indication of acoustic levels being generated by the system. See
the Acoustic Output chapter in the Advanced Reference Manual
for more information. This display is based on NEMA/AIUM
Standards for Real-time Display of Thermal and Mechanic
Acoustic Output Indices on Diagnostic Ultrasound Equipment.
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Safety

Acoustic Output Display Specifications

The display consists of three parts: Thermal Index (TI),
Mechanical Index (M), and a relative Acoustic Output (AO)
value. Although not part of the NEMA/AIUM standard, the AO
value informs the user of where the system is operating within
the range of available output.

The Tl and MI are displayed at all times. The Tl display starts at
a value of 0.0 and increments in steps of 0.1. The Ml display
values between 0 and 0.4 increment in steps of 0.01 and for
values greater than 0.4, increments in steps of 0.1.

Thermal Index

Depending on the examination and type of tissue involved, the
Tl parameter will be one of three types:

+ Soft Tissue Thermal Index (TIS). Used when imaging soft
tissue only, it provides an estimate of potential temperature
increase in soft tissue.

+ Bone Thermal Index (TIB). Used when bone is near the
focus of the image as in the third trimester OB examination,
it provides an estimate of potential temperature increase in
the bone or adjacent soft tissue.

* Cranial Bone Thermal Index (TIC). Used when bone is
near the skin surface as in transcranial examination, it
provides an estimate of potential temperature increase in
the bone or adjacent soft tissue.
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Safety Precautions

Acoustic Output Display Specifications (continued)

Mechanical Index

MI recognizes the importance of non-thermal processes,
cavitation in particular, and the Index is an attempt to indicate
the probability that they might occur within the tissue.

Changing the Thermal Index Type

You can select the displayed Tl type on Utility -> Imaging ->
B-Mode. This preset is application dependent so each
application could specify a different Tl type.

Controls Affecting Acoustic Output

The potential for producing mechanical bioeffects (Ml) or
thermal bioeffects (TI) can be influenced by certain controls.

Direct. The Acoustic Output control has the most significant
effect on Acoustic Output.

Indirect. Indirect effects may occur when adjusting controls.
Controls that can influence Ml and T1 are detailed under the
Bioeffects portion of each control in the Optimizing the Image
sections.

Always observe the Acoustic Output display for possible effects.

LOGIQ P8/P9/P10 — Basic User Manual 2-39
Direction 5841298-1EN Rev. 2



Safety

Best practices while scanning

NOTE:

é WARNING

4 Acoustic
= Output
" Hazard

Raise the Acoustic Output only after attempting image
optimization with controls that have no effect on Acoustic
Output, such as Gain and TGC.

Refer to the Optimizing the Image sections for a complete
discussion of each control.

Be sure to have read and understood control explanations for
each mode used before attempting to adjust the Acoustic
Output control or any control that can effect Acoustic Output.

Use the minimum necessary acoustic output to get the best
diagnostic image or measurement during an examination.
Begin the exam with the probe that provides an optimum focal
depth and penetration.

Acoustic Output Default Levels

2-40

In order to assure that an exam does not start at a high output
level, the LOGIQ P8/P9/P10 initiates scanning at a reduced
default output level. This reduced level is preset programmable
and depends upon the exam category and probe selected. It
takes effect when the system is powered on or New Patient is
selected.

To modify acoustic output, adjust the Power Output level on the
Touch Panel.
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Device Labels

Device Labels

Label Icon Description

The following table describes the purpose and location of safety
labels and other important information provided on the

equipment.

Table 2-13: Label Icons

or protection.

IEC 60601-1:2005+A1:2012

Label/lcon Meaning/Reference Standard Location
Identification and Rating Plate Manufacturer’'s name and address Rating Plate
EN ISO 15223-1:2016 and I1SO
7000-3082
Identification and Rating Plate Date of manufacture Rating Plate
EN ISO 15223-1:2016 and I1SO
7000-2497
Serial Number Rating Plate
SN ISO 7000-2498 and EN 1SO
15223-1:2016
GE Part Number Rating Plate
H E F ISO 7000-2493 and EN ISO
15223-1:2016
Type/Class Label Used to indicate the degree of safety Rear of the system
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Safety

Table 2-13:

Label Icons (Continued)

Label/lcon

Meaning/Reference Standard

Location

Rx Only

United States only
Prescription Requirement label

21 CFR 801.109 and Alternative to
Certain Prescription Device Labeling
Requirements Guidance to Industry 1/
2/2000 U.S. Food&Drug
Administration modified by General
Electric for clarity that this is for the
USA

Rear of the system

C€oss

CE Mark

The CE Mark of Conformity indicates
this equipment conforms with the
Council Directive 93/42/EEC.

European Directive 93/42/EEC

Rear of the system

EC | REP

Authorized European Representative
address

EN ISO 15223-1:2016

Rear of the system

IP Code (IPX8)

Indicates the degree of protection
provided by the enclosure per IEC60
529. Can be used in operating room
environment.

IEC 60601-1:2005+A1:2012 Annex
D.3 and IEC 60529

Footswitch

ECG symbol

GE created

Right side of the OPIO

Nos
R

Type BF Applied Part (man in the box)
symbol is in accordance with IEC
60878-02-03.

IEC 60601-1:2005+A1:2012 Annex
D.1 and IEC 60417-5333

Probe marked Type BF

Defibrillation-proof CF applied part

IEC 60601-1:2005+A1:2012 Annex
D.1 and IEC 60417-5336

ECG connector

Follow instruction for use.

IEC 60601-1:2005+A1:2012 Annex
D.1 and ISO 7010-M002

Rear of the system
Probe connector
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Device Labels

Table 2-13:  Label Icons (Continued)

Label/lcon Meaning/Reference Standard Location

“General Warning Sign” Rear of the system

IEC 60601-1:2005+A1:2012 Annex D
and ISO 7010-W001

“Warning” - Dangerous voltage” (the Internal

lightning flash with arrowhead) is used
to indicate electric shock hazards.

IEC 60601-1:2005+A1:2012 Annex
D.2 and ISO 7010-W012

“Mains OFF” indicates the power off Rear of the system
position of the mains power breaker.

IEC 60601-1:2005+A1:2012 Annex
D.1 and IEC 60417-5008

“Mains ON” indicates the power on Rear of the system
I position of the mains power breaker.

IEC 60601-1:2005+A1:2012 Annex
D.1 and IEC 60417-5007

“ON” indicates the power on position Operator control panel
of the power switch.

CAUTION: This Power Switch DOES
NOT ISOLATE Mains Supply.

IEC 60601-1:2005+A1:2012 Annex
D.1, IEC 60417-5007 and IEC
60417-5009

“Protective Earth” indicates the Internal

@ protective earth (grounding) terminal.

IEC 60601-1:2005+A1:2012 Annex
D.1 and IEC 60417-5019
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Safety

Table 2-13:

Label Icons (Continued)

Label/lcon

Meaning/Reference Standard Location

v

“Equipotentiality” indicates the
terminal to be used for connecting
equipotential conductors when
interconnecting (grounding) with other
equipment.

Connection of additional protective
earth conductors or potential
equalization conductors is not
necessary in most cases and is only
recommended for situations involving
multiple equipment in a high-risk
patient environment to provide
assurance that all equipment is at the
same potential and operates within
acceptable leakage current limits. An
example of a high-risk patient would
be a special procedure where the
patient has an accessible conductive
path to the heart such as exposed
cardiac pacing leads.

IEC 60601-1:2005+A1:2012 Annex
D.1 and IEC 60417-5021

Rear of the system

This symbol indicates that waste
electrical and electronic equipment
must not be disposed of as unsorted
municipal waste and must be collected
separately. Please contact an
authorized representative of the
manufacturer for information
concerning the decommissioning of
your equipment.

WEEE Directive 2012/19/EU

Rear of the system
Probe connector
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Device Labels

Table 2-13:  Label Icons (Continued)

Label/lcon Meaning/Reference Standard Location

Indicates the presence of hazardous Probe connector
substance(s) above the maximum
‘“] concentration value. Maximum

‘%! j concentration values for electronic
information products, as set by the
People’s Republic of China Electronic
Industry Standard SJ/T11364-2006,
include the hazardous substances of
lead, mercury, hexavalent chromium,
cadmium, polybrominated biphenyl
(PBB), and polybrominated diphenyl
ether (PBDE). “10” indicates the
number of years during which the
hazardous substance(s) will not leak
or mutate so that the use of this
product will not result in any severe
environmental pollution, bodily injury,
or damage to any assets.

China Electroniclndustry Standard SJ/
T11364-2014

Indicates the presence of hazardous Rear of the system
: substance(s) above the maximum
é 2 {] ? concentration value. Maximum
concentration values for electronic
information products, as set by the
People’s Republic of China Electronic
Industry Standard SJ/T11364-2006,
include the hazardous substances of
lead, mercury, hexavalent chromium,
cadmium, polybrominated biphenyl
(PBB), and polybrominated diphenyl
ether (PBDE). “20” indicates the
number of years during which the
hazardous substance(s) will not leak
or mutate so that the use of this
product will not result in any severe
environmental pollution, bodily injury,
or damage to any assets.

China Electronic Industry Standard SJ/
T11364-2014
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Safety

Table 2-13:

Label Icons (Continued)

Label/lcon

Meaning/Reference Standard

Location

Do not use the following devices near
this equipment: cellular phone, radio
receiver, mobile radio transmitter,
radio controlled toy, broadband power
lines, etc. Use of these devices near
this equipment could cause this
equipment to perform outside the
published specifications. Keep power
to these devices turned off when near
this equipment.

ISO 7010-P013

Rear of the system

LAMP CONTAINS MERCURY, |
DISPOSE ACCORDING TO
STATE/ILOCAL LAW. #T3814

) A, IWRLERGE. |

This product consists of devices that
may contain mercury, which must be
recycled or disposed of in accordance
with local, state, or country laws.
(Within this system, the backlight
lamps in the monitor display, contain
mercury.)

A chemical element with the symbol
Hg and atomic number 80

Rear of the system

MEDICAL - ULTRASOUND EQUIPMENT

AS TO ELECTRICAL SHOCK, FIRE AND

MECHANICAL HAZARDS ONLY IN

[ us ACCORDANCE WITH ANSI/AAMI
ESG0601-1:2005/|RIZ012 AND AL-2012,

C1:2009/RI2012 AND AZ2010/RIZ012

CSA CANCSA-C22.2 NO. 60601-1:14

551K,
S

UL conformity mark according to
ANSI/AAMI ES60601-1:2005/(R) 2012
and CAN/CSA C22/2 NO. 601.1:14.

ANSI/ AAMI ES60601-1:2005/(R)
2012 and CAN/CSA-C22.2 No.
60601-1:14

Rear of the system

How to lock Monitor Arm prior to
transport

GE created

Rear of the system.

DO NOT place a finger, hand or any
object on the joint of the monitor or
monitor arm to avoid injury when
moving the monitor and monitor arm.

GE created

Rear of the LCD monitor.

DO NOT push the system. Use the
handle to push/pull the system, e.g.,
DO NOT use the LCD. Failure to do so
may cause serious injury or system
damage.

IEC 60601-1:2005+A1:2012 Annex
D.2 and ISO 7010-P017

Rear of the system
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Device Labels

Table 2-13:

Label Icons (Continued)

Label/lcon

Meaning/Reference Standard

Location

Caution

IEC 60601-1:2005+A1:2012 Annex
D.1, ISO 7000-0434A and EN ISO
15223-1:2016

Probe connector

EAL

Eurasian Confirmity mark; the single
conformity mark for circulation of
products on the markets of
member-states of the Customs Union.
This product passed all conformity
assessment (approval) procedures
that correspond to the requirements of
applicable technical regulations of the
Customs Union.

conformity with the technical
regulation

SIDE OF FAN BRKT, Country
specific label

Seguranca

wow. Compulsério

INMETRO

INMETRO Certification: TUV
Rheinland Brazil

Brazil INMETRO

SIDE OF FAN BRKT, Country
specific label

Non-lonizing Electromagnetic SIDE OF OPIO
Radiation
(p=i)
[ IEC 60417-5140
IEC TR 60878-5140
GOST Symbol. Russia Regulatory Rear Panel

Country Clearance.

National standards of the Russian
Federation and CIS countries
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Table 2-13:

Label Icons (Continued)

Label/l

con

Meaning/Reference Standard

Location

“ GE ULTRASOUND KOREA, Ltd.

100-260v~, S0/60Hz, 500-500VA

9, Sunhwan-ro 214bean-gil, Jungwon-gu, Bikg
SEONGNAM-SI, GYEONGG!-DO, Republcc of Korea 5842858

d 202001 LOGIQPE RY
[E0 123456789 mmmwm

MSEre,  MEDICAL- ULTRASOUND EQUIPMENT AS TO ELECTRICAL
SHOCK, FIRE AND MECHANICAL HAZARDS ONLY IN

c US ACCORDANCE WITH ANSI/AA!
ANDAL2012,CL2009/RIZD]

B3RS (SACAN/CSA-C22.2 NO.60601-114

LOGIQ P8

1111000000(211000000000

ES60601-1:2005/1R12012
AND A2:2010/1Rj2012

P

“ GE ULTRASOUND KOREA, Ltd.
SEONGNAM-SI, GYEONGGI-DO, R
100-240V -, 50/60Hz, S00-500VA

=] 123456789 gl

M5S0 MEDICAL - LLTRASOUN

\

9. Sunhwan-ro 214beon-gi, Jungwon-gu, B3 kg
M w001 EER L0GIgPIRG
& > SHOCK, FIRE AND MECHANICAL HAZARDS ONLY IN
c@us ACCORDANCE WITH ANSY/AAMI ESE0601-1:2005/1R12012

AND AL:2012, C1:2009/RI2012 AND AZ20104RI2012
E355635 CSACANICSA-C22 2 NO. 60601-1'14

LOGIQ P9

epublicof Koreo 5842859

101X00000000000000
(11X000000211000000000
ID EQUIFMENT AS TO ELECTRICAL

‘ GE ULTRASOUND KOREA, Lid

SEONGNAM-SI, GYEONGGI-DO, Republic of Korea 5842860

100-2404'~, S0/60Hz. 500-500VA
4] w2001 LOGIQ P10

9, Sunhwaon-ro 214beon-gi, Jungwon-gu, 83kg

[E5] 123456789 mmm:mwmo

",‘55"/@’ MEDICAL - ULTRASOUND EQUIPMENT AS TO ELECTRICAL
SHOCK, FIRE AND MECHANICAL HAZARDS ONLY IN
c s ACCORDANCE WITH ANSU/AAMI ESE0601-1:2005/RI2012
AND A1Z012, C1:2003/R12012 AND AZ2010/{RI2012
E3S5835  CSACANICSA-CZ22 NO60601-1:14

LOGIQ P10

R4

1111000000¢211000000000

d GE ULTRASOUND KOREA, Ltd.

100-240V~, 50/60Hz, 500-500VA
] 202001 LOGIQPI0

9, Suntwan-ro 214beon-gil, Jungwon-gu, 83kg
SEONGNAM-SI. GYEONGGI-DO, Republic of Korea 5858143

[E5] 123456789 (o mmmﬂmu)m
(et

X587, MEDICAL - ULTRASOUND EQUIPMENT AS TO ELECTRICAL
SHOCK, FIRE AND MECHANICAL HAZARDS ONLY IN
c U ACCORDANCE WATH ANSU/AAMI ESE0EOL- 1200512012
AND A12012, C1-2009ARI2012 AND A2-2010/IRI2012
ESSSEIS  CSACANICSA-C22.2 NO.6ORO1-1:14

LOGIQP1O

RAHD

(11100000012 1J000000000

Every system has a unique marking
for identification, the Unique Device
Identification (UDI) Label. The UDI
label consists of a series of
alpha-numeric characters and barcode
which uniquely identify the LOGIQ P8/
P9/P10 system as a medical device
manufactured by General Electric.
Scan or enter the UDI information into
the patient health record as required
by country-specific laws.

GE created

Rating Plate

=e

e-IFU symbol

Rear of the system

Use two people to transport system on

inclines. This label also indicates the

system weight.

The equipment weights approximately

67kg (148 Ibs) (69 kg with HD Display

(152 Ibs)). To avoid possible injury and

equipment damage when transporting

from one area of use to another.

* Be sure the pathway is clear.

» Use two or more persons to move
the equipment on inclines or long
distance.

Rear of the system
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Device Labels

Label location

= 9®®®(E.»Rxﬂnlu§_3

—

A

Figure 2-2. Label location

* Required for Asia.

1. LCD Caution Label
2. Gender Caution Label (Only for India, China, Korea)
3. Multi Caution Label
4. LOGIQ P8/P9/P10 Rating Label (Only for China, Korea,
Japan)
5. LOGIQ P8/P9/P10 Rating label
6. UL Label
LOGIQ P8/P9/P10 — Basic User Manual 2-49
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Safety

Label on the packing box

Air Pressure
700 - 1060hpa

Humidity !oqnv. ADTSIC In Storage
Non Conden -18°C-50°C In Transportatio

KIB 0D G P
CGMSQ

Figure 2-3. Package label

This label is printed on the packing box of the system to indicate
the humidity, temperature and air pressure condition for the
storage and shipment.
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RoHS LOGIQ P8/P9/P10 Hazardous Substances

RoHS LOGIQ P8/P9/P10 Hazardous

Substances

Table 2-14: Table of Hazardous Substances’ Name and Concentration for LOGIQ P8/

PO/P10
Hazardous Substances’ Name
Component
Name Pb Hg Cd Cr(VI) PBB PBDE
Ultrasound Probes | X O o} O o} o}
LCD Monitor X (o) (0] o (0] o)
Operator Panel X O (0] O (0] (0]
PWAs X (o) (0] (o) o) (o)
Cables X O o} o} o} o}
Power assembly X (0] O (0] (0] (0]
System Covers X (0] (0] (0] (0] (0]
Frame Assembly O (0] (0] (0] (0] (0]
Rubber o O o} o} o} o}

This table is prepared according to SJ/T 11364.

O: Indicates that hazardous substance contained in all of the homogeneous materials for this part is below

the limit requirement in GB/T 26572.

X: Indicates that hazardous subsstance contained in at least one of the homogeneous materials used for

this part is above the limit requirement in GB/T 26572

« Data listed in the table represents best information available at the time of publication.

« Applications of hazardous substances in this medical device are required to achieve its intended clinical
uses, and/or to provide better protection to human beings and/or to environment, due to lack of
reasonably (economically or technically) available substitutes.
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Chapter 3

Preparing the System for Use

Describes the site requirements, console overview,
system positioning/transporting, powering on the
system, adjusting the display monitor, probes and
operator controls.
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Preparing the System for Use

Introduction

ﬁ WARNING

f CAUTION
f CAUTION

Training

3-2

Site Requirements

All the warnings in the Safety chapter should be read and
understood before operating the unit.

Do not unpack the LOGIQ P8/P9/P10. This must be performed
by qualified service personnel only.

Always use the system on a flat surface in the patient
environment.

Do not attempt to install the system alone. General Electric,
Affiliate, or Distributor Field Engineers and Application
Specialists will install and setup the system. See ‘Contact
Information’ on page 1-7 for more information.

Perform regular preventive maintenance.

Maintain a clean environment. Turn off, and if possible,
disconnect the system before cleaning the unit.

Only qualified physicians or sonographers should perform
ultrasound scanning on human subjects for medical diagnostic
reasons. Request training, if needed.

LOGIQ P8/P9/P10 — Basic User Manual
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Site Requirements

Before the system arrives

The ultrasound unit must operate within the proper environment
and in accordance with the requirements described in this
section. Before using the system, ensure that the requirements
are met.

Power Requirements

* A separate power outlet with a 15 amp circuit breaker.
* Frequency: 50 Hz, 60 Hz (+/-2%)
+ 100V - 240V AC

Electromagnetic interferences

This medical equipment is approved, in terms of the prevention
of radio wave interference, to be used in hospitals, clinics and
other institutions which are environmentally qualified. The use of
this equipment in an inappropriate environment may cause
some electronic interference to radios and televisions around
the equipment.

Ensure that the following is provided for the new system:

» Take precautions to ensure that the console is protected
from electromagnetic interference.

Precautions include:

* Operate the console at least 5 meters (15 feet) away
from motors, typewriters, elevators, and other sources
of strong electromagnetic radiation (non-medical grade
UPS must be at least 2 meters (6 feet) away from
console).

* Operation in an enclosed area (wood, plaster or
concrete walls, floors and ceilings) helps prevent
electromagnetic interference.

+ Special shielding may be required if the console is to be
operated in the vicinity of radio broadcast equipment.

strong electric or magnetic fields (close to a transformer), or
near instruments generating high-frequency signals, such as
HF surgery. These can affect the ultrasound images adversely.

f CAUTION Do not operate the system in the vicinity of a heat source, of

LOGIQ P8/P9/P10 — Basic User Manual 3-3
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Preparing the System for Use

Environmental Requirements

The system should be operated, stored, or transported within
the parameters outlined below. Either its operational
environment must be constantly maintained or the unit must be

turned off.
Table 3-1:  System Environmental Requirements
Operational Storage Transport

Temperature 10° - 35°C/50° - 95°F with 2D [ -10°-50°C -10°-50°C

probe 14° - 122°F 14° - 122°F

18° - 30°C/64.4° - 86°F with

4D probe
Humidity 10-80% non-condensing 10 - 90% 10 - 90%

non-condensing non-condensing

Pressure 700 - 1060hPa 700 - 1060hPa 700 - 1060hPa

f CAUTION
f CAUTION

Check the room temperature before you use the 4D probe.

Ensure that the probe face temperature does not exceed the
normal operation temperature range.

Operating Environment

f CAUTION

Ensure that there is sufficient air flow around the ultrasound unit
when installed in a fixed location.

Do not cover the ventilation holes of the LOGIQ P8/P9/P10.

Operating altitude

3-4

Maximum operating altitude for use: 3000m
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Site Requirements

Probe

Probes should be operated, stored, or transported within the
parameters outlined below.

NOTE: See provided TEE probe user manual for the environmental
requirements of the TEE probe.

Table 3-2: Probe Environmental Requirements

Operational
Temperature 10° - 35 °C for 2D probe
18° - 30 °C for 4D probe
Humidity 10 - 80% (non-condensing) for 2D probe
30 - 80% (non-condensing) for 4D probe
Pressure 700 - 1060hPa
LOGIQ P8/P9/P10 — Basic User Manual 3-5
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Preparing the System for Use

Console Graphics

Console Overview

N =

N OAWL

Figure 3-1.

LCD Monitor

USB port

2-1> USB Port (additional
option with HD Display)
Touch panel

Probe holder

Control panel swivel button
Control panel up/down button
A/N keyboard (Option)

Multi purpose holder (Option)

10.
1.
12.
13.

14.
15.

DVD Drive (Option)

BW printer (Option)

Drawer (Option)

Foot rest

CW pencil probe port
(Option)

Side tray (Standard)

Probe ports - 4 active probe
ports (3 RS, 1 DLP)

16.
17.
18.
19.
20.
21.
22.
23.

24.

LOGIQ P8/P9/P10 System (High cabinet type example)

Paper tray (Option)
Audio speaker

OPIO tray (Option)
Rear handle (Option)
ECG connector (Option)
Articulating arm
External I/O panel
Extended Battery Life
(Option)

Probe Light
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Console Overview

Low cabinet type

Figure 3-2. Low cabinet

a. DVD Drive (Option)
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Preparing the System for Use

High cabinet type

LOGIQ

Figure 3-3. High cabinet

a. DVD Drive (Option)
b. B/W Printer or Drawer
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Console Overview

Speakers

Audio is provided by speakers. For the location of the speaker,
see Figure 3-1 on page 3-6.

NOTE: You make volume corrections on the Ulility Touch Panel (Master
Volume, Effects Volume).
* Audio Doppler operation
» Audio playback of recorded scan sessions
» Audio error notification.
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Preparing the System for Use

Peripheral/Accessory Connection

Peripheral/Accessory Connector Panel

f CAUTION

f CAUTION

f CAUTION
f CAUTION

3-10

LOGIQ P8/P9/P10 peripherals and accessories can be properly
connected using the Peripheral/Accessory Connector Panel.

For compatibility reasons, use only GE-approved probes,
peripherals, or accessories.

DO NOT connect any probes or accessories without approval
by GE.

The connection of equipment or transmission networks other
than as specified in these instructions can result in electric
shock hazard. Alternate connections will require verification of
compatibility and conformity to IEC/EN 60601-1 by the installer.

DO NOT touch the conducting parts of the USB or Ethernet
cables when connecting equipment to the unit.

When using peripheral device, observe all warnings and
cautions given in peripheral operator manuals.
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Console Overview

Peripheral/Accessory Connector Panel (continued)

=
4@
3 HDMI
—

L & 8
i
S\I\—J 9

=8 v@

100- 240V 50/ 60Hz 5004

Figure 3-4. Peripheral/Accessory Connector Panel

1. USB Port USB2.0 Full Speed

2. Composite connector Composite connector for external
monitor

3. HDMI connector HDMI connector for external monitor

4. USB Port USB2.0 Full Speed

5. S-Video connector S-Video connector for external monitor

6. Circuit breaker 10A

7. AC Inlet 100-240Vac

8. Ethernet LAN for InSite, DICOM, Network storage
Connection

9. Equipotential terminal
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Preparing the System for Use

Peripheral/Accessory Connector Panel (continued)

connector, HDMI connector or S-video connector, the external
peripheral and external monitor shall be powered through a
medical grade isolation transformer (Figure 1-5) if it requires
external AC power source. Please contact GE Service
Representative for installation of medical grade isolation
transformer.

f CAUTION When connecting external peripherals on USB port, composite

Figure 3-5. MED 300 WR (medical grade isolation
transformer)
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Console Overview

Storage areas

Probe holder and Gel warmer

. _a
a P
e & & & @
.- = -
Figure 3-6. Probe holder and Gel warmer (Gel holder)
a. Probe holder
b. Gel warmer (Gel holder)
Turn on the system, then turn on the gel warmer.
- a
Figure 3-7. On/Off switch of Gel warmer
a. On/Off switch (Left: Off, Right: On)
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Preparing the System for Use

Trays (Option)

b
Figure 3-8. Trays
a. OPIO tray
b. Papertray
CAUTION DO NOT place the probe, the footswitch and/or any peripherals
on the side tray when moving/transporting the system.
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Console Overview

Multi purpose holder (option)

Figure 3-9. Multi purpose holder (Option)

a. Optional multi purpose holder
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Preparing the System for Use

Attachment for small probe (Option)

Figure 3-10. Attachment (Option)

Push the attachment into the probe holder as below.

\

Figure 3-11. Push the attachment

Figure 3-12. Attachment in the proper position
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Console Overview

Extended Battery (Option)

Figure 3-13. Extended Battery

a. Optional Extended Battery

The recommended battery usage is:

* Power Assistant: 15 minutes of offline scanning
+ Extended battery: 60 minutes of offline scanning
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Preparing the System for Use

View current battery status

When the system is running on battery power, the following
icons display on the status bar at the bottom of the display:

Table 3-3: Battery status icons

Icon Description
No icon AC Plugged; no battery present
AC Plugged; battery is fully charged (100%)
P
Ml
AC Plugged; battery is partially charged (50%-94%)
I :-l-l
=g
AC Plugged; battery is partially charged (20%-49%)
EI-: :II- I :‘l-.l
= -]
AC Plugged; battery is partially charged (0%-19%)
< gl
AC Unplugged; battery is fully charged (100%)
AC Unplugged; battery is partially charged (50%-94%)
[ .II-
AC Unplugged; battery is partially charged (20%-49%)
AC Unplugged; battery is partially charged (0%-19%)
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Console Overview

View current battery status (continued)

Battery error icon

When an abnormal status of the battery is detected, the system
displays the following icon:

Table 3-4: Battery error icon

Icon Description

+ Battery Temperature error
« Communication error or battery charge error

NOTE: If this icon displays, do not inititate Power Assistant. Contact the
technical service department or your local GE representative.
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Preparing the System for Use

Starting Power Assistant

When the AC cable is unplugged or if there is an AC power
failure, the system transitions to Power Assistant. The following
dialog displays before entering Power Assistant.

@ ,- Information '

Starting Battery operation.

ENNNEERREEEE |
X Concel |

Figure 3-14. Power Assistant mode

NOTE: Verify that the system is in Power Assistant after unplugging the
power cable. The following message “Running on Battery. Key
operation locked” appears on the display during Power
Assistant.

NOTE: If the system does not transition to Power Assistant, contact the
technical service department or your local GE representative.
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Console Overview

When in Power Assistant

é CAUTION

NOTE:

f CAUTION

In Power Assistant, most of the console devices, such as the
keyboard, gel warmer and printers, are turned off to minimize
battery usage.

When in Power Assistant, DO NOT perform the following
operation:

+ Connect and disconnect probes.

* Remove peripheral devices.

* Eject or insert CD/DVD media and the external USB
storage device.

To shut down the system while in Power Assistant, plug in the
power cable, exit from Power Assistant, and then perform
regular shut down operations.

When remaining battery capacity is 30% or less, the LED on
the operator panel starts blinking. Plug in the AC cable without
delay if the LED starts blinking.

If the remaining battery capacity is too low, the system will
automatically start the full shutdown sequence.

Warning

Low Battery. System shutting down.

Figure 3-15. Battery low power warning message

LOGIQ P8/P9/P10 — Basic User Manual 3-21
Direction 5841298-1EN Rev. 2



Preparing the System for Use

Recovering from Power Assistant

The system recovers from Power Assistant when power is
supplied to the LOGIQ P8/P9/P10. The system returns to full
functionality in 10 seconds.

Refreshing the battery

3-22

To maintain the battery life, it is recommended to refresh the
battery every 6 months. Refresh procedure:

1.
2.

o gk w

®© N

Turn on the system.

Wait until the battery is fully charged. it takes at least 1 hour
to fully charge the battery.

Turn off the system.
Remove all probes.
Turn on the system.

Unplug the AC cable and wait until the system shuts down.
It may take 30 minutes or more to complete shutdown.

Wait at least 5 hours.
Plug in the AC cable.
Turn on the system.

. Wait until the battery is fully charged. It takes about 3 hours

to fully charge the battery.
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Console Overview

Battery deterioration

When the system detects battery deterioration, the following
dialog displays:

Figure 3-16. Battery life message

If this message displays, contact the technical service
department or your local GE representative.

Battery Disposal

Power Assistant uses a Lithium lon battery. Used battery will
require to discard as chemical waste. Please contact your local
authority for the directions.

NOTE: When removing a defective battery, ensure that it is disposed of
in accordance with local regulations. Alternatively, forward it to
GE for proper disposal.
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Preparing the System for Use

Offline Scanning (Option)

Offline scanning feature allows user to scan using battery power
(AC unplugged) and automatically switches to power assistant
mode (power saving mode) when the battery is running out to
prevent data loss.

Activating Offline Scanning

To use offline scanning feature, please go to utility and check
“Allow Offline Scanning (restart needed)” from System >
General page to activate offline scanning. You need to restart
application after updating the check box.

Figure 3-17. Allow Offline Scanning check
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How to use Offline Scanning

When Offline scanning is activated, the system enters an offline
scanning mode automatically when the system is disconnected
from AC power. (When Offline Scanning is disabled, the system
enters power assistant mode.)

WARNING The fresh battery allows user to keep scanning for 20 minutes
(B Mode). However, it depends on scan condition and

hardware configurations.

handle (transfer/ export/ import) patient data.(Export/Import/
Backup/ Burn Media, Dicom Transfer, etc.) The system can be
unexpectedly shutdown when the battery capacity is not
enough and resulted in losing patient data. Please note the
message in the status bar when offline scanning is activated. It
is strongly recommend to use AC power to use patient data
handling actions.

Figure 3-18. Warning message

f WARNING Do not use offline scanning mode when you need to
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Preparing the System for Use

How to see the current battery status

ﬁ WARNING

Recommendation

There is a battery icon in the status bar, but also user can
access to detailed information from battery information popup.

Click battery icon in the status bar to display the battery
information popup, which is including the current battery
capacity, brief condition, and current temperature.

Please note that the system switches to power saving mode
automatically when the capacity is under 50%.

Figure 3-19. Battery Condition

Please plug in AC power if possible, keep using the battery
power can impact to the battery life.

Optional Battery Power Saving Mode

Information

3-26

When the system located away from AC power, user can switch
to optional power-saving mode using the button in the battery
status popup. The system allows back to Offline Scanning mode
with the pressing Power button or Freeze button when the
system is in optional power-saving mode.

To notify that the battery is running out, the system displays a
dialog to confirm user want to keep scanning or not. User can
keep scanning more as possible or, go to optional power saving
mode to find near AC power.
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Powering the System

Powering the System

Connecting the System

f CAUTION
f CAUTION
f CAUTION

To avoid risk of fire, the system power must be supplied from a
separate, properly rated outlet. See ‘Before the system arrives’
on page 3-3 for more information.

Under no circumstances should the AC power plug be altered,
changed, or adapted to a configuration rated less than specified.
Never use an extension cord or adapter plug.

To help assure grounding reliability, connect to a “hospital grade”
or “hospital only” grounded power outlet.

Use the appropriate power cord provided by or designated by
GE.

Ensure that the retaining clamp for the power plug is fixed
firmly.

Use caution to ensure that the power cable does not
disconnect during system use.

If the system is accidentally unplugged, data may be lost.
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Preparing the System for Use

Connecting the System (continued)

é WARNING

Voltage level check

Failure to provide an adequate earth circuit can cause electrical
shock, resulting in serious injury.

Connection of additional protective earth conductors or
potential equalization conductors is not necessary in most
cases and is only recommended for situations involving
multiple equipment in a high-risk patient environment to
provide assurance that all equipment is at the same potential
and operates within acceptable leakage current limits. An
example of a high-risk patient would be a special procedure
where the patient has an accessible conductive path to the
heart such as exposed cardiac pacing leads.

Check the rating label on the rear side of the system. Check the
voltage range indicated on the label.

Connecting to the electrical outlet

é WARNING

NOTE:

f CAUTION

3-28

POWER OUTAGE MAY OCCUR. The ultrasound unit requires
a dedicated single branch circuit. To avoid circuit overload and
possible loss of critical care equipment, make sure you DO
NOT have other equipment operating on the same circuit.

To connect the system to the electrical supply:

1. Ensure that the wall outlet is of the appropriate type.
2. Ensure that the power switch is turned off.

3. Unwrap the power cable. Make sure to allow sufficient slack
in the cable so that the plug is not pulled out of the wall if the
system is moved slightly.

4. Attach the power plug to the system and secure it in place
by using the retaining clamp.

5. Push the power plug securely into the wall outlet.

Do not use an extension cord or adapter plug.

Disconnect the plug from the wall outlet in case an emergency
should occur. Ensure easy access to the power outlet.
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Powering the System

Power On
CAUTION Press the Power On/Off switch to turn the power on. The
circuit breaker must also be in the on position. For circuit
breaker location, see ‘Circuit breaker’ on page 3-41 for more
information.
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Preparing the System for Use

To turn on the system

1. Ensure that the unit is properly plugged into an AC outlet of
sufficient capacity (120V/10A or 240V/5A).

2. Turn on the breaker at the back of the system (refer to
Figure 3-27 ). At this point, the On/Off switch should be
turned off.

3. Momentarily press the On/Off switch. The switch turns on a
light. (refer to Figure 3-27 ).

4. The system should now go through its boot-up process with
no further user intervention (approximately 1 to 2 minutes).

Figure 3-20. Power On/Off Switch Location

a. Power On/Off switch
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Powering the System

Power Up Sequence

The system is initialized. During this time:

+ The system boots up and the status is reflected on the
monitor.

NOTE: If no probe is connected, the system goes into freeze mode.
» Peripheral devices are activated on power up.

After initialization is complete, all lighted controls on the Control
Panel light and the default B-Mode screen is displayed on the
monitor.
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Preparing the System for Use

Password Protection

Login

3-32

NOTE:

At login, you are notified that “You are accessing a diagnostic
medical device that is provided by authorized usage only. Data
stored on this device may be subject to various regulations
including but not limited to regulations which govern disclosure
and privacy of this data. By using this device you are
acknowledging that you are authorized to do so and are trained
in appropriate use and regulatory guidelines.”

You can change the wording that appears on the Login screen.
Please refer to Chapter 10, System Administration section, for
more information (Utility -> Admin -> Logon).

1.
2.
3.

Operator: Enter the Operator ID.

Password: Enter Operator’s password (optional).

Logon or Cancel.

*  OK: Proceed with the logon

+ Emergency: Data stored only for the duration of the
current exam (EUSR).

Change Password: Change password, as specified by the
Password Policy.
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Powering the System

Initial Login to the LOGIQ P8/P9/P10

When first logging in to the LOGIQ P8/P9/P10,

1. The Administrator should log in, typing “ADM” as the
Operator Login.

NOTE: No password is needed for the initial administrator log in.

TitleLogin

Figure 3-21. First Admin Login to the LOGIQ P8/P9/P10
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Preparing the System for Use

Initial Login to the LOGIQ P8/P9/P10 (continued)

2. Upon ADM Login, specify the institution’s Default Security
Level for the LOGIQ P8/P9/P10: Lowest, Medium, High
(Recommended), or Highest, then select Apply Change.

NOTE: You may choose Skip For Now up to 20 times total to
postpone choosing the Security Level. After 20 skips the
system will require a Security Level to be chosen.

Figure 3-22. Default Security Level
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Powering the System

Initial Login to the LOGIQ P8/P9/P10 (continued)

Table 3-5:  Security Levels

Security Level

Complexity Rules

Skip For Now Best for users not responsible for system security setup. Prompt will
re-appear at each logon until security level is set up for you. This skip can
be chosen 20 total times before the system will require a security level to
be chosen.

Lowest Autologon enabled. No password complexity rules.

Medium Autologon disabled. Minimum Password Requirements:

« 8 characters.

* Include at least two of the following: upper case character, lower case
character, number or special character.

» Password cannot contain username.

» Cannot use the last 10 passwords.

High (Recommended)

Autologon disabled. Minimum Password Requirements:

10 characters.

* Include at least one of each of the following: upper case character, lower
case character, number or special character.

» Cannot contain username.

» Cannot use last 16 passwords.

Highest

Autologon disabled. Minimum Password Requirements:

* 14 characters.

* Include at least one of each of the following: upper case character, lower
case character, number or special character.

» Cannot contain username.

» Cannot use last 25 passwords.
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Preparing the System for Use

Initial Login to the LOGIQ P8/P9/P10 (continued)

3. If a Security Level is chosen, the Confirm Change screen
appears.

If Lowest or Medium Security Level was chosen, you will be
prompted to acknowledge that the security setting is lower
than GE Healthcare recommends to secure the system. You
will not be able to Confirm Change unless the “I Agree” box
is selected.

If Medium, High or Highest Security Level was chosen, you
can choose to change your password immediately and/or to
force all users to change their password at next login.

Figure 3-23. Confirm Change Screen
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Powering the System

Initial Login to the LOGIQ P8/P9/P10 (continued)

4. You will be prompted to set up the ADM password, based on
the selected Security Level.

NOTE: If the password you type doesn’t meet the selected Security
Level’s password complexity rules, the screen will prompt
you (in red) to correct the password, as shown below.

Figure 3-24. Change Password
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Preparing the System for Use

Changing Your Password

The System Administrator manages system groups, users, and
permissions. After you have been added as a valid user, the
System Administrator will assign you a temporary password.
When you log into the system for the first time, you will be
prompted to change your password.

You can change your password at any time when first logging
onto the system. To change your password
1. Type your name in the Operator field.

2. Press the Change Password button. The Change Password
pop-up appears.

Change Password

Figure 3-25. Password Change

3. Type the following:

+ Password: Type your current password.
* New Password: Type your new password.
+ Confirm Password: Retype your new password.
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Powering the System

Logoff
To logoff, press the Power On/Off switch momentarily and a
SYSTEM-EXIT window appears.
Change Password
Shutdown Cancel
Figure 3-26. System Exit Window
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Preparing the System for Use

Power Off

f CAUTION

3-40

NOTE:

NOTE:

NOTE:

DO NOT turn off the circuit breaker before the monitor display
turns off.

Data may be lost or system software damaged if the circuit
breaker is turned off before the system shuts down.

To power off the system:

1.

Set the brake and use the operator panel movement
to lock the control panel in place.
When you shutdown the system, enter the scan screen and

lightly press the Power On/Off switch at the front of the
system once. The System-Exit window is displayed.

DO NOT press and hold down the Power On/Off switch to
shutdown the system.

Using the Trackball, select Shutdown.
The shutdown process takes a few seconds and is
completed when the control panel illumination shuts down.

DO NOT select Exit for Shutdown. Exit is only available to
Service representative.

If the system has not fully shut down in 60 seconds in the
power-off sequence, press and hold down the On/Off switch
until the system shuts down.

Disconnect the probes.

Clean or disinfect all probes as necessary. Store them in
their shipping cases or another appropriate probe storage
system to avoid damage.
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Powering the System

Circuit breaker

NOTE:

The Circuit Breaker is located at the rear panel of the system.
On supplies main power to all internal systems. Off removes
main power from all internal systems. The circuit breaker
automatically shuts off power to the system in case of a power
overload.

If a power overload occurs:

1. Turn off all peripheral devices.
2. Reactivate the Circuit Breaker switch.
The Circuit Breaker switch should stay in the On position; DO

NOT hold the switch in the On position. If the Circuit Breaker
switch remains On, follow the Power On procedure.

Figure 3-27. Circuit Breaker (located on the rear panel)

a. Circuit Breaker

If the Circuit Breaker switch does not remain in the On position
or trips again:

1. Disconnect the Power Cable.
2. Call Service immediately.

DO NOT attempt to use the system.
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Probes

Introduction

Only use approved probes.

Selecting probes

+ Always start out with a probe that provides optimum focal
depths and penetration for the patient size and exam.

* Begin the scanning session by choosing the correct
application and preset for the examination by selecting
Model.

* Begin the scan session using the default Power Output
setting for the probe and exam.

NOTE: Selecting a new probe unfreezes the image.
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Probes

Connecting the Probe

f CAUTION

f CAUTION
f CAUTION

Inspect the probe before and after each use for damage or
degradation to the housing, strain relief, lens, seal, cable and
connector. DO NOT use a transducer which appears damaged
until functional and safe performance is verified. A thorough
inspection should be conducted during the cleaning process.

Remove any dust or foam rests from the probe pins.

Fault conditions can result in electric shock hazard. Do not
touch the surface of probe connectors which are exposed
when the probe is removed. Do not touch the patient when
connecting or disconnecting a probe.

Probes can be connected at any time, regardless of whether the
console is powered on or off. To ensure that the ports are not
active, place the system in the image freeze condition.

Figure 3-28. Probe port

a. Active probe port
b. Pencil probe port
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Preparing the System for Use

Connecting the Probe (continued)

é CAUTION

3-44

To connect a probe:

1.

Place the probe's carrying case on a stable surface and
open the case.

Carefully remove the probe and unwrap the probe cord.
Put the probe in the probe holder.

DO NOT allow the probe head to hang free. Impact to the
probe head could result in irreparable damage. Use the
integrated cable management hook to wrap the cord.

Inspect the probe before and after each use for damage or
degradation to the housing, strain relief, lens, seal, cable
and connector. DO NOT use a transducer which appears
damaged until functional and safe performance is verified. A
thorough inspection should be conducted during the
cleaning process.

Hold the probe connector vertically with the cable pointing
upward.

Prior to inserting the probe, ensure that the connector
locking handle is positioned to the left.

Align the connector with the probe port and carefully push
into place.

Before inserting probes, inspect the probe connector pin. If
the pin is bent, do not use the probe until it has been
inspected and repaired/replaced by a GE Service
Representative.

Push the connector locking handle to the right to secure the
probe connector.

Carefully position the probe cord so it is free to move and is
not resting on the floor.
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Probes

Connecting the CW Pencil Probe

Insert the probe connector into the probe port all the way, seated
in. Carefully position the probe cord so it is free to move and is
not resting on the floor.
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Cable Handling

Take the following precautions with probe cables:

+ Keep free from wheels.
* Do not bend the cable acutely
* Avoid crossing cables between probes.

Activating the Probe

To activate the probe, select the appropriate probe from the
probe indicators on the Touch Panel.

The probe's default settings for the mode and selected exam are
used automatically.

CAUTION Make sure that the probe and application names displayed on
the screen correspond to the actual probe and application
selection.
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Probes

Deactivating the Probe

When deactivating the probe, the probe is automatically placed
in freeze mode.

To deactivate a probe:

1.

Ensure the LOGIQ P8/P9/P10 is in freeze mode. If
necessary, press the Freeze key.

Gently wipe the excess gel from the face of the probe.
Ensure that the probe is placed gently in the probe holder.

Disconnecting the Probe

Probes can be disconnected at any time. However, the probe
should not be active when disconnecting the probe.

1.

Ensure the probe is deactivated. Deactivate by selecting
another probe or pressing Freeze.

2. Move the probe locking handle to the left.
3. Pull the probe connector straight out of the probe port
carefully.

CAUTION DO NOT allow the probe head to hang free. Impact to the
probe head could result in irreparable damage. Use the
integrated cable management hook to wrap the cord.

4. Ensure the cable is free.
5. Be sure that the probe head is clean before placing the
probe in its storage box.
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Transporting Probes

» Secure the probe in its holder for moving short distances.

*  When transporting a probe a long distance, store it in its
carrying case.

Storing the Probe

It is recommended that all probes be stored in the provided
carrying case for probe storage.

Carrying case:

* First place the probe connector into the carrying case.
+  Carefully wind the cable into the carrying case.

»  Carefully place the probe head into the carrying case. DO
NOT use excessive force or impact the probe head.

CAUTION DO NOT store probes in the side tray. To avoid damage, store
the probe in its carrying case.
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System Positioning/Transporting

System Positioning/Transporting

Before moving the system

CAUTION

f CAUTION
f CAUTION

When moving or transporting the system, follow the precautions
below to ensure the maximum safety for personnel, the system,
and other equipment.

When the system is not in use AND/OR before moving/
transporting the system, make sure that the control panel/
monitor arm locks firmly and flip down the monitor to prevent
system damage.

DO NOT place probes or the footswitch into the side tray when
moving/transporting the system. This is not a storage space for
probes, footswitch and any peripheral devices.

If you park the system on a slippery slope, you MUST use the
brakes on the wheel.

CAUTION This equipment is not to be used during transportation (e.g.
ambulance cars, aircraft).
CAUTION DO NOT attempt to move the console using any cables or
fixtures, such as the probe connectors.
CAUTION Handle carefully. A drop of more than 5 cm can cause
mechanical damages.
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Before moving the system (continued)

1. Adjust the OPIO to the lowest position.
2. Adjust the monitor as shown in Figure 3-29 on page 3-50

== s < 3> = o=

Figure 3-29. Monitor position for moving system

3. Ensure that the monitor arm is locked as shown in
Figure 3-30 on page 3-50

Figure 3-30. Monitor locking
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System Positioning/Transporting

Before moving the system (continued)

4.

NOTE:

Turn the system off, including the circuit breaker (see
‘Power Off’ on page 3-40 for more information), and
removed the plug from the wall.

All cables from off-board peripheral devices must be
disconnected from the console.

Disconnect the footswitch from the console.
Wind the power cable around the cable hook.

To prevent damage to the Power Cord, DO NOT pull
excessively on the cord or make sharp bends while
wrapping.

Connect all probes to be used while off site. Ensure that
probe cables are out of the way from the wheels and not
protruding beyond the console. Use the probe management
hooks located below the Operator Panel to further secure
the probe cables.

Store all other probes in their original cases or in soft cloth
or foam to prevent damage.

Put the coupling gel in the gel holder.

. Ensure that no loose items are left on the console and

unlock the wheels.
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Preparing the System for Use

Wheels

Moving

nj Hazard
f CAUTION
f CAUTION

3-52

Examine the wheels frequently for any obvious defects that
could cause them to break or bind.

Each wheel has an independent brake pedal. A left rear wheel
also has a swivel lock.

Figure 3-31. Wheel lock and Swivel lock

1. Wheel Lock Engaged 4. Wheel Lock Engaged

2. Unlocked 5. Swivel Lock Engaged

3. Unlocked 6. Wheel and Swivel Lock
Engaged

Never move the system with locked wheels.

When two or more people are releasing the wheels, take extra
precaution to prevent unexpected movement which could
result in possible toe injuries.

If you use/park the system on a slippery slope, you MUST use
the brakes on the wheel.
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System Positioning/Transporting

Moving the System

1. The system weighs approximately 67 kg (148 Ibs.) (69 kg
with HD Display (152 Ibs.)), depending on which peripherals
are loaded onto the system. To avoid possible injury and
equipment damage:

* Be sure the pathway is clear.
* Limit movement to a slow careful walk.
* Use two or more persons to move the system on
inclines or long distances.
2. Grasp the rear handle bar and push the system.

NOTE: The swivel lock on the left-rear caster helps control the
system while moving.

Moving the system, no incline Moving the system on incline

» Take extra care when moving the system long distances
and on inclines (>5 degrees). Ask for help if necessary.

DO NOT attempt to move the console using any cables
or fixtures, such as the probe connectors.

+ DO NOT attempt to move the system by pulling cables
or belts placed around the monitor and/or monitor arm.

* Use the foot brake (pedal) when necessary.

* Avoid ramps that are steeper than ten degrees to avoid
tipping over the system.

NOTE: Wheel chair ramps are usually less than five degrees.
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Preparing the System for Use

Moving the System (continued)

« Utilize additional care and personnel when loading into
a vehicle for transport.

* Do not let the system strike walls or door frames.
* Use extra care when crossing door or elevator
thresholds.

NOTE: When you cross the threshold with the LOGIQ P8/P9/
P10, move quickly.

3. Once the destination is reached, lock the wheels.
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System Positioning/Transporting

Transporting the System

Use extra care when transporting the system using vehicles. In
addition to the instructions used when moving the system (see

‘Before moving the system’ on page 3-49 for more information),
also perform the following:

Only use vehicles that are designed for transport of the
LOGIQ P8/P9/P10 system.

Ensure that the transporting vehicle can handle the weight
of the system plus the passengers.

Employ two to three persons to load and unload safely from
a vehicle.

Ensure that the load capacity of the lift (a minimum of 100kg
[220 Ibs] is recommended) is capable of handling the weight
of the system.

Ensure that the lift is in good working order.

Secure system with straps or as directed otherwise to
prevent motion during transport.
Prevent vibration damage by driving cautiously. Avoid

unpaved roads, excessive speeds, and erratic stops or
starts.
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Preparing the System for Use

Load the system onto a vehicle

NOTE:

NOTE:

3-56

Load and unload the system to a vehicle parked on a level
surface.

Secure the system while it is on the lift so that it cannot roll.
Use either wood chocks, restraining straps, or other similar
types of constraints. Do not attempt to hold it in place by
hand.

Load the unit aboard the vehicle carefully and over its center
of gravity. Keep the unit still and upright.

Do not lay the unit down on its side.

Ensure that the unit is secured inside the vehicle. Strap the
LOGIQ P8/P9/P10 with belt to prevent movement while in
transit.

Twist the belt around the rear handle (1) and the footrest/
caster (2).

DO NOT restrain the LOGIQ P8/P9/P10 at the monitor or
the monitor neck using a belt.

Figure 3-32. Wrapping position of the belt

5. Drive cautiously to prevent vibration damage.
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System Positioning/Transporting

Reinstalling at a new location

1. When the unitis in place at a new location, lock the wheel
brakes.

2. Follow the installation procedure described in ‘Connecting
the System’ on page 3-27 .

Acclimation Time

After being transported or stored, the system requires one hour
for each 2.5 degree increment when its storage or transport
temperature is below 10 degree C or above 40 degree C.

Table 3-6: System Acclimation Time Chart

Degree C 50 45 40 35 30 25
Degree F 122 113 104 95 86 77
hours 4 2 0 0 0 0
Degree C 20 15 10 5 0 -5
Degree F 68 59 50 41 32 23
hours 0 0 0 2 4 6
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Preparing the System for Use

Operator Controls

Control Panel Map

Controls are grouped together by function for ease of use. See
the callout for this figure on the following page.

LOGIQ

Figure 3-33. Console Panel Map

1. Probe Holder and Cable 6. Trackball, Trackball Keys, Pointer,
Management Measure, Comment, Body Pattern,

2. Touch Panel Joystick controls Clear, Programmable Keys

3. Power On/Off 7. L/R, Start/Stop, Freeze,

4. User Define keys (include BT Keys) Simultaneous

5. Mode/Gain/XYZ (3D/4D) Controls 8. Steer/Zoom/Depth

9. Auto, PW Auto Positioning
10. P1(Print) key
11. Freeze key
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Operator Controls

Control panel adjustment

range of motion before moving the control panel. This includes

f CAUTION To avoid injury or damage, make sure nothing is within the
both objects and people.

The control panel position can be adjusted for easy viewing and
easy-to-use.

To raise/lower the Control panel

1. Push the up/down button of the right front handle and hold it.
2. Release the button at the desired height.

Figure 3-34. Up/Down Control

100mm

LOGIQ

Figure 3-35. Up/Down
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Preparing the System for Use

To swivel the Control panel

1. Push the swivel button of left front handle and hold it.
2. Release the button at the desired position.

Figure 3-36. Swivel Control

30° 30°

Figure 3-37. Swivel range
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Operator Controls

Key lllumination

All the keys on the front panel, except for the keyboard, and
some rotaries have a two-level backlight capability. The
following backlighting indicates availability.

The keyboard area must have task lighting or equivalent to allow
operation in a dark room.

Table 3-7:  Key lllumination

Backlight Capability Availability
OFF Function is not available
Green Activated/ON
Blue Inactive/Available
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Preparing the System for Use

Keyboard (Optional)

Esc

Help (F1 Key)
Arrow (F2 Key)
Eject (F3 Key)
Spooler (F4 Key)

Create a Fast Key
(F5 Key)

Play a Fast Key (F6
Key)

Home/Set Home
(F7 Key)

Text1/Text2 (F8
Key)

Grab Last (F9 Key)

Word Delete (F10
Key)

Alt+1 or Alt+2
Alt+D

Ctrl + N
Ctri+ S

3-62

The standard alpha-numeric keyboard has some special
functions.

Exit current display screen.

Access Online help / user manual.
Annotation arrow.

Eject media.

Activates DICOM Job Spooler screen.

Creates a Fast Key.

Plays a Fast Key.

Move annotation cursor to home position; shift+key to set
current annotation cursor position as the new home position.

Switch between user text annotation overlays.

Activate the last selected data for edit.

Erase word associated with comment cursor.

If you encounter a problem and cannot collect the logs
immediately:

Place a time stamp marker in the log.

Collect the logs.

Once the logs are collected, the engineering team would be able

to see the marker you added which will help engineering to
troubleshoot the problem.

Create New Model.

Overwrite Current Model.
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Operator Controls

On Screen Keyboard

You can use "On Screen Keyboard" on touchscreen. Keyboard
will show up when you press "Keyboard" button on touchscreen.
And you can hide it with "Exit" button on Keyboard. see Figure
on page 3-63 .

Figure 3-38. On Screen Keyboard
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Preparing the System for Use

User defined hard key

You can arrange the order of User defined hard key on the
control panel as you have programmed in the Utility page.

:@ ® ‘% =
V) ()
®o \Ol X Y

Figure 3-39. User defined hard key

000

000

1. Assign the function to each key in Utility -> System -> User
Configurable Key -> User Defined Hard Key

Figure 3-40. Utility page
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Operator Controls

User defined hard key (continued)
2. On the Control Panel, remove the key cap and replace it in
the order shown on the Utility Screen.

NOTE: Number 1 is located at the top, on the left key; Number 5 is
located at the bottom, on the right key.

a. Stick the flat-blade screwdriver in the hole on the upper
side of the key cap and bring up.

Figure 3-41. Remove the key cap

b. Push the key cap until it clicks into the new position.

CAUTION Before cleaning the control panel, make sure the key cap is
firmly in place.
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Preparing the System for Use

Touch Panel

The Touch Panel contains exam function and mode/function
specific controls.

Exam Function Controls

3-66

Figure 3-42. Exam Function Controls

Patient: Enters Patient screen

Scan: Enters scanning mode screen

End Exam: Activates Image Management and Touch Panel
with end of exam options.

Keyboard: Activates on screen keyboard.

TGC: Activates TGC function.

Probe Indicator: Indicates and selects the probes, changes
models as well as Create New or Save As.

Indicates the number of pages for this mode. To move to the
next page, touch the “dot” or swish your hand from right to
left/left to right.

To view all/fewer of the controls for this Touch Panel, press
this Research/Clinical button.
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Operator Controls

Touch Panel (continued)

NOTE: Different menus are displayed depending on which Touch Panel
is selected.

At the bottom of the Touch Panel, there are five combination
rotary dials/push buttons. The functionality of these rotaries
changes, depending upon the currently-displayed menu. Press
the button to switch between controls, or rotate the dial to adjust
the value, or move the control left/right or up/down to adjust the
value.
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Preparing the System for Use

Mode/Function Specific Controls

In general, the key name is indicated at the top of the key. There
are different types of Touch Panel keys as illustrated below:

Cross Beam

Virtual Convex

Figure 3-43. Mode/Function Specific Controls

1. Press to toggle control on/off.

2. Progress/Select keys are used for controls that have three
or more choices.

3. Progression keys are used to assess the impact of the
control on the image progressively.

4. 6-way functionality knobs (below the touch panel): Adjust
controls by pressing (dot symbol), rotate (circled arrow
symbol), move up/down (vertical line with arrows) or left/
right (horizontal line with arrows).
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Operator Controls

Key descriptions

Mode, Display and Print

This group of controls provides various functions relating to the
display mode, display orientation, image recording/saving,
freeze, gain and Cine scroll.

The Mode Controls select the desired display mode or
combinations of display modes.

During dual display modes the L and R keys activate the
Left or Right displayed image.

Auto is used to:
* initiate auto optimize
* turn off auto optimize.

Depth controls the image display depth.

Print keys are used to activate/print the designated
recording device.

The Freeze key is used to stop the acquisition of ultrasound
data and freeze the image in system memory. Pressing
Freeze a second time continues live image data acquisition.

To activate a specific mode, press the appropriate mode
key. Each mode has its own gain control via the larger gray
knob surrounding the mode key.

The gain is control by rotating the mode assigned rotary
button below the touch panel.
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Preparing the System for Use

Measurement and Annotation

3-70

This group of controls performs various functions related to
making measurements, annotating and adjusting the image
information.

The Comment key enables the image text editor and
displays the annotation library Touch Panel.

The Clear key is generally used to erase functions, such as
annotations/comments, body patterns and measurements.
Pressing the Clear key again exits the selected function.

The Body Pattern/Ellipse control has a dual purpose:

* Press the Body Pattern/Ellipse control, it enables the
Body Pattern Touch Panel and displays the default
pattern on the screen. When body patterns are active,
the knob rotates the probe position indicator.

* Rotate the Body Pattern/Ellipse control, it activates the
ellipse measurement function after the first distance
measurement has been set and the second caliper is
activated.

Press Set to fix the measurement after the ellipse
adjustment is complete. The measurement is then displayed
in the measurement result window.

The Measure key is used in all types of basic
measurements. When the Measure key is pressed, the
measurement Touch Panel is displayed.

The Set key, located on the Trackball on-screen controls, is
used for various functions, but is generally used to fix or
finish an operation (e.g. to fix a measurement caliper).

The Trackball is used with almost every key function in this
group. Trackball control depends on the last key function
pressed.
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LCD Monitor

LCD Monitor

Related Hazards - LCD Monitor

the monitor or monitor arm to avoid injury when moving

f CAUTION + DO NOT place a finger, hand or any object on the joint of
the monitor and monitor arm.

+ To avoid result of injury or system damage, NEVER place
any object or liquid on the monitor, whether in the home or
flip down/transport position.

If an object or liquid falls/spills into the monitor or the
cabinet, unplug the system immediately. Call a Service
Representative for information.

DO NOT scratch or press on the panel with any sharp
objects, such as a pencil or pen, as this may result in
damage to the panel.

+ Toavoid injury or damage, make sure nothing is within the
range of motion before moving the monitor and monitor
arm. This includes both objects and people.

+ Before moving the system to another location, be sure to
lock LCD/LCD arm in transport position.

+ The LCD screen may have defective pixels. These pixels
may appear as a slightly light or dark area on the screen.
This is due to the characteristics of the panel itself, and
not the product.

* The backlight of the LCD panel has a fixed life span.
When the screen becomes dark or begins to flicker,
contact a qualified Service Representative for information.

NOTE:  Bright light could impact readability of screen.
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Preparing the System for Use

Moving the LCD monitor

The LCD monitor moves in the range of below.

(F

H

Figure 3-44. Monitor moving range

H

3-72 LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2



LCD Monitor

Adjusting the LCD Monitor Position

Grab the bottom of the LCD monitor when you adjust the
position of the monitor and monitor arm.

. ./

Figure 3-45. Positioning the LCD monitor

Figure 3-46. Positioning the HD Display

Locking/unlocking the monitor

1. Turn the release knob counter clockwise to unlock the LCD
monitor. The LCD monitor can be moved freely in all
directions.

2. Turn the release knob clockwise to raise the lock and move
the LCD monitor into the parked position.
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Preparing the System for Use

Figure 3-47. Positioning the LCD monitor

1. Unlocked LCD monitor
2. Locked LCD monitor
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Monitor Display

Monitor Display

Monitor Display Tour

Figure 3-48. Monitor Display Tour
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Preparing the System for Use

Monitor Display Tour (continued)

1. System Date and Time (Note: The date on the 12. Measurement Calipers and System Message
monitor may truncate the century when using Bar
the YYYY-MM-DD date format). 13. Patient Name, Patient Identification
2. Caps Lock (lit when on), Network Connection 14. Power Output Readout
Indicaor (Wireless LAN, Wired, Mobile 15. Probe ldentifier, Exam Preset
Bluetooth), Battery Status, DVR status, InSite 16. Live/Freeze Indicator
Indicator. (if applicable) 17. Imaging Parameters by Mode, Speed of
3. Measurement Calipers and System Message Sound(SoS) Indicator (if applicable)
Bar 18. Depth Scale.
4. Image Clipboard 19. Focus Indicator and Color FLow Focal Zone
5. Image Preview Marker
6. Worksheet/Direct Report 20. Image Management Icons and LOGIQ Apps
7. Gray/Color Bar. Icon (not shown)
8. Institution/Hospital Name, Date, Time 21. Body Patern
9. Operator Identification 22. CINE Gauge
10. Probe Orientation Marker 23. Trackball Controls and Status
11. Image and Color Window 24. 6Tc-RS Probe temperature display

25. 6Tc-RS Probe angle display

Live/Freeze Indicator

Live/Freeze Indicator shows active image scan status with
Single/Dual/Quad format and has four choices (Live/Not Live/
Update/B Pause).

Live/Freeze Indicator display (on/off) is configurable on Utility ->
System -> System Display menu.

Table 3-8: Live/Freeze Indicator

. E n
. o ﬂ u

Live
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Monitor Display

Monitor Display Layout

Monitor Display Layout is configurable on Utility -> System ->
System Display menu.

Figure 3-49. Defalt Image Format (4:3)

1.
2.
3.
4.
5.
6.
7.
8.
9.

Title bar

Information window 1
Information window 2

Scan Area

Control Window

Preview window/User Label
Clipboard

Trackball mapping and Set keys
Status area
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Preparing the System for Use

Information Window

Measurement Summary, Scan Assistant Guide, Side Clipboard,
and My Desktop are displayed options for Info1 or Info2 window.

1 2 L] &

Figure 3-50. Information Window - Example

Measurement Summary
Side Clipboard

Scan Assistant Guide
My Desktop

Pob-~
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Monitor Display

My Desktop
The user can import graphics (jpeg) and write a caption for that
graphic to display on My Desktop in Utility -> User Specific.
Figure 3-51. User Specific
Table 3-9:  User Specific
Preset Parameter Description
My Desktop Title Free text
Picture 1 and 2 Browse to load jpeg and type the caption.
Background Color Background Color: Select the background color.
Default Color: Reset the background color to factory default.
Import Import the graphic.
LOGIQ P8/P9/P10 — Basic User Manual 3-79

Direction 5841298-1EN Rev. 2



Preparing the System for Use

User Label

In Utility -> Application -> Settings -> Label Area, you can enter
User Label which displays in the Preview Window as a brief
note.

For example, P1 - Stills only, P2 - Stills, Clips (3 sec.), P3 -
Volume, P4 Screen Capture.

Comments

Label Arca

Search Cancel

Figure 3-52. Application Settings Preset Menu

Table 3-10:  User label

Preset Parameter Description
Show labels If selected, the system displays the User Label in the Preview Window at the
left-bottom of the monitor.
Label 1 -8 User labels have eight text lines. Each User Label is limited 50 characters.
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Monitor Display

Change the Display Image Area

You can change the screen format layout by pressing the lower,
right-hand corner of the Display Image Area icon on the display:

Table 3-11:  Display Image Area Selections

Display Image
Area icons

Click Image Display Area icon to toggle current display
area and extra large area.

Default Layout
* (4:3 Layout) Standard
* (16:9 Layout) Full Wide

Large Image Layout
* (4:3 Layout) Standard
* (16:9 Layout) Full Wide

Extra Large Layout
* (16:10 Layout) Partial Wide

Table 3-12: Display Image Area Examples

Default Layout Standard

Default Layout Full Wide
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Preparing the System for Use

Table 3-12:  Display Image Area Examples (Continued)

Large Image Layout Standard

Large Image Layout Full Wide

Extra Large Layout Partial Wide

NOTE: Even If there are buttons on the rear cover of the monitor, DO
NOT use those buttons for adjustment. The LOGIQ P8/P9/P10
system will override the parameter(s) and the monitor does not
have capability to retain parameters.
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Monitor Display

Using the Monitor Display Controls to Manage Images

Image Management Icons

You can manage images from the display via these on-display
controls.

Table 3-13: Image Management Icons

Utility
Activate the Utility page

Report
Activate the Report writer page

My Trainer Plus
Activate the My Trainer Plus

Image Display Area
Press Image Display Area to select Image Display Area - Default/Large/Extra large.
See ‘Change the Display Image Area’ on page 3-81 for more information.

Worksheet
Activate the Worksheet.

Active Images
Press Active Images to go to the Patient Active Images page.

Compare Assistant
Press to activate Compare Assistant.

Activate Save As Menu - Note: Save As Menu icon is displayed only when an image is
recalled or scan state is frozen/CINE Loop.

Delete Recalled Image/Delete Last Image - Delete Recalled Image is displayed only when
one image is recalled. / Delete last image icon is displayed only when the image is not
recalled and there are non-stored images. You can use this to delete an image from the
clipboard. Place the cursor on the clipboard image you want to delete, then press Set to
select the image. Then place the cursor on the Delete icon and press Set.

LOGIQ Apps
Activate the LOGIQ Apps

Next/Previous Image(s) and Clipboard Slide Show

Press the left arrow to move to the previous image; press the right arrow to move to the

next image.

Clipboard Slide Show

The Clipboard Slide Show plays all images on the clipboard and wraps around the ends. To

activate, press and hold [Ctrl] + [Previous Arrow] or [Ctrl] + [Next Arrow].

» Each image recalls for three seconds, or the length of the loop, whichever is longer.

* You can manually skip to a new image during the slide show by recalling it, as usual.

* To end the slide show manually, press [Ctrl] + [Previous]/[Next] again.

+ Slide Show ends when you go to live scanning, or if the clipboard is not shown when it's
time for the next image to load.
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Trackball Key Map

3-84

NOTE:

The current mapping is shown on the trackball mapping display
area in the lower, right-hand corner of the display screen. Six
Trackball keys surround the Trackball. These Trackball keys are
mapped based on the current state of the system (live imaging,
frozen imaging, measurements, etc.)

Trackball functionality is labeled on the display. To activate new
functionality for the Trackball, press the correct key adjacent to
the Trackball, as indicated on the display.

If there are more than 2 functions assigned to a single key, the
selected function is highlighted.

Scroll

Start. /End
Frame Frame

Figure 3-53. Example: Trackball Functionality for Cine

For Live B, B-Flow and Contrast mode with linear probes. Top
Trackball key allows user to select “Steer” function (when B
Steer+ is not enabled). When “Steer” function is selected, B
Steer is activated to left or right as user presses Trackball A or B
key.
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Monitor Display

Trackball Key Map (continued)

B Focus @I B Focus
L2 ER

Table 3-14:  Trackball smart keys (A and B)
Keys A and B
Imaging Mode Symbols Function
Live B, B-Flow, Focal Zone Down/Up
Contrast

Frq g Frq
4 B3

Frequency Down/Up

Live Color Flow, TVI,
Power Doppler, B-Flow
Color

| AL

ROI box steer

Scale § Scale
s 2 K

Scale Down/Up

PW, CW, TVD

Baseline Down/Up

Mode Cursor

Scale Down/Up

B Steer+

ROl box steer+

Live Color Flow, Power
Doppler

Auto Doppler Assist
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Chapter 4

Preparing for an Exam

Describes how to begin an exam.
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Preparing for an Exam

Beginning an Exam

Introduction

Begin an exam by entering new patient information.

The operator should enter as much information as possible,
such as:

Dataflow

Exam category

Patient ID

Patient name

Exam Information

ok wbd~

The patient's name and ID number is retained with each
patient's image and transferred with each image during
archiving or hard copy printing.

identification with the patient. Make sure the correct patient

f CAUTION To avoid patient identification errors, always verify the
identification appears on all screens and hard copy prints.
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Beginning an Exam

Beginning a New Patient

Pressing the Patient Touch Panel key displays the Patient
Screen on the monitor.

Patient

PATIENT

Figure 4-1. Patient Touch Panel

New Patient should be selected at the beginning of each new
patient exam. End Exam should be pressed at the end of each
exam. Pressing New Patient automatically stores all patient
data, annotations, measurements, calculations and worksheets
of the last exam. Images are not automatically stored. A warning
message appears regarding images being erased or saved. It is
always best to select “Store All” if you are unsure of saving.
Exams and patients can always be erased later.

NOTE: If the current patient does not exist, selecting the Patient View
tab activates the Patient Search screen.
NOTE: If the current patient exists, selecting Exam View activates the
Exam History screen.
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Patient Screen

—
o

Details

(4)

® (5)
(6)

Save and Exit

220N R ODbD -

- O

4-4

Figure 4-2. Patient Screen

Image Management
Function Selection
Query This Patient
EZBackup

Dataflow Selection
Save and Exit
Patient Information
Category Selection
Exam Information

. Scan Assistant Program

Patient View/Exam View
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Beginning an Exam

Patient Screen (continued)

Enter Patient Data with the alphanumeric keyboard.

To navigate through the Patient Entry menu, use the Tab key or
Trackball and Set to move and fix the cursor.

Image Management

+ Patient—Provides a search and creation of patient. (currently
selected)

» Image History—Provides a list of images per exam for the
currently selected patient.

+ Active Images—Provides preview of the currently selected
exam and Compare Assistant.

» Data Transfer—Provides an interface to handle patient data
from a remote device.
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Preparing for an Exam

Function Selection

NOTE:

NOTE:

New Patient—Used to clear patient entry screen in order to
input a new patient’s data into the database.

Register—-Used to enter new patient information into the
database prior to the exam.

If you are using the auto-generate Patient ID feature, do not
select Register. It is always a good practice to Register all
patients.

Details—Select the Details box to activate/deactivate the
exam details. Exam details include Indications, Comments,
Admission Number, Performing Physician’s Telephone
Number, Referring Physician’s Telephone Number, Operator
Telephone Number, and Exam Description.

The Exam Description pull-down selection is used as the
DICOM identifier.

4-6

Figure 4-3. Details Window
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Beginning an Exam

EZBackup

One-step method to backup patient images to an external
media.

Dataflow Selection
Select the appropriate dataflow.
NOTE: If you use a DVD-R, select DICOM CD Read in Dataflow.

If you place the cursor on the icon, the pop-up menu displays
disk capacity.

Dataflow:

L ocal Archive - Int. HD

Figure 4-4. Dataflow Pop-up

Save and Exit
Used to save all changes and exit the Patient Menu.
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Preparing for an Exam

Patient Information
« Patient ID Number

» Alternate (Other, Second) Patient ID Name and Number.
The system now allows you to enter a second identification
number for the same patient, which may be required in
certain countries. This is only displayed if enabled on the
Connectivity -> Miscellaneous screen.

+ Patient Name—Last, First and Middle

+ DOB (Birthdate)

+ Age (automatically calculated when birthdate is input)

« Sex

Category Selection

Select from 9 exam application categories: Abdomen,
Obstetrics, Gynecology, Cardiology, Vascular, Urology, Small
Parts, Pediatrics or PoC.

When a category is selected, the measurement and category
presets are displayed.
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Beginning an Exam

Exam Information
Shows the Current/Active Exam information. Information
pertinent to the selected exam category appears in the window.
All possible information needs to be entered.
* Images-Displays the selected exam’s images.
* Clear-Clears existing data.

+ Past Exam (only for OB)-Input past exam data (register the
patient before using).

Figure 4-5. Input Past Exam
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Preparing for an Exam

Scan Assistant Program

The Scan Assistant Program is either selected automatically or
manually, depending on the preset as configured on the
Utility--> System--> General page.

4-10 LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2



Beginning an Exam

Patient View/Exam View

Lists the patients in the database.

NOTE: When you double-click the patient on the patient list using the
Set key, the Review screen or New Exam entry screen displays
depending on the preset. You set this preset via Select Review
or New Exam in Utility -> Connectivity -> Miscellaneous ->
“Double click on patient list to start” preset.

NOTE:

Search key—select search item from Patient ID, Last Name,
First Name, Birthdate, Sex, Exam Date, Exam Today,
Accession Number, Exam Description, Exam Date Before,
Exam Date Between, Exam Date After, Locked (Y, N) or
Img. Archived (Y, N).

String—enter appropriate information.

If you select Locked (Y, N) or Archived (Y, N) for the Search
key, enter Y (Yes) or N (No).

Clear—Clears the entered string.

Listing XX of XXX -- Displays the quantity of patients that
match the search criteria in the search window and the
quantity of patients in the database.

Review—Select Patient/Exam for review.

Resume Exam—Continues the exam for that patient if you
select the last exam of the day.

New Exam—Creates a new exam based on a current or
searched patient.

Delete—Deletes Patient/Exam.
“Delete” is only displayed when you login as Administrator.
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Preparing for an Exam

Patient View/Exam View (continued)

4-12

Lock/Unlock—Locks the exam/patient. Prevents move and
delete functions.

To lock, select the exam or patient to be locked and select
Lock.

If you select the patient, all exams are locked. If you select
one exam, the selected exam is locked and the lock icon
displays in the patient ID cell.

To unlock, select the locked exam or patient and select
Unlock.

Exam View

Displays the Exam History of the selected patient by date.

The system can display the Detail Mode instead of Exam
View when you select the patient on the patient list and
press Review or Register. If the Detail Mode preset on Utility
-> Connectivity -> Miscellaneous menu is selected, the
Detail Mode displays.

+ Disk - Displays the disk name on which you saved the
exam’s image data. If “+” displays behind the disk name,
the data is saved on two or more disks.

LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2



Beginning an Exam

Patient Screen (continued)

f CAUTION

NOTE:

NOTE:

To maintain optimum system performance and to safeguard
patient data, keep the total number of patients in the database
below 1,000.

To reduce the total number of patients in the database, perform
the following procedure.

1. Before starting EZBackup, select “Unlock All” on the
Utility -> Admin -> Logon screen.

Prepare the unformatted CD-R or DVD-R before EZBackup.

Pre-formatted CD-R or DVD-R cannot be used for
EZBackup.

2. First perform EZBackup and then Backup (Patient Archive
and Report Archive).

3. Go to the patient screen, select the patients/exams to
delete. Select “Delete” to delete the selected data.

Ensure that all patients are exported or backed up BEFORE
deleting them.

We recommend attaching the patient list to the EZBackup
media. Insert the media and select DICOM CD Read for the
dataflow (if you use a USB drive, select DICOM USB Drive
Read). Press the right Set key to select the patient. Press the
left Set key to bring up the print menu. Select Print and press
the right Set key to print the patient list.

Printing the Patient List

You can print the patient list on a connected printer.

1. Move the cursor to the patient list and select any patient.
2. Press the left Set key. The pop-up menu displays.
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Preparing for an Exam

Figure 4-6. Print the patient list

3. Select Print and press the right Set key.
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Beginning an Exam

Scanning a New Patient

WARNING

>

ARNING

>

AUTION

>

WARNING

>

WARNING

>

WARNING

>

Imaging functions may be lost without warning. Develop
emergency procedures to prepare for such an occurrence.

Ensure you have selected a dataflow. If No Archive is selected,
no patient data is saved. A ? appears next to Dataflow if No
Archive is selected.

To avoid patient identification errors, always verify the
identification with the patient. Make sure the correct patient
identification appears on all screens and hard copy prints.

Always use the minimum power required to obtain acceptable
images in accordance with applicable guidelines and policies.

Always use the system on a flat surface in the patient
environment.

Ensure that the hands of the patient are away from the system
during the exam.

The position of the operator and the patient vary by scan
region.

In most cases, the operator sits/stands straight in front of the
operator console and the patient lies on the bed on the right (or
left) side of the system.
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Preparing for an Exam

Scanning a New Patient (continued)

4-16

NOTE:

NOTE:

NOTE:

NOTE:

When starting a new patient’s exam, ensure you do the
following:

1.
2.
3.

9.

Press Patient.
Press New Patient on the Patient menu.

If there are images on the clipboard, a pop-up menu
appears. Specify whether you want to store images
permanently, delete images, or go to active images.

Choose the exam category.

Verify the dataflow.

DO NOT use the removable media Dataflows on the New
Patient menu.

The system can display a warning dialog when the patient is
registered to “No Archive”. If the “Warn register to No
Archive” preset is selected in the Ultility -> Connectivity ->
Miscellaneous menu, a warning displays. A different
dataflow for permanent storage of patient data should be
selected.

Fill in patient information.

You can also select a patient from the patient database at
the bottom of the Patient menu if the patient has a patient
ID.

Columns drive the ordering of the patients displayed. The
column that you select drives the order of the displayed
patient database.

Do not use the following characters when filling in patient
information:

N <>+ =] &

Select Register.

Select the probe to start scanning (or select Exit, Esc, Scan,
or Freeze).

Perform the exam.
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Beginning an Exam

Scanning a New Patient (continued)

f CAUTION

10. Store the images/loops to the clipboard.

1.

To store the still image, press Freeze and run the cineloop
using the Trackball. Select the frame and press P1 (or the
assigned Print key).

To store the cineloop, press Freeze and run the cineloop
using the Trackball. Select the start/end frame and run the
selected loop. Press P1 (or the assigned Print key).

When you have completed the study, press End Exam. The
image management screen displays. Select the images (still
frame or cineloop) you want to store or select Select All to
store all images. Select Permanent Store to store the
images permanently.

After completing the measurement, verify that the
measurement result window is updated before you send or
save the image.

NOTE: Return to the patient screen automatically from the scan
screen when you select OK from the “ID is not unique”
warning message.
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Preparing for an Exam

Starting a new exam on an existing patient

Press Patient.

Select the patient from the Patient List.

Select New Exam.

A new exam is created. Enter the data and begin the scan.

o

Ending a Patient Exam

When you have completed the study, press End Exam, End
Current Patient or New Patient, then Store All Images
Permanently.
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Beginning an Exam

Entering a Patient List

All patient information can be entered before starting an exam.

ok~ wbd-=

6.

Press Patient to display the Patient Screen.

Press New Patient to erase the current patient data.
Enter the Patient ID.

Enter the patient and exam information.

Press Register.

Repeat above steps as required.

Or, select the patient from the Patient List and select Resume
Exam to start an exam.

Scanning without entering any patient data

To scan a patient without entering any patient data until the end

of the exam:
1. Press Scan.
2. When you scan the patient and save images to clipboard

without a patient, you will receive a warning that states, “A
patient must be selected for permanent storage of image.”
Press OK.

3. Press Patient to display the Patient Search screen.
4. Enter the Patient ID.

NOTE: If you have images or measurements that are not attached
to a Patient ID, the message “Unsaved images,
measurements or fetus number will be linked to the current
patient information, continue?” appears when the patient ID
is registered.

5. Enter patient data and exam information as necessary.
6. Press Active Images.
7. Press Permanent Store.
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Preparing for an Exam

Retrieving and editing archived information

Searching for an existing patient

1. Press Patient to display the Patient Screen. The Patient
Search Screen is displayed on the bottom portion of the
Patient Menu.

2. Select the search key (Patient ID, First Name, Last Name,
etc.). Type the search string.
NOTE: When the number of patients on a hard disk is in the
hundreds, it takes time to search for a patient or switch to
another screen. In this case, do one of the following:

* Uncheck the “Auto search for patient” preset, found
under Patient/Exam Menu Options in Utility ->
Connectivity -> Miscellaneous.

* Delete unnecessary patient data.

3. An appropriate patient is displayed.

Resume Exam MNew Exaim

Figure 4-7. Patient Search Screen

a. Select Review to review the exam history of this patient.

If you select the patient of the day, Resume Exam in
place of Review displays to continue the exam.

Select New Exam to create a new exam for this patient.
Select Delete to delete this patient.

d. Lock. See ‘Patient View/Exam View’ on page 4-11 for
more information.

NOTE: “Delete” is only displayed when you login as Administrator.

4-20 LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2



Beginning an Exam

Pop-up menu

If you select the patient and press the left Set key, the pop-up
menu displays.

Figure 4-8. Archived Patient

If you select the patient of the day, Resume Exam displays to
continue the exam.

Figure 4-9. Patient of the Day

NOTE: The preset “Double click on patient list to start”, located on the
Utility -> Connectivity -> Miscellaneous screen, allows you to
display either the Review or New Exam screen by double
clicking the Set key on the patient name.
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Preparing for an Exam

Edit and Copy Patient

NOTE:

NOTE:

NOTE:

NOTE:

NOTE:
NOTE:

é CAUTION

4-22

The “Edit and Copy Patient” function:

+ Copies data from a registered patient on the local archive to
a newly-created patient on the local archive. The
newly-created patient will have new identifiers: patient ID,
other ID, patient name, sex, etc.

* Assigns a new UID to the copied exam data. The
newly-copied patient has the same medical data as the
copied patient but with a different UID.

“Edit and Copy Patient” will only copy patient data, images
inside the local archive; it will not allow patient data or images
from outside of the local archive. This includes the following
types of images: exported, MPEGvue, SaveAs, DICOM Store,
or (DICOM) print.

“Edit and Copy Patient” does not copy the patient’s report.
Remove the report link from the database for copied patient.

“Edit and Copy Patient” does not deal with patient information
already burned in image pixels.

The image and title bar, including patient information, is copied
asis.

The “Edit & Copy” function does not display for a current patient.

The “Edit & Copy” function does not display when multiple
patients are selected.

The user is responsible for patient data, diagnostic information
or any other patient-related information entered in the
database.
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Beginning an Exam

Edit and Copy Patient (continued)

1. Ensure that you are logged in as an Administrator on the
system.

2. Select the Local Archive dataflow.

3. Select the patient from the Patient View list and left click to
bring up the “Edit & Copy” pop-up menu.

Last Name First Name
dfdd ddd

Resume Exam New Exam Delete

Figure 4-10. Select an Exam to Copy and Edit

4. A confirmation dialog displays. Select OK.

Cancel

Figure 4-11. Copy Patient Pop-Up Confirmation
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Preparing for an Exam

Edit and Copy Patient (continued)

5. The “Edit and Copy Patient” dialog displays. All the fields
inherit the values from the original patient’s exam, except for
Patient ID and Other ID.

Figure 4-12. Edit and Copy Dialogue

* Generate Patient ID generates a patient ID.

» Clear All clears all fields except for Patient ID and Other
ID.

* Cancel button cancels the “Edit and Copy Patient”
function.

6. Fill in the Patient information fields, then press OK.

NOTE: If the newly-entered Patient ID is not unique in the database,
the Patient ID turns to red and an error message displays on
the status bar.

Figure 4-13. Copy Status Bar
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Edit and Copy Patient (continued)

7. When the copy is done, the patient list is refreshed.

a Birthdate
dfdd d 09/12/1969

Resume Exam New Exam Delete Listing 4 of 4

Figure 4-14. Completed Patient Copy
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Changing Patient Information or an Exam

f CAUTION

4-26

NOTE:

The user is responsible for patient data, diagnostic information
or any other patient related information entered in the
database.

If patient information needs to be edited, pressing Patient
enables the Patient Screen for modifying information.

If the patient is still active, you can go to the New Patient page
and choose the tab that is desired. The exam changes in the
Exam View area.

If the exam category needs to be changed, pressing New Exam
allows modification of the Patient Screen without erasing
accumulated patient images, measurements, annotations,
calculations and worksheets.

1. Display the Patient screen by pressing Patient.

2. Select patient from the Patient list. The system automatically
searches to see if the patient is already in the database.

+ Select Search key (Patient Data: ID, First Name, Last
Name, Birthdate, Sex or Exam Date.

» Enter search string (for example, initial letter of Patient
Name)
3. The appropriate patient is displayed.

If patient information needs to be edited or the exam
category changed, use the New Exam feature. Pressing
New Exam allows modification of the Patient Screen
without erasing accumulated patient images,
measurements, annotations, calculations and worksheets.

Patient identification information cannot be modified.

4. To have the database shown in its entirety, Backspace on
the Search string and all patient names appear.

5. Select Register to register the new exam.

A new exam is automatically created on that patient unless
an exam already exists on that day for that patient.

6. To display the patient information on the title bar, press the
Esc key, the B-Mode key or Register.

Select the Model and appropriate probe Touch Panel keys, if
necessary.
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Deleting the existing patient/exam/image

make sure you have already saved the data with EZBackup,
Backup, or Export. Verify the media before deletion.

f CAUTION Before deleting a patient or image from the Patient Screen,
Deleting the existing patient

1. Search and select the patient in the patient list with the Ctrl
or Shift keys.

2. Select Delete. The confirmation dialog box displays.
OR

Press the left Set key. A pop-up menu displays. Select
Delete. The confirmation dialog box displays.

Figure 4-15. Select the patient in the patient list

3. Select OK to delete or Cancel.
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Deleting the existing patient/exam/image (continued)

Delete multiple patients from the patient list

1. Select the multiple patients to be deleted from the patient
list.

2. Select Delete. The confirmation dialog box displays.
OR

Press the left Set key. A pop-up menu displays. Select
Delete. The confirmation dialog box displays.

Figure 4-16. Select Patients to Delete

3. Select Yes to delete or No to cancel.

Deleting the existing exam
1. Search and select the patient in the patient list.
2. Select Review.

3. The patient exam screen displays. Select the exam to be
deleted.

4. Select Delete. The confirmation dialog box displays.
5. Select Yes to delete or No to cancel.

Deleting the existing image

Search and select the patient in the patient list.

Select Review. The patient exam screen displays.
Select the exam which contains the image to be deleted.
Select Active Images to display the image list.

Select the image to delete and select Delete. The
confirmation dialog box displays.

6. Select Yes to delete or No to cancel.

o wbd -~
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Selecting a Model
Selecting an Application Preset

The exam category preset that best describes the desired exam
to be performed is chosen after the exam category is selected.

The factory default preset selections are displayed on the Touch
Panel.

A typical example for the Abdomen exam category is shown
below.

Figure 4-17. Abdomen Preset Selection Touch Panel

Use these parameters as a starting point for the exam.
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Selecting a probe

Select the appropriate probe from the probe indicator. Probes
can be used in more than one exam category/application.

+ Always start out with a probe that provides optimum focal
depths and penetration for the patient size and exam.

* Begin the scan session using the default Power Output
setting for the probe and exam.

Virtual Convex

Figure 4-18. Probe Indicators (Example)
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Chapter 5

Optimizing the Image

Describes how to adjust the image. This chapter is
broken into the following sections: B-Mode, M-Mode,
Color Flow Mode, M Color Flow, Doppler Mode,
Contrast Enhanced Ultrasound, Elastography, and
3D Mode and 4D Mode.
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Optimizing the Image

Optimizing B-Mode

Intended Uses

B-Mode is intended to provide two-dimensional images and
measurement capabilities concerning the anatomical structure
of soft tissue.

MI1.2 Tis 0.3

Figure 5-1. B-Mode Display -- Representative Example
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Typical B-Mode Exam Protocol

A typical examination using B-Mode might proceed
1. Record exam-related patient information. Verify system
setup (probes and presets).

2. Position the patient and the console for optimum operator
and patient comfort. Perform the scan.

3. Complete the study by collecting all the data.

CAUTION Ensure that the hands of the patient are away from the system
during the exam.

The position of the operator and the patient vary by scan
region.

In most cases, the operator sits/stands straight in front of the
operator console and the patient lies on the bed on the right (or
left) side of the system.

CAUTION Always use the minimum power required to obtain acceptable
images in accordance with applicable guidelines and policies.
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Optimizing the Image

B-Mode Scanning Hints

5-4

These B-Mode controls produce the following results:

Auto Optimize. Automatically improves the contrast resolution
of the image by changing the gray scale to match the image
data. Available in B-Mode and Doppler Mode.

Coded Harmonics. Improves image clarity and tissue contrast
by reducing clutter and artifacts.

B-Flow. Provides a more intuitive representation of
non-quantitative hemodynamics in vascular structures.

Frequency. Changes system parameters to best optimize for a
particular patient type.

Gray Map. Affects the presentation of B-Mode information.
Choose the gray map prior to making other adjustments. There
is an interdependency between gray maps, gain, and dynamic
range. If you change a map, revisit gain and dynamic range
settings.

Dynamic Range. Changes the amount of gray scale
information displayed. A higher dynamic range shows more
gray scale information displayed, while a lower dynamic range
displays less gray scale information onto the same display
scale. If you increase the gain, you may want to decrease the
Dynamic Range.

Frame Average. Smooths the image by averaging frames.
Reduces noise in the image.

TGC. Adjust TGC to adjust Gain in specific areas.

Focal Zones. Focal zones should be placed roughly in the
lower half of the display depth, at or below the organ of interest.

Width. Sizes region of interest. Adjust the Width to the smallest
reasonable size to maximize frame rate.
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Depth

Description

Adjusting

Preset

Values

Benefits

Affect on other
controls

Bioeffects

Depth controls the distance over which the B-Mode images
anatomy. To visualize deeper structures, increase the depth. If
there is a large part of the display which is unused at the bottom,
decrease the depth.

Each adjustment cycles you to the next Depth setting. Imaging
and display parameters adjust automatically.

To increase/decrease, adjust Depth.

You can reverse how the Depth control functions on the Utility ->
System -> General page. You can set the depth by probe and
application on the Ultility --> Imaging page.

Depth increments vary by probe and application. Depth displays
on the monitor in centimeters.

Depth values are returned to the factory or user preset value
when you change the following: Probe, Exam Category, Exam
Calcs, or New Patient.

Depth adjusts your field of view. It increases your field of view to
look at larger or deeper structures; it decreases your field of
view to look at structures near the skin line.

After adjusting the depth, you may need to adjust the TGC and
focus.

Changing Depth,

* Clears Cine memory.
» Erases real-time calculations graphics on the display (but
not the completed results on the worksheet page).

Changing the depth may change the Tl and/or MI. Observe the
output display for possible effects.

Make sure enough space is left below the anatomy of interest
to demonstrate shadowing or enhancement.
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Gain

Description

Adjusting

NOTE:

Preset

Values

NOTE:

Benefits

Affect on other
controls

Bioeffects

NOTE:

5-6

B-Mode Gain increases or decreases the amount of echo
information displayed in an image. It may have the effect of
brightening or darkening the image if sufficient echo information
is generated.

To decreaselincrease, rotate Gain (Mode key).

Gain values vary depending on the probe; they are not
associated with a particular position of the knob.

TruAccess allows you to change the gain on a frozen image.
B-Mode gain is independent of M-Mode and Doppler and Color
Flow Gain. Changing the M-Mode Gain while in M-Mode does
not affect the B-Mode image gain.

You can set gain by probe and application on the Utility -->
Imaging page.

Gain displays on the monitor in Gn. Maximum gain varies by
probe. Gain values vary by probe, application, and frequency
setting.

Maximum gain is factory preset to an optimum setting to
eliminate noise in the display.

Gain values are returned to the factory or user preset value
when you change the following: Probe, Exam Category, Exam
Calcs, or New Patient.

Gain allows you to balance echo contrast so that cystic
structures appear echo-free and reflecting tissue fills in.

After you adjust the Power Output, you may need to adjust the
gain. Generally speaking, if you increase the Power Output, you
need to decrease the gain; if you decrease the Power Output,
you need to increase the gain. Gain and TGC interact by adding
together.

Gain has no affect on Power Output. However, with increased
gain, the power output level can usually be reduced to produce
an equivalent image quality.

Always optimize gain before increasing the Power Output.
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Focus
Description
Adjusting
NOTE:
NOTE:
Values
Benefits

Affect on other

Increases the number of focal zones, moves the focal zone(s)
and changes the zone width so that you can tighten up the beam
for a specific area. A graphic caret corresponding to the focal
zone position(s) appears on the right edge of the image.

To increase/decrease the number of focal zones, adjust Focus
Num.

To move the focal zone to the near/far field, adjust Focus
Position.

To change the zone width, use Focus Width.

Focus Position and Focus Number share the same control. The
Focus control turns to move focus position when Focus Position
is shown. Push in to show Focus Number. Turn to change the
focus number.

You can set the focus (Depth % and Number, and Number
Crossbeam) by probe and application on the Utility--> Imaging
page.

Focus zone number and position vary depending on the depth,
zoom, probe, application, and frequency setting selected.

Focal zone number values are returned to the factory or user
preset value when you change the following: Probe, Exam
Category, Exam Calcs, or New Patient.

Focus optimizes the image by increasing the resolution for a
specific area.

Changing the focal number affects the frame rate. The greater

controls number of focal zones, the slower the frame rate.

Bioeffects Changing the focal zone may change the Tl and/or MI. Observe
the output display for possible effects.
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Auto Optimize

Description

Benefit

Adjusting

Preset

Values

Affect on other
controls

5-8

Auto Optimize (Auto) lets you optimize the image based upon a
the actual B Mode image data (Auto Tissue Optimize, ATO). The
preset levels (Low, Medium, and High) allow you to pick a
preference for the contrast enhancement in the resulting image.
Low does the least amount of contrast enhancement, high does
the most.

Auto is available in single or multi image, on live, frozen or CINE
images (in B-Mode only), and while in zoom.

Auto optimize status shown in Info Window. It is displayed as X
in the Map X/N where X shows the selected Map type, and N
shows the Auto Optimize status.

Auto in PW Doppler Mode (ASO: Auto Spectral Optimization)
optimizes the spectral data. Auto adjusts the Velocity Scale/PRF
(live imaging only), baseline shift, dynamic range, and invert (if
preset). “Running Auto Spectral Optimization” appears at the
bottom of the monitor upon activation. Upon deactivation, the
spectrum is still optimized.

Auto can be found in reduced optimization time and a more
consistent and accurate optimization process.

To activate, press AO key.

Specify the ATO Level: Low, Medium, or High via Utility -->
Imaging --> B-Mode.

Specify the Auto Invert on ASO for Doppler mode: On or Off via
Utility --> System --> System Imaging. If you select On,
automatically the spectrum displays in the upper side of
baseline with ASO.

Specify the AO key operation: ATO, CTO, or Both (ATO + CTO).

Auto is active until you deactivate it or when you change the
following: Probe, Exam Category, Exam Calcs, or New Patient.

You may need to adjust the Gain.
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Optimizing B-Mode

Continuous Tissue Optimization (CTO)

Description

Preset

Adjusting

Benefit

NOTE:

NOTE:

CTO is intended to optimize the spatial continuous gain
adjustment on B-mode images instead of, or in combination with
ATO.

You can select Auto Optimize Mode via Utility --> Imaging --> B
--> Auto Optimize Mode.

When CTO is selected, CTO works instead of ATO.
When Both is selected, both ATO and CTO work.
To activate, press right Auto key.

Press Auto key again to turn off CTO.

CTO can reduce optimization time and create a more consistent
process.

When investigating anatomical structures of very low
echogenicity the user may turn off CTO in order to assure the
visualization of all reflected echoes, even if obscured by
surrounding noise.

When activating CTO with M-Mode, only the B-mode image is
optimized.
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Optimizing the Image

CrossXBeam

Description

Adjusting

Preset

5-10

CrossXBeam is the process of combining three or more frames
from different steering angles into a single frame. CrossXBeam
is available on Convex and Linear probes.

CrossXBeam combines multiple co-planar images from different
view angles into a single image at real-time frame rates, using
bi-cubic interpolation.

CrossXBeam combines frames steered from a minimum of three
different angles and up to a maximum of five steer angles
(Convex probes) or up to a maximum of seven (7) steer angles
(Linear probes).

To activate CrossXBeam, press the CrossXBeam key on the
Touch Panel.

To adjust the number of frames being compounded, press the
CrossXBeami# Touch Panel key. Select Low, Mid or High
(Convex probes); or select Low, Mid High, or Max (Linear
probes).

Select CrossXBeam Type (Hybrid, Mean, Max) via CrossXBeam
Type on the Touch Panel. Max detects maximum values; Mean
detects averaged values; Hybrid detects a mix of both average
and maximum values.

You can preset B-Mode CrossXBeam:

+ To activate upon entering B-Mode/Color Flow Mode/PW
Doppler Mode

* Preset the CrossXBeam #

*  Preset Focus Number for CrossXBeam

* Preset Line Density CrossXBeam

*  Frame Average CrossXBeam

+ CrossXBeam Usage (B, B/CF, B/CF/Elasto, B/Dop, B/CF/
Dop, B/CF/Dop/CF+Dop, or B/CF/Elast/Dop/CF+Dop)

These presets can be made via the Utility --> Imaging page.
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Optimizing B-Mode

CrossXBeam (continued)

Values

Benefits

All linear and certain curved convex probes are supported.
Multiple focal zones are supported. B-Mode CrossXBeam is
available while in B-Mode, Color Flow, or PW Doppler Mode.
Steering is optimized by probe. The displayed compound image
depth is equal to the image depth of the non-steered frame.

The following controls are not available:

* Harmonic Imaging

* CINE Loops acquired using CrossXBeam.

* Read Zoom

* All Measurement and Analysis packages

* Virtual Convex (Linear probe)

* SRI HD, Line Density, Depth, Map, TGC, Gain, Edge
Enhance, Frame Averaging, Compression, Colorize,

Acoustic Output, Rejection, Rotation, Auto, Reverse,
Dynamic Range, Biopsy, LOGIQView, 3D Imaging

The following features are supported in CrossXBeam:

* Anatomical M-Mode
« B-Flow

The combined single image has the benefits of reduced speckle
noise, reduced clutter, and continuity of specular reflectors.
Therefore, this technique can improve contrast resolution with
increased conspicuity of low contrast lesions, better detection of
calcifications, biopsy needle visualization, and cystic boundary
definition.
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Optimizing the Image

SRI-HD (High Detection Speckle Reduction Imaging)

Description

5-12

SRI-HD (High Detection Speckle Reduction Imaging) is an
adaptive algorithm to reduce the unwanted effects of speckle in
the ultrasound image. Image speckle usually appears as a
grainy texture in otherwise uniform areas of tissue. Its
appearance is related to image system characteristics, rather
than tissue characteristics, so that changes in system settings,
such as probe type, frequency, depth, and others, can change
the appearance of the speckle. Too much speckle can impair
image quality and make it difficult to see the desired detail in the
image. Likewise, too much filtering of speckle can mask or
obscure desired image detail. Extra care must be taken to select
the optimal SRI-HD level.

SRI-HD is available in B-Mode imaging and may be used with
any transducer or clinical application when image speckle
appears to interfere with the desired image detail.

LOGIQ \ ’ LOGIQ
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Figure 5-2. B-Mode Image before SRI-HD (left) and
After SRI-HD (right)
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Optimizing B-Mode

SRI-HD (High Detection Speckle Reduction Imaging) (continued)

Values

Benefits

NOTE:

Varies, depending on the probe.

We recommend that you select the SRI-HD level by observing
the enhanced image in side-by-side dual image comparison with
the original, unprocessed image. Dual display mode is activated
by pressing the L and R keys simultaneously.

In selecting the level of SRI-HD, you must observe the effects of
SRI-HD in the desired region of interest and should make a
real-time comparison with the original image. The optimal level
depends on the clinical situation and improves with experience.
Observing the original and SRI-HD-processed images together
helps to determine whether too much or too little SRI-HD has
been applied.

Dual image mode for SRI-HD can also be activated on a stored
CINE Loop. This allows you to always see the original,
unprocessed or enhanced image by going into the Dual display
mode and to change the SRI-HD settings when reviewing the
CINE Loop.

SRI-HD is available on 3D.

*  You cannot change SRI-HD after the scan starts.
» The effects for the rendered image are less than the
2D-image.

Smooths the image when image speckle interferes with the
desired image detail.
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Optimizing the Image

Coded Harmonic Imaging (CHI)

Description
Adjusting
NOTE:
NOTE:
Values
NOTE:
Benefits
Bioeffects
5-14

Harmonic imaging utilizes Digitally Encoded Ultrasound (DEU).
Coded Harmonics enhances near field resolution for improved
small parts imaging as well as far field penetration.

To activate Coded Harmonic imaging, press CHI on the touch
panel.

You can specify the parameters for CHI in Utility -> Imaging ->
HAR.

Muilti frequency is not active when the image is frozen.
On/Off. "CHI' appears in place of ‘B’ in the Info Window.

Changing multi frequency resets those parameters which are
presettable by frequency to their preset values for the current
harmonic frequency.

Multi frequency values are returned to the factory or user preset
value when you change the following: Probe, Exam Category,
Application, or New Patient.

Coded Harmonics diminishes low frequency high amplitude
noise and improves imaging technically difficult patients. Coded
Harmonics may be especially beneficial when imaging isoechoic
lesions in shallow-depth anatomy in the breast, liver, and
hard-to-visualize fetal anatomy.

Activating multi frequency mode may change the Tl and/or MI.
Observe the output display for possible effects.
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Optimizing B-Mode

Frequency

Description

Adjusting

NOTE:
NOTE:

Values

Benefits

Bioeffects

Multi Frequency mode lets you downshift to the probe's next
lower frequency or shift up to a higher frequency.

To select a new frequency, adjust Frequency up or down.

The selected frequency appears in the upper, right-hand portion
of the monitor display.

Frequency change is not active when the image is frozen.

Changing frequency resets those parameters which are
presettable by frequency to their preset values for the current
frequency.

Vary, depending on the probe and application.

Frequency values are returned to the factory or user preset
value when you change the following: Probe, Exam Category,
Exam Calcs, or New Patient.

This optimizes the probe's wide band imaging capabilities at
multiple frequencies to image at greater depths.

Activating multi frequency mode may change the Tl and/or MI.
Observe the output display for possible effects.
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Optimizing the Image

Steer

Description

Adjusting

Values

Preset

Benefits

Bioeffects

5-16

You can slant the B-Mode or Color Flow linear image left or right
to get more information without moving the probe. The angle
steer function only applies to linear probes.

To slant the linear image to the left/right, select Steer and then
move the Trackball in the left/right direction or select Trackball
left/right smart key.

To set default direction, select Left or Right in B Steer Beam
Direction menu located in Utility --> Imaging --> B.

Linear probes can be steered left, center, or right up to a
maximum of 15 degrees, depending on the probe.

Steer is not available while using CrossXBeam.

Steer values are returned to factory or user preset value when
you change: Probe, Exam Category, Exam Calcs, or New
Patient.

Reverse Steer Controls via Utility --> System --> System
Imaging.

B Steer Beam Direction via Utility --> Imaging --> B.

Provides a Doppler cursor angle suitable for linear probe
orientation. Beneficial in Peripheral Vascular to image carotids.

Activating angle steer may change the Tl and/or MI. Observe
the output display for possible effects.
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Optimizing B-Mode

Mode Cursor
Description Displays the M/D-Mode cursor on the B-Mode image.

Adjusting To activate/deactivate the M/D-Mode cursor, press Mode
Cursor (left Set key). Trackball to position the M/D-Mode
cursor. Adjust the Angle and SV Length as necessary.

Figure 5-3. Cursor tab

Benefits Lets you position the cursor before you go into M-Mode or
Doppler Mode so that you can make optimum use of the larger
B-Mode image.
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Optimizing the Image

Virtual Convex/Max Angle

Description

NOTE:

Adjusting

Values

Benefits

Bioeffects

NOTE:

5-18

On Linear and Sector probes, Virtual Convex/Max Angle
provides a larger field of view in the far field. Virtual Convex/Max
Angle is always active with Sector probes.

Virtual Convex is not available in CW while in Triplex.

To activate/deactivate Virtual Convex/Max Angle, select Virtual
Convex/Max Angle.

On/Off.

Virtual Convex allows for a wider field of view. Available in
B-Mode, Color Flow Mode, and Doppler Mode. CrossXBeam is
available on Virtual Convex with linear probes. Max Angle View
allows for a wider field of view. Available in B-Mode.

Activating Virtual Convex/Max Angle may change the Tl and/or
MI. Observe the output display for possible effects.

Color Flow can be steered when in straight fire, but not in Virtual
Convex.
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Optimizing B-Mode

TGC

Description

Adjusting

NOTE:

Values

Preset

Benefits

TGC amplifies returning signals to correct for the attenuation
caused by tissues at increasing depths. TGC slide pots are
spaced proportionately to the depth. The area each pot
amplifies varies as well. A TGC curve may appear on the display
(if preset), matching the controls that you have set (except
during zoom). You can choose to deactivate the TGC curve on
the image.

To decrease/increase TGC, move slide pot to the left/right (TGC
slider display on touch screen by pressing TGC icon button on
touch screen).

TGC adjusts automatically when using zoom.

When you change the depth, TGC is rescaled across the new
depth range. Each pot is proportionately scaled across the
depth.

TGC Display On/Off -- preset via Utility --> System --> System
Imaging.

TGC balances the image so that the density of echoes is the
same throughout the image.

Figure 5-4. Digital TGC

8 TGC Slider

Reset TGC

3 User Defined TGC
Exit TGC Screen

e
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Optimizing the Image

Width

Description

Adjusting

Values

Benefits

Affect on other
controls

Bioeffects

Tilt

Description

Adjusting

Values

Benefits

Bioeffects

5-20

You can widen or narrow the size of the sector angle to
maximize the image's region of interest (ROI).

To narrow/widen the angle, move the trackball to right/left after
active the Width control (located on the Trackball Top key).

Varies, depending upon the probe (not applicable to linear
probes) and application.

Increase the sector angle to see a wide field of view; decrease
the sector angle when you need to have a faster frame rate, as
in fetal heart.

Changing the sector angle affects the frame rate. The narrower
the sector angle, the faster the frame rate.

Changing the sector angle may change the Tl and/or MI.
Observe the output display for possible effects.

You can steer the sector angle to get more information without
moving the probe while in B-Mode, M-Mode, Doppler Mode, and
Color Flow Mode. Tilt is not available on Linear probes.

To tilt the angle to the left/right, adjust Tilt using a Trackball key
when shown on the Trackball controls on the display.

Varies, depending on the probe.

Allows you to move a reduced sector angle laterally, without
moving the probe. Beneficial in GYN.

Steering the sector angle may change the Tl and/or MI. Observe
the output display for possible effects.
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Optimizing B-Mode

Dynamic Range

Description

Adjusting

Values

Benefits

Affect on other
controls

Reverse

Description

Adjusting

Values

Benefits

é CAUTION

LOGIQ P8/P9/P10 — Basic User Manual

Dynamic Range controls how echo intensities are converted to
shades of gray, thereby increasing the adjustable range of
contrast.

The Dynamic Range control name changes to Compression on
frozen images.

To increase/decrease, adjust Dynamic Range.

The settings cycle in 3dB or 6dB steps from 36 dB to 96 dB. The
current value displays. Dynamic Range values vary by probe,
application, and frequency setting.

Dynamic Range levels are returned to the factory or user preset
value when you change the following: Probe, Exam Category,
Exam Calcs, New Patient, or Multi Frequency.

Dynamic Range is useful for optimizing tissue texture for
different anatomy. Dynamic Range should be adjusted so that
the highest amplitude edges appear as white while lowest levels
(such as blood) are just visible.

Dynamic range operates in realtime, Freeze, CINE, and CINE
Timeline, but is not available while in DVR playback. It also
affects Gain.

Flips the image 180 degrees left/right.

To flip the image 180 degrees, press the assigned Reverse key
on the touch panel user-defined button or user-defined hard key.

The image rotates in 180 degrees left/right. Reverse settings
vary by probe and application.

Reverse settings are returned to the factory or user preset value
when you change the following: Probe, Exam Category, Exam
Calcs, or New Patient.

Used for anatomical correctness.

When reading a reverse image, be careful to observe the probe
orientation to avoid possible confusion over scan direction or
left/right image reversal.
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Optimizing the Image

Line Density

Description Optimizes B-Mode frame rate or spatial resolution for the best
possible image.

Adjusting Press Line Density right to increase resolution or left to
increase frame rate.
Select the default value for Line Density on the Utility ->
Imaging -> B preset page and press Save.

Values Varies by probe.

NOTE: Not available in timeline.

Values vary by probe and application. Line Density values are
returned to the factory or user preset value when you change
the following: Probe, Exam Category, Exam Calcs, or New
Patient.

Benefits A lower line density is useful in fetal heart beat, adult cardiac
applications and in clinical Radiology applications requiring
significantly higher frame rates.

A higher line density is useful in obtaining very high resolution,
e.g., thyroid, testicles.

Affect on other Line density changes the vector density and frame rate.
controls
Bioeffects Activating color flow line density may change the Tl and/or MI.

Observe the output display for possible effects.

Line Density Zoom

Description You can set the default value for Line Density in zoom
independently.
Adjusting Select the default value on the Utility -> Imaging -> B -> Line

Density Zoom and press Save.
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Optimizing B-Mode

Colorize

Description

NOTE:

Adjusting

PRF

Description

NOTE:

Edge Enhance

Description

Benefits

Affect on other
controls

Colorize is the colorization of a conventional B-Mode image or
Doppler Spectrum to enhance the user's ability to discern B, M,
and Doppler Mode intensity valuations. Colorize is NOT a
Doppler Mode.

You can colorize realtime or CINE images or Timeline CINE.
Colorizes the gray scale image to enhance the eye's
discrimination capability.

Spectrum Colorize colorizes the spectrum as a function of power
using the inverse of the Colorize map for the signal intensity in
each Doppler line.

Colorize enhances the visibility of the spectrum's characteristics
and enhances your ability to identify spectral broadening and
the edge contours of the spectrum used to define the peak
frequency/velocity.

The gray bar displays while Colorize is activated.
To activate Colorize,

1. Select Colorize on the Touch Panel.
2. Trackball to cycle through available maps.
3. Press Set to select.

To deselect, select a gray map.

Reduces noise artifacts in the image. When you activate PRF,
the frame rate decreases and the noise artifacts are filtered.

Available for only Cardiac application.

Edge Enhance brings out subtle tissue differences and
boundaries by enhancing the gray scale differences
corresponding to the edges of structures. Adjustments to
M-Mode's edge enhancement affects the M-Mode only.

Edge Enhance cleans out the B-Mode image/M-Mode timeline
by subduing some of the gray scale in order to highlight the
vessel wall or organ. This is helpful when you cannot
differentiate between the chambers of the heart.

Edge Enhance operates in real-time only; not in Freeze or CINE.
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Optimizing the Image

Frame Average

Description Temporal filter that averages frames together, thereby using
more pixels to make up one image. This has the effect of
presenting a smoother, softer image.

Benefits Smooths the image.
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Optimizing B-Mode

Maps
Description The system supplies B, M, and Doppler Mode system maps.

Maps are preset-specific and are arranged in order from the
softest map on the top of the menu to the most contrasty map on
the bottom of the menu.

The only exception is Map J, which is a very soft map.

In Doppler mode, the Clear map offers a bluish coloring
compared to the standard gray map. Clear Maps provide a more
transparent map. Clear maps are displayed under gray maps.

Adjusting To select a map, press the Gray Map Touch Panel key. A map
window displays. The image reflects the map as you go through
the selections.

Values Map values vary by probe, application, and frequency setting.
Map values are returned to the factory or user preset value
when you change the following: Probe, Exam Category, Exam
Calcs, or New Patient.
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Optimizing the Image

Rejection

Description Selects a level below which echoes will not be amplified (an
echo must have a certain minimum amplitude before it will be
processed).

Benefits Allows for the elimination from the display of low level echoes
caused by noise.

Rotation

Description Rotates the image 90, 180 and 270 degrees.

Benefits 180° Beneficial in transvaginal and transrectal scanning.
90° and 270° beneficial for pediatrics hip scanning and
measurement.

CAUTION When reading a rotated image, be careful to observe the probe
orientation to avoid possible confusion over scan direction or
left/right image reversal.

Suppression
Description Suppresses the noise in the image.
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Optimizing B-Mode

Speed of Sound (SoS) Tissue Imaging

NOTE:

Speed of Sound is available on all probes for the following
applications: Abdomen, Abdomen 2, Renal, and Breast. The
Speed of Sound control is displayed only for these applications
and are hidden in all other applications, even when research
mode is enabled.

Speed of Sound displays on the monitor display as “SoS” with
the speed following, “SoS 1500” (when the speed of sound is
not equal to 1540).

A control has been added on the Touch Panel to change the
transmitted speed of sound for various breast tissue types:

To activate Speed of Sound for Breast, for example,

1. Select Model--> Small Parts--> Breast--> B-Mode--> Speed
of Sound.

2. Press Speed of Sound on the Touch Panel. Speed of Sound
selections appear at the bottom of the Touch Panel in place
of the Focus Position/Number control.

3. Adjust the Speed of Sound control up/down to achieve the
desired image. The system displays the Speed of Sound
(SoS) on the Touch Panel in the upper, right-hand corner of
the display as “SoS ####".

SoS settings are returned to the default for an SoS of 1540 (or
when the SoS is not displayed on the display).
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Optimizing the Image

B-Flow / B-Flow Color (Option)

B-Flow

Description

Presetting

NOTE:

Activating

Using B-Flow

5-28

B-Flow is intended to provide a more intuitive representation of
non-quantitative hemodynamics in vascular structures.

B-Flow is digitally-encoded Ultrasound, using digital codes to
enhance weak signals from small particulate reflectors (blood
flow) and suppress signals from strong reflectors (tissue). Flow
and tissue are displayed simultaneously without threshold
decision and overlay.

All B-Mode measurements are available with B-Flow active:
depth, distance along a straight line, % stenosis, volume, trace,
circumference, and enclosed area.

Preset the default B Flow Mode, either B Flow or B Flow Color
via Utility--> Imaging--> General--> BF/BFC button. Specify the
default to be either B Flow or B Flow Color.

Most parameters are user presettable by probe and application
in the preset menu (Ulility -> Imaging -> BF).

To activate/deactivate B-Flow, press B-Flow button on the touch
panel or user-defined hard key. Doppler Mode is available while
in B-Flow; however, M-Mode and Color Flow/PDI Modes are not
available.

To optimize the image:

Adjust the frequency, display depth, and focal zone location
basded on the patient body type and anatomy of interest. Adjust
Sensitivity/PRI and Background setting as needed (see below).

Adjust the remaining Imaging parameters and presets as
needed; functionally is the same as B-mode when in B-Flow
mode.
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B-Flow / B-Flow Color (Option)

B-Flow (continued)

Scanning Hints

Benefits

Affect on other

B-Flow is especially intuitive when viewing blood flow, for acute
thrombosis, parenchymal flow, and jets. B-Flow helps you
visualize complex hemodynamics and highlights moving blood
and tissue. B-Flow was implemented using Digitally Encoded
Ultrasound (DEU). There are no artifacts such as bleeding,
blooming, or aliasing.

The greater the speed, the better the image scatter density and
size. If the scan direction is the same as the flow direction, then
the image scatter is elongated; if the scan direction is the
opposite as the flow direction, then the image scatter is tighter.
Therefore, have the scan direction opposite to that of flow
direction. Switch the way you hold the probe, with the probe
orientation marker inferior to maintain correct orientation on the
monitor. Flow starts from where the focal zone is located.

Lower the background when imaging the kidney, liver, and
spleen. Keep the focal zone as close to flow as possible. Itis
beneficial to narrow the sector width and increase the frame
rate.

To view high speed jets only for stenosis, use a PRI value of 10
or lower. Use the Background control to display an appropriate
amount of tissue background including plaque.

To view slow flow, use a large PRI value while avoiding a PRI
value that introduces a bar artifact.

Compared to Color Doppler mode, B-Flow provides better
spatial and temporal resolution, displays blood flow in the entire
image, i.e. NO ROI, and is not angle dependent as it does not
use the Doppler Principle. B-Flow is therefore a more realistic
(intuitive) representation of flow information, allowing you to
view both high and low velocity flow at the same time.

When you activate B-Flow, the system remembers the imaging

controls parameters set while in B-Mode. When you optimize the frame
rate via Line Density, you compromise the resolution and when
you optimize the resolution, you compromise the frame rate.
B-Flow is not available in 3DView.

Bioeffects When you select B-Flow, the PRF increases.
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Optimizing the Image

B-Flow (continued)

Accumulation
Description
Values

Benefit

Background
Description

Value

Capture

Description

NOTE:

5-30

Accumulation enhances the flow in an image; ideal to capture
dynamic flow in a still picture.

Off - Infinite. Infinite provides the same result as applying CINE
Capture to a B-Flow CINE clip.

Accumulation detects the maximum signal and holds it
(accumulates it) for the level specified (Off - Infinite).

Adjusts the amount of tissue displayed on the B-Flow image.
Works along with the Tissue control.

0,1,2,3

* 0 = Least amount of tissue displayed.
+ 3 = Most tissue displayed.

B-Flow Capture provides users the ability to create an
accumulated image in B-Flow Live. Maximum intensity
projection algorithm to detect the strongest signal between the
frames and display the results.

When turning on Live Capture, the cine buffer is cleared of prior
data.
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B-Flow / B-Flow Color (Option)

B-Flow (continued)

Sensitivity/PRI

Description

NOTE:

Visualization

Sensitivity/PRI (Pulse Repetition Interval) is proportional to the
time interval between the pulses sent to develop the B-Flow
image.

In general, a larger value is recommended for slow flow as slow
flow detection requires more time separation between pulses so
the system can detect the difference in flow profile. However, a
larger value could cause bar artifacts on the image. Therefore, it
is suggested to not increase the PRI value more than needed. A
small value of PRI should be used when the interest is in fast
flow only, e.g. viewing a jet in a stenosis case, where the jet is of
interest.

Sensitivity/PRI is Probe and Model dependent.

Description Define the display technique.
Values « B-Flow. Displays only B-Flow image.
* Dual. Displays B-Mode and B-Flow images simultaneously
using dual screen.
+ Hybrid. Displays the B-Flow image over the B-Mode image
using Hybrid Map.
Press L and R at the same time to switch between Visualization
values. The switch sequence can be selected in Utility ->
Imaging -> BF -> "L/R Button Sequence".
NOTE:  Available for L3-12-RS, ML6-15-RS, 12L-RS, L4-12t-RS,
C1-6-D, C2-7-D, C3-10-D, 10C-D and C1-5-RS probe.
LOGIQ P8/P9/P10 — Basic User Manual 5-31

Direction 5841298-1EN Rev. 2



Optimizing the Image

B-Flow Color (BFC)

Description

Activating

5-32

NOTE:

NOTE:

B-Flow Color is intended to provide a B-Flow representation with
colorized flow and background B-Mode image.

Although the BFC is based on B-Flow technology, the BFC
image is processed and made by the Color Flow processor and
therefore has both the advantages of B-Flow and Color Flow.
Consequently, imaging parameters and presets are functionally
the same as Color Flow/PDI.

Refer to ‘Color Flow Mode’ on page 5-45 for details on each
parameter.

You can select the steering relation between Doppler cursor and
B-Flow Color window in Utility --> System --> System Imaging
--> Controls.

While in BFC, you can steer the PW cursor or CF RO/
independently.

To activate B-Flow Color,

*  While in B-Mode, press B-Flow on the touch panel or
user-defined hard key to activate B-Flow. Then press Color
on the Touch Panel.

* Adjust the parameters to get the best image.
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B-Flow Color (BFC) (continued)

Enhance (B-Flow Color)

Description Enhance provides a range of choices for B-Flow Color image
quality.
Values Enhance “Off” is the original B-Flow Color setting which gives
you the dynamic appearance of the flow with high frame rate.
Enhance “On” adds sensitivity and stability/continuity to the
flow’s appearance, along with lower frame rates than Enhance
“Off.ﬂ
Scale
Description Same as Scale in Color Flow/PDI Mode.
Values Increase for higher flow states.
Decrease to display smaller vessels and slower flow.
HD Color
Description High Definition Color to visualize smaller vessels and slower
flow.
Value On, Off
NOTE:  Only available L3-12-RS, ML6-15-RS, 12L-RS, L4-12¢-RS,
C1-6-D and C1-5-RS probe.
NOTE: Triplex is not available in HD Color.
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B-Flow Quick Card

B-Flow

Table 5-1:

B-Flow Technology

Digitally encoded technology:

Using digital codes to enhance weak signals from
small particulate reflectors and suppress signals
from strong reflectors (tissue). Coded excitation and
tissue equalization are key to B-Flow.

Activation

Created by the B-Mode processor.

B-Flow is located on the keyboard next to the
B-Mode button. B-Flow gain is controlled by turning
the B-Mode gain button.

Limits of B-Mode and Color Doppler
B-Mode blood flow is displayed as black.

Color Doppler

1. Lack of true hemodynamics representation

2. Color writing on bright interfaces

3. Color outside vessel wall, over gain and high
threshold

4. Inferior spatial resolution compared to B-Mode

5. ROI angle dependency

Table 5-2:

Clinical Advantages of B-Flow

Advantages

1. Visualize both high and low velocity flow
simultaneously

2. No ROl to generate image

3. True hemodynamics, no overwriting on vessel
wall

4. Helps enhance spatial resolution of blood flow
and less angle dependence than color flow

Examples

1. High grade stenosis

2. Soft plaque or plaque ulcerations

3. Early thrombus

4. Organ perfusion such as Renal or placenta
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B-Flow (continued)

Table 5-3:

B-Flow System Tool

System Tools

Definition

Use

Background

Display option for
background B-Mode
image.

Turn background off to suppress tissue signal
allowing enhanced visualization of small vessels.
Turn background on to display tissue signal to help
identify surrounding landmarks in the image.

PRI/Sensitivity

Pulse repetition interval is
the time interval between
the pulses that are sent to
develop the B-Flow* image

For sensitivity to slow flow and small vessel
identification, increase the PRI. Decreasing the PRI
is useful in high flow conditions and helps minimize
flash. The balance ill vary based on probe and
application used.

Accumulation

Detects the maximum
signal and holds it for a
specified time

Use in slow flow states to help increase the time of
optimal vessel visualization. During live scanning
choose from the dropdown the fraction of a second
the image will accumulate.

Frame Average

Temporal filter to enhance
the smoothness of the flow
appearance

Increase frame average to help with smoother flow
appearance. If accumulation is used, frame
average will be ignored.

Frequency

Multiple B-Flow scan
frequencies are available
depending on probes used

Increase the frequency to enhance the detail.
Decrease the frequency for additional penetration.

Dynamic Range

Adjusts the amount of gray
scale information displayed

Increase dB level when less contrast is desired for
a softer image. To enhance the appearance of the
flow, decrease dB level. A decrease in dB level
increases contrast.

SRI

Speckle Reduction
Imaging is an adaptive
algorithm that reduces
image noise from small
specular

To enhance the flow profile, increase SRI. This can
be done in post-processing images if desired.

Cine Capture

Maximum intensity
projection algorithm to
detect the strongest signal
between the frames and
display the results

Cine Capture allows the user to represent the
dynamic flow situation in the vasculature with a
single still image. Adjustments can be made to
modify the start and end frames used in the
process. Select from the touch panel, a “c” will
appear in the image parameter list in place of
frame average.

Visualization

Define the display
technique.

» B-Flow. Displays only B-Flow image.

* Dual. Displays B-Mode and B-Flow image
simultaneously using dual screen.

» Hybrid. Displays the B-Flow image over the
B-Mode image using Hybrid Map.
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B-Flow Color

Table 5-4:

B-Flow Color

Digitally encoded technology:

Provides a B-Flow representation with colorized flow

and a clear background B-Mode image. Uses an
ROI box giving the advantages of both B-Flow and
Color Flow.

Activation
Turn on B-Flow, activate B-Flow Color by choosing
“Color” on the B-Flow touch panel menu.

Limits of Color Doppler

Lack of true hemodynamics representation
Color writing on bright interfaces

Color outside vessel wall

Inferior spatial resolution compared to B-Mode
ROI angle dependency

o=

Table 5-5: Advantages of B-Flow Color

Advantages

1. Dynamic flow appearance

2. High frame rate

3. Clear background tissue with vessel
hemodynamics

4. Less tissue motion artifact

Examples

1. High grade stenosis

2. Aneurysm formation

3. Access graft

4. Organ perfusion such as renal transplant

Table 5-6:  B-Flow Color System Tool

System Tools Definition Use
Enhanced Increases packet size for Use when imaging many small vessels such as
sensitivity versus frame renal parenchyma. Turn off when higher frame rate
rate. is needed.
Accumulation The system detects the Use in slow flow states to help increase the time of

it for the specified time.

maximum signal and holds

optimal vessel visualization. During live scanning
choose from the dropdown the fraction of a second
the image will accumulate.

Focal Zone By adjusting the Focal
Zone position within the
ROI box the user affects
the sensitivity to flow in
these vessels.

The focal zone will track with the ROI until the user
selects this button. Locate the focal zone at or
below the area of most interest for more consistent
flow through the ROI.

Frequency Multiple B-Flow* Color
frequencies are available

use.

depending on the probe in

Select Frequency from the touch panel and select
the dropdown to utilize the bandwidth of
frequencies available for each transducer and
mode.
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Table 5-6: B-Flow Color System Tool (Continued)
System Tools Definition Use
Wall Filter WO and W1, use to Two settings, Use W1 in higher velocity flow states.
decrease overwriting of WO to help display low flow velocities.
vessel wall movement.
Scale The number of pulses Decrease to display smaller vessels and slower
being sent per second. flow. Increase for higher flow states to help reduce
Scale is the reciprocal of overwriting of vessel wall.
PRI.
HD Color Visualize the smaller and On, Off
slower flow in B-Flow NOTE: Only available on L3-12-RS, ML6-15-RS,
Color. 12L-RS, L4-12t-RS, C1-6-D and C1-5-RS probe.
Table 5-7:  B-Flow System Cine Tool
System Tools Definition Use

Cine Capture Cine Capture uses a
Maximum Intensity
Projection algorithm to
detect the strongest signal
between the frames and
displays the result.
Adjustments can be made
to modify the start and end
frames used in the

Acquire a B-Flow or B-Flow Color clip and select
Cine Capture from the cine tab on the touch panel.
Cine Capture allows the user to represent the
dynamic flow situation of the vasculature in a single
still image or across a loop.

process.

Enhancement Applied to a Cine Capture Use to visualize parenchymal perfusion with added
image to express the depth of information. The shade process allows the
vessel structure. Shade anterior and posterior portions of the vessel to be
Forward (FW) and Shade displayed. Shade Forward (FW) brings the first
Reverse (RV) will providea | frame to the front of Cine Capture. Shade Reverse
3D appearance of vessel (RV) brings the last frame to the front of the Cine
structures in a 2D image. Capture. Enhance levels are especially useful in
Enhance Levels 1-3: Data allowing the user to see the vessel structure built
from selected frames are by the Cine Capture and the hemodynamics of the
enhanced and then blood flow enhanced simultaneously.
superimposed on the Cine
Capture images.

Sync Mode Phase synchronizes User can select two Cine loops, recall them, and

multiple cine loops. Used
most often in Stress echo
and contrast.

select Sync Mode to sync the loops. Image Sync
can also be done on two Cine loops acquired with
ECG leads.
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Intended Use

Introduction

Typical exam protocol

5-38

Optimizing M-Mode

M-Mode is intended to provide a display format and
measurement capability that represents tissue displacement
(motion) occurring over time along a single vector.

M-Mode is used to determine patterns of motion for objects
within the ultrasound beam. The most common use is for
viewing motion patterns of the heart.

LOGIQ P8/P9/P10 has three types of M-Mode:

Conventional M-Mode: displays a distance/time plot of a
cursor line in the axial plane of the 2D-image. Conventional
M-Mode can be combined with Color Mode.

Anatomical M-Mode (AMM)
Curved Anatomical M-Mode (CAMM)

A typical examination using M-Mode might proceed as follows:

1.

o &

© o N

Get a good B-Mode image. Survey the anatomy and place
the area of interest near the center of the B-Mode image.

Press Mode Cursor.

Trackball to position the mode cursor over the area that you
want to display in M-Mode.

Press M-Mode.

Adjust the Sweep Speed, TGC, Gain, Power Output, and
Focus Position, as needed.

Press Freeze to stop the M trace.

Record the trace to disk or to the hard copy device.
Press Freeze to continue imaging.

To exit, press M-Mode.
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M-Mode Display

Figure 5-5. M-Mode Display -- Representative Example
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Scanning Hints

Sweep Speed

Description

Adjusting

Values

Benefits

NOTE:

5-40

These M-Mode controls produce the following results:
Sweep Speed. Controls speed of M-Mode update.

Dynamic Range. Affects the amount of gray scale information
displayed.

Changes the speed at which the timeline is swept.
Available in M-Mode and Doppler Mode.
Available in M Color Flow Mode.

To increase/decrease, select Sweep Speed.
Each selection represents a different sweep time.

Sweep Speed values are returned to the factory or user preset
value when you change the following: Probe, Exam Category,
Exam Calcs, or New Patient.

You can speed up or slow down the timeline to see more or
fewer occurrences over time.

The sweep speed information represents the user selected
sweep speed and should be used only as a reference to confirm
that the image was acquired at the selected sweep speed. It is
not to be used for measurements or analysis. This is not an
absolute value, but simply a reference number. Users
performing studies using standardized protocols may find this
sweep speed information useful for reading studies from other
institutions.
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Anatomical M-Mode

Description Anatomical M-Mode gives you the ability to manipulate the
cursor at different angles and positions. The M-Mode display
changes according to the position of the cursor.

Anatomical M-Mode displays a distance/time plot from a cursor
line, which is independent from the axial plane. AMM is available
in B, Color and TVI.

NOTE: To set up AMM, go to Utility--> Imaging--> AMM. Select the
specific probe and parameters.

NOTE: Turn off CrossXBeam before activating AMM/CAMM.

Figure 5-6. Anatomical M Mode
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Anatomical M-Mode (continued)

Activating

Benefits

Bioeffects

5-42

NOTE:

NOTE:

To activate Anatomical M-Mode:

1. While in M-Mode, press the Anatomical M knob on the
bottom of the Touch Panel.

or

Press Set (Mode Cursor) while in B/B+CF/B+PDI and select
Anatomical M to go to live B/B+CF/B+PDI + AMM.

Anatomical M-Mode can also be used with previously
acquired digitally stored 2D images. More than one heart
cycle should be stored if performing M-Mode in post
processing.

2. Use the trackball (assigned function: Pos) to position the M
cursor over the required area of the image.

3. Press the top Trackball key to allow free rotation of the solid
arrow line throughout the 2D image (trackball assigned
function: Angle).

Rotate the Touch Panel control to angle the M cursor at a
given angle.

Color Flow Mode and Color M-Mode are Doppler Modes
intended to add color-coded qualitative information concerning
the relative velocity and direction of fluid motion within the
B-Mode or M-Mode image.

Changing the Packet Size, Scale, and ROI size may change the
Tl and/or MI. Observe the output display for possible effects.
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Curved Anatomical M-Mode (CAMM)

Curved Anatomical M-Mode (CAMM) displays a distance/time
plot from a free-drawn cursor line. CAMM is available in B, CF
and TVL.

NOTE: Curved Anatomical M-Mode can also be used with previously
acquired digitally stored B-Mode images.

1.

NOTE:

NOTE:

NOTE:

While in AMM mode, Change Curved AMM to ON in the M
Mode tab.

Use the Trackball to position the start point of the time
motion curve in the B-Mode image.

Press Set to fix the start point.

Use the Trackball to position the next point.

The time motion curve is drawn by the green line.

Press Set to fix the point.

Repeat step 4 and 5 to draw a complete time motion curve.

The time motion curve can be edited by following the curve
back to the desired point and redrawn as desired. Following
the curve back to the starting point will delete the time
motion curve.

Press Set twice to complete.
Move the cursor to the desired anchor point and press Set.
Move the point to the desired position and press Set.

The arrow cursor appears on the M-Mode image and the
red bar appears on the time motion curve.

The red bar indicates the position of the time motion curve
relative to the arrow cursor on the CAMM image. They move
relative to one another.

Press Set to clear a cursor line.
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Intended Use

Optimizing Color Flow

Color Flow Mode is a Doppler Mode intended to add
color-coded qualitative information concerning the relative
velocity and direction of fluid motion within the B-Mode image.

Introduction

NOTE: Most parameters are user presettable by probe and application
in the preset menu (Ulility -> Imaging -> CF).

A typical examination using Color Flow Mode,

1.

NOTE:

5-44

Follow the same procedure as described under B-Mode to
locate the anatomical area of interest.

After optimizing the B-Mode image, add Color Flow.

Use all noise reduction controls with care. Excessive
application may obscure low level diagnostic information.
Move the color flow area of interest as close to the center of
the image as possible.

Optimize the color flow parameters so that a high frame rate
can be achieved and appropriate flow velocities are
visualized.

Press Freeze to hold the image in memory.
Record color flow images as necessary.

If more definitive information is needed about flow, utilize the
procedures described under Doppler Mode.

To exit Color Flow, press CF-Mode or B-Mode.
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Color Flow Mode

Figure 5-7. Color Flow Mode screen - Representative Example

Uses

Color Flow is useful to see flow in a broad area. Color Flow
allows visualization of flow in the CF ROI, whereas Doppler
Mode provides spectral information in a smaller area.

Color Flow is also sometimes used as a stepping stone to
Doppler. You use Color Flow to locate flow and vessels prior to
activating Doppler.
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Flow Model Shortcuts

Flow Model Shortcuts values vary by application. Below is an
example of the Abdominal Flow Model Shortcuts and the
following table lists all the following Flow Model Shortcuts by
application.

In the Abdominal application on the Color Flow Touch Panel,
you will see Aorta, Renal, Renal Art or Penetration flow
selections.

In the Vascular Exam Category--> LEV Application on the Color
Flow Touch Panel menu, you will see Low Flow or Fast Flow

selections.
Table 5-8:
Renal » Aorta
» Twinkle
* Fast Flow (Renal Art)
* Penetration
OB * Fetal Echo
Gyn * Ovary
Card » Fast Frame Rate
* Penetration
Vasc * Vert Art
SMP * Slow Flow
* Med Flow
* Carotid
Ped * Resolution
* Med Flow
* Penetration
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Gain

Description

Adjusting

Values

Benefits

Bioeffects

Gain amplifies the overall strength of echoes processed in the
Color Flow window or spectral Doppler timeline.

To decrease/increase Gain, rotate Gain (the mode assigned
rotary key).

Gain values change depending on the probe and application;
they are not associated with a particular position of the button.

Values vary by probe, application, and multi frequency setting.
Gain displays as dB. Gain values are returned to the factory or
user preset value when you change the following: Probe, Exam
Category, Exam Calcs, New Patient, or Multi Frequency.

Allows you to control the amount of color within a vessel or to fill
in or clean out spectral information.

Gain has no affect on Power Output. However, with increased
Gain, the power output level can usually be reduced to produce
an equivalent image quality.

Scale (Velocity Scale)

Description
Adjusting

Values

Benefits

Affect on other

Increases/decreases the Scale on the color bar.
To raise/lower the velocity scale, adjust Scale.
Scale is in kHz.

Velocity Scale values are returned to the factory or user preset
value when you change the following: Probe, Exam Category,
Exam Calcs, or New Patient.

Imaging of higher velocity flow requires increased scale values
to avoid aliasing.

Changing the Velocity Scale may affect Power Output and frame

controls rate. When you adjust the velocity scale, CINE memory is
cleared.

Bioeffects Changing the Velocity Scale range may change the Tl and/or
MI. Observe the output display for possible effects.
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Wall Filter

Description Filters out low flow velocity signals. It helps get rid of motion
artifacts caused from breathing and other patient motion.

Adjusting To raise/lower the wall filter, press Scale/Wall Filter until you
reach Wall Filter, then adjust Wall Filter up/down.

Values Values vary, depending upon probe, application, and packet
size. The wall filter is displayed numerically on the monitor (Hz).
Wall Filter values vary by probe and application and are
returned to factory or user preset value when you change:
Probe, Exam Category, Exam Calcs, or New Patient.

Benefits Gets rid of excess, unnecessary low frequency signals caused
by motion.
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Size/Position of the color window

Description

Adjusting

Values

Benefits

Affect on other

Adjust size and position of the color window.

The window grows from the center of the color window. To
adjust the size, press the Upper trackball key on the left side to
select Size (Size/Position appears in the Trackball keys on the
monitor display) then move the Trackball left/right, up/down. To
adjust the position, press the Upper trackball key on the left side
to select Pos then move the Trackball to position the color
window.

Sector and Convex Probes. Ranges from 5 degrees to full
B-Mode image.

Linear Probe. Ranges from 5mm to full B-Mode image.

Increase the color window to see a larger area; decrease the
color window to improve frame rate and spatial resolution.

The smaller the color window, the faster the frame rate and vice

controls versa.

Bioeffects Sizing the color window may change the Tl and/or MI. Observe
the output display for possible effects.

CF/PDI Width

Description You can set the default CF/PDI ROI width.

Adjusting Select the value on the Utility -> Imaging -> CF mode and press
Save.
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CF/PDI Vertical Size

Description You can set the default CF/PDI ROI vertical size.
Adjusting Select the value on the Utility -> Imaging -> CF mode and press
Save.
5-50 LOGIQ P8/P9/P10 — Basic User Manual

Direction 5841298-1EN Rev. 2



Optimizing Color Flow

Invert (Color Invert)

Description

NOTE:
Adjusting

Values

Benefits

Baseline

Description

Adjusting

Values

Benefits

Lets you view blood flow from a different perspective, e.g., red
away (negative velocities) and blue toward (positive velocities).
You can invert a real-time or frozen image.

Invert reverses the color map, NOT the color Scale.
To reverse the color flow, press Invert (Color Invert) .

In Triplex, both Color Flow and Doppler Mode velocity scales
are inverted.

Invert and non-Invert. Values vary by probe and application.

Invert values are returned to the factory or user preset value
when you change the following: Probe, Exam Category, Exam
Calcs, or New Patient.

Allows you to view blood flow according to your personal
preference, without flipping the probe.

Changes the Color Flow or Doppler spectrum baseline to
accommodate higher velocity blood flow. Minimizes aliasing by
displaying a greater range of forward flow with respect to
reverse flow, or vice versa.

Baseline adjusts the alias point. The default baseline is at the
midpoint of the color display and at the midpoint of the color bar
reference display.

To adjust the baseline, adjust Baseline up/down, as necessary.

Zero velocity follows the baseline. The total Scale range remains
the same. Values vary by probe and application.

Baseline values are returned to the factory or user preset value
when you change the following: Probe, Exam Category, Exam
Calcs, or New Patient.

Unwraps the alias during color flow imaging. Higher velocities
can be displayed without reversal of colors.
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Angle Steer

Description

Adjusting

Values

NOTE:

Benefits

Bioeffects

Accumulation

Description

Values

Availability
Benefit
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You can slant the ROI of the Color Flow linear image left or right
to get more information without moving the probe. The Angle
Steer function only applies to linear probes.

To slant the linear image to the left/right, adjust Angle Steer.

Angle Steer can be set in Utility -> Imaging -> CF/PDI Limit to 3
Angle Steer if you want to use all angles or just available only 3
angles (left 20, 0, right 20).

Linear probes can be steered left (20, 15, 10 degrees), center,
or right (20, 15, 10 degrees). Angle Steer values are returned to
the factory or user preset value when you change the following:
Probe, Exam Category, Exam Calcs, or New patient

9L-RS probe and L3-12-RS probe can be steered left (30, 20,
15, 10 degrees), center, or right (30, 20, 15, 10 degrees).

Provides a Doppler cursor angle suitable for linear probe
orientation. Beneficial in Peripheral Vascular to image carotids.

Activating angle steer may change the Tl and/or MI. Observe
the output display for possible effects.

Accumulation enhances the flow in an image.

8 settings: Off, 6 Various levels, or frames, of accumulation, and
Infinite. If Accumulation is turned off, then Frame Averaging is
used; if Accumulation is set, then Accumulation is used.

Available in Contrast, Color Flow, PDI, and B-Flow.

Accumulation detects the maximum signal and holds it for the
level specified.
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Color Flow Line Density

Description

Adjusting

Values

Benefits

Affect on other
controls

Bioeffects

Line Density Zoom

Optimizes the Color Flow frame rate or spatial resolution for the
best possible color image.

To adjust the line density, select the Line Density Touch Panel
key.

Select the default value on the Utility -> Imaging -> CF -> Line
Density and press Save.

The current frame rate is shown on the Touch Panel. Frame
Rate/Resolution values vary by: Probe, Exam Category, Exam
Calcs, New Patient, and Frequency.

Settings are returned to factory or user preset value when you
change any of the above.

Low line density is useful in fetal heartbeat, adult cardiac
applications, and clinical Radiology applications which require
significantly higher frame rates. High resolution is useful in
situations where very small vessels are being imaged, e.g.,
thyroid, testicles.

Line density changes the vector density and frame rate.

Modifying line density may change the Tl and/or MI. Observe
the output display for possible effects.

Description You can set the default value for Line Density in zoom
independently.

Adjusting Select the default value on the Utility -> Imaging -> CF -> Line
Density Zoom and press Save.
Allows you to select a specific color map. After you have made
your selection, the color bar displays the resultant map.
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Map

Description

Adjusting

Values

Benefits

Map Compress

Description

Benefits

5-54

Allows you to select a specific color map. After you have made
your selection, the color bar displays the resultant map.

After you activate Color Flow, the Color Flow Touch Panel
displays. To cycle through available maps, select Map, move the
Trackball to view available maps, and press Set to select.

Velocity Maps (V). Flow shown as blue away/red toward the
probe.

Velocity Variance Maps (VV). Provides a measure of turbulence
(stenosis). Adds green to velocity maps.

Shows the direction of the flow and highlights the higher velocity
flows.

When you increase the value, high velocity elements in the map
are compressed so that the map darkens. When you decrease

the value, low velocity elements in the map are compressed so
that the map lightens. The effect is visible in the color bar.

Changes the gradation in the map.
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Threshold

Description
Adjusting

Values

Benefits

Frame Average

Description

Adjusting

Values

Benefits

Affect on other

Threshold assigns the gray scale level at which color
information stops.

To increase/decrease the gray scale threshold, select
Threshold left/right.

The settings cycle through various values: 0%-100% of the gray
scale. High values display more color; low values displays more
B-Mode gray scale data. The Color Threshold level is displayed
on the Touch Panel.

Values vary by probe and application and are returned to factory
or user preset value when you change: Probe, Exam Category,
Exam Calcs, or New Patient.

Limits color flow overlay to low level echoes inside vessel walls.
Helps minimize color “bleeding' outside vessel walls.

Averages color frames.

To smooth temporal averaging, select Frame Average. The
selected value displays on the Touch Panel.

Frame Average values vary by probe and application. The
values are returned to factory or user preset value when you
change: Probe, Exam Category, Exam Calcs, or New Patient.

Higher frame averaging keeps the color displayed longer for
increased flow visualization while lower frame averaging
provides greater flow dynamics.

Trades off between frame rate and color quality. As the color

controls quality increases, the frame rate may decrease and as the frame
rate increases, the color image quality decreases.
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Transparency Map
Description Brings out the tissue behind the color data.
Adjusting Select Transparency Map to adjust

NOTE: Select the default value on the Utility -> Imaging -> CF ->
Transparent select and press Save.

Benefits Helps demonstrate the tissues behind the color.
Spatial Filter

Description Smooths out the color, makes it look less pixely.
Adjusting Select Spatial Filter to adjust.

NOTE: Select the default value on the Utility -> Imaging -> CF -> Spatial
Filter and press Save.

Benefits Smooths the image.
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Flash Suppression

Description Activates/deactivates Flash Suppression, a motion artifact
elimination process.

Values Values are returned to factory or user preset value when you
change: Probe, Exam Category, Exam Calcs, or New Patient.

Benefits Beneficial to suppress flash.
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Packet Size

Description Controls the number of samples gathered for a single color flow
vector.

Adjusting To increase/decrease the packet size, select Packet Size left/
right.

Values Values vary by probe and application and are returned to factory
or user preset value when you change: Probe, Exam Category,
Exam Calcs, or New Patient. Values are displayed on the
monitor display as P.

Benefits Allows you to improve the color sensitivity and accuracy of color
averaging (increase packet size) or frame rate (decrease packet
size), as needed.

Affect on other When you decrease the packet size, you increase the frame rate

controls at the expense of image quality. When you increase the packet
size, you improve image quality at the expense of frame rate.

Bioeffects Changing packet size may change the Tl and/or MI. Observe

the output display for possible effects.

Sample Vol (Sample Volume)

Description Adjusts the size of the color flow doppler transmit wave (or
pulse) and size (or length). Lower setting gives better flow
resolution and a higher setting increases sensitivity.

CF/PDI Auto Sample Volume

Description You can set the default CF/PDI Auto Sample Volume.

Adjusting Select the value on the Utility -> Imaging -> CF -> CF/PDI Auto
Sample Volume and press Save.

CF/PDI Center Depth

Description You can set the default CF/PDI center depth.
Adjusting Select the value on the Utility -> Imaging -> CF mode and press
Save.

CF/PDI Focus Depth (%)

Description You can set the default CF/PDI focus depth (%).

Adjusting Select the value on the Utility -> Imaging -> CF -> CF/PDI Focus
Depth (%) and press Save.
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CF/PDI Frequency (MHz)

Description You can set the default CF/PDI Frequency (MHz).
Adjusting Select the value on the Utility -> Imaging -> CF mode and press
Save.

CF/PDI Auto Frequency

Description You can set the default CF/PDI Auto Frequency.

Adjusting Select the value on the Utility -> Imaging -> CF mode and press
Save.
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Power Doppler Imaging (PDI)

Description

Adjusting

NOTE:

Values

Benefits

Affect on other
controls

5-60

Power Doppler Imaging (PDI) is a color flow mapping technique
used to map the strength of the Doppler signal coming from the
flow rather than the frequency shift of the signal. Using this

technique, the ultrasound system plots color flow based on the
number of reflectors that are moving, regardless of their velocity.
PDI does not map velocity, therefore it is not subject to aliasing.

Press PDI. The color flow window appears over the B-Mode
image. Move the Trackball to move the CF window. To exit,
press PDI or select a new mode.

Most parameters are user presettable by probe and application
in the preset menu (Utility -> Imaging -> PDI).

On/Off.
Twelve power and four directional PDI maps are available.
Since PDI does not display velocity, it does not alias.

When PDI is activated, the following controls are adjusted: Color
Map is set to a power map. Line Density is adjusted. Threshold
is set to 100%. Frame Averaging is adjusted. Packet Size is
adjusted.

These controls are reset to their previous values upon exiting
PDI.

When changing maps, higher gain settings may be needed.
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Directional Power Doppler

You can select the DPO 0, 1, 2, and 3 Directional Power Doppler
maps while in PDI.

NOTE: If you store a PDI image and recall it, you can still switch to the
Directional Power Doppler map and vice versa. However, an
image stored as non-directional then switched to directional just
adds direction to a non-directional map and vice versa.

If the image is aliasing while in Directional Power Doppler,
increase the Scale.
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Optimizing M Color Flow

M Color Flow Mode

Description M Color Flow is used for fetal cardiac applications. Color Flow
overlays color on the M-Mode image using velocity and variance
color maps. The Color Flow wedge overlays the B-Mode image
and M-Mode timeline.

The Color Flow maps available in M-Mode are the same as in
Color Flow Mode. The size and position of the Color Flow
window in B-Mode determines the size and position of the Color
Flow window in M-Mode.

All M-Mode measurements are available with M Color Flow
active: depth, distance along a straight line, % stenosis, volume,
trace, circumference, enclosed area, distance, time, slope, and
heart rate.

M Color Flow mode can be activated on the sector probes only.
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M Color Flow Mode (continued)

Activating

Benefits

Bioeffects

:‘- ] Al ;A v I-'b
3 -.—'/_' -..——’_‘ v"' ~ "‘ v"* v’

To activate M Color Flow Mode, press M (M-Mode). Then press
CF (Color Flow) - or - press CF, then press M.

CM tab is displayed.

 ——— e —— e  —

- o

Figure 5-8. M Color Flow screen -- Representative Example

Color Flow Mode and Color M-Mode are Doppler Modes
intended to add color-coded qualitative information concerning
the relative velocity and direction of fluid motion within the
B-Mode or M-Mode image.

Changing the Sweep Speed, Packet Size, Frame Rate/
Resolution, Zoom, PRF, and ROI size may change the Tl and/or
MI. Observe the output display for possible effects.

LOGIQ P8/P9/P10 — Basic User Manual 5-63
Direction 5841298-1EN Rev. 2



Optimizing the Image

Optimizing Spectral Doppler

Intended Use

Doppler is intended to provide measurement data concerning
the velocity of moving tissues and fluids. PW Doppler lets you
examine blood flow data selectively from a small region called
the sample volume.

Typical Use - PW Doppler

In Pulsed Wave Doppler (PW) Mode, energy is transmitted from
the ultrasound probe into the patient, as in B-Mode. However,
the received echoes are processed to extract the difference in
frequency between the transmitted and received signals.
Differences in frequencies can be caused by moving objects in
the path of the ultrasound signal, such as moving blood cells.
The resultant signals are presented audibly through the system
speakers and graphically on the system display. The X axis of
the graph represents time while the Y axis represents the shift in
frequency. The Y axis can also be calibrated to represent
velocity in either a forward or reverse direction.

PW Doppler is typically used for displaying the speed, direction,
and spectral content of blood flow at selected anatomical sites.
PW Doppler operates in two different modes: conventional PW
and High Pulse Repetition Frequency (HPRF).

PW Doppler can be combined with B-Mode for rapidly selecting
the anatomical site for PW Doppler examination. The site where
PW Doppler data is derived appears graphically on the B-Mode
image (Sample Volume Gate). The sample volume gate can be
moved anywhere within the B-Mode image.
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Typical exam protocol

A typical examination using PW Doppler Mode might proceed as
follows:

NOTE: Most parameters are user presettable by probe and application
in the preset menu (Ulility -> Imaging -> PW/CW).

1.

10.

1.

12.

Connect the appropriate probe, leaving the probes in their
respective holders.

Position the patient for the examination.

Press Patient. Enter the appropriate patient data using the
appropriate exam category.

Select the preset, application and probe to be used.

Locate the anatomy to be examined. Get a good B Mode
image. Press CF to help locate the vessel you wish to
examine.

Press Mode Cursor to display the sample volume cursor
and gate.

or

Press PW. The PW Doppler spectrum appears and the
system operates in combined B+Doppler Mode. Adjust
Volume to adjust Doppler audio. The Doppler signal is
heard through the speakers.

Position the sample volume cursor by moving the Trackball
left and right. Position the sample volume gate by moving
the Trackball up and down. Size the gate by clicking SV
Length.

Optimize the PW Doppler spectrum, as necessary. Refer to
the Doppler Optimization section of this chapter for more
information.

Press Update to toggle between real time B-Mode with
Doppler Mode (with audio).

Sample along the whole length of the vessel. Make sure that
the probe is parallel to flow. Listen, then look, when
positioning the sample volume cursor.

Press Freeze to hold the trace in memory and stop imaging.
Activate CINE Timeline, as necessary.
Perform measurements and calculations, as necessary.

Refer to the Measurements and Calculations chapter for
more information.
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Typical exam protocol (continued)

5-66

13

14
15

16
17

. Record results by pressing the appropriate print key,
depending on the setup of your recording devices.

. Press Freeze to resume imaging.

. Repeat the above procedure until all relevant flow sites have
been examined.

. Replace the probe in its respective holder.
. To exit PW, press PW. To exit CW, press CW.
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Spectral Doppler Display

Time zero (the start of the trace) appears on the left side of the
graph. As time progresses, the trace moves to the right. The
baseline of the graph (representing zero velocity, zero frequency
shift, or no detected flow), appears as a solid line running
horizontally across the display. By convention, movement
toward the probe is positive and movement away from the probe
is negative. Positive frequencies or velocities appear above the
baseline. Negative frequencies or velocities appear below the
baseline.

Typically, blood flow is not uniform but is composed of a mix of
blood cells moving at different velocities and in different
directions. Thus, the display is composed of a spectrum as gray
scale values. Strong signals are displayed as bright while weak
signals are displayed as varying shades of gray.

HPRF (High Pulse Repetition Frequency) is invoked when you
are operating in PW Doppler Mode and conditions activate
HPRF (when the velocity scale factor or sample volume gate
depth exceeds certain limits). When HPRF is active, multiple
sample volume gates appear along the Doppler mode cursor.
Doppler information can be received from any of the multiple
sample volume gates. The Doppler signals from all the gates are
added together and displayed in one spectrum.

Information about the PW Doppler display is automatically
written on the screen and updated when scanning parameters
are changed.

This chapter includes:

* Adiscussion of PW Doppler.
+ Activating Pulsed Wave Doppler.
*  Optimizing the Doppler spectrum.
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PW Doppler Mode Display

Figure 5-9. PW Doppler Mode Display -- Representative Example

Table 5-9:  Doppler Mode Display Explanations

Doppler Display Description, Format, Values
Scale Velocity Scale, displayed as PRF in kHz.
Wall Filter Wall filter size, displayed as WF in Hz.
Doppler Gain Displays as GN in decibels (dB).

Sample Volume Depth

Displays (in Cm) when Doppler cursor is present.

Doppler Angle
(AC ##)

Indicates angle in degrees between the Doppler mode cursor and the angle
correction indicator. Displays when Doppler cursor is present. The Doppler
Angle displays in red when the angle exceeds 60°. Velocities obtained when
the angle is greater than 80° are displayed as asterisks (***).

Spectral Invert

INVERT appears when the spectral trace is inverted and the plus/minus
signs (+/-) are reversed.

HPRF HPRF mode is used when detected velocities exceed the processing
capabilities of the currently selected PW Doppler scale or when the selected
anatomical site is too deep for the selected PW Doppler scale.

Time Scale Each selection represents a different sweep time.

Angle Correct

Indicates flow direction.

Sample Volume Gate

Indicates sample volume box. Each probe defaults to a specific range gate.

Doppler Velocity Scale Flow direction has a positive and negative indicator, noted in centimeters per
second (cm/sec.). When the velocity scale is less than 10 cm/s, it is displayed
to the first decimal point (4.6 rather than 5 cm/s). The Doppler velocity scale
adjust as you adjust the Scale.
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Auto Doppler Assist

NOTE:

Auto Doppler Assist automatically positions and steers Color
Flow ROl and PW Cursor. This to feature is available on all
linear probes. Available in Color Flow, Color Flow + PW (Triplex
and non-Triplex).

To use Auto Doppler Assist, position the cursor in the Color Flow
ROI (the Color Flow ROI has to include the vessel of interest, or
part of it). Press the appropriate Touch Panel Auto control
(shown below) or press the Auto control to the left for Color Flow
or to the right for Pulsed Wave. Manual map the “Auto” controls
via Utility--> User Configurable Key.

WUpdate

Simul Off

Figure 5-10. Auto Doppler Assist

Upon pressing the Auto Doppler Assist button, the system will
automatically:

* Pick the artery or vein (depending on the selected
application).

»  Center the Color Flow ROI on the vessel of interest.

»  Steer with the direction of the vessel.

+ Keeps the Sample Volume in the middle of the ROI.

+  Steers the PW Cursor (if existing) to maintain the angle
correct set by the operator under Auto Correct on the Utility
--> Imaging --> PW --> Angle Correct.

If the angle is set to zero, then the system uses 60 degrees.
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Doppler Sample Volume Gate Position (Trackball)

Description

Adjusting

Values

Benefits

Bioeffects

Moves the sample volume gate on the B-Mode's Doppler Mode
cursor. The gate is positioned over a specific position within the
vessel.

To move sample volume gate position, press the top trackball
key to select Pos, move Trackball up or down until positioned
inside the vessel.

To move sample volume gate position, press the top trackball
key to select Pos, move Trackball up or down until positioned
inside the vessel.

Defaults to 50% of the depth and can move continuously
throughout the field of view.

Positions the sample volume gate to sample blood flow.

Changing the sample volume gate position may change the Tl
and/or MI. Observe the output display for possible effects.

Doppler Sample Volume Length

Description

Adjusting

NOTE:

Values

Benefits

Bioeffects

5-70

Sizes the sample volume gate.

To increase/decrease the gate size, adjust SV Length on the
Touch Panel. Hold down key to continuously size gate.

You can adjust the sample volume gate length whenever the
sample volume gate appears on the display.

Adjustments to the sample volume gate size are made from the
center point of the sample volume position.

Values vary by probe and application.

A smaller gate produces accurate sampling results because it is
more sensitive. You can also enlarge the gate for sampling large
vessels or areas.

Changing the sample volume gate size may change the Tl and/
or MI. Observe the output display for possible effects.
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Angle Correct/Auto Angle

Description

NOTE:

Adjusting

NOTE:

Benefits

Quick Angle

Description

Adjusting

Estimates the flow velocity in a direction at an angle to the
Doppler vector by computing the angle between the Doppler
vector and the flow to be measured.

When the Doppler Mode Cursor and angle correct indicator are
aligned (the angle is 0), you cannot see the angle correct
indicator.

Flow toward the probe is mapped above the baseline and vice
versa.

To adjust the angle relative to the probe face, adjust Angle
Correct to the left/right. The velocity scale changes when you
adjust angle correct.

Press Angle Correct to access Auto Angle.

Angle Correct can be adjusted in Triplex Mode when Update is
activated.

Angle Correct values vary by probe and application. Angle
Correct values are returned to the factory or user preset value
when you change the following: Probe, Exam Category, Exam
Calcs, or New Patient.

Optimizes the accuracy of the flow velocity. This is especially
useful in vascular applications where you need to measure
velocity.

Quickly adjusts the angle by 60 degrees.
Press Quick Angle to toggle between Off, Right and Left.
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Steer/Fine Steer

Description

Adjusting

Values

NOTE:

Benefits

Bioeffects

5-72

You can slant the ROI of the Color Flow linear image left or right
to get more information without moving the probe. The angle
steer function only applies to linear probes.

To slant the linear image to the left/right, adjust Steer to the left
or right.

Press Steer to access Fine Steer.

Linear probes can be steered left (10, 15, 20 degrees), center,
or right (10, 15, 20 degrees).

Steer values are returned to factory or user preset value when
you change: Probe, Exam Category, Exam Calcs, or New
Patient.

Fine Steer value can be changed in 2 degree increments.

9L-RS probe and L3-12-RS probe can be steered left (30, 20,
15, 10 degrees), center, or right (30, 20, 15, 10 degrees).

Provides a Doppler cursor angle suitable for linear probe
orientation. Beneficial in Vascular applications.

Activating angle steer may change the Tl and/or MI. Observe
the output display for possible effects.
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Audio Volume

Description Controls audio output.
CAUTION Audio sounds change rapidly, often abruptly. Increase the
volume in small steps to avoid startling the patient.

Benefits An audio representation of the flow within a vessel can be used
to evaluate proper probe angle and position.

Auto Spectrum Optimize (Auto)

For details on Auto, See ‘Auto Optimize’ on page 5-8 for more
information.
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Cycles to Average

Description The average value over a number of cycles (from 1-5). For
example, if you set the number of cycles at 3, values would be
averaged for 3 cycles. If you have 5 cycles on the display, the
PS would be the average of 3 of the 5 cycles, which are
identified by a line drawn over the 3 averaged cycles.

Available for live and frozen images.

Display Format

Description Changes the horizontal/vertical layout between B-Mode and
Doppler Mode or timeline only.

Benefits You can select how to have your Doppler timeline and anatomy
displayed.
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Update

Description

Adjusting

Values
Benefits

Bioeffects

Toggles between simultaneous and update presentation while
viewing the timeline.

To activate, press Update to toggle between simultaneous and
update. Doppler Mode does not restart each time the image is
updated; however, a black bar may appear with a lightning bolt
signalling a break in the timeline.

On/Off.
Update increases the Spectral Doppler display quality.

Activating Update may change the Tl and/or MI. Observe the
output display for possible effects.

Simultaneous (Duplex/Triplex)

Description

Adjusting
Preset

Benefits

Duplex allows two modes to be active at the same time; Triplex
allows three modes to be active at the same time.

+ B+PWorB+ CW orB + CF (Duplex)
+ B+ PW+CForB+ CW+ CF (Triplex)

Update pauses the image while keeping the CW / PW timeline
active.

When Duplex/Triplex is OFF, either the image or timeline is
active. Update then switches the active side between the image
and the timeline.

Select Simultaneous on Touch Panel.
You can preset Duplex in Utility --> Imaging --> General.

Allows the user to have multiple modes active at the same time.

LOGIQ P8/P9/P10 — Basic User Manual 5-75
Direction 5841298-1EN Rev. 2



Optimizing the Image

Baseline

Description

Adjusting

Values

Benefits

5-76

Adjusts the baseline to accommodate faster or slower blood
flows to eliminate aliasing.

Baseline adjusts the point in the spectrum where the velocity
trace is at zero. The default baseline is at the midpoint of the
spectrum. To shift the baseline, adjust Baseline on the Touch
Panel.

The baseline displays as a solid line running across the
spectrum. The baseline is raised and lowered in equal
increments, depending on the current Doppler scale factor. The
control does not wrap when the maximum baseline shift (in
either direction) has been reached.

50% is the center of the display, +95% is the top edge of the
display and 5% is the bottom edge of the display. Baseline
values vary by probe and application and are returned to the
factory or user preset value when you change: Probe, Exam
Category, Exam Calcs, or New Patient.

Unwraps the alias. Rearranges the velocity scale without
changing the velocity scale. Readjusts the positive and negative
velocities limit without changing the total velocity range.
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Compression

Description

Values

Benefits

Invert

Description

Values

Benefits

Compression controls how echo intensities are converted to
shades of gray, thereby increasing the range of contrast you can
adjust.

The current value displays on the Touch Panel. Compression
values vary by probe and application and are returned to the
factory or user preset value when you change the following:
Probe, Exam Category, Exam Calcs, or New Patient.

Optimizes the image's texture and smoothness by increasing or
decreasing the amount of gray scale.

Vertically inverts the spectral trace without affecting the baseline
position.

The plus (+) and minus (-) signs on the velocity scale reverse
when the spectrum is inverted.

Positive velocities display below the baseline.

Forward/reverse. The trace corresponds to flow direction
(positive flow is forward flow toward the probe or negative flow is
reverse flow away from the probe). The invert setting is returned
to the factory or user preset value when you change the
following: Probe, Exam Category, Exam Calcs, or New Patient.
In Triplex, both Color Flow and Doppler Mode velocity scales
are inverted.

If you change the probe angle to accommodate anatomy, blood
flow still moves in the same direction, but the Doppler
information will be reversed. It is easier in cases like this to
invert the spectrum instead of reversing the probe orientation.
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Scale (Velocity Scale)

Description

High PRF

NOTE:

Adjusting

Values

5-78

Adjusts the velocity scale to accommodate faster/slower blood
flow velocities. Velocity scale determines pulse repetition
frequency.

If the sample volume gate range exceeds single gate Scale
capability, the system automatically switches to high PRF mode.
Multiple gates appear, and HPREF is indicated on the display.

High Pulse Repetition Frequency (HPRF) is a special operating
mode of PW Doppler. In HPRF mode, multiple energy pulses
are used. This allows higher velocities to be detected without
causing aliasing artifacts. HPRF mode is used when detected
velocities exceed the processing capabilities of the currently
selected PW Doppler scale or when the selected anatomical site
is too deep for the selected PW Doppler scale. The pulse
repetition frequency (PRF) is displayed to the left of the
spectrum in frames per second.

Ensure that only one gate overlays a blood vessel at a time.
Otherwise, signals from more than one flow area are
superimposed.

To adjust the Scale, turn the rotary. The display updates velocity
scale parameters after you adjust the velocity scale.

Velocity Scale values vary by probe and application. In Triplex,
when you change the velocity scale in Color Flow, the Doppler
Mode velocity scale is also updated if Triplex is on.

Velocity Scale values are returned to the factory or user preset
value when you change the following: Probe, Exam Category,
Exam Calcs, or New Patient.
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Scale (Velocity Scale) (continued)

Benefits Blood flow information is not cut off due to the effect of aliasing.
Affect on other When you raise the velocity scale, the spectral waveform may
controls decrease in size; when you lower the velocity scale, the spectral

waveform may increase in size. Changes in the spectrum are
relative to changes in the velocity scale, that is, it sizes
accordingly. When you adjust the velocity scale, CINE memory
is cleared. Adjustments may affect sample volume size and
Doppler wall filter.

Bioeffects Changing the velocity range may change the Tl and/or MI.
Observe the output display for possible effects.
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Wall Filter

Description Insulates the Doppler signal from excessive noise caused from
vessel movement.

Adjusting To increase/decrease, select Wall Filter on the Touch Panel.

Values Values vary, depending upon the probe and application. The
current value displays on the Touch Panel and the monitor. Wall
Filter values are returned to the factory or user preset value
when you change the following: Probe, Exam Category, Exam
Calcs, New Patient.

Benefits Gets rid of excess, unnecessary information. Cleans out low
level noise above and below the baseline so you don't see or
hear it on the spectrum.

Affect on other Wall filter may be changed by changes to the velocity scale.

controls

Trace Method (Spectral Trace)

Description Traces the average mean and peak velocities in realtime or
frozen images.

Adjusting To get a peak trace, click MAX. A green trace displays on the
spectrum.
To get a mean trace, click MEAN. A blue trace displays on the
spectrum.

Benefits Lets you trace the cardiac cycle.

Trace Sensitivity

Description Adjust the trace to follow the waveform for signal strength.

Benefits If the signal is very faint, increasing the Trace Sensitivity will

allow the system to trace that signal strength.

Trace Direction

Description Specifies trace direction.

Selecting Trace You can select where on the waveform to perform the trace,
Position above, below, or both (above and below).
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Cursor Moving

Description On Utility--> Imaging, specify No Action, Update 2D/CF-Long,
Medium, or Short, or Update Doppler-Slow, Medium, or Fast.

Cursor Moving lets you ‘walk’ Doppler through a vessel while the
Doppler gate is moving. Updates are more frequent on Fast vs.
Medium vs. Slow. If you set the preset to Update 2/D/CF, this
causes the B Mode/Color Flow image to go live while you move
the Doppler cursor.
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Time Resolution

Description Adjusts image appearance so that if you select a lower setting,
the image appears smoother; if you select a higher setting, the
image appears sharper.

Benefits Time Resolution = 3 (high) smooths the Timeline; Time
Resolution =1 (low) increases the time resolution (sharpens the
image).
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PW Simultaneous Priority

Description Adjust spectrum appearance

Preset You can select Spectrum or Balanced via Utility -> Imaging ->
PW.

Values Values Spectrum: Spectrum improves the appearance of the

spectrum under a certain velocity range at Simultaneous mode.

Balanced: Balanced reduces the artifact. Appearance of the
spectrum is inferior as compared with Spectrum mode.

NOTE:  Not all probe have this prese
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Auto CHI off in Simultaneous

Description Turn off CHI in PW Simultaneous
Preset On Utility -> Imaging -> PW, check the checkbox.
Values If you select Spectrum mode with PW Simultaneous Priority, CHI

image changes to the fundamental image automatically at
Simultaneous mode for reduce the artifact.
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CW Doppler - Continuous Wave Doppler (CWD) (Option)

Steerable

There are two CW Doppler operating modes: Steerable and
Non-Imaging.

Allows examination of blood flow data all along the Doppler
Mode cursor rather than from any specific depth. Gather
samples along the entire Doppler beam for rapid scanning of the
heart. Range gated CW allows information to be gathered at
higher velocities.

Allows viewing of the B-Mode image to position the Doppler
cursor to the area of interest while viewing the Doppler spectrum
(shown below in the B-Mode image) and listening to the Doppler
Audio signal.

Works with the sector probes.
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Non-Imaging
Provides only Doppler Spectrum and Audio for ascending/
descending aortic arch, other hard-to-get-to spaces or higher
velocities.

Works with P8D, P6D and P2D as well.
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Activating CW Doppler

To activate CW Doppler Mode, press CW.

The Steerable CW Doppler spectrum displays along with the
B-Mode image. The cursor changes to a Doppler cursor.

You can now position and size the sample volume gate to get a
velocity. Use Doppler Audio to listen for when the sample
volume gate is positioned over an area of flow.

Update toggles between real time B-Mode with Doppler Mode
and real time spectral display.
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Exiting CW Doppler

To exit CW Doppler Mode, press CW.
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Strain Elastography

Strain Elastography

Description

Strain Elastography shows the spatial distribution of tissue
elasticity properties in a region of interest by estimating the
strain before and after tissue distortion caused by external or
internal forces. The strain estimation is filtered and scaled to
provide a smooth presentation when displayed.

Below is an example of Strain Elastography. The Strain
Elastography color map/bar appears, this image appears in dual
image mode, and Strain Elastography imaging parameters
appear on the right-side of the display below E.

You activate Strain Elastography via the Elasto key on
user-defined hard key (If user is assign Elasto mode to User
Defined Hard Keys).

Elasto is available on C1-5-RS, L6-12-RS, 12L-RS, 9L-RS,
L4-12t-RS, L3-12-RS, E8Cs-RS, BE9CS-RS, IC9-RS, C1-6-D
and ML6-15-RS probes.

Figure 5-11. Strain Elastography Example
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Activating Elastography

Figure 5-12. Strain Elastography Touch Panel 1

NOTE: You can specify which Strain Elastography controls you want to
appear on the Touch Panel. You can set these via Utility ->
Application -> Imaging Controls -> Clinical Controls Elasto.

Table 5-10:  Strain Elastography Touch Panel Description

Parameter Description

Axial Smoothing Controls the smoothness of the strain elastography image in the axial
direction. A higher value means a smoother image.

Sample Vol Controls the transmit pulse length. A higher value means longer transmit
pulse which gives better SNR (Signal to NoiseRatio) but reduces axial
resolution.

Lateral Smoothing Controls the smoothness of the strain elastography image in the lateral

direction. A higher value means a smoother image.

Window Controls the RF data segment size for the motion tracking. A higher Window
value gives a better signal to noise ratio (SNR) at the cost of axial resolution.

Map Controls the strain elastography maps. Seven different maps are available
with various contrast and color schemes, including a grayscale map.

Frame Average Controls the persistence of the strain elastography images.
Frequency Controls the transmit frequency.
Strain sensitivity If SO Map (in live) is selected, user can control strain sensitivity (SS).
Soft Compress Individually controls the image enhancement for the softer than average
tissues.
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Strain Elastography

Table 5-10:  Strain Elastography Touch Panel Description (Continued)

Parameter Description
Hard Compress Individually controls the image enhancement for the harder than average
tissues.
Scale Controls the time interval between consecutive firings. A lower value dictates

a higher sensitivity to weak manual motion.

Transparency High values bring out the tissue behind the strain elastography data. You
adjust via the Color Gain control; this imaging parameter appears as a “T” on
the right-hand portion of the display.
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Activating Elastography (continued)

Figure 5-13. Strain Elastography Touch Panel 2

Table 5-11:  Strain Elastography Touch Panel Description

Parameter Description
Biopsy Kit Biopsy Kit.
Sample Vol Controls the transmit pulse length. A higher value means longer transmit

pulse which gives better SNR but reduces axial resolution.

Frame Reject Controls how many frames get rejected due to low quality vertical motion. A
higher value means more frames get rejected. A rejected frame has a
completely transparent ROl with the B-Mode background showing through.

Noise Reject Controls how many frames get rejected due to lateral and elevational motion.
A higher value means more frames get rejected. A rejected frame has a
completely transparent ROl with the B-Mode background showing through.

Line Density Optimizes B-Mode frame rate or spatial resolution for the best possible
image.
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How to Use

The Strain Elastography image is achieved by pulsating the
probe while you are scanning the anatomy of interest. Here are
some criteria to use:

Handheld elasticity imaging can be very dynamic as the size of
distortion depends on the movement of the hand-held probe. To
maintain stable and consistent displayed strains, pay attention
to the Quality graph. Two forms of feedback are provided. In
either form, an ideal manual compression is indicated by a high
value feedback. In addition, apply the following post-processing
controls: Smoothing, Window, Scaling, and Frame Averaging.

Strain Elastography displays firmer tissue in blue and softer
tissue in red. To enhance Blue, increase Hard Compress; to
enhance Red, increase Soft Compress on the Touch Panel. To
enhance elastography contrast, reselect the Color Map.

If you need more resolution, increase Smoothing, increase
Frequency, reduce Sample Volume, or reduce Window.

If you need a smoother image, increase Window, Smoothing,
and Sample Volume.

If the images seem too flashy, decrease Frame Reject to 1.0 and
Noise Reject to have consistent imaging throughout.

NOTE:  Refer to Elastography Quantification of Chapter 13 Quantitative
Analysis on how fto use Elastography Quantification.
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Application Parameters
You can set the Quality Bar and Quality Graph on the Utility-->
Application--> Settings --> Elasto.
For Quality Bar:
» Check to display a Quality Bar for Elastography.
For Quality Graph:

+  Off (No elasto quality graph is displayed in the image)
+  Small, Medium or Large for display size of Quality Graph.

General Imaging Parameters by Application/Probe/Feature
Select the Default Elasto Mode via Utility--> Imaging--> General.

You can specify Strain to be the default setting by application
and probe.

1. To specify a default probe per application, select Utility -->
Imaging --> General.

2. Select the application.

3. Select the default probe from the pull-down menu.

4. Specify the Default Elasto setting:

+ Strain
e Shear
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Strain Elastography maps

There are two (2) Strain Elastography maps: an E Mapand a S
Map.

The E Map calculates the mean strain for the whole ROI and
assigns this mean value to a green (center) color. This is best
suited for imaging a localized mass compared to the
surrounding tissue with external forces (the movement of the
hand-held probe).

The S Map is useful for imaging diffusely-distributed diseases
and local strain changes brought about by internal forces such
as the movement of a beating heart and moving vessels. The
default strain sensitivity is unique by probe/application. You can
adjust the strain scale by adjusting the strain sensitivity tool.
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Typical Exam Protocol

5-96

NOTE:

1. Press Elasto at the console to activate.

2. Adjust the position of the ROI to place the suspicious area at
the center.

3. Adjust the size to include surrounding tissue.

4. Instruct the patient that during the exam they can mostly
breathe normally. However, advise the patient that they will
need to suspend their breathing mid breath so that you can
obtain an optimum image while performing the scan.

5. Start the acquisition.

6. Freeze the image when desired frame is obtained. Using the
trackball or "frame by frame" knob, select a frame on a
plateau of the quality graph or when consistent frames with
green bars are visualized.

7. Perform the measurement. The system prompts you
through the measurement.

To configure Strain Elastography settings, select Utility-->
Imaging--> ELASTO.

LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2



Strain Elastography

Measurements

A/B Ratio
1. Press Measure.
2. Select A/B Ratio measurement and type Area.
3. Draw the first measurement at the elastography image and
the second at the reference B-mode image.

NOTE: The two drawing areas should be placed at the borders of the
lesion (B-Mode) and at the color pattern borders of the
elastogram (Elastography image).
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Measurements (continued)

E-Ratio

2D Measurement. Measures the elasticity index of a single ROI
and calculates the ratio between two ROls. You can label two
different regions. You can also set the ROl on a reference
screen (B mode) with dual screen.

Figure 5-14. 2D Measurements

1. Press Measure.
2. Select E-Ratio measurement and type Circle or Area.

3. Draw the first measurement at the reference tissue and the
second at the lesion of interest. This measurement results in
the calculation of the ratio of the E-Indexes of the two areas
(reference and lesion).

NOTE: These two areas should be approximately at the same depth
(side-by-side position) and size.

NOTE: The value represents how many times stiffer the lesion is
comparing to the reference tissue. If E-Ratio is less than 1, the
lesion is softer than the reference tissue.
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Measurements (continued)

E-Index

NOTE:

Definition. Elasticity index (E) is defined as the value from 0.0
to 6.0. This index shows the color distribution within the
measured circle (ROI) relative to the whole ROI box. A higher
value means “higher stiffness” and “blue color is dominant”.

Elasto Raw Data has two data sets of index and color for each
pixel. Therefore, this index is not affected by the color
appearance change (color map and hard/soft compression).
Index detects smaller strain difference of hard region by a
assigning wider dynamic range for a smaller strain.

1. Press Measure.

2. Select Elasto measurement.

3. Draw the circle at the lesion of interest either on the
elastogram or the B-Mode image. This measurement gives
an absolute value between 0 (softest) and 6 (hardest).

The circle should be placed at the borders of the lesion
(B-Mode) or at the color pattern borders of the elastogram
(Elastography image).
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Measurements (continued)

Table 5-12:  Elastography Index / Raw Strain Graph

Elasticity index Color Mapping
A A A A
: * -
(E=0to 1)
0.5 Soft
v
Hard o E=1 | | Center Color
(E=1 10 6) -F
3
Hard
E=5
N = ¥
Hard average Soft
Raw Strain (input)
a. Compression Curve is given by Soft/Hard compress key
b. Unique Line (not changed by user)
c. Signal is much compressed for color score/appearance
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Strain Elastography

Strain Elastography Quick Card

Strain Elastography Basics

Table 5-13:

Strain Elastography

Graphic

Description

Manual Compression:
1. Press “Elasto” button at the console to
activate.

2. Select Strain on Touch panel.

3. Adjust the position of the ROI to place the
suspicious area at the center.

4. Adjust the size to include surrounding tissue

(ROI's size = x3 dimension of the lesion per
axis).

Manual compression depends on the type of

probe.

1. Linear probes: Perform slight compressions
keeping transducer perpendicular to the skin.
Duration: 5 sec or 10 compressions.

2. Convex probes: Turn the patient on his left side
more than 90 deg. Pressing with the probe
above the lesion, allowing the heart and lungs
to create the compressions.

3. Endocavitary probes: Perform soft, angular

movement in plane of the probe. Duration: 5
sec or 10 compressions.

Note 1: Any very soft (vessel, cyst, air) or very stiff
(bone) tissue above the lesion or the reference
area may cause interference with the
compressions. You may want to attempt from a
different view.

Note 2: Keep the lesion within the image and watch
the quality graph for consistent high nearly flat
(plateau-like) peaks.

Select the frame to analyze

1. Press “Freeze.”

Using the trackball or “frame by frame” knob, select
a frame on a plateau of the quality graph (Image 1,
A) or when consistent frames with green bars are
visualized (Image 1, B).

2.

Image 1: Elastography image with quality graph (A),
quality bar (B) and elasto color bar (C).

The relation between elastogram colors and area’s
stiffness is given at the elastography color bar (Image
1, C).

Less Stiff

Stiffer
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Strain Elastography Basics (continued)

Table 5-14:  Clinical Applications

Application Compare the suspicious lesion with: Probe

Breast A fatty area in the breast or the average rounding * ML6-15-RS
breast tissue. * 12L-RS

* L4-12t-RS
* L6-12-RS
+L3-12-RS
*9L-RS

Thyroid A normal area in the parenchyma of the gland. * ML6-15-RS
* 12L-RS

* L4-12t-RS
* L6-12-RS
+L3-12-RS
*9L-RS

MSK A normal area in the same part of the body. * ML6-15-RS
* 12L-RS

* L4-12t-RS
* L6-12-RS
+L3-12-RS
*9L-RS

Liver A normal area in the parenchyma of the liver. *9L-RS
* C1-5-RS
* C1-6-D

Prostate A normal area in the parenchyma of the prostate. * E8Cs-RS
* BE9CS-RS
* IC9-RS

Uterus A normal area in the parenchyma of the uterus. * E8Cs-RS
+|IC9-RS
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Strain Elastography Basics (continued)

Table 5-15:  Strain Elastography Adjustments
Tool Definition Clinical Use
Frequency (1) Range depends on probe. Adjust the frequency depending on the suspicious
lesion’s depth. Lower frequency enhances sensitivity
of the elastogram.
Scale (2) Defines the elasto sensitivity | Adjust the scale depending on user’s compression

to the manual compression
speed.

speed. Perform two compressions per second (scale
value between 0.1-0.18). For different speed,
decrease the scale for slower technique and increase
for faster. Additionally, deeper lesions demand harder
and slower compression, decrease for this case.

Frame Average

3

Temporal filter to enhance
the smoothness of the elasto
colors appearance.

Adjust the frame average inversely to scale.
Decrease when scale is increased and increase
when scale is decreased.

Frame Reject (4)

Defines the level of quality
bar that frames are rejected.

Adjust the frame reject especially in Abdominal
scanning (A weak signal is most often seen in ABD
scanning when compressions are controlled by the
internal body movement). Decrease frame reject to
acquire an elastogram with lower than max quality at
the quality bar but still a good elastogram.

Map (5)

Defines the relation between
elasto color and tissue
stiffness.

Adjust the Elasto map to provide a different
visualization of the elastogram colors. Set to E3-E4 in
order to have more redblue color levels instead of
green (it is hard to recognize the small difference
between many green tones). These maps are
separating the elastogram color bar in three equal
parts (redgreen-blue). Additionally, use E-Invert to
invert the color indication for soft and hard tissue
(red-hard, blue-soft).

Transparency

Defines the transparency of
the overlaid elastogram in
relation to B-mode.
Controlled by CF gain.

Adjust the transparency to change the appearance of
the elastogram. Decrease transparency in order to
create an elastogram with more vivid colors.

LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2

5-103




Optimizing the Image

Strain Elastography Basics (continued)

Table 5-16:

Strain Elastography Measure

A/B Ratio*

* Press “measure.”

« Select “A/B Ratio” measurement and type “Area.”

* Draw the first measurement at the elastography
image (right) and the second at the refernce
B-mode image (left).

TIP: The two drawing areas should be placed at the
borders of the lesion (B-Mode) and at the color
pattern borders of the elastogram (Elastography
image).

E-Index*

* Press “measure.”

« Select “Elasto” measurement.

» Draw the circle at the lesion of interest either on
the elastogram or the B-Mode image. This
measurement gives an absolute value between 0
(softest) and 6 (hardest).

TIP: The circle should be placed at the borders of
the lesion (B-Mode) or at the color pattern borders
of the elastogram (Elastography image).

E-Ratio*

* Press “measure.”

« Select “E-Ratio” measurement and type “Circle or
“Area.”

» Draw the first measurement at the reference tissue
and the second at the lesion of interest. This
measurement results in the calculation of the ratio
of the E-Indexes of the two areas (reference and
lesion).

TIP: These two areas should be approximately at
the same depth (side-by-side position) and size.

Note: The value represents how many times stiffer
the lesion is comparing to the reference tissue. If
E-Ratio is less than 1, the lesion is softer than the
reference tissue.

* Not for sale in the United States. Not cleared for use by the United States FDA.
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Strain Elastography

Strain Elastography Basics (continued)

Table 5-17:  Strain Elastography Measure Cine or Mulit-frame measurements

QAnalysis

Acquire a cine loop (10 compressions or 5 sec)

Press “QAnalysis” at the cine tab at the touch

panel..

3. Push Run/Stop at the touch panel.

4. Select a frame that the full size of the lesion is
visualized.

5. Select to draw either areas or circles at the left
bottom of the screen (Image, 1).

6. Draw the ROI first at the reference tissue and

then at the lesion (like E-Ratio measurement).

N =

Note: The two graphs represent the value of E-index
of each frame. The exact value of E-Index for the
selected frame (red line, image, 2) is indicated at the
right, top side of the screen (Image, 3).

7. Press “Ratio” on the touch panel. The graphs
represents the E-Ratio value of each frame.

Note: The exact value of E-Ratio for the selected
frame (red line, Image, 2) is indicated at the right,
top side of the screen (Image, 4).

TIP: The maximum number of ROIs is up to 8, one
for the reference tissue and 7 for lesions.
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f CAUTION

Overview

5-106

Shear Wave Elastography

Use Shear Wave Elastography as a complement to other
techniques when making a diagnostic decision.

Shear wave elastography on the LOGIQ P8/P9/P10 is an
ultrasound imaging mode in which shear waves are generated
in-vivo acoustically via the imaging ultrasound transducer. The
motion of the shear waves is then tracked using ultrasound to
determine their velocity of propagation, which is a quantifiable
indicator of the mechanical properties of the tissue through
which it traveled.

The steps associated with performing this analysis on the
LOGIQ P8/P9/P10 include;

1. Correctly placing a user-specific region of interest (ROI)
over the anatomy of interest.

2. The user activates the shear wave analysis mode where the
shear wave generation and tracking occurs.

3. After acquiring the data, the user either stores the image or
analyzes it via measurement tools which can produce shear
wave velocity or stiffness statistics of areas within the ROI.
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Overview (continued)

Figure 5-15. Shear wave Probe Characteristics

1. Excitation and imaging transducer
2. Tissue
3. Propagating Wave
4. Focus
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Intended Uses

Shear wave elastography Intended Uses are:

e« Abdomen
 Small Parts
*  Musculoskeletal

* Urology
+ Gyn

CAUTION Shear wave elastography IS NOT intended for use for
Obstetrical exams.

Figure 5-16. Shear Wave Elastography Mode
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Configuring Shear Wave

To configure Shear Wave parameters, you need to adjust the
following Utility pages:

Imaging Parameters

ELASTO Imaging Parameters (Utility -> Imaging -> Elasto)
General Imaging Parameters (Utility -> Imaging -> General)
System Imaging Parameters (Utility -> System -> System
Imaging)

Measurement Parameters (Utility -> Measure ->

Advanced -> for Abdomen, Small Parts, Urology and Gyn)

To configure Shear Wave Elastography settings, select Utility-->
Imaging--> ELASTO.

Acoustic Output (%)

Transparency — The transparency of the shear wave image
overlay

Gain — Gain, as can be manipulated by the CF knob
Width — ROI Width (values vary by probe)

Vertical Size (cm) — ROI Vertical Height (values vary by
probe)

Center Depth (cm) — ROI Center Depth (values vary by
probe)

Color Map - Select shear wave (SW) Maps plus other
ELASTO (E) Maps.

Quality - Check to enable Quality function on touch panel.

Quality Map - Select shear wave Quality Maps (SWQO or
SWQ1)

Enter ELASTO DualView by Default — Check to select
entering shear wave in DualView.
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Imaging Parameters (continued)

Shear wave Color Bars:

Elluu Smﬂl“u

Figure 5-17. Shear wave maps

The illustration shows the color maps for kiloPascals and
velocity (meters per second). The images look the same,
regardless of the unit (m/s or kPa). You can preset which color
on the map represents stiffness (Red as Hard or Blue as Hard).

General Imaging Parameters by Application/Probe/Feature

Select the Default Elasto Mode via Utility--> Imaging--> General.

You can specify shear wave to be the default setting by
application by probe.

1. To specify a default probe per application, select Utility -->
Imaging --> General.

2. Select the application.

3. Select the default probe from the pull-down menu.

4. Specify the Default Elasto setting:

e Shear
e Strain

5-110 LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2



Shear Wave Elastography

System Imaging Parameters

You can set the shear wave Display Units and specify which
color on the shear wave map represents stiffness on the
Utility--> System--> System Display page.

Set the Shear Elasto Display Units to either of the following
settings:

* m/s (meters per second)
+ kPa (kiloPascals)
Specify which color on the shear wave map represents stiffness:

* Red as Hard
* Blue as Hard
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Measurement Parameters

5-112

On the Utility--> Measure--> Advanced--> Abdominal page, set
the following:

Auto Shear Measure Fixed Size - Sets to ON to move the
shear wave measurement circle with keeping the fixed size.

Auto Shear Measure Size — Sets the Default Diameter size
of the shear wave measurement circle

Shear Calculation Method — Specify Mean (Mean averages
all of the shear wave points within the measurement circle)
or Median (Median sorts, then selects the middle point of all
points within the measurement circle)

Shear Units Determine Folder — When On is specified, the
unit specified pre-selects the measurement folder. If m/s is
specified as the unit, then the Velocity folder is used; if kPa
is specified as the unit, then the Stiffness folder is used

On the Utility--> Measure--> Advanced--> Small Parts page,
specify the Calculation Method (Mean/Median).

Auto Shear Measure Size - Sets the Default Diameter size
of the shear wave measurement circle.

Auto Shear Measure Fixed Size - Sets to ON to move the
shear wave measurement circle with keeping the fixed size.

Shear Calculation Method — Specify Mean (Mean averages
all of the shear wave points within the measurement circle)
or Median (Median sorts, then selects the middle point of all
points within the measurement circle)
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Shear Wave Elastography

Activating Shear Wave

4.

To activate shear wave, press ELASTO.

To position and size the shear wave ROI, adjust the top
Trackball control.

To Start or return to Pre-Mode shear wave, touch the
right-most Trackball control.

To perform measurements, activate the Measure control.

ELASTO -- When you activate ELASTO, the default Elasto
Mode appears on the display and Touch Panel. In this example,
shear wave was preset as the default Elastography Mode.
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Shear Wave Display

Shear wave displays as follows while performing a
measurement:

Figure 5-18. Shear wave Display with Measurement

1. Measurement Window 6. Imaging Parameters
Always display in Abdomen measurement. « E = Elastography, Shear Wave
2. Shear wave Map * Gn = Gain
3. Measurement(s) » T = Transparency
4. Shear wave ROI » SVD = Sample Volume Depth
5. Trackball Controls * AO% = Acoustic Output Percentage

*» f50-200Hz = Shear Wave Vibration Frequency --
Displays the normal and image frequency range.
» Gen = General.
“Gen” appears when viewing an image where
general settings were applied.
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Shear Wave Quality Indicator

The Shear Wave Quality Indicator displays the reliabiliy of the
Shear Wave Image. A Quality value is computed for every pixel
of the Shear Wave image and displayed as an image in a
color-coded ROI. Locations with higher quality values have
more reliable Shear Wave data.

To View the Shear Wave Quality Image

The Quality Image can only be displayed in Dual Mode. It can be
turned on and off using the Quality button on the Shear Elasto
page on the touch panel.

Figure 5-19. Quality Image Button

NOTE: You must be in Elasto Dual Mode to select the Quality button.
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To View the Shear Wave Quality Image (continued)

When the Quality Image display is turned on, the Quality Image
is displayed on the left and the Shear Elasto image on the right.

Figure 5-20. Shear Wave Display with Quality Image Enabled

Color Bar for Quality Image

Quality Image

The Color Bar on the left of the Quality Image shows the quality
value corresponding to the colors in the Quality Image. Low
qualiy is indicated by the colors at the bottom of the bar, and
high quality by colors at the top.

Quality Map
There are two Quality Maps available to choose from on the
Shear Elasto screen (under Quality Map), each with a specific
color range:
+  SWAQO - Black/red/orange/yellow/white (low to high qualiy)
+  SWQ1 - Red/orange/yellow/green (low to high quality)
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Shear Wave Touch Panel

Figure 5-21. Shear wave ELASTO Touch Panel

Table 5-18: Shear Wave Elastography Touch Panel Parameters

Preset Parameter Description
Strain Elasto Toggle touch key between Strain and shear wave elastography.
Measurement Bias Press to bring up measurement bias information. See ‘Measurement Bias
Information Information Table’ on page 5-119 .
Phantom Press the phantom button to get good performance when measuring stiff,

motion-free phantoms. The 049A phantom is recommended. For more
information, refer to CIRS website at http://www.cirsinc.com/products/all/74/
elasticity-ga-phantoms/?details=specs .

Map Shear wave Color Map.

Auto Measurement Only available in Abdomen measurement.

Off, Single or Multi

Single: When 1 frame of SWE acquisition is completed, the system freezes,
enters measure status, and the active measurement circle is placed
automatically.

Multi: After taking multi frame SWE acquisition, it1s possible to take
measurement without scrolling image.

Power Output The acoustic output of the shear wave.
Range Min/Max Velocity, or Stiffness displayed.
Transparency The transparency of the shear wave image overlay.
Delete You can delete the selected ShearWave measurement.
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Table 5-18: Shear Wave Elastography Touch Panel Parameters

Preset Parameter Description
Quality Press the Qualiy button to open the Quality Indicator screen (while in Dual
Mode).
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Measurement Bias Information Table

The Measurement Bias Information table displays the bias and
precision percentage at different spatial resolutions (Bias/
Precision vs Object Size, in millimeters) and at incremental
depths (Bias/Precision vs Depth, in centimeters) for each shear
wave probe.

Table 5-19: Measurement Bias Information Tables

Measurement Bias Information Table for the L3-12-RS Probe (Stiffness on the left and Velocity on the right)

L3-12 Shear Wave Measurement Data L3-12 Shear Wave Measurement Data

Measurement Bias Information Table for the C1-5-RS Probe (Stiffness on the left and Velocity on the right)

C1-5 Shear Wave Measurement Data C1-5 Shear Wave Measurement Data

Measurement Bias Information Table for the 12L-RS Probe (Stiffness on the left and Velocity on the right)
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Table 5-19: Measurement Bias Information Tables

12L Shear Wave Measurement Data 12L Shear Wave Measurement Data

Measurement Bias Information Table for the C1-6-D Probe (Stiffness on the left and Velocity on the right)

ement Data

Measurement Bias Information Table for the IC9-RS Probe (Stiffness on the left and Velocity on the right)
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Table 5-19: Measurement Bias Information Tables

IC9 Shear Wave Measurement Data IC9 Shear Wave Measurement Data

B

Measurement Bias Information Table for the ML6-15 Probe (Stiffness on the left and Velocity on the right)

Speed Ranges and Accuracy are shown at the top of the Bias/
Precision vs Object Size tables.
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Using Shear Wave (SWE)

NOTE:

There are three shear wave states:

Pre-shear wave acquisition

Pre-shear wave acquisition is an intermediate mode
between B-mode and shear wave acquisition. During
Pre-mode, the previous B-mode imaging mode is still active.

You cannot store images in Pre-Mode.

Shear wave acquisition

Pressing the “Start" set key initiates SWE acquisition.
Post-shear wave acquisition (Freeze)

The system displays the acquired SWE image and
background B-mode image. The User can cycle through the

acquired frames, perform measurements, and annotate the
image.

SWE images can be stored in both raw data and DICOM format.

Pre-Shear wave Mode

5-122

Shear wave Acquisition Post-Shear wave
Acquisition
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Typical Exam Protocol (Liver)

A recommended shear wave elastography protocol to scan the
liver is,

1.

NOTE:

9.

Image the right lobe of the liver intercostally in Pre-shear
wave Mode.

Position and size the ROI.

The smaller the ROI, the faster the Frame Rate.

Instruct the patient that during the exam they can mostly
breathe normally. However, advise the patient that they will
need to suspend their breathing mid breath so that you can
obtain an optimum image while performing the scan.

Adjust ROI as needed, avoiding vessels and fluid-filled
structures. It is advisable to avoid rib shadows whenever
possible.

Start the shear wave acquisition.
Freeze the image when desired frame is obtained.

Perform the measurement. The system prompts you
through the measurement.

The system will auto sequence the measurements and walk
you through all of the measurements (Abdominal
Application Preset), if preset.

For Breast measurements, users typically take single
measurement to measure the lesion once. Or, users can
perform a ratio of two different tissues (one of the lesion and
non-lesion tissue).

Repeat steps 3 through 9 for the remaining samples.

10. Typically, users obtain ten (10) samples.
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Typical Exam Protocol (Liver) (continued)

11. Once measurements are complete, you can elect to add
another site to the exam. To add another site, press Add
Site on the Touch Panel. Select Enter Site Name to add the
name for the new site.

Stiffness
Velocity

@ Worksheet @ Summary Return

Delete Site

Figure 5-22. Add Additional Shear Wave Site and Enter Site
Name

NOTE: If you no longer need the added site, you can select to
delete the site via Delete Site on the Touch Panel.

12. Once measurements for all sites are complete, select
Summary on the Touch Panel to view saved measurements.

CAUTION Excessive manual compression of the underlying tissue with
the probe can lead to biased shear wave measurements.
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How to use “Auto”

Only available in Abdominal application.

Single 1. Select Single for Auto.

2. Freeze the image when desired frame is obtained.

3. The system enters the measure status and the active
measurement circle is placed automatically.

4. Position and size the ROI manually.

5. Press any of the print button.

* The measurement result is fixed.
*  Print action is performed with each Print button setting.
*  The system unfreezes automatically.
6. Repeat steps 2 through 5 for the remaining samples.
Multi 1. Select Multi for Auto.

2. After taking multi frame SWE acquisition, the system
displays the first frame and starts SWE measurement
automatically.

3. Fix the first measurement. The system displays next frame
automatically.

4. Continue the measurement for the remaining samples
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Shear Wave Measurements

The higher the velocity, the stiffer the tissue.

Types of shear wave measurements

5-126

NOTE:

There are two types of measurement units for quantifying
stiffness:

* Velocity (meters per second)
+ Stiffness (kiloPascals)

Measurement used to quantify stiffness: Shear wave imaging
measures the velocity of shear waves generated by acoustic
radiation force impulse in tissue. The velocity, in units of meters
per second (m/s), can be converted to Young’s Modulus
(stiffness), in units of kiloPascals (kPa), under simplifying
assumptions. Velocity or stiffness can be used to quantify the
local tissue elasticity.

Acoustic radiation force is generated by a transfer of momentum
from an acoustic wave to the medium through which it is
propagating, caused by absorption and scattering in soft tissue.
Impulsive application of focused acoustic beams in tissue can
generate shear waves which propagate away from the focal
region of the beam.
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Types of shear wave measurements (continued)

Transducer

g e — Acoustic wave
o
l Shear wave
, i
x
©
Track
generated
! shear waves
Apply high-intensity
ultrasonic pulse to
push on tissue
CAUTION Tissue inhomogeneities and other factors may bias shear wave
measurements.
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Measurement Analysis

To take shear wave measurements, typically users get ten (10)
samples.

1. After you have acquired the desired image, avoiding vessels
and fluid-filled structures, press Freeze.

2. Press Measure. Select the measurement (Stiffness or
Velocity) unless preset to “Shear Units Determine Folder” is
turned on.

NOTE: This step only needs to be done in he Musculoskeletal and
Prostate Model and is not needed in Abdomen and Breast.

Figure 5-23. Shear wave Measurement Touch Panel (Finger)
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Measurement Analysis (continued)

3. Perform the measurement. The system prompts you
through the measurement.

a. Position the first caliper at the desired location on the
ROI. Place the first control point and press Set on the
Trackball control.

An ROI ellipse appears and a second caliper.

b. Adjust the size of the ROI. Adjust ellipse and place the
last control point.

NOTE: This step only needs to be done in the Breast Small Parts
Model unless you use the Auto Shear Measure Fixed Size
and is not needed in Abdomen.

4. Repeat the scan and measurement. The system will auto
sequence the measurements and walk you through all of the
measurements, if preset.

Figure 5-24. Measurement Auto Sequence (Velocity -
Abdomen)
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Measurement Analysis (continued)

Figure 5-25. Measurement Auto Sequence (Stiffness -
Abdomen)

5. Measurements are transferred to the Worksheet.

Figure 5-26. Shear wave Worksheet

NOTE: The measurements’ Median and Inter-Quartile Range (IQR) are
displayed by default on the display and on the Worksheet (see
red circled item in the figure above.) To also display the
measurements’ mean and standard deviation, go to Utility-->
Measure, select Stiffness or Velocity folder, and under
Available Folders and Measurements checkmark the E Mean

and E Std selections.
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Measurement Analysis (continued)

1.

You can re-calculate the sample in the middle of the auto
sequence.

For example;

Perform measurement of V1 -> V2 -> V3.

2. Press Clear to to deactivate the active measure circle of V4.
3. Select desisred folder you want recalculate on the Touch
Panel and perform measurement.
4. Press Set to fix the measurement result.
5. Measure V4 is activated automatically.
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Measurement Information
Shear wave Measurements and Accuracies:

Table 5-20: System Measurements and Accuracies

Limitations or

Measurement Units Useful Range Accuracy Conditions
Velocity m/s Shear wave ROI +10%, or 0.5 m/s, for SD less than or
the L3-12-RS and equal to 5% for

+15%, or 0.5 m/s, for multiple repeated
the C1-5-RS, C1-6-D, measurements
ML6-15-RS, 12L-RS, over the range of
IC9-RS, whichever is depths for which
greater overtherange | measurements

of depths for which can be made,
measurements can limited by shear
be made, limited by wave penetration.
shear wave
penetration.

Stiffness kPa Shear wave ROI +20%, or 0.75 kPa, SD less than or

for the L3-12-RS and equal to 10% for
30%, or 0.75 kPa, for multiple repeated
the C1-5-RS, C1-6-D, measurements
ML6-15-RS, 12L-RS, over the range of
IC9-RS, whicheveris | depths for which
greaterovertherange | measurements

of depths for which can be made,
measurements can limited by shear
be made, limited by wave penetration.
shear wave

penetration.

The formula for Stiffness: E = 3 * rho * ¢?
Where E = Young’s modulus of tissue

rho = density of tissue (assumed to be 1 g/cc)
¢ = shear wave speed in m/s

Note: The conversion from shear wave speed (m/s) to Young’s
modulus is done under the assumption that the underlying
material in which the shear wave propagates is linear, isotropic,
incompressible, and homogenous.

relative indices intended only for the purpose of comparison
with other measurements performed using the LOGIQ P8/P9/
P10. Absolute values for these measurements may vary
among different measurement devices.

f CAUTION The values for shear wave speed and tissue modulus are
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Scanning Hints

HINTS You may find the following recommendations helpful when

performing a Liver shear wave scan:

* Locate right lobe of liver intercostally.

* Place the ROI away from the capsule in an area free of
vessels and fluid-filled structures.

* Use a smaller ROI for faster Frame Rates

*  Suspend Patient breathing in mid-breath during the scan

» Position the ROI between 2-5 cm deep for an optimal shear
wave scan

You may find the following recommendations helpful when

performing a Breast shear wave scan:

* Locate lesion

» Place lesion in center of ROI, including a sufficient amount
of the surrounding tissue

*  Only compress slightly, if necessary (compression changes
the elastic tissue properties).

To increase frame rate:

* Reduce ROI Width

»  Turn off Penetration Mode

* Reduce Push Output

To increase penetration:

*  Turn on Penetration Mode

» Keep Push and Track Output at 100%

+ Place ROl away from edges of image

To reduce artifacts:

*  Minimize motion during acquisition

* Ensure there are no vessels within the ROI or near the left
or right edge of the ROI. It is advisable to avoid rib
shadows whenever possible.

* Keep ROI at least 1cm away from the liver capsule.
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Overview

ﬁ WARNING

Using 3D

DO NOT scan any pacemaker patient using the sensor device.
The magnetic fields emitted from the device may interfere with
the pacemaker operation.

Easy 3D is compatible with every 2D transducer using a
freehand acquisition to generate a volume dataset.

3D Volume datasets are allowing the navigation in the 3D cube
itself and providing access to the 3 different main planes - axial,
sagitta and coronal.

There are two 3D Packages:

Table 5-21: 3D Package Options

3D Type Description Sensor/No Sensor Available Tabs
Easy 3D Designed for rendering No sensor 3D Acquisition, Easy
B Mode and Color Flow 3D, Movie

Mode images, e.g.,
Baby Face scans.

Advanced 3D

Designed for rendering No sensor 3D Acquisition, Easy
B Mode and Color Flow 3D, Advanced 3D,
Mode images, e.g., Movie

vessel trees.

5-134
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3D Acquisition

Acquiring a 3D Scan

NOTE:

NOTE:

To acquire a 3D scan,

1.
2.
3.

Optimize the B-Mode image. Ensure even gel coverage.
Press the 3D/4D control panel key. Two screens appear.
Set appropriate values for Acq Mode and Scan Plane. Also,
set the scan distance before scanning.

* Acquisition mode

Sensorless Parallel is for all acquisitions done with the
linear probes and on regular shapes, where you can
move the probe parallel on the skin.

Sensorless Sweep is for the sweep acquisition using he
curved probe (i.e. intercostal liver scan or kidney).

* Scan Distance

The Scan Distance is an indicator for the size of the
Volume: Have you acquired longer distance than 6 cm,
increase the Scan distance. Have you acquired a
shorter distance than 6 cm, decrease the Scan
distance. For sweep acquisition 6 means a transducer
angulation of around 60 degree.

To start acquiring the image, press Start (left Trackball key).

To perform a parallel scan, scan evenly. To perform a sweep
(fan) scan, rock the probe once. Note the distance of the
scan.

The 3D volume of interest (VOI) is dynamically assembled
on the right side of the screen.

If the image stops before you’re done scanning, start
acquiring the 3D volume of interest again.

To complete the 3D scan, press End (right Trackball key).

You can also press Freeze, but then you need to also press
the 3D key to obtain the final render.
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Acquiring a 3D Scan (continued)

3D Notes

* Adjust the 3D dataset brightness with B-Mode or Color Flow
Mode Gain.

» Use Colorize to change the color of the active dataset.
* Use Zoom to increase the zoom factor of the active dataset.

» Vertical lines may be seen in a resliced image. This usually
happens when you scan too fast or if the scan distance is
set to a high value.

Scan more slowly, adjust the frame rate for a faster rate or
adjust the scan distance.

5-136 LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2



Using 3D

3D Acquisition Parameter Description

Table 5-22:

Front To Back

Figure 5-27. 3D Acquisition

3D Acquisition Description and Instructions for Use

3D Parameter

Description

App (Application) Presets

Selections: None, OB - Baby Face, Vascular, User 1, User 2, User 3

None. No application preset applied.

OB - Baby Face. After having scanned in this mode, certain rendering
parameters are set automatically. The gray surface mode is activated and the
texture mode is switched off. The gray surface mode values for opacity and
threshold are set automatically according to the datasets histogram.
Vascular. Available only with Advanced 3D package. After having scanned in
this mode, certain rendering parameters are set automatically. The color
image is rendered in the texture mode. The values for opacity and threshold
of the texture mode are set automatically according to the datasets
histogram. The B-Mode image is rendered in the gray surface mode. Opacity
and threshold values are defined according to the histogram.

Delete Active User Preset

Select to delete a user preset (User 1, User 2, or User 3).
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Table 5-22: 3D Acquisition Description and Instructions for Use (Continued)

3D Parameter

Description

Acquisition Mode

Selections: Sensorless Parallel, Sensorless Sweep

Sensorless Parallel. In this mode the probe must be moved during 3D data

acquisition without angling it. You should scan the object you want to render

in 2-4 seconds. The speed at which you scan should be constant. No sensor
is mounted on the probe.

+ Since the time for rendering depends on the acquired number of frames, it
is recommended that you check the frame rate. Low frame rates result in
fewer acquired frames for the 3D dataset which results in intensive
rendering (interpolation). Therefore, low frame rate = long render times.

Sensorless Sweep. In this mode the probe must be moved to a position

where you can clearly see a middle cut of the object you want to scan and

render. Tilt the probe to about 30 degrees until the object you want to scan
disappears. Start the acquisition and tilt the probe over a distance of around

60 degrees until the object disappears again. The entire scan time should be

around 2-4 seconds. During the sweep, the probe may not be moved parallel,

just tilted. No sensor is mounted on the probe.

Before starting an acquisition, take care that the transmitter is positioned

correctly during data acquisition and that the transmitter cannot move.

Scan Plane

Selections: Front to Back, Side to Side

Front to Back. After having scanned in this mode, the rendered dataset is
shown in a frontal view. For acquiring a fetal face in sagittal cuts, use this
mode.

Side to Side. After having scanned in this mode, the rendered dataset is
shown from a side view. For acquiring a fetal face in coronal cuts, use this
mode.

Display Format

50/50. Display in Dual Image (2D and 3D).
Only 2D. Display in Single Image.

3D

Starts the rendering process.

Scan Distance

Adjusts the distance covered during the scan. Depending on the real width of
a scan acquired during a 3D acquisition, the volume of interest’s width can be
enlarged or reduced. You can adjust the shape of a fetal face if the baby’s
head looks oval instead of round. The assumed default width of a parallel
scan is 6 cm; or 60 degrees for a sweep scan.

NOTE:

NOTE:

NOTE:

NOTE:

5-138

The selection of user presets is effective only while 3D mode is
active. Exiting 3D mode and activating 3D mode again resets
the 3D presets to the default setting, regardless if Patient or
application changes.

Changing the tab between [Easy] and [Adv3D] changes some
parameters that are not common between those tabs.

When a 3D image is recalled, no 3D presets are active and
parameters are recalled from the image file.

Default Scan Distance, Opacity and Threshold may not be
consistent and may change per scan. After the User Preset is
saved and recalled, Opacity and Threshold are consistent.
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Manipulating the Volume of Interest

Imagine you are able to manipulate the 3D volume of interest
(VOI) in your hand. The 3D VOI is a tangible anatomical object
that you can see and manipulate easily using the Trackball and
Set control panel keys.

Practice positioning the pointer at different places within the 3D
VOI. Highlight different colors (white, red, yellow, or green).
Press Set to select a VOI for manipulation. Use the hand to
manipulate the 3D VOI.

Rotating the 3D VOI Left/Right or Forward/Backward

You can rotate it left to right or right to left. You can rotate it
forward/backward. Press right Set key when the white pointer
finger is positioned on the white box. Move the closed white
hand to manipulate the 3D VOI.

Figure 5-28. Manipulating the 3D Volume of Interest (White
Hand)
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Moving Through the 3D VOI

You can move through the 3D VOI using the red hand. Press
Set when the red pointer finger is positioned on the red box.
Move the closed red hand to move through the 3D VOI.

NOTE:  Any plane in the volume can be made active (highlighted with
red box) by clicking on it.

Figure 5-29. Moving through a 3D Volume of Interest (Red
Hand)
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Viewing Specific Portions of the Anatomy

You can pull back tissue to view specific portions of anatomy
using the yellow hand. Press Set when the yellow pointer finger
is positioned on the yellow box. Move the closed yellow hand to
manipulate the 3D VOI.

NOTE: This actually moves an edge. A yellow hand appears only when
the pointer is on an edge of the VOI.

Figure 5-30. Manipulating the Edge of a 3D Volume of Interest
(Yellow Hand)
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Pulling Back a Corner of the VOI to View Specific Anatomy

You can pull back a corner to view specific portions of anatomy
using the green hand. Press Set when the green pointer finger is
positioned on the green box. Move the closed green hand to
manipulate the 3D VOI.

Figure 5-31. Manipulating a Corner of the 3D Volume of
Interest (Green Hand)
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Easy 3D

Grey Surface

Figure 5-32. Easy 3D

Descriptions and instructions for using Easy 3D follow:

Table 5-23: Easy 3D Description and Instructions for Use

3D Parameter Description

Reset Resets the 3D volume of interest back to its original orientation.

Utilities Select Average Off, Average Light, Average Medium, or Average Strong.

Auto Movie Initializes the calculation and display of a 3D movie. A rotation of 30 degrees
left and right around the actual image position (either the default position
after acquisition or the position that was manually defined by manipulating
the 3D volume of interest) is shown. For this 60 degree rotation, eleven
images in steps of 6 degrees are calculated.

Save Preset Save as a user preset (User 1, 2, or 3).

Undo Undoes any manipulation you have done to your 3D dataset.

Scalpel Structures, for example a part of the placenta hiding the view to a fetal face,
can be cut out in a rendered image. All visible structures can be cut out.
The option of ‘erase inside’ deletes all structures inside the marked region.
The option of ‘erase outside’ deletes all structures outside the marked region.
The region in the rendered image is marked with the right Set key. To define
the contour of the region, press the right Set key for each vertex. To close the
contour, double click the right Set key. As long as a contour is not closed, it
can be traced back with the left Set key. The cut out process can be undone
by the Undo Last function.

As soon as the Apply button is pressed, a new dataset is generated.
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Table 5-23: Easy 3D Description and Instructions for Use (Continued)

3D Parameter

Description

Gray Surface

Activates the gray surface rendering mode. It leads to a transparent
appearance of the object, generated by displaying only a surrounding shell of
structures.

Texture

Activates the texture or photorealistic rendering mode. It creates a
photorealistic appearance of the object. The shading depends on the
orientation of the surface of the object.

If both Texture and Gray Surface mode are switched on, the mixture
percentage of both modes can be defined.

Render

Changes between the rendered image view and the view of a volume of
interest. The volume of interest shows the acquired ultrasound images
transformed into an isotropic rectangular coordinate system. The volume of
interest can be manipulated as described above.

Orientation Marker

You can now specify/define, then add the following orientation markers while
in 3D via the Orientation Marker key:
* TRV Sup to Inf
Ant Scan
Prb Rt
* Ant Scan
* Prb Rt
* TRV Inf to Sup
Ant Scan
Prb Rt
* Ant Scan
* Prb Rt
* SAG Lt to Rt
Ant Scan
Prb Sup
* Ant Scan
* Prb Sup
* SAG Rt to Lft
Ant Scan
Prb Sup
* Ant Scan
» Arb Sup
* Defined
* Superior
* Inferior
* Left
* Right
* Anterior
* Posterior
 Cancel
* None

Threshold/Opacity

Threshold defines which gray values are used for rendering and which are
considered noise. Opacity defines how strict Threshold is used for
discrimination. A low opacity value creates a firmer appearance of the
surface. A high opacity value leads to a transparent appearance of the
rendered image.
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Table 5-23: Easy 3D Description and Instructions for Use (Continued)

3D Parameter Description

Scan Distance Adjusts the distance covered during the scan. Depending on the real width of
a scan acquired during a sensorless 3D acquisition, the volume of interest’s
width can be enlarged or reduced. You can adapt the form of a fetal face if
the baby’s head looks oval instead of round. The assumed default width of a
parallel scan is 6 cm; or a fan scan 60 degrees.

Colorize/Contrast Colorizes the 3D render or adds contrast to the 3D rendered image.
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Advanced 3D

Figure 5-33. Advanced 3D

Descriptions and instructions for using Advanced 3D follow:

Table 5-24:  Advanced 3D Description and Instructions for Use
3D Parameter Description
Reset Resets the 3D volume of interest back to its original orientation.
Utilities Use smoothed volume for rending the 3D volume.
Strong = Most Smoothing.
Auto Movie Initializes the calculation and display of a 3D movie. A rotation of 30 degrees

left and right around the actual image position (either the default position
after acquisition or the position that was manually defined by manipulating
the 3D volume of interest) is shown. For this 60 degree rotation, eleven
images in steps of 6 degrees are calculated.

Save Preset

Save as a user preset (User 1, 2, or 3).

Undo

Undoes any manipulation you have done to your 3D dataset.

Tile

The display can be divided into 1, 2, 4, or 6 windows. Switching to a lower
number of windows keeps the images from left to right.

3D Landscape

Shows a combination of 2D slices and a 3D rendered image. After a color
acquisition you can combine the 2D B-Mode image slices with a 3D rendered
color image. This mode allows stepping through the B-Mode images along a
vessel structure.

The 2D slice can be moved with the right Set key. The Trackball symbol has
to be positioned inside the 2D plane.
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Table 5-24: Advanced 3D Description and Instructions for Use (Continued)

3D Parameter Description

Scalpel Structures, for example a part of the placenta hiding the view to a fetal face,
can be cut out in a rendered image. All visible structures can be cut out.
The option of ‘erase inside’ deletes all structures inside the marked region.
The option of ‘erase outside’ deletes all structures outside the marked region.
The region in the rendered image is marked with the right Set key. To define
the contour of the region, press the right Set key for each vertex. To close the
contour, double click the right Set key. As long as a contour is not closed, it
can be traced back with the left Set key. The cut out process can be undone
by the Undo Last function.

As soon as the Apply button is pressed, a new dataset is generated.

Active Data Manipulations of rendering parameters only have an effect on the data
defined as Active Data. After having selected Active Data, a list of data is
displayed, Gray Data or Inversion. Choose the data to be manipulated.
Active Data is only available when you select both Inversion and Gray Data in
Visible Data.

NOTE: Inversion Mode is only available for Black-and-White mode.

Visible Data After selecting Visible Data, a list of data is displayed, Gray Data or Inversion.
Choose the data you want to display. For example, if only Inversion is
chosen, the B-Mode image is switched off in the rendered image and only
inversion mode is displayed.

Define Axis For certain display and measurement modes (Angular Plane Mode, Angular
Volume Measurement Mode), an axis in the volume of interest is required. To
define the axis, set the start point by using the Trackball to position one end
of the axis and pressing the right Set key, then positioning the other end of
the axis and pressing the right Set key.
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Table 5-24: Advanced 3D Description and Instructions for Use (Continued)

3D Parameter

Description

Group Planes

Selections: Off, Main, Parallel, Angular

Off. A VOI or a rendered image is displayed. The Render button changes
between the rendered image view and the view of the VOI. The VOI shows
the acquired Ultrasound images transformed into an isotropic rectangular
coordinate system.

Main. Three orthogonal cuts (with colored frames) of the acquired VOI are
displayed after pressing Main. The VOI shows the acquired ultrasound
images transformed into an isotropic rectangular coordinate system.

On the left top of the image a complete VOl is displayed. It shows the position
of the three orthogonal planes in the VOI. A green point displayed in each
plane defines the point of intersection of the three planes. This point can be
set to different positions in the planes by double clicking the right Set key. A
plane can be moved parallel in the VOI by pressing the right Set key on the
position of the green point and moving the Trackball up and down inside the
plane.

Parallel. In this mode all displayed VOls get the orientation of the last
modified volume. Normally four VOls are displayed. It is possible to display
six VOlIs by increasing the number of displayed volumes in the Tile area.
Between the first and the last VOI, the selected planes are parallel and
equidistant. A modification on the plane in one VOI results in a parallel
modification of the planes in all other VOls.

Angular. Before starting the Long Axis Rotation Mode, make sure that a long
axis has correctly been defined in the VOI (see Define Axis above). The
function starts in the long axis display mode. In the upper, left-hand corner a
short axis cut is shown which gives an overview of the orientation of the long
axis planes.

To move these planes, press and hold down the right Set key while moving
the Trackball.

Type 1/2

Defines the rendering modes. Selections: Gray Surface, Texture, Maximum
Intensity, Minimum Intensity, Average Intensity, and None. If both Type 1 and
Type 2 rendering modes are switched on, the mixture of both modes can be
defined.

Gray Surface. Activates the gray surface rendering mode. It leads to a
opaque appearance of the object, generated by displaying only a
surrounding shell of anatomical structures. Adjust Threshold and Opacity as
well.

Texture. Activates the texture of photorealistic rendering mode. It creates a
photorealistic appearance of the object. The shading depends on the
orientation of the surface of the object. Adjust Threshold and Opacity as well.
Maximum Intensity. Transparent appearance of the object. Generated by
displaying the maximum gray values in the VOI.

Minimum Intensity. The rendered image is generated by displaying the
lowest gray values in the VOI that exceed the defined threshold. Dark
anatomical structures, like cysts, can be shown in this mode.

Average Intensity. Transparent appearance of the object. Generated by a
summation of the gray values.

None for Type 2. No second rendering mode is used in addition to the Type
1 rendering mode.

Render

Changes between the rendered image view and the view of a volume of
interest. The volume of interest shows the acquired ultrasound images
transformed into an isotropic rectangular coordinate system. The volume of
interest can be manipulated as described above.
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Table 5-24: Advanced 3D Description and Instructions for Use (Continued)

3D Parameter Description

Reslice Selections: Cube, 2D Plane, and 2D Cubic Plane

Cube. The VOI shows the acquired ultrasound images transformed into an
isotropic rectangular coordinate system. This mode allows you to work
simultaneously with six cut planes.

Virtual Rescan. The marked cut planes under Reslice Cube (red border) is
displayed without any perspective distortions, e.g., parallel to the screen.
This allows you to move through the volume one slice at a time in any
direction.

Cubic Plane. Only one cut plane view is shown in a perspective displayed
VOI. The cut plane can be moved freely without any limitations.
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Optimizing the Image

Movie 3D

Figure 5-34. Movie 3D

Descriptions and instructions for using Movie 3D follow

Table 5-25: Movie 3D Descriptions and Instructions for Use

3D Parameter Description

Manual An animated rotation of the rendered image can be calculated and displayed by this
function. Using this function, you first need to define the start and end position of the
rotation. To define this, move the VOI to the start position, the press Define Start.
Move the VOI to the end position and press Define End.

Movie 360 The calculation and display of a complete rotation around the axis, defined by the

Degrees Axis button, starts in steps of 15 degrees.

Auto Movie Initializes the calculation and display of a 3D movie. A rotation of 30 degrees left and
right around the actual image position (either the default position after acquisition or
the position that was manually defined by manipulating the 3D volume of interest) is
shown. For this 60 degree rotation, eleven images in steps of 6 degrees are
calculated.

Axis All rotations (Auto Move and Movie 360) are calculated as rotations around the
specified axis (X, Y, or Z).

Movie Speed You can adjust the speed of any 3D rotation.

Pause Stops and restarts the rotation. As soon as Pause is pressed, the different rotation
steps can be displayed by moving the Trackball.
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Chapter 6

Scanning/Display Functions

Describes additional ways in which to adjust the image.
In addition, describes ways to get useful information
electronically.
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Scanning/Display Functions

Freezing an Image

Introduction
Freezing a real-time image stops all movement and allows you
to measure and print the image.

NOTE: While the image is frozen, all Power Output is suspended.

Freezing an image

To freeze an image,

1. Press Freeze. The Freeze key backlight turns green.

If you are in a mixed mode, both screen formats stop
immediately. Deactivating Freeze restarts both modes and
places a black bar on the trace to indicate the time discontinuity.

To reactivate the image,

1. Press Freeze again.
NOTE: Selecting a new probe unfreezes the image

NOTE:  Deactivating Freeze erases all measurements and calculations
from the display (but not from the worksheet).
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Using CINE

Introduction

CINE images are constantly being stored by the system and are
available for playback or manual review via CINE.

You can view CINE as a continuous loop via CINE Loop or
manually review CINE images frame by frame via the Trackball.

Data in CINE is available until new data is acquired. CINE is
stored on the system's memory and can be archived as well.

CINE is useful for focusing on images during a specific part of
the heart cycle or to view short segments of a scan session.

Cine gauge

Figure 6-1. Cine gauge

Loop speed
. Cine gauge
3. Current frame number/total frame number
The cine gauge indicates which frame you are viewing of the whole loop.
4. Current number of seconds/total number of seconds
The cine gauge indicates which frame you are viewing of the whole loop.
Start frame
6. End frame

N =

o
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Scanning/Display Functions

Touch Panel

The following Touch Panel appears:

Figure 6-2. Cine Touch Panel

Table 6-1:  Cine Touch Panel description

Parameter Description
Select All Select all frames of the cineloop.
Sync Mode Phase synchronizes multiple cineloops.
Num Cycles Control the number of heart cycles to be included in the cineloop.
First Move to the first frame of cineloop.
Last Move to the last frame of cineloop.
Run/Stop Start/Stop the cineloop review.
Loop Speed Adjust the cineloop playback speed.
Cycle Select Select the heart cycle to review.
Start Frame Rotate the rotary to select the start frame and push to set the frame.
End Frame Rotate the rotary to select the end frame and push to set the frame..

Frame by Frame

Review the cine image frame by frame manually.

Capture

Searches through all images between the start frame and end frame and
displays each peak or the highest velocity/tissue power.

Capture Recon.

Capture Recon. reconstructs small blood vessels in the cine mode.

6-4
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Using CINE

Table 6-1:  Cine Touch Panel description

Parameter Description

Enhancement Execute the enhancement to the Cine capture image. Select Off, Shade FW,
Shade Ry, Enhance1, Enhance2 or Enhance3.

Motion Correction Motion correction compensates each frame and cancels the motion.
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Using CINE

NOTE:

NOTE:

NOTE:

Preset the parameters as necessary.

1.
2.
3.

8.
9.

Press Freeze.
Move the Trackball to activate Cine.

Use the trackball or Frame by Frame to scroll through the
acquisition and find the sequence of interest.

Press Start Frame or End Frame to set the corresponding
cineloop boundary to the current frame as necessary.

Rotate Start Frame and End Frame to trim or expand the
cineloop boundaries.

Adjust Cycle Select to move from heart beat to heart beat
and select the heart cycle of interest.

Adjust Num cycles to select the number of heart beats to
play back.

Press Run/Stop to run the cineloop and then press the print
key to store the cineloop.

Cine loops stored on the clipboard are indicated with a
movie strip icon.

Press Run/Stop again to stop the cine loop.
Press Freeze to return to live scanning.

If you don'’t need edit, only press Run/Stop to run the cineloop
and print key to store.

Cineloop storage can be configured to store heart cycles with
additional time before and after the R-wave and to display a
preview before storage. Refer to ‘Print Controls’ on page 10-68 .

Adjust the cine loop speed

Rotate Loop Speed to set the speed of the cineloop playback.

The speed factor (%) is displayed above the cine gauge.

To view a cineloop frame by frame

6-6

In freeze, use the trackball or Frame by Frame to scroll through
the cineloop frame by frame.
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Synchronize cine loops

Recall stored cine loop to right side of dual screen.
Recall same cine loop to left side of dual screen.
Change visualization of left side image

Select Sync mode to start the synchronization.

el

NOTE: This is useful for Hybrid Contrast to display and check Contrast
and Hybrid Contrast for example.

Recalling a cine loop

To recall a cine loop, double click on the cine loop on the
clipboard.

NOTE: CINE Loops stored on the Clipboard are indicated with a movie
strip icon.

Cine Mode Selection

To scroll the B-Mode cine loop only, toggle the top Trackball key
and select Scroll B.

To scroll the Timeline cine loop only, toggle the top Trackball key
and select Scroll D.

Velocity Scale with B-Mode Only

If you review the B-Mode cine loop while in Doppler Mode with
the Timeline using Scroll B, the Velocity Scale displayed with the
Timeline is for the time phase of the currently-displayed B-Mode
image, NOT for the time phase of the acquired Doppler
Spectrum.

Check the velocity value with the measurement function if you
review the cine loop using Scroll B. Note that there may be a
discrepancy between the velocity scale displayed and the
velocity measured using the measurement function.
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Mark CINE

Preset

1. Check Enable Mark Cine Control via Utility ->
Application -> Print Controls.

Mark Cine

Enable Mark Cine Control ¥

Preview clips longer than..(s) 10

Figure 6-3. Mark Cine on Print Control

Table 6-2: Mark Cine

Preset Parameter

Description

Enable Mark Cine Control

Lets you mark where you want the CINE Loop to start (prospective CINE).

Preview Loop Longer
than...(s)

When selected, allows you to review cine loops before storage for loops

longer than selected time frame (in seconds).

How to use

NOTE:

NOTE:

6-8

2. Press Save.

1. Press Mark Cine to specify the starting point for loop storing
or cine review.

When you press Mark Cine, the current image frame is
noted as a start frame.

2. Press the appropriate print key while continuing to live scan
to store the cine loop.

Selecting Mark CINE when a Mark CINE already exists causes
the new Mark CINE to replace the previous one.

Changing modes or other actions that flush CINE memory
causes the Mark CINE to be removed and the image data will
not be saved.
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Preview

NOTE:

Background Store

Loop Preview can be enabled independently for Time-Based
Store, ECG-Based Store, and Mark CINE. This is useful for
setting preview preferences based on the application.

The Contrast Time Span setting overrides the Time Span when
in Contrast Mode.

Live Clips are stored in the background to allow you to continue
scanning. This works for both Raw Data and for DICOM Loops

(with Direct Store On or Off). Image Ordering is preserved with

Background Store.

The benefit of Background Store is that clips are stored with
minimal interruption to live scanning.

NOTE: Background Store IS NOT supported with V Nav, 4D, or with
previously-acquired CINE Loops.

NOTE: The system may stop acquisition while storing if CINE memory
is at least 80% full. Monitor CINE memory while storing CINE
loops to ensure continuous live scanning.

NOTE: DICOM loops take significantly longer to store. Storage time
may approach or exceed loop time. Allow extra space in CINE
memory when saving DICOM loops.

NOTE: The CINE gauge turns purple to indicate the section of CINE
memory that is being stored in the background.
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Image Storage Hints

HINTS Setup Tips

*  Print Button Setup is now Application specific. When you
access Application--> Print Controls, the current
Application is the default Application.

* To apply the same Print Control Settings for all
Applications, select All Applications as the preset on the
Print Controls Menu. Be sure to re-enter values if the field
is green.

*  Print button setup for the file format and destinations are
still configured via the Connectivity Menus.

Usage Tips

+ If you select Mark CINE, the next time you press Print
completes the Mark CINE Loop Store, independent of its
configuration.

+ The CINE gauge turns green when a Prospective CINE
Clip is pending.

*  You can cancel Prospective Store by pressing Freeze/
Unfreeze or by changing Modes.
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Cine Capture

Selecting Capture searches through all images between the
start frame and end frame and displays each peak or the highest
velocity/tissue power. Adjust the start frame and end frame
points to limit the image frames used in the process.

1.

Display the CINE loop which is in memory or recalled from
archive.

NOTE: Cine Capture applies only to 2D images (B, B Flow, CF, PDI,
Contrast, etc.).
NOTE: On 2D duplex modes (B/CF, B/PDI, etc.), Cine Capture is
not applied to the background B-Mode image, even if the
CF/PDI display is turned off.
2. Run the cineloop.
3. Select Capture on the Touch Panel to display the captured
image.
A character 'C' displays on the screen instead of the frame
average level.
4. If necessary, save the captured image.
5. Press Capture again to turn Cine Capture off.
NOTE: Cine Capture can be used on exported files by using the Save
As function. You can save the still image (jpeg) and cine loop
(avi) by using Save As.
NOTE: Cine Capture does not effect TIC Analysis.
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Capture Recon.

Description

Procedure

6-12

NOTE:

Capture Recon. reconstructs small blood vessels in the CINE
mode.

It is available in B-Flow, BFC, Coded Contrast, CF, PDI, and
B-Mode without CrossXBeam.

Capture Recon. shows smaller blood flow information than
conventional B-Flow image, which expected for the
characterization of tumor, chronic liver disease, vascular
abnormality, etc.

1.

Scan B-Flow mode in the ordinary way, except:

Sensitivity can be larger (20 (default) to 30 or more).

Acquire a short clip, then freeze.

+ Combination of Capture helps to imagine resulting
image.

+ 3-dimensional sweep may be efficient to visualize many
vessels.

Press Capture Recon on the CINE Touch Panel. Adjust

threshold as necessary.

The order of the frames is rearranged by order of smaller
artifact. The frame which has motion artifact is rejected.
Move the Trackball or assigned rotary to review the image
Frame by Frame.

While the Capture Recon, is activated, the color of CINE gauge
turns pink.
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Enhancement

Enhancement executes the enhancement process to cine
capture images.

1. Display the cine capture image using Capture.
NOTE: Enhancement applies only to Cine Capture images.

2. Select Enhancement. A character 'C' displays on the
screen instead of the frame average level.

Shade Fw/Shade Rv

Select Fw (Forward) that brings start frame or Rv
(Reverse) that brings last frame of cine to the front. The
system has two thresholds for the Shade process.
Comparison will be made frame by frame after the
thresholds have been met. If the two thresholds are
satisfied, no comparison will be made with the rest of
the frame.

Using ShadeFw/RYV, lower intensity echoes in the near
frame will be masked by higher intensity echoes in the
far frame. ShadeFw/Rv makes it possible to show lower
intensity echoes in the near frame despite the fact that
there may be a higher echo projection in the far frame.
Therefore, the anteroposterior position of the blood
vessel is clearly displayed.
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Scanning/Display Functions

Enhancement (continued)

Enhance1/Enhance2/Enhance3

The part corresponding to the data of the selected frame
is enhanced and superimposed on the entire cine
capture images. This allows you to visualize the spatial
relationships with the B-mode image and the flow
appearance.

Figure 6-4. Enhancement image example

3. If necessary, save the enhanced image.

NOTE: You can save the still image (JPEG) and cine loop (AVI) by
using Save As.
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Motion Correction

Understanding of the vascular structure is important, for
example, with liver cancer. Though, the captured image distorts
or blurs due to the patient’s breathing. Motion correction
compensates each frame and cancels the motion.

NOTE: Motion Correction is activated only for B, CHI, Contrast and
B-Flow.
1. Displays the cine capture image using Capture.
2. Select Motion Correction. The system generates the
captured image with motion correction.
The user can store the cine clip with the state of motion
correction kept in the raw data.

The user can store the still image as the single frame
DICOM image without the raw data.
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Zooming an Image

Introduction

Figure 6-5. Zoom - Example

Zoom Image

Reference Image: Reference image is the small un-zoomed image.
Zoom ROI: Zoom ROI indicates the region of the image to zoom.
Pos/Size: Use the top trackball key to change position and size of ROI.

LN

Two kinds of zoom exist: Pan Zoom and HD Zoom.

+ Pan Zoom magnifies the display of the data without making
any changes to the ultrasound image data acquired. The
entire image is acquired and the ROI can be moved or
resized.

+ HD Zoom only acquires the image data within the ROlI,
increasing density of the image in the ROIl. HD zoom can
only be performed during live scanning.
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Zooming an Image

Pan Zoom
To activate Pan zoom, rotate Zoom knob clockwise.
To deactivate Pan zoom, rotate Zoom knob counterclockwise
until entire image is displayed.
HD Zoom
To activate HD zoom, press Zoom knob and rotate it clockwise.
To exit HD zoom, press Zoom knob again.
Bioeffect
HD zooming an image changes the frame rate which tends to
change thermal indices. The position of the focal zones may
also change which may cause the peak intensity to occur at a
different location in the acoustic field. As a result, the Ml (TI)
may change.
$# Acoustic Observe the output display for possible effects.
— Output
~ Hazard
LOGIQ P8/P9/P10 — Basic User Manual 6-17

Direction 5841298-1EN Rev. 2



Scanning/Display Functions

Split Screen

Overview

LOGIQ P8/P9/P10 supports the following multiple image format:

* Dual (split the window area into 2 areas)

*  Wide Dual (split the window area into 2 areas, but wider
than the normal dual)

*  Quad (split the window area into 4 small areas)
This is useful, for example, when measuring AFI of OB.
* Simultaneous (Dual) (split the module window are into 2
areas, and both panes are live and active)

NOTE: The recalled split screen cannot be edited.
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Dual screen

1. Press L to activate a dual screen. The single image is
placed on the left side.

NOTE: When you activate the dual screen by pressing L, the single
image is placed on the left side; when you activate by
pressing R, the single image is placed on the right side.

2. Press R. The left side image is freezed and the image
displays in the right side.
3. Press Freeze to freeze the image of the right side.

4. Press Freeze again to unfreeze the active image which has
the gray bar under the image.

To switch between active images, press L or R.
5. Press B-mode key to return to the single screen.
NOTE: To put a copy of the image on the opposite side when entering

dual split screen, use the “When Entering Dual Image” preset
found on Ultility --> Application --> Settings preset page.
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Quad screen

NOTE:

Simultaneous mode

Press and hold down L to activate a quad screen. The
single image is placed on the upper left.

When you activate the dual screen by pressing L, the single
image is placed on the left side; when you activate by
pressing R, the single image is placed on the right side.

Press R. The left side image is freezed and the image
displays in the upper right.
Press Freeze.

Press Freeze again to unfreeze the image which has the
gray bar under the image.

Press L or R to move the gray bar to the image of the left
side or the right side.

Press B-mode key to return to the single screen.

While using CFM or PDI, press L and R keys simultaneously to
display B and B+CFM, or B and B+PDI in real-time on the left
and right side.

It is useful to observe the ROI in B-Mode.

6-20
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Dual Caliper

In split screen, you can draw a caliper, area, ellipse, or spline
trace on both the left and right image at the same time.
Whichever side of the screen that you annotate is called the
“Original” graphic. The copy is called the “Shadow” graphic.

This feature is available in the following modes:

B-Mode:B-Mode

Color Flow Mode:Color Flow Mode
B-Mode:Color Flow Mode
Simultaneous Mode.

Contrast

Elastography

NOTE: Dual Caliper IS NOT available in B-Mode: B/PW Mode or in
B-Mode:B/M Mode, or with different probes.

Figure 6-6. Original (Left), Shadow (Right)
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Dual Caliper (continued)

6-22

NOTE:

NOTE:

NOTE:
NOTE:

NOTE:

NOTE:

NOTE:
NOTE:

Only the Original graphic contains the graphic numbering. In this
way you can always distinguish between the Original and the
Shadow graphic.

You can only edit the Original graphic; however, when you do
edit the Original graphic, the Shadow graphic is also edited at
the same time.

If you delete either graphic, both are deleted.

When a measurement is selected without Dual B-Mode images
or with different probe images, a warning message is displayed
on the status bar and the selected measurement is cancelled.

If the first point of the Original graphic is out of the Shadow
image area, then a warning message displays on the status bar
and the Shadow graphic is not drawn.

The Trackball move area is limited to the narrow area of both
images.

You cannot take a measurement across dual images.

The 2D Dual measurement tool cannot be copied.
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Dual caliper for 2D image

2D Dual Caliper / 2D Dual Area / 2D Dual Ellipse / 2D Dual
Spline Trace / 2D Dual Circle are not available through the
factory default. To enable these measurements, add a new
measurement using “2D Dual Caliper”, “2D Dual Area”, 2D Dual
Ellipse”, “2D Dual Spline Trace” or “2D Dual Circle” tool in the
Utility--> Measure--> M&A preset menu.

1. Select Blank from Add measurement.

ADD MEASUREMENT

OK

Cancel

Figure 6-7. Add Measurement

2. Select appropriate dual caliper tool from Tool drop-down
menu.

Figure 6-8. Drop-down menu

3. Type the measurement and parameter name as you like.
4. Add the created measurement to the Touch Panel.
5. Display the dual imamge and press Measure.
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Dual caliper for 2D image (continued)

6-24

NOTE:

NOTE:

NOTE:

NOTE:

NOTE:

Select an added measurement from the Touch Panel to
enable the appropriate measurement. A caliper displays.

When the measurement is selected without dual B images
or with different probe images, a warning message displays
on the status bar and the selected measurement is
cancelled.

To position the caliper at the start point, move the Trackball.

You can use both images as an original image.

If the first point of the original graphic is out of the shadow
image area, then the warning message displays on the
status bar and the shadow graphic is not drawn.

To fix the start point, press Set. The caliper changes to an
active caliper.

Only original graphic has graphic numbering to distinguish
between original image and shadow image.

The trackball move area is limited to the narrow area of both
images.

Only the original graphic can be edited. When the original
graphic is edited, the shadow graphic is also updated.

To complete the measurement, press Set. The system
displays the measurement result in the Results Window.
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Annotating an Image

Annotating an Image

Introduction

The comment function provides the capability to type the
comments of free text and/or insert the pre-defined comments
from the comment library.

Text annotations may be inserted anywhere in the image area. It
also provides the user with arrow markers to point to parts of the
image.

Comments appear on all prints, photos, DVR or CINE loops.

CAUTION Annotations (text, arrow, and bodymark) are created on
separate layers. When viewing annotated images on a different

system or when zooming the image, the position of the
annotations on the image may be slightly changed.
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Adding Comments to an Image

Figure 6-9. Comment Touch Panel

Table 6-3:  Control Touch Panel

No.

Function

Description

Small list

Each Touch panel key can also be configured to hold a small list of up to 3
comments. The first word in the list is displayed on the Touch Panel and
the others can be accessed by toggling the key.

To program your system with specific comments, see ‘Creating a small list’
on page 10-46 for more information.

Comment swap

Comment Swap button in Comment Mode allows the user to do a quick
swap of comments from side to side in dual screen. In other words, the
comments on the left image are moved to the right image and vice versa.

Arrow Rotate

Rotate the arrow.
You can also rotate the arrow by Trackball.

Arrow Size

Adjust the length and thickness of the arrow,

Highlight/Grab word

Press Grab Word to grab latest text group.
To increase/decrease the area of the highlighted selection, use
HIGHLIGHT rotary.

6-26
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Adding Comments to an Image (continued)

Figure 6-10. Trackball key

Table 6-4: Comment Trackball key

No. Function Description
1. Comment Switch to Comment mode.
2. Arrow Switch to Arrow mode.
3. Word Delete Delete the selected word.
4. Grab Last Activate the last selected data for edit.
5. Set Erase word associated with comment cursor.
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Adding Comments to an Image (continued)

Free text

NOTE:

Pre-defined text

6-28

ok~ w0bd-=

Press Comment.

Type the desired text using the alhanumeric keyboard.
Press Enter to move to the next line.

Move the text cursor to the desired position using Trackball.

Press Set to fix the placement of the comment. The color
returns to yellow or to the user selected color.

If selected “Automatically Set Text” in Utility -> Comment ->
Comment, the system sets the comment at the cursor position
automatically when text entry is complete.

Press Comment.

Select a pre-defined text from the comment library on the
Touch Panel.

Move the text cursor to the desired position using Trackball.

Press Set to fix the placement of the comment. The color
returns to yellow or to the user selected color.
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Adding Comments to an Image (continued)

Layered annotations

Cursor position

Annotations can be entered on two different layers (called Text 1
and Text 2). This function enables the user to show/hide
different annotations on the same image.

1. Press F8.
“Text 1 (Display and Edit)” displays in the message area.
2. Press Comment to enter comments.
Toggle the F8 key to cycle through the three Text 1/Text 2 states
asa below:
+ Text 1 (Display and Edit)-- Only Text 1 displays.
+ Text 2 (Display and Edit) -- Only Text 2 displays.

+ Text 1 (Display) and Text 2 (Display and Edit) -- Both
displayed; only Text 2 comments editable. Both Text 1 and
Text 2 comments erased with new patient, new exam, or
probe change.

To preset the Text Overlay Sequence, go to Utility ->
Comment -> Comment and select either Text 1 and Both or
Text 1 and Text 2 and Both.

The font color for the Text1 and Text2 overlays can be set
separately. Go to Utility -> Comment -> Comment and specify
the text color for Text 1 Color and Text 2 Color.

Pressing the F7 (Cursor Home) key returns to the user
specified position or factory default position.

A new cursor home position is established by placing the cursor
in the desired position and pressing Shift+Home.

LOGIQ P8/P9/P10 — Basic User Manual 6-29
Direction 5841298-1EN Rev. 2



Scanning/Display Functions

Adding Comments to an Image (continued)

Arrow Pointers

6-30

NOTE:

NOTE:

1. Press F2 (Arrow). The arrow pointer displays.

2. Move the pointer using the Trackball to any place on the
screen. The pointer head direction can be controlled by
movement of the Trackball or Arrow Rotate control.

3. To readjust the length and thickness of the pointer, use the
Arrow Resize rotary control. The default for the pointer size
can be preset.

4. Press Set to fix the place of the pointer and direction of the
pointer head. The BLUE color turns to YELLOW (or the
default color if changed).

5. To delete the arrow marks, press the Clear key while in the
arrow pointer mode (The top Trackball key is assigned to
Arrow).

This action clears the comments only, not the arrows on the
screen. To erase all comments as well as arrows, press and
hold the Clear key.

To prevent the Trackball from changing the arrow angle, select
the “Keep arrow angles” preset at Utility -> Comments ->
Comments.
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Adding Comments to an Image (continued)

Word wrap

NOTE:

Comments wrap to the next line when they are within one
character of the right margin if Word Wrapping is selected in the
Text Boundary preset. See ‘Comments Libraries/Comments
Preset Menu’ on page 10-47 for more information.

The word wrap starts one line below the start of that comment.

1 2

WORD WRAP WORD
WRAP

Figure 6-11. Next Line Word Wrap

1. Before 2. After

If the cursor appears at the right edge of the lowest line, or a
word cannot be completed in the lower right corner, word wrap
cannot be executed.

The same word wrap principles apply for library scripts as typed
comments.
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Adding Comments to an Image (continued)
Comment Retention

Comments from the B-Mode images are retained and carried
over when switching to multi-image format or duplex mode.

The position of the comments is adjusted so that it is at the
same relative position with respect to the display window in the
new format as it was in the single image format.

NOTE: Comments may not be retained when the image is switched to
M-Mode image format depending on the preset.

NOTE:  If “Clear Non Active Image Comments” in Utility -> Comment ->
Comment is selected, comments from the non-activated images
are automatically cleared when entering in dual or quad image
screen.

NOTE: Comment Swap button in Comment Mode allows the user to do
a quick swap of comments from side to side in dual screen. In
other words, the comments on the left image are moved to the
right image and vice versa.
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Body Patterns

An additional way to annotate the image display is with body
patterns. Body patterns are a simple graphic of a portion of the
anatomy that is frequently scanned. The body pattern and probe
marker can serve as a reference for a patient and probe
positioning when images are archived or scanned.

1.

Press rotary corresponding to Bodypattern. The
bodypattenrss specific to the current application are
displayed.

Touch the bodypattern to insert. The selected bodypattern
with a probe marker is displayed on the scanning screen.

Using the trackball, adjust the position of the probe marker.

Rotate rotary of Bodypattern to set the probe marker
orientation.

To move the bodypattern:

* Press Move Pattern.

* Move the bodymark to a new location with the trackball.
* Press Set to anchor the bodypattern to the new location.
Press Set on the keyboard or Scan on the Touch Panel to
exit without erasing the body pattern.

To clear the body pattern, Press rotary of Bodypattern to
activate body patterns and then press the Clear key.

The body pattern packages may be customized to
accommodate user preference. Up to 30 individual body
patterns in the packages can be changed.
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Body Patterns (continued)

Figure 6-12. Touch Panel displays of Body Pattern - example

Table 6-5:  Control Touch Panel

No. Function Description

1. Move Pattern Each Touch panel key can also be configured to hold a small list of up to
3 comments. The first word in the list is displayed on the Touch Panel and
the others can be accessed by toggling the key.

To program your system with specific comments, see ‘Creating a small
list on page 10-46 for more information.

2. Save Position Move the body pattern to the desired location and press the Save
Position.Current position of Body Pattern is saved as a Home Position of
current display format.

Hold down Save Positionto reset the home position to factory default.

3. Save Probe Position Rotate the arrow.

You can also rotate the arrow by Trackball.

The probe mark type is selectable by rotating the Probe Type control on
the Touch Panel. There are different choices available with one being a
blank selection.

4. Rotate Probe Rotating probe mark position by rotating the Rotate Probecontrol on the
Touch Panel.

To select the active side in dual B-Mode, use the Active Side
rotary control at the bottom of the Touch Panel.

You can use the Zoom control to select the body pattern. If you
want to assign the select function to the Zoom control, see ‘Body
Pattern Libraries/Libraries Preset Menu’ on page 10-56.
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Notes for Body pattern (Probe mark)

* Probe Type is the type of probe mark displayed on the body
pattern It can be saved only for each body pattern on the
Touch Panel while body pattern is activated, but not in the
Utility preset menu. Therefore, Probe Type cannot be saved
as an Application or System Preset.

To save the Probe Type,
a. Activate the Body Pattern.
b. Select a Body Pattern on the Touch Panel.

c. Select a type of probe mark with the Probe Type Touch
Panel key.

d. Place the probe mark at the proper location.
e. Select the Save Probe Position Touch Panel key.

NOTE: “Save Probe Position” saves both the Probe Mark position
and Probe Type.

* When a Body Pattern is selected and no Probe Mark has
been saved on it, the latest used Probe mark is carried over
to the Body Pattern.
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Notes for Body pattern (Probe mark) (continued)

+  Check the Body Pattern on the Touch Panel if the Probe
Mark does not appear on the monitor.

Figure 6-13. Body Pattern Touch Panel

a. When the Probe Mark is saved for the Body Pattern, the
Probe mark is displayed in yellow on the Touch Panel
and should also be shown on the monitor.

b. When the Probe Mark is saved with “Probe Type -
None”, the Probe Mark is displayed in gray on the Touch
Panel and is not shown on the monitor. Reselect an
appropriate Probe Type and save as necessary.

c. When the Probe Mark is not saved, no Probe Mark is
displayed either on the Touch Panel or the monitor.
Select an appropriate Probe Type and save as
necessary.
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Body Patterns (continued)

Figure 6-14. Body Patterns Available

1. abdo1 16. body 1 31. breast 1 46. carotid 1

2. abdo 2 17. body 2 32. breast 2 47. carotid 2

3. abdo3 18. body 3 33. breast 3 48. carotid 3-Lt
4. abdo 4 19. body 4 34. breast 4-Lt 49. carotid 3-Rt
5. aorta 20. body 5 35. breast 4-Rt 50. carotid 4

6. arm1 21. body 6 36. breast 5-Lt 51. carotid 4-Lt
7. arm2 22. body 7-Lt 37. breast 5-Rt 52. carotid 4-Rt
8. arm3 23. body 7-Rt 38. breast 6-Lt 53. carotid 5

9. arm4 24. body 8-Lt 39. breast 6-Rt 54. chest 1

10. arm 5 25. body 8-Rt 40. breast 7-Lt 55. fetus 1

11. arm 6 26. body 9 41. breast 7-Rt 56. fetus 2

12. arm 7 27. body 10 42. breast 8-Lt 57. fetus 3

13. arm 8 28. body 11-Lt 43. breast 8-Rt 58. fetus 4

14. arm 9 29. body 11-Rt 44. breast 9-Lt 59. fetus 5

15. arm 10 30. body 12 45. breast 9-Rt 60. fetus 6
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Body Patterns (continued)

Figure 6-15. Body Patterns Available

61. fetus 7 76. foot 3-Rt 91. hand 3-Lt 106. heart 1
62. fetus 8 77. foot 4-Lt 92. hand 3-Rt 107. heart 2
63. fetus 9 78. foot 4-Rt 93. hand 4-Lt 108. heart 3
64. fetus 10 79. foot 5-Lt 94. hand 4-Rt 109. heart 4
65. fetus 11 80. foot 5-Rt 95. hand 5-Lt 110. heart 5
66. fetus 12 81. foot 6-Lt 96. hand 5-Rt 111. heart 6
67. fetus 13 82. foot 6-Rt 97. hand 6-Lt 112. heart 7
68. fetus 14 83. foot 7-Lt 98. hand 6-Rt 113. heart 8
69. fetus 15 84. foot 7-Rt 99. hand 7-Lt 114. heart 9
70. fetus 16 85. foot 8-Lt 100. hand 7-Rt 115. heart 10
71. foot 1-Lt 86. foot 8-Rt 101. head 1 116. heart 11
72. foot 1-Rt 87. foot 9-Lt 102. head 2 117.legs 1
73. foot 2-Lt 88. foot 9-Rt 103. head 3 118. legs 2
74. foot 2-Rt 89. hand 1 104. head 4 119. legs 3
75. foot 3-Lt 90. hand 2 105. head 5 120. legs 4
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Body Patterns (continued)

Figure 6-16. Body Patterns Available

121.legs 5 136. neck 3 151. organ 7 166. twin 2
122. legs 6 137. neck 4 152. organ 8 167. twin 3
123.legs 7 138. neck 5 153. organ 9 168. twin 4
124.legs 8 139.0b 1 154. pelvis 1 169. twin 5
125.legs 9 140.0b 2 155. pelvis 2 170. twin 6
126. legs 10 141.0b 3 156. post-breast-bilateral 171. twin 7
127.legs 11 142.0b 4 157. post-breast-Lt 172. twin 8
128. legs 12 143.0b 5 158. post-breast-Rt 173. uro 1
129. legs 13-a-Lt 144.0b 6 159. rheuma 174. uro 2
130. legs 13-a-Rt 145. organ 1 160. shoulder-back-Lt 175.uro 3
131. legs 13-Lt 146. organ 2 161. shoulder-back-Rt 176. uro 4
132. legs 13-Rt 147.organ 3 162. shoulder-front-Lr 177.uro 5
133. liver 148. organ 4 163. shoulder-front-Rt 178. uro 6
134. neck 1 149. organ 5 164. thyroid 179.uro 7
135. neck 2 150. organ 6 165. twin 1 180. uro 8
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Body Patterns (continued)

181. uro 9 female
182. uro 9 male

183. uro 10 female-Lt
184. uro 10 female-Rt
185. uro 10 male-Lt
186. uro 10 male-Rt
187. uro 11

188. uro 12

189. uro 13-Lt

190. uro 13-Rt

191. uterus 1

192. uterus 2

193. uterus 3

194. vet cat 1

195. vet cat 2

6-40

196.
197.
198.
199.
200.
201.
. vet dog 1
203.
204.

202

205

vet cat 3
vet cat 4
vet cat 5
vet cow 1
vet cow 2
vet cow 3

vet dog 2
vet dog 3

. vet dog 4
206.
207.
208.
209.
210.

vet dog 5

vet horse 1
vet horse 2
vet horse 3
vet horse 4

Figure 6-17.

211.
212.
213.
214.
215.
216.
217.
218.
219.
220
221.
222.
223.
224.
225.

vet horse 5
ankle-Lt
ankle-Rt
ankle lat-Lt
ankle lat-Rt
ankle post-Lt
ankle post-Rt
arm-Lt
arm-Rt

. arm post-Lt

arm post-Rt
elbow-Lt
elbow-Rt
elbow lat-Lt
elbow lat-Rt

226.
227.
228.
229.
230.
231.
232.
233.
234.

235

239

Body Patterns Available

elbow post-Lt
elbow post-Rt
foot-Lt

foot-Rt

foot lat-Lt

foot lat-Rt
forearm-Lt
forearm-Rt
forearm post-Lt

. forearm post-Rt
236.
237.
238.

hand-Lt
hand-Rt
hand post-Lt

. hand post-Rt
240.

head
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Body Patterns (continued)

Figure 6-18. Body Patterns Available

241. head lat-Lt 256. leg-Lt

242. head lat-Rt 257. leg-Rt

243. head post 258. leg post-Lt

244 hip-Lt 2509. leg post-Rt

245. hip-Rt 260. shoulder-Lt
246. hip lat-Lt 261. shoulder-Rt
247. hip lat-Rt 262. shoulder lat-Lt
248. hip post-Lt 263. shoulder lat-Rt
249. hip post-Rt 264. shoulder post-Lt
250. knee-Lt 265. shoulder post-Rt
251. knee-Rt 266. thigh-Lt

252. knee lat-Lt 267. thigh-Rt

253. knee lat-Rt 268. thigh post-Lt
254. knee post-Lt 269. thigh post-Rt
255. knee post-Rt 270. wrist-Lt
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271.
272.
273.
274.
275.
276.
277.
278.
279.
280.
281.
282.
283.

284
285

wrist-Rt
wrist post-Lt
wrist post-Rt
new carotid 2
carotid2-Lt
carotid2-Rt
brain1
brain2
brain3
brain4
breastSA-Rt
breastSA-Lt
lung1

.organ10
.organ11
286.

vet-marmoset
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Overview

NOTE:

Create a Fast Key

NOTE:

NOTE:
NOTE:

NOTE:

NOTE:

6-42

Using the Fast Key

A keyboard Fast Key is available to record and run a sequence
of often-run keystrokes.

Ensure that you have a patient selected prior to running the Fast
Key operation.

1. Press the F5 key. The “Do you want to create the Fast Key?”
dialog displays. Select OK to continue.

2. Select a key to assign a Fast Key to (a-z, 0-9).

If you select a Front Panel control, a Touch Panel key or any
key besides a-z or 0-9, a warning dialog displays and the
procedure is cancelled.

Assign Fast Key Function to Key 0 - 9 in Utility -> System ->
User Configurable Key before you create a Fast Key.
There is no distinction between capital and small letters.
The key code is the same in Russian and Greek (a-z, 0-9).
3. If the selected key is already assigned to a Fast Key, a
warning dialog displays.
Select Yes to continue. The Fast Key file is overwritten.
Select No to cancel the Fast Key setup.
4. Input the key sequence to be assigned.
It is impossible to save a power cycle sequence or any input
from outside of the system.

If a warning dialog displays due to the limitations of the
number of key sequences, press F5 to finish and retry.

5. Press the F5 key to complete a Fast Key setup. The
information dialog displays. Select OK.
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Start a Fast Key

NOTE:

NOTE:

NOTE:

Press the F6 key to start a Fast Key. The message “Select
the key which the Fast Key is assigned to” displays on the
status bar.

The F6 key is ignored if another dialog displays on the
system.

If you press F5 after F6, the F6 function cancels and the F5
function is enabled.

Press the key assigned to the Fast Key macro. The
message “Fast Key playback is finished” displays on the
status bar when the macro is finished.

To stop the Fast Key during the operation, press F6. The
message “Fast Key playback is cancelled” displays on the
status bar.

Select the running speed in the Run Fast Key Speed preset
on Utility -> System -> General.

Backup and Restore the Fast Key

You can backup/restore the Fast Key via Utility -> System ->
Backup/Restore.

To backup, select User Defined Configuration in the Backup
section.

To restore, select User Defined Configuration in the Restore
section.
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Electronic Documentation

Documentation Distribution

Documentation is being provided via:

» Electronic media. You can view user documentation (all
languages) on a PC or on the Ultrasound Scanner via the
Customer Documentation media, which includes:

» Basic User Manual (translated)

* Advanced Reference Manual (English and French)

* User Guide (translated)

* Release Notes and Workarounds (translated, optional)
+ Basic Service Manual (English only)

»  Privacy and Security Manual (translated)
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Using Online Help Via F1

Online Help is available via the F1 key. After pressing F1, Help
appears. The Help screen is divided into three sections:
navigational tools on the top, left portion of the screen (Hide,
Back, Forward), help book navigational tools on the left portion
of the screen (Contents, Index, Search, Favorites), and the
content portion on the right side of the screen where help topics
are displayed.

ol )@ o
Technical Publications

5841298-8EN

Rev.

CE..

LOGIQ P8/P9/P10 Online help

liraang Euoonss Divessa SUITEEC concorng mwdeal Sraces C€_

Figure 6-19. Opening Help Screen
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Navigating through the Help Book

Online Help is organized like a manual, with individual chapters,
sections, and pages. Click on the plus (+) sign next to MANUAL
to open up the book. Click on the plus sign next to the chapter
you want to view to open up that chapter. Click on the plus sign
next to the chapter you want to view to open up that section.
Open up the page to view that page’s information.

% Direction 5791623300

G
Hide Back Forward

Contents

Index } Search ] Favortes I

= (L) MANUAL
[£] Revision History
[5] RegulatoryRequirements
[E] ReguistoryRequiremerts
[5] RequlatoryRequiremerts
@ RegulatoryRequiremets
@ Chapter 1 - Introduction
@ Chapter 2 - Safety
Q Chapter 3 - Preparing the System for Use
@ Chapter 4 - Preparing for an Exam
@ Chapter 5 - Optimizing the Image
@ Chapter 6 - Scanning/Display Functions
@ Chapter 7 - General Measurements and Calculations
@ Chapter 8 - Application MaA
@ Chapter 9 - Reconding images
([} Chapter 10 - Customizing Your System
@ Preseis
0 System Presets
@ WyPage Presets
@ Imaging Pressis
[SRVA] Commers Libraries Presels
[£] Overview
@ Comments Libraries/Libraries Preset Menu
[£] Comments Libraries/Comments Preset Menu
@ Comments Libraries/ Applications Preset Menu
[£] Comments Libraries/Mapping Preset Menu
@ Body Pattems Presets
@ Application Pressts
2] User Specific
@ 3040
@ Confiquring Connectivity
@ System Administration
@ Search

DEEIEEEEEEEA

Comments Libraries Presets

O
C
Comments Libraries/Comments Preset Menu

iew

ments Libraries/Libraries Preset Menu

Comments Libraries/Applications Presst Menu

Comments L ibraries/Mapping Preset Menu

Figure 6-20. Sample Help Topic

The blue, underlined text links you to related topics. Click on the
link to move to the new topic.
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Links

After you click on a blue, underlined portion of text, the screen

updates with this link’s content. To go back to the previous

screen, press Back. To return to the link, press Forward.

[ Direction 5791623-300

Hide

e =
Back Forward

Gt 1 index | Search | Favartes |

=1 L) MANUAL

[] Revision History
EJ RegulatoryReguirements
@ RegulatoryReguirements
|5] RequlatoryRequirements
@ RegulatoryRequirements
@ Chapter 1 - ntroduction
@ Chapter 2 - Safety
Q Chapter 3 - Preparing the System for Use
@ Chapter 4 - Preparing for an Exam
@ Chapter 5 - Optimizing the Image
Q Chapter € - Scanning/Display Functions
@ Chapter 7 - General Measurements and Calculations
@ Chapter 8 - Application M&A
Q Chapter 3 - Recording images
i (] Chapter 10 - Customizing Your System
@ Presets
Q System Presets
@ MyPage Presels
@ Imaging Presets
£l () Comments Libraries Presets
] Overview
@ Comments Libraries/Libraries Preset Menu
@ Comments Libraries/ Applications Preset Menu
@ Comments Libraries/Mapping Preset Menu
@ Body Pattems Presets
@ Application Pressts
2] User Specic
@ 304D
@ Configuring Conmectivity
Q System Administration

Preset Parameter
Text Font Size
| Text color (Text1 and
Text?)
Text Boundary
Small List Operation

Enable Type Over Mode

Reset Small List

Comments Libraries/IComments Preset Menu

On the Comments tab, you specify text and pointer options.

Figure 10-19: Comment/Comments Preset Menu

Table 10-40: Text (Continued)

Description

Specify the font size. The font size increases as the number
increases.

Select the color for comment Text1 and Text2

Select Group Move or Word Wrapping.

Select whether you want small list options to display in a pop-
up window or by a toggle function

Select to type over existing comments. Position the cursor aver
the text to be changed, then start typing.

Select to indicate that small lists should not be reset to the first
item.

Figure 6-21. Topic Link
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Searching for a Topic

To search for a specific topic, click on the Search tab in the left
portion of the screen. Type in the topic name in the Type in the
keyword to find: field. Topics with the word or phrase you typed
appear in the Select Topic to display: area. Either double click
on the topic you want to view or highlight the topic and press the
Display button to view this topics.

22 Direction 5791623-300
e =

Hide: Back Forward

Contents } Index  Search | Favortes I

Type in the keyword to find

Resistive Index (5I)

1. From the Doppler Generic Touch Panel, select [

[RI

Select Topic to display:

The system displays an active caliper with vertical and horizontal dotted lines.

List Topics 2. To position the caliper at the peak systolic velocity, move the Trackball.
3. To fix the measure point, press Set
The system displays a second active caliper.

Delete data

Doppler Mode Measurements
FeaturesSpecifications

M & A Advanced Preset

Setting up Auto Vascular Caleulation Parameters
Tricefy lcons

Resistive Index (R

4. To position the second caliper at the end diastolic velocity, move the Trackball.
5. Tocomplete the measurement. press Set.
The system displays PS, ED, and [§l in the Results Window.
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Display
Figure 6-22. Search Results
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Saving Favorite Topics

You may find that there are topics you need to refer to often. In
this case, it's a good idea to save these topics as Favorites. To
save a topic as a favorite, press the Favorites tab, highlight the
topic in the Topics window, and press the Add button. You can

view this topic quickly by going to the Favorites help tab.

¥ Direction 5791623-300 - m] X
e =
Hide  Back Forward
Contents } Index 1 Search  Favortes Resistive Index (5I)
1. From the Doppler Generic Touch Panel, select [
The system displays an active caliper with vertical and horizontal dotted lines
2. To position the caliper at the peak systolic velocity, move the Trackball.
3. Tofix the measure point, press Set
The system displays a second active caliper.
4. To position the second caliper at the end diastalic velocity. move the Trackball.
5. To complete the measurement. press Set.
The system displays PS, ED, and 5l in the Results Window.
< >
Bemove Display
Current topic
]Reslstlve Index {RI)
Add
Figure 6-23. Adding Favorites
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Using the Index

Or, you can look for topics by using the Index. Press the Index
tab, then use the scroll bar to look up a topic.

2 Direction 5731623-300

& D
Hde  Back Forward

Contents  Index | Search 1 Favorites 1

Type in the keyword to find:

Resistive Index (RI)

1. From the Doppler Generic Touch Panel, select RI.

‘Res\slwe Index {RI), Doppler generic measurement

The system displays an active caliper with vertical and horizontal dotted lines.

Report Writer report templates, customizing
Repoart Writer reports

activating

creating

editing

factory templates
inserting images
-Resistive index (R]), Doppler g
Results window

right side view, console
rotating an image
S Map, Hlastography
5/D Ratio, Doppler measurement
safety
electromagnetic compatiblty (EMC}
equipm
hazards
labels
patiert
patient training, ALARA
personnel
precaution icons, defined
precaution levels, defined
probes
sample volume, adjusting
gate position
length
Scale, adjusting
Color Flow
Scalpel, 30/4D imaging
Scan Assistant
Awailability
Definitions
Description

A 2. To position the caliper at the peak systolic velocity, move the Trackball.
3. Tofix the measure point, press Set
The system displays a second active caliper.
4. To position the second caliper at the end diastolic velocity, move the Trackball.
5. To complete the measurement, press Set.
The system displays PS, ED, and Rl in the Results Window.

v

Display

Other Help Features

Exiting Online Help

6-50

Figure 6-24. Index

To hide the left side of the screen, press the Hide icon at the
upper, left-hand portion of the screen. To view the left side of the
screen again, press the Show icon at the upper, left-hand
portion of the screen.

To size the Help window, position and hold down the cursor at
the corner of the screen while moving the Trackball.

To move the Help window to the Touch Panel display, position
and hold down the cursor at the very top of the Help window
while moving the Trackball to the Touch Panel display.

To exit Online Help, press the ‘X’ in the upper, right-hand corner
of the Online Help window.
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Electronic media

Accessing Documentation Via a Windows PC

To view user documentation on a Windows PC,

1.

2.
3.
4

Insert the media into the media drive.
Open the media drive on your desktop.
Double click on the ‘gedocumentation.html’ document.

Select the item you want to view (click on the blue,
underlined link in the File Name column).

To close the window, click on the ‘X’ in the upper, right-hand
corner of the browser window.

NOTE: If your PC does not have Adobe Reader, a free download is
available on the Adobe website at http.//www.adobe.com.

Updating Documentation on the Ultrasound Scanner Via the USB

The latest version of the Online Help is located on the USB
Flash drive. To update to the latest version,

1.

NOTE:

Power down the LOGIQ P8/P9/P10 and insert the elFU
USB Flash Drive into a rear USB port.

Ensure that the system is USB Device Enabled (check
setting on System Admin Utility Page).

Power on the LOGIQ P8/P9/P10 and follow the screen
prompts.

a. Select Install SW... on the Start Application screen.
b. Select OK on the first StartLoader screen.

c. Select the package and then select Install on the
second StartLoader screen; software installation will
begin.

d. As you verify each feature works correctly, select
“Passed.”. If all features work correctly and “Passed” is
selected for all features, the signature field is enabled at
the bottom of the New Software Verification Checklist.
Type your signature (minimum of three characters) and
press OK. The system is now ready for use.

3. Remove the USB Flash Drive.

NOTE: You can search through a document, use hyperlinks in the Table
of Contents and Index to locate topics, and navigate via
bookmarks.
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NOTE:

In addition to viewing documentation on the Ultrasound system,
the Documentation media can be read on any PC.

To exit, press the X’ in the upper, right-hand corner of the
documentation window.

Viewing Online Help in a Language Different from the System Language

6-52

On the Utility --> System --> Online Help Language page, select
the language you wish to view Online Help.

If the translated Online Help is not available, you will be directed
to select a different language.

Translated Online Help files can be updated via the elFU USB
Flash Drive. Please contact your Applications/Field Service
Representative to order an updated elFU Kit.
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Using MyTrainer+

Activate MyTrainer+

Move the cursor to MyTrainer+ icon and press the right or left
Set key and press the MyTrainer user defined touch button.
MyTrainer+ is displayed on the left side of the monitor or in full
screen.

Press Esc key on the keyboard or Exit on MyTrainer+ to exit
from MyTrainer+.

MyTrainer+ automatically selects contents of active functionality
or mode when there is contents of active functionality/mode.

If there is no contents of active functionality/mode, MyTrainer+
displays topics list.
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Activate MyTrainer+ (continued)

Figure 6-25. My Trainer+

1. MyTrainer+ icon
2. MyTrainer+
3. MyTrainer user defined touch button
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Small layout

B & [+]

Figure 6-26. Small layout

*  When displaying contents in Small layout, you can use
following keyboard-shortcut.

* The up arrow (Pg Up) key: Go to the previous page
within the current topic.

* The down arrow (Pg Dn) key: Go to the next page within
the current topic.

» The left arrow (Home) key: Go back to the List of
Available topics

*  When displaying topics list in Small layout, you can use
following keyboard-shortcut.
* The up arrow (Pg Up) key: Go to the previous topic.
* The down arrow (Pg Dn) key: Go to the next topic.
* The right arrow (End) key: Display the content.
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Full screen layout

Figure 6-27. Full screen layout
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Layout Setting

Select Small layout or Full screen layout.

«  Small layout displays MyTrainer+ by side-by-side with a
image.

»  Full screen layout displays MyTrainer+ in the full screen
over scan image.

Select languages

Select MyTrainer+ language.

Supported languages: English, French, Spanish, German,
Italian, Brazilian Portuguese, Japanese, Simplified Chinese and
Russian.

NOTE: Language setting of MyTrainer+ is independent from Utility
language setting. Only for MyTrainer+.

L
=
-
¥
¥
.
o

Figure 6-28. Select languages
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System Language Configuration

Select the System Language and Date/Time Format

The default operating system language and keyboard may be
changed from the Utility > System > General page.

Figure 6-29. Utility System General Screen

1. Select the desired system language from the Language
dropdown menu (1). Then select Save at the bottom left of
the screen. Do NOT restart yet.

2. Select Regional Options (2) to open the Regional Options
Dialogue Box.

6-58 LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2



System Language Configuration

Select the System Language and Date/Time Format (continued)

Figure 6-30. Regional Options Dialogue Box

3. Set“Current OS Language” (3) and “Keyboard” (4) to match
the system language selected in Step 1.

Set “Current Format” (5) for date/time preference.
4. After making changes to the Regional Options, select OK in

the Regional Options dialog box to save the changes and
restart the system.

NOTE:  For the United Kingdom, it is recommended to use ENG
Language (1), English (United States) OS Language (3), and
modify “Current Format” time/date settings to English (United
Kingdom) (4) (see Figure 6-30 on page 6-59 ).

Change the Keyboard Language
To change the keyboard language, press the left Alt+Shift on the

keyboard to toggle through all available keyboard languages
until you reach the desired language.
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English (International) Keyboard

When the system language is set to English (United States),
pressing the Ctrl+Shift on the keyboard toggles between the
English (United States) keyboard and the English (International)
keyboard.

Apostrophe/Quatation Marks

To type an apostrophe or quotation marks while using the
English (International) keyboard, you must press the space key
after the apostrophe or quotation mark to display the character.

Special Accented Characters on the English (International) Keyboard

To type special accented characters, from the English (United
States) keyboard, press Ctrl+Shift to change to the English
(International) keyboard, then press the AltGr+appropriate
keyboard key listed below.

+  [ARGr]+[Q] to type a

+  [ARRGr]+[W] to type a

*  [AtGr]+[E] to type é

*  [AlRGr]+[Y] to type U

*  [ARGr]+[I] to type i

*  [ARRGr]+[P] to type 6

*  [AIRGr]+[A] to type &

* [AltGr] + [Function Key] + [,] to type ¢

* [Shift] + [6] + [a] to type &

* [Shift] + [6] + [e] to type &

* [Shift] + [6] + [i] to type T

* [Shift] + [6] + [0] to type &

* [Shift] + [~] + [a] to type &

* [Shift] + [~] + [n] to type A

* [Shiffj +[]+[a]toa

* [Shiffj+[]+[e]toé

* [Shift] +[]+[i]toT

* [Shiffj +[]+[0]to 6
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Chapter 7

General Measurements and
Calculations

Describes how to perform general measurements and
calculations.
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Introduction

Introduction

Measurements and calculations derived from ultrasound images
are intended to supplement other clinical procedures available
to the attending physician. The accuracy of measurements is not
only determined by system accuracy, but also by the use of
proper medical protocols by the user. When appropriate, be sure
to note any protocols associated with a particular measurement
or calculation. Formulas and databases used within the system
software that are associated with specific investigators are so
noted. Be sure to refer to the original article describing the
investigator's recommended clinical procedures.

and charts based on published scientific literature. The
selection of the appropriate chart and clinical interpretation of
calculations and charts is the sole responsibility of the user.
The user should consider contraindications for the use of a
calculation or chart as described in the scientific literature. The
diagnosis, decision for further examination, and medical
treatment must be performed by qualified personnel following
good clinical practice.

f WARNING The system provides calculations (e.g. estimated fetal weight)
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Basic Operation

Measure and Assign

Press Measure on the control panel.
Select the measurement tool via the upper trackball key.

Perform the measurement. Follow the instructions displayed
on the message area at the bottom of the screen.

To assign a label, select the measurement in the
Measurement result window and press Set.

4 AFI-Q3 2.86 cm Cancel
5 AFI-Q4 4.12 cm
AFl 1213 cm

Figure 7-1. Label menu

Select the required label from the menu. For example, if it is
a distance measurement, the list includes all distance
calculations for the current study.

or

Select User Name from the menu. The dialogue window
displays.

Enter the appropriate name and select OK.

Figure 7-2. Enter Measurement Name
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List of general measurements

The following types of general measurements are available
when you press Measure but do not choose a specific
calculation. The type of measurement depends on the current
scan mode.

7-4

NOTE:

After pressing Measure, rotate between various measurement
types with the upper Trackball keys.

B and CF Modes

Dist (Caliper)
Trace

Spline
Intensity
Open Trace
Open Spline

You can preset the sequence of B and CF area measurements
in the Measure Key Sequence (B/CF) preset in the Ultility ->
Measure -> Advanced screen. See the “M&A Advanced Preset”
section for more information.

Doppler Mode

Velocity
Trace
Slope
Time

M-Mode

Caliper
Time
Slope
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Assign and Measure

1. Press Measure on the control panel.

2. Select the measurement on the Touch Panel.
If you select the measurement folder, the sub menu tab is
displayed. You can select and perform the measurement in
the tab.
If the folder is configured with auto-sequence measurement,

the next measurement in the study is pre-selected. To skip a
pre-selected measurement, select another measurement.

3. Perform the measurement. Follow the instructions displayed
on the message area at the bottom of the screen.
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Location of Measurement Controls

i ) @

"y
[

‘al ©)p

Figure 7-3. Locating Measurement Controls

Table 7-1:  Measurement controls

Control Description

1. Measure Activates a measurement caliper and the calculation package associated
with the currently selected preset.

2. Ellipse Atfter the first caliper for a distance measurement has been set and the
second caliper positioned, Ellipse activates the area/ellipse measurement
function. During the ellipse adjustment, use the Trackball to increase or
decrease the size of the ellipse. Select Cursor Select to adjust the
measurement calipers.

3. Ellipse Size During the ellipse adjustment, Ellipse Size activates to control the ellipes size.

4. Clear During a measurement sequence, erases the measuring caliper and
measurement data from the display. When not performing a measurement
sequence, clears all calipers and measurements from the display.

5. Pointer Key Select to display a pointer on the monitor.

6. Trackball Moves the measurement calipers, selects the measurement on the Summary
Window and controls the ellipse size of the curved lines. Trackball also
selects items on the Touch Panel with the Pointer and Set keys.

7. Trackball Keys The functionality of these keys changes (e.g. Set, Change Measure, etc)
depending on the mode or action. Current functionality is displayed on the
lower-right corner of the monitor.

7-6 LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2



Introduction

Touch Panel
B/M/Doppler Mode Select Tab

The B, M, or Doppler mode select tab key allows the user to
select measurements associated with a particular mode of
active study.

The system provides a default mode selection.

Figure 7-4. B-Mode - Example
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Exam Calcs Tab

The Exam Calcs Tab is used for selecting calculations from
other study in the selected Exam Category.

Abdomen

Figure 7-5. Exam Calcs Tab - example

Selecting a measurement in a different application
While scanning a patient, you may find that you want to measure
an item that is not in the current application. In that case, Exam
Category allows you to select other calculations without
changing application.
1. Select Exam Calcs in the measurement mode.
2. Select Exam Category .

3. Select the exam category that has the calculation you want
to make.

4. Select the study and the desired measurement.
5. After you complete the measurement, to return to the
original application, repeat steps 1-4.

NOTE: This measurement DOES NOT appear on the original
application worksheet.
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Options tab
The Options tab allows you to specify the following
measurement and display options:
Options
Figure 7-6. Measurement and Display Options - Example
Table 7-2: Measurement and Display Options

No. Description

1. Select Hide Display to hide the Results Window and Summary Window. Hide Display on the Touch
Panel key is lit.
To re-display them, select Hide Display again.

2. The system displays the following choices:
*12x12
*9x9

3. Select Heart Rate Cycle to hange the number of cycles used in the calculation. The system displays
a list of choices from 1 — 10.

4. You may want to change where the Results Window is positioned on the monitor display. To change
the location of the Results Window, select Move Res Win. The system displays a list of choices.

5. Select Auto or Manual for Doppler Trace.
* Auto — the system traces the Doppler waveform from the begin time to the end time.
* Manual — trace the waveform manually.

6. After you press Set to complete the measurement, the dotted line remains on the display if the Show
Caliper Line is selected.
If Show Caliper Line is not selected, the system erases the dotted line and only the measurement
calipers with a number or symbol are displayed.
Note: The Show Caliper Line on the Options tab takes precedence over the Cursor Line Display
preset, found on the System -> System Measure screen.
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Push/Rotary button area

At the bottom of the Touch Panel, there are five combination
rotary dials/push buttons. The functionality of these rotaries
changes, depending upon the mode, exam category, study, etc..

Side Rt/Lt

The system has measurements for the patient's right and left
side. To change side, push or rotate the Side rotary button.

Delete
Delete the fixed first caliper.

Cursor select

When there are several measurements on the display, to rotate
through and activate previously fixed calipers, push or rotate the
Cursor Select rotary button.
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Exam category/Study/Measurement

For each patient, the system organizes information by exam
category, study, and measurement. The definitions of these
terms are as follows:
+ Exam Category — categories include the following:

* Abdomen

+  Obstetrics

*  Gynecology

+ Cardiology
* Vascular

* Urology

* Small Parts

e Pediatrics

+ Study/Preset — after you choose an exam category, the
system allows you to select a study. For example, when you
choose the Obstetrics exam category, you can choose one
of the following studies:

*  Generic

+ OB-1

« OB-2/3

+ OB-General
* Fetal Heart

« OB/GYN Vessel

*+ Measurement — the measurements and calculations
needed to analyze an item of anatomy. For example, a
femur length is a measurement. A measurement can
include several pieces of measurement data. For example,
to calculate the ovarian volume, you need to measure width,
length, and height.
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General Instructions

General Guidelines

Any measurement can be repeated by selecting that
measurement again from the Touch Panel.

The system retains all measurements, but the worksheet retains
only the last six measurements of each type.

Measurement and calculation results

As you take measurements, each measurement is given a
sequential number on the display and in the Results Window.
The system can display nine measurements on the screen at
one time.

Once the Results Window has nine measurements, if you make
any further measurements, the system erases the first
measurement and adds the new measurement ("first in, first
out").

Measurement graphics are kept while in cine scroll. The
measurement graphic is redisplayed on the frame where it is
taken, if preset “Keep Graphics with Cine Scroll” on the
Advanced M&A page.

Selecting a calculation

When you take measurements, you can select the calculation
before you take the measurement or after you take it. For
example, in Obstetrics, if you select the calculation before you
take the measurement, the estimated fetal age is displayed as
you take the measurement. If you select the calculation after you
take the measurement, the estimated fetal age is displayed after
you complete the measurement.

NOTE:  After you take a measurement, if you select a calculation and
the measurement is not applicable for the calculation, then the
system assumes you want to start the calculation. The system
then uses the calculation for the next measurement.
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Erasing measurements

The following actions erase measurements from the system's
memory:

* If you adjust the Trackball, unfreeze the image, or press
Clear, the system erases all completed measurements and
calculations on the display. Measurements and
calculations, however, remain on the worksheets.

+ If you select New Patient, the system erases all
measurements and calculations on the display and clears
the worksheets.

+ If you make a new measurement that exceeds the
maximum number of allowable measurements, the system
erases the first (oldest) measurement and adds the new
measurement.

+ If the second caliper is active, to erase the second caliper
and activate the first caliper, press Clear.
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General Instructions (continued)

7-14

HINTS

The following are actions you can take while performing
measurements.

+ Before making measurements, to stop the acquisition of
image data, press Freeze.

* For measurements such as distance, to make fine
adjustments before completing the measurements, press
the top Trackball key to toggle between active calipers.

+ Before completing the measurement sequence, to erase
the active measuring caliper and the current data
measured, press Clear.

+ After the sequence is complete, to erase all data that has
been measured to this point, but not data entered on
worksheet pages, press Clear.

*  When there are several measurements on the display, to
rotate through and activate previously fixed calipers, adjust
the Cursor Select knob. After a cursor is activated, you
can change the measurement.

NOTE: If you want to change a trace measurement, you
must erase it and trace again.

+ To repeat any measurement, select that measurement
again from the Touch Panel.

Calculation formulas are available in the Advanced Reference
Manual.
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Measurement Cursor

Cursor preset

While you are making a measurement, the measurement cusor
is either active (open plus sign) or fixed (closed plus sign). An
active cursor is green and a fixed cursor is yellow.

The system allows you to identify measurements by number or
by unique symbol. The symbols are used in sequence as listed.
The first symbol is used for the first measurement, the second
symbol for the second measurement, and so on.

T XK K QKHDH-

Figure 7-7. Fixed Caliper Symbols

Measurement graphics are kept while in cine scroll. The
measurement graphic is redisplayed on the frame where it is
taken, if preset on the Advanced M&A page.

You can preset the measurment cursor in Utility -> System ->
System Measure.

nt

Figure 7-8. System/System Measure Preset Menu

Table 7-3:  Cursor

Preset Parameter

Description

Cursor Type

Select whether to mark measurements with numbers or symbols.

Cursor Size

Specify 12x12 or 9x9.

Cursor Line Display

If selected, after you press Set to complete a measurement, the cursor line is
displayed. If not selected, after you press Set to complete a measurement,
only the cursor number or symbol is displayed.

Cursor Ellipse Cross Line
Display

Check box to display the cross line in Ellipse.
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Table 7-3:  Cursor (Continued)

Preset Parameter Description
D Manual Trace Cross Check box to display the cross line with the caliper.
Line Display
Cursor Position Select 1st Cursor, 2nd Cursor, or Image Center.
Color When Set (reboot) Select white, yellow, bright red, or orange.
Cursor is Displayed when The active cursor does not display until you move the Trackball. This
Trackball is Moved assumes the following presets are set: Repeat Measurement, Repeat,
Default Measurement, and Cursor.
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Copy, move and paste measurement tools

NOTE:

Copy and Paste

You can copy, move and paste the measurement graphic.

This function is supported with trace, area trace, spline trace,
volume trace, ellipse, 3-point ellipse, circle and intensity. The
Double tools and Dual tools are not supported.

Measure the trace.

If present, clear the active caliper using the Clear key. Press
the Arrow key to display the green arrow cursor on the
screen. Move the cursor to the + mark of the measurement
graphic. The selected graphic color changes from yellow to
green.

Press Set. The pop-up menu displays. Select Copy.

Copy & Move

Mowe

Cancel

Figure 7-9. Copy and Move Menu

Press Set on the outer side of the measurement graphic.
The pop-up menu displays.

Select Paste. The copied graphic displays on top of the
original graphic in green. Move it to the desired position
using the Trackball and press Set to fix the location.

NOTE: Ifthe copied graphic is bigger than the pasted area, "Paste”
fails and "The copied graphic cannot be pasted to this area”
message displays on the status bar.
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Copy and Move

Move

7-18

Measure the trace.

If present, clear the active caliper using the Clear key. Press
the Arrow key to display the green arrow cursor on the
screen. Move the cursor to the + mark of the measurement
graphic. The selected graphic color changes from yellow to
green.

Press Set. The popup menu displays. Select Copy&Move.

The copied graphic displays on top of the original graphic in
green. Move it to the desired position using the Trackball
and press Set to fix the location.

Measure the trace.

If present, clear the active caliper using the Clear key. Press
the Arrow key to display the green arrow cursor on the
screen. Move the cursor to the + mark of the measurement
graphic. The selected graphic color changes from yellow to
green.

Press Set. The pop-up menu displays. Select Move.

Move the selected graphic to the desired position using the
Trackball and press Set to fix the location.
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Performing Measurements on Saved Images

You can perform measurements on recalled images. Select the
image, then perform the measurement. If the image was not
saved as a raw DICOM image, you need to calibrate the image
prior to performing the measurement.

To calibrate the image,

1. Recall the image.

2. Press Measure. The Measurement Calibration Touch Panel
appears.

Figure 7-10. Meas. Calib Touch Panel

3. Select the mode you need to be in to perform the
measurement.

4. Press the appropriate mode key on the Touch Panel (2D
calib for B-Mode, MM calib for M-Mode, or Dop. calib for
Doppler mode). The specified mode calibration pop-up
appears.
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Performing Measurements on Saved Images (continued)

5. The system prompts you, depending on the mode.

B-Mode:

a. Place the first point of the caliper on the ruler. Press
Set.

b. Position the cursor at the 5 cm point on the ruler. Press
Set.

c. Type “5” into the 2D-Mode Calibration pop-up window.
Press OK.

2D-MODE CALIBRATION

Length of line [cm]

Cancel

Figure 7-11. 2D-Mode Calibration
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Performing Measurements on Saved Images (continued)

M-Mode or Doppler Mode:

a. Place the cross on zero depth and minimum or zero
time.

Place the cross on maximum depth and time.

Type the time (in seconds) and velocity (cm/sec) in the
M-Mode/Doppler Mode calibration pop-up window.

M-MODE CALIBRATION

Time interval [s]

Depth [cm]

Cancel

Figure 7-12. M-Mode Calibration

S/D-MODE CALIBRATION

Time interval [s]

Cancel

Figure 7-13. Doppler Mode Calibration
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General Measurements and Calculations

Overview

7-22

Generic Measurements

Each exam category has a Generic study. The Generic studies
provide you quick access to measurements such as volume,
angle, A/B ratio, and % stenosis. The particular measurements
available in each Generic study vary, depending on the exam
category and the mode. This section describes generic
measurements, organized by mode.

To access Generic studies:

1. On the Control Panel, press Measure.
2. On the Touch Panel, select Exam Calcs.
3. On the Touch Panel, select the Generic folder.

Calculation formulas are available in the Advanced Reference
Manual.
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Generic Measurements

B-Mode Measurements

In B-Mode, the Generic study includes the following
measurements:

% Stenosis

*  Volume

+ Angle

* Velocity

+ Stiffness

* V Ratio

+  Sitiff. Ratio
* A/B Ratio

Figure 7-14. B-Mode Generic Study

NOTE: The following instructions assume that you first scan the patient
and then press Freeze.
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General Measurements and Calculations

% Stenosis

Diameter

7-24

NOTE:

NOTE:

NOTE:

You can calculate % Stenosis by diameter or by area, depending
on the mode.

The LOGIQ P8/P9/P10 automatically activates the % Stenosis
with the default selection. If another method is preferred, select
it from the Touch Panel.

When you use diameter to calculate the %stenosis, always take
the measurement from a cross-sectional view of the vessel.

To calculate percent stenosis by diameter:

1.
2.

From the Generic Touch Panel, select % Stenosis.
Select %sten(Diam).
The system displays an active caliper.

Make a distance measurement of the inner area of the blood
vessel.

The system displays an active caliper for the second
distance measurement.

Make a distance measurement of the outer area of the blood
vessel.

The system displays each distance measurement and the
% Stenosis in the Results Window.

For details on how to make a distance measurement, See
‘Distance measurement’ on page 7-46 for more information. .

For the diameter calculation, do NOT take a distance
measurement from a longitudinal view. This may lead to an
inaccurate assessment of % stenosis.
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Generic Measurements

% Stenosis (continued)

Area

To calculate percent stenosis by area:

1.
2.

NOTE:

Ellipse + Area

From the Generic Touch Panel, select % Stenosis.
Select %sten(Area).
The system displays a caliper.

Make a trace measurement of the inner area of the blood
vessel.

To erase an open trace, move the Trackball.

Press Set.

The system displays a second caliper.

Make a trace measurement of the outer area of the blood
vessel.

The system displays the two area measurements and
percent stenosis in the Results Window.

To calculate percent stenosis by ellipse and area:

1.
2.

NOTE:

From the Generic Touch Panel, select % Sten[E+A] folder.
Ellipse is selected by default.

The system displays a caliper.

You can select the trace at this time.

Make an ellipse measurement of the inner area of the blood
vessel.

Press Set.

The system displays a caliper.

Make a trace measurement of the outer area of the blood
vessel.

The system displays the two area measurements and
percent stenosis in the Results Window.

NOTE: % Stenosis (E+A) is not available through the factory default. To
enable %Stenosis (E+A), add “%Steno(E+A)” to the Measure &
Study list on the Utility -> Measure -> M&A screen.
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General Measurements and Calculations

Volume

7-26

NOTE:

NOTE:

NOTE:

The volume calculation can be made from any of the following
measurements:

+ One distance

+ Two distances

* Three distances

*  One ellipse

* One distance and one ellipse

For details on how to make a distance measurement, See
‘Distance measurement’ on page 7-46 for more information.

For details on how to make an ellipse measurement, See
‘Circumference and area (ellipse) measurement’ on page 7-48
for more information.

IMPORTANT!! If you want to make a volume calculation using
one or two distances, you must select Volume BEFORE you
make the measurements.

If you select Fix Caliper by Print Key on the Utility --> System -->
System Measure, the print key does not function like the Set
key, but instead ends the measurement sequence and initiates
the volume calculation based on the number of measurements
taken so far.

To make a volume calculation using one or two distances:

1. Select Volume.

2. Make one or two distance measurements.

3. Select Volume.
The system displays the distances and the volume in the
Results Window.
Use the Clear key to erase the green caliper.
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Generic Measurements

Volume (continued)

To make a volume calculation using three distances:

1.

Make three distance measurements.

NOTE: Three distances can be done in the dual format mode (side
by side images). One measurement is usually made in the
sagittal plane and two measurements in the axial plane. To
use the dual format mode, press the L or R key on front
panel.

2. Select Volume.
The system displays the distances and the volume in the
Results Window.

To make a volume calculation using one ellipse:

1. Make one ellipse measurement.

2. Select Volume.
The system displays the ellipse measurement and the
volume in the Results Window.
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General Measurements and Calculations

Volume (continued)

7-28

NOTE:

To make a volume calculation using one ellipse and one
distance:

1.

Make one distance measurement and one ellipse
measurement.

Select Volume.

The system displays the distance and ellipse measurement
and the volume in the Results Window.

Volumes are most accurate when measurements are taken
in the sagittal and axial scan planes.

To display sagittal and axial plane images simultaneously,
use the side-by-side dual format option.

If you change the parameters or category during the volume
measurement, please follow the procedure below before you
restart the measurement.

1.

Check the number of each measurement in the summary
window.

If the numbers are not all the same, it shows that you have
the calculation which is not completed. Open the Worksheet
and clear that calculation.
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Generic Measurements

Volume (continued)

Table 7-4:  Volume Calculations

Calc Name

Input Measurements

Volume (spherical)

One distance

Volume (prolate spheroidal)

Two distances, d1>d2

Volume (spheroidal)

Three distances

Volume (prolate spheroidal)

One ellipse: (d1 major axis, d2 minor axis)

Volume (spheroidal)

One distance d1, and one ellipse (d2 major axis, d3 minor axis)

Figure 7-15. Volume Calculation Examples

One distance

Two distances

Three distances

One ellipse

One distance and one ellipse

ok wbd=

Calculation formulas are available in the Advanced Reference
Manual.
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General Measurements and Calculations

Volume (continued)

Post-assignment for General Volume
You can input a unique name for the general volume
measurement. You can group the general volume
measurements for each application.
1. Complete the volume measurement.

2. Move the caliper to the measurement result box (with green
frame) and select Set.

3. The volume name menu appears. Select Name Volume.

| dl 6.52cm
|2 d2 5.14cm| N

|3d3 433cm| De
| Vol 75.97 ml|

Figure 7-16. Volume Name menu

4. The dialog box displays. Enter a new name or choose the
existing name.

Figure 7-17. Volume Name Dialog box

NOTE: The factory default volume name cannot be changed (for
example, Renal Volume).
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Generic Measurements

Angle
This function measures the angle between two intersecting
planes.
1. From the Generic Touch Panel, select Angle.
The system displays an active caliper.
2. To position the caliper at the start point, move the Trackball.
3. To fix the position of the first caliper, press Set.
The system displays a second active caliper.
4. To position the second caliper at the apex of the angle,
move the Trackball.
5. To fix the position of the second caliper, press Set.
The system displays a third active caliper.
6. To position the third caliper, move the Trackball.
7. To complete the angle measurement, press Set.
The system displays the angle in the Results Window.
NOTE: To rotate through and activate previously fixed calipers, adjust
the Cursor Select control.
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A/B Ratio

In B-Mode, you can calculate A/B ratio by diameter or by area.

NOTE: The LOGIQ P8/P9/P10 automatically activates the A/B Ratio
with the default selection. If another method is preferred, select
it from the Touch Panel.

Diameter
1. From the Generic Touch Panel, select A/B Ratio.
2. Select ratio(Diam).
The system displays an active caliper.
3. Make a distance measurement of the first diameter.

The system displays an active caliper for the second
distance measurement.

4. Make a distance measurement of the second diameter.
The system displays each distance measurement and the
A/B ratio in the Results Window.
NOTE: The first distance is the A diameter. The second distance is the
B diameter.

For details on how to make a distance measurement, See
‘Distance measurement’ on page 7-46 for more information.

Area
To calculate A/B ratio by area:

1. From the Generic Touch Panel, select A/B Ratio.
2. Select ratio(Area).
The system displays a caliper.
3. Make a trace measurement of the A area.
NOTE: To erase an open trace, move the Trackball.

The system displays a second caliper.

4. Make a trace measurement of the B area.
The system displays the two area measurements and the
A/B ratio in the Results Window.

For details on how to make a trace measurement, See
‘Circumference and area (trace) measurement’ on page 7-49 for
more information.

Dual Caliper
If “Dual Caliper on Simultaneous” is checked in Utility -->
System --> Sysem Measure menu, dual caliper is automatically
enabled when you ener simulaneous view.

7-32 LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2



Generic Measurements

Velocity and Stiffness Ratios

If set to display via configuration settings, these two
measurements appear. Refer to Elastography Option
documentation.
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General Measurements and Calculations

M-Mode Measurements
In M-Mode, the Generic study includes the following
measurements:

% Stenosis
« A/B Ratio
* HR (Heart Rate)

Figure 7-18. M-Mode Generic Study

% Stenosis

See ‘% Stenosis’ on page 7-24 for more information.
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Generic Measurements

A/B Ratio
In M-Mode you can measure A/B ratio by diameter, time, or
velocity.

NOTE: The LOGIQ P8/P9/P10 automatically activates the A/B Ratio
with the default selection. If another method is preferred, select
it from the Touch Panel.

Diameter
See ‘Diameter’ on page 7-32 for more information.
Time
To calculate A/B ratio by time:
1. Select A/B.
2. Select ratio(Time).
The system displays an active caliper.
3. To position the caliper at the A point, move the Trackball.
4. To fix the measure point, press Set.
The system displays a second active caliper.
5. To position the second caliper at the B point, move the
Trackball.
6. To complete the measurement, press Set.
The system displays the two time measurements and A/B
ratio in the Results Window.
Velocity
To calculate AB ratio by velocity:
1. Select A/B.
2. Select ratio(Velocity).
The system displays an active caliper with vertical and
horizontal dotted lines.
3. To position the caliper at the A velocity, move the Trackball.
4. To fix the measure point, press Set.
The system displays a second active caliper.
5. To position the second caliper at the B velocity, move the
Trackball.
6. To complete the measurement, press Set.
The system displays the two velocity measurements and the
A/B ratio in the Results Window.
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General Measurements and Calculations

Heart Rate

To calculate the heart rate from M-Mode:

1.

NOTE:

Obtain an image and press Measure. Select HR.
The system displays an active caliper.

To position the caliper at a recognizable point in the first
cycle, move the Trackball.

To fix the first caliper, press Set.
The system displays a second active caliper.

To position the caliper at the identical point in the next cycle
(depending on preset), you need to move the Trackball.

In the message bar at the bottom of the display, the system
indicates the number of cycles you should measure.

INVERT;

AAAAAAA

Figure 7-19. Two Heart Beat Reference (example in Doppler
mode)

5. To complete the measurement and transfer the calculation

to the worksheet, press Set.

NOTE: For information about how to specify the number of heart beats
that the system will use, See ‘Options tab’ on page 7-9 for more
information.
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Generic Measurements

Doppler Mode Measurements

In Doppler Mode, the Generic study includes the following
measurements:

PI (Pulsatility Index)

RI (Resistive Index)

PS/ED Ratio or ED/PS Ratio
A/B Ratio

HR (Heart Rate)

Figure 7-20. Doppler Mode Generic Study

NOTE: The following instructions assume that you do the following:

1.

In the B-Mode part of the display, scan the anatomy you
want to measure.

2. Go to the Doppler Mode part of the display.
3. Press Freeze.
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General Measurements and Calculations

Control Assignment

Cancel Transfer

NOTE:

Vessel location

7-38

NOTE:

Only for Vascular, Abdomen, OB and GYN.

After the Auto Vascular calculation results are assigned to a
particular vessel, the user can cancel the assignment and
assigned parameters are removed from Worksheet and Report

page.

When Cancel Transfer occurs, a message appears on the
screen to indicate the value was erased from Worksheet and
Report page.

If the vessel has a location, you can select one of the following:
* Proximal (Prox)

+ Middle (Mid)

+ Distal (Dist)

If you do not wish to assign a vessel location, press the lit
location, then no location is assigned. Choose the folder you
want the value assigned fto.

To select one of the locations, adjust the Touch Panel control.

LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2



Generic Measurements

Pulsatility Index (PI)

For auto trace:

1.

Select PI.

The system displays a caliper and a vertical dotted line.
Position the caliper at the beginning of the waveform.
To fix the start point, press Set.

The system displays a second active caliper.

Position the caliper at the end of the waveform.

To complete the measurement, press Set.

The system displays peak systole, minimum diastole, end
diastole, TAMAX, and Pl in the Results Window.

For manual trace:

1. Select PI.
The system displays a caliper and a vertical dotted line.

2. Position the caliper at the beginning of the waveform.

3. Tofix the start point, press Set.
The system displays a second active caliper.

4. Manually trace the entire waveform.

5. To complete the measurement, press Set.
The system displays peak systole, minimum diastole, end
diastole, TAMAX, and Pl in the Results Window.
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General Measurements and Calculations

Resistive Index (RI)

1. From the Doppler Generic Touch Panel, select RI.

The system displays an active caliper with vertical and
horizontal dotted lines.

2. To position the caliper at the peak systolic velocity, move the
Trackball.

3. To fix the measure point, press Set.
The system displays a second active caliper.

4. To position the second caliper at the end diastolic velocity,
move the Trackball.

5. To complete the measurement, press Set.

The system displays PS, ED, and Rl in the Results Window.
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PS/ED or ED/PS Ratio

To calculate the Peak Systole/End Diastole ratio or End
Diastole/Peak Systole ratio:

1.

Select PS/ED or ED/PS.

The system displays an active caliper with vertical and
horizontal dotted lines.

To position the caliper at peak systole (PS) or end diastole
(ED), move the Trackball.

To fix the measure point, press Set.
The system displays a second active caliper.

To position the second caliper at end diastole (ED) or peak
systole (PS), move the Trackball.

To complete the measurement, press Set.

The system displays the peak systole, end diastole, and PS/
ED or ED/PS ratio in the Results Window.

Heart Rate
To measure heart rate, See ‘Heart Rate’ on page 7-36 for more
information. or select any of the following measurements.
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General Measurements and Calculations

A/B Ratio

In Doppler Mode you can measure A/B ratio by velocity, time, or
acceleration.

NOTE: The LOGIQ P8/P9/P10 automatically activates the A/B Ratio
with the default selection. If another method is preferred, select
it from the Touch Panel.

Velocity

See ‘Velocity’ on page 7-35 for more information.

Time

See ‘Time’ on page 7-35 for more information.

Acceleration

To measure A/B ratio by acceleration:
1. Select A/B.
2. Select ratio(Acc).
The system displays an active caliper.
3. Make a distance measurement of the A acceleration point.

a.

To position the active caliper at the start point, move the
Trackball.

To fix the start point, press Set.

The system fixes the first caliper and displays a second
active caliper.

To position the second active caliper at the end point,
move the Trackball.

A dotted line connects the measurement points.
To complete the measurement, press Set.
The system displays the distance value in the Results

Window and displays an active caliper for the second
distance measurement.

4. To make a distance measurement of the B acceleration
point, repeat steps a—d.

The system displays the two acceleration measurements
and the A/B ratio in the Results Window.

7-42

LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2



Generic Measurements

Acceleration

Acceleration Time (AT)

Select Accel.

The system displays an active caliper with vertical and
horizontal dotted lines.

To position the caliper at peak systole, move the Trackball.
To fix the measure point, press Set.
The system displays a second active caliper.

To position the second caliper at end diastole, move the
Trackball.

To complete the measurement, press Set.

The system displays the peak systole, end diastole,
acceleration time, and acceleration in the Results Window.

Select AT.

The system displays an active caliper and a vertical dotted
line.

To position the caliper at the start point, move the Trackball.
To fix the first caliper, press Set.

The system displays a second active caliper.

To position the caliper at the end point, move the Trackball.
To complete the measurement, press Set.

The system displays the acceleration time in the Results
Window.

Peak Systole (PS), End Diastole (ED), or Minimum Diastole (MD)

To calculate the peak systole, end diastole, or minimum diastole:

1.

Select PS, ED, or MD.

The system displays an active caliper with vertical and
horizontal dotted lines.

2. To position the caliper at the measurement point, move the
Trackball.
3. To complete the measurement, press Set.
The system displays the peak systole, end diastole, or
minimum diastole in the Results Window.
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General Measurements and Calculations

Helpful hints

HINTS The following hints can help when making a measurement

»  Prior to making measurements, use the Cine function, if
necessary, to display the best image.

* As you take measurements, each measurement is given a
sequential number on the display and in the Results
Window. Nine measurements can be displayed in the
Results Window at one time.

*  Once the Results Window has nine measurements, if you
make any further measurements, the system erases the
top (first) measurement and adds the new measurement
last ("first in, first out").

*  While you are taking a measurement, the value in the
Results Window updates until you complete the
measurement.
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Mode Measurements

Mode Measurements

B-Mode Measurements

The following measurements can be made in B-Mode.

+ Distance
+ Circumference
+ Circumference and Area
* Ellipse Method
+ Trace Method
+  Spline Method
* Intensity (Echo level) Method

NOTE: The following instructions assume that you first scan the patient
and then press Freeze.

f CAUTION DO NOT perform a depth measurement using 4D probes.
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General Measurements and Calculations

Distance measurement

To make a distance measurement:

1.
2.

7-46

Press Measure once; an active caliper displays.

To position the active caliper at the start point, move the
Trackball.

To fix the start point, press Set.

The system fixes the first caliper and displays a second
active caliper.

To position the second active caliper at the end point, move
the Trackball.

A dotted line connects the measurement points, if preset
accordingly.

To complete the measurement, press Set.

The system displays the distance value in the Results
Window.

Before you complete a measurement:

+ To toggle between active calipers, press the top
Trackball key.

+ To erase the second caliper and the current data
measured and start the measurement again, press
Clear once.

After you complete the measurement:

+ Torotate through and activate previously fixed calipers,
adjust Cursor Select.

* To erase all data that has been measured to this point,
but not data entered onto worksheets, press Clear.
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Mode Measurements

Circumference measurement

Open Trace

To trace the circumference of a portion of the anatomy and
calculate its length:

NOTE:  Set OpenTrace to the Touch Panel in Utility -> Measure before
perform the measurement. See ‘Display/hide a folder or a
measurement in the Touch Panel’ on page 7-94 for more
information.

1.

2.
3.
4

Press Measure.
Select Open Trace from the Touch Panel.
Position the caliper at the start point.

To fix the trace start point, press Set. The caliper changes to
an active caliper.

Move the Trackball to trace the measurement area. A
dotted line shows the traced area.

To complete the measurement, press Set. The system
displays the circumference in the Results Window.
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General Measurements and Calculations

Circumference and area (ellipse) measurement

You can use an ellipse to measure circumference and area. To
measure with an ellipse:

1.
2.
3.

7-48

Press Measure once; an active caliper displays.
To position the active caliper, move the Trackball.

To fix the start point, press Set. The system fixes the first
caliper and displays a second active caliper.

To position the second caliper, move the Trackball.
Adjust the Ellipse control; an ellipse with an initial circle
shape displays.

To position the ellipse and to size the measured axes (move
the calipers), move the Trackball.

To increase the size, adjust the Ellipse control in a
clockwise direction. To decrease the size, adjust the Ellipse
control in a counterclockwise direction.

To toggle between active calipers, press the top Trackball
key.

To complete the measurement, press Set. The system
displays the circumference and area in the Results Window.

Before you complete the ellipse measurement:

To erase the ellipse and the current data measured, press
Clear once. The original caliper is displayed to restart the
measurement.

To exit the measurement function without completing the
measurement, press Clear a second time.
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Mode Measurements

Circumference and area (trace) measurement

To trace the circumference of a portion of the anatomy and
calculate its area:

1.
2.

Press Measure.

Press the top Trackball key to select Trace; a caliper
displays.

To position the caliper at the start point, move the Trackball.

To fix the trace start point, press Set. The caliper changes to
an active caliper.

To trace the measurement area, move the Trackball around
the anatomy. A dotted line shows the traced area.

To complete the measurement, press Set. The system
displays the circumference and the area in the Results
Window.

Before you complete the trace measurement:

To erase the line (bit by bit) back from its current point,
move the Trackball or adjust the Ellipse control
counterclockwise.

To erase the dotted line but not the caliper, press Clear
once.

To clear the caliper and the current data measured, press
Clear twice.
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General Measurements and Calculations

Circumference and area (spline trace) measurement

7-50

NOTE:

NOTE:

NOTE:

NOTE:

To trace the circumference of a portion of the anatomy and
calculate its area:

Spline trace is not available through the factory default. The
system defaults to trace. To enable spline trace, modify the
Measure Key Sequence preset found in Utility -> Measure ->
Advanced preset menu.

1.
2.

Press Measure.

Press the top Trackball key to select Spline Trace; a caliper
displays.

To position the first caliper at the start point, move the
Trackball.

To fix the trace start point, press Set. The first caliper turns
yellow. The second caliper appears at the same position as
the first caliper and is green.

When pressing the Clear key once, the second caliper
disappears and the first caliper is activated.

If Clear is pressed again, the first caliper disappears and the
Spline trace is cancelled.

To position the second caliper, move the Trackball and
press Set. The third caliper appears at the same position.

The Clear key functionality is the same as noted in the
previous step.

The spline trace requires at least three points to draw the
trace. Continue setting the points of the trace until the
desired points are set.

Press Set again after the last caliper is fixed to finalize the
spline trace. All points are removed from the line and the
spline trace turns yellow.

Pressing Set twice finishes the trace measurement.

If Clear is pressed twice when more than 3 points exist on
the trace, all points are removed and the first caliper again
displays.
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Mode Measurements

Circumference and area (spline trace) measurement (continued)

Edit the spline trace

NOTE:

NOTE:

NOTE:
NOTE:

Select Cursor Select. The spline trace changes to green
and all points appear on the trace as yellow.

A pick-caliper appears on the center of the image and the
message “Edit spline trace” displays at the bottom of the
screen.

The pick-caliper is used to select and move the trace points.

Figure 7-21.  Edit spline trace

Select Cursor Select again. The trace is deactivated
(changes to yellow) and all points, including the pick-caliper,
are removed.

If the previous/next fixed caliper exists on the image, it is
activated.

Pressing Clear at this time removes all points and the trace
graphic.

Move the pick-caliper to the desired point and press Set.
The point is activated and turns green.

Move the point to the desired position and press Set. The
point is fixed and turns yellow. The pick-caliper appears on
the center of the image.

The spline trace is updated at run time.

To remove a point, press Clear while moving the point. The
trace turns green and the remaining points continue to be
shown as yellow. If there are less than three points, the
spline trace is removed.

Press Set again. All points are removed from the trace and
the trace is shown as yellow.
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General Measurements and Calculations

Intensity (Echo level) measurement

7-52

NOTE:

NOTE:

To make an echo level measurement:

1.
2.

Press Measure.

Press the top Trackball key to select Intensity. A caliper
displays.
To position the caliper at the start point, move the Trackball.

To fix the trace start point, press Set. The caliper changes to
an active caliper.

To trace the measurement area, move the Trackball around
the anatomy. A dotted line shows the traced area.

To complete the measurement, press Set. The system
displays the echo level, as EL __ dB, in the Results Window.

The echo level measurement is only available on a frozen
image, not on a B-paused image.

Echo Level is not available through the factory default. To
enable echo level, modify the Measure Key Sequence preset,
found in the Utility -> Measure -> Advanced preset.
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Doppler Mode Measurements

Five basic measurements can be made in Doppler Mode.

Velocity
TAMAX and TAMEAN (Manual or Auto Trace)

Two Velocities with the Time Interval and Acceleration
between them

Time Interval
Volume Flow

NOTE: The following instructions assume that you do the following:

1.

In the B-Mode part of the display, scan the anatomy you
want to measure.

2. Go to the Doppler Mode part of the display.
3. Press Freeze.
Velocity
To measure velocity:
1. Press Measure; an active caliper with a vertical dotted line
displays.
2. To position the caliper at the desired measurement point,
move the Trackball.
3. To complete the measurement, press Set. The system
displays the velocity measurement in the Results Window.
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Slope (Velocity, Time Interval and Acceleration)

Time interval

7-54

To measure two velocity values, the time interval (ms), and
acceleration (m/s?):

1.

Press Measure. Press the top Trackball key to select Slope;
an active caliper with vertical and horizontal dotted lines
displays.

To position the caliper at the start point, move the Trackball.

To fix the start point, press Set. The system fixes the first
caliper and displays a second active caliper.

To position the second caliper at the end point, move the
Trackball.

To complete the measurement, press Set. The system
displays the two peak end point velocities, the time interval,
and the acceleration in the Results Window.

To measure a horizontal time interval:

1.

Press Measure. Press the top Trackball key to select Time;
an active caliper with vertical and horizontal dotted lines
displays.

To position the active caliper at the start point, move the
Trackball.

To fix the start point, press Set. The system fixes the first
caliper and displays a second active caliper.

To position the second caliper at the end point, move the
Trackball.

To complete the measurement, press Set. The system
displays the time interval between the two calipers in the
Results Window.
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TAMAX and TAMEAN

Manual Trace

The value measured depends upon the Vol Flow Method preset.
The two selections available are: Peak (TAMAX) and Mean
(TAMEAN).

To do a manual trace of TAMAX or TAMEAN:

1.

Press Measure. Press the top Trackball key to select
Trace; a caliper displays. Select Manual on the Touch
Panel.

2. To position the caliper at the trace start point, move the
Trackball.

3. To fix the start point, press Set.

4. To trace the velocity spectrum boundary, move the
Trackball.
NOTE: To edit the trace line, move the Trackball.

5. To complete the measurement, press Set. The system
displays the measurement values in the Results Window.
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TAMAX and TAMEAN (continued)

Auto Trace

7-56

NOTE:

The value measured depends upon the Vol Flow Method preset.
The two selections available are: Peak (TAMAX) and Mean
(TAMEAN).

To auto trace TAMAX:

1.

Press Measure. Press the top Trackball key to select
Trace; an active caliper with a vertical dotted line displays.
Select Auto on the Touch Panel.

To position the caliper at the trace start point in the Doppler
spectrum, move the Trackball.

To fix the start point, press Set.

To position the vertical caliper at the end point, move the
Trackball.

To complete the measurement, press Set. The system
automatically fixes both calipers and traces the maximum
value between the two points. The system displays this
value in the Results Window.

When you set the Auto Trace for Both (above and below),
the system picks up the maximum power of the signal, NOT
the maximum velocity. If the maximum velocity is not the
maximum power, the system may not trace accurately. If
you want to use maximum velocity, select either Above or
Below.
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Edit Trace

NOTE:

NOTE:

NOTE:

NOTE:

NOTE:

Auto Trace can be edited after taking an Auto Trace
measurement.

1.

After taking an Auto Trace measurement, select the
measurement result on the result window. The Edit Trace
(Edit Peak or Edit Mean) menu window appears.

If the system cannot take the trace data correctly from the
image, Edit Trace does not work.

Select Edit Trace. The first caliper (manual trace caliper)
appears on the center of the image. Use the Trackball to
move the caliper on the trace line to the start point.

To cancel Edit Trace at this time, press Clear, Scan, or
Freeze.

Press Set to fix the first caliper. The second caliper appears.
Edit the trace manually using the second caliper.

The Ellipse control is used to edit the trace.
When pressing the Clear key once at this time, the second

caliper disappears and the first caliper appears in the center
of the image.

If you press Scan or Freeze at this time, the caliper is
automatically fixed and the result window updates.

Press Set to fix the second caliper. The trace and the result
window update. The trace data (TAMAX and TAMEAN) are
updated, though the other points (e.g. PS, ED) are not
updated by trace. The points can be edited with Cursor
Select.

While in Edit Trace, Cursor Select is disabled.

Repeat Edit Trace as needed.
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Doppler Auto Calc Average Cycle

When using Auto Calc, a selection is available to average a
number of cycles automatically. There is also a preset selection
in the Utility Imaging PW page for this feature. When using
average cycle:

Selected cardiac cycle lines display on the image. Point
calipers are not displayed.

When changing the number of cycles from 1 to >1, all the
data is reacquired from the image, recalculated and
updated.

When multiple cycles are selected in AutoCalc, the average
values calculate and display automatically.

When selecting Peak Value (PV), average cycle is not
available.

NOTE: You cannot edit the lines while in Average Cycle. Cursor Select
is not available at that time.

NOTE:  Average Cycle data is acquired from the display image area
only, for both live and frozen. The average cycle data fails if the
setting for the number of cycles is larger than the number of
image cycles.

7-58

Figure 7-22. PW Touch Panel (Page 2)
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Volume Flow - Manual Calc

You perform a manual Volume Flow measurement using the
TAMAX plus a Volume Flow coefficient compensation.

1. To perform the Volume Flow measurement using the
TAMAX plus a Volume Flow coefficient compensation, in
Utility-->Measure-->Advanced, select the following:

* Trace = Manual
* Vol Flow Method = TAMAX [you MUST also select a
Volume Flow coefficient for use with TAMAX.]

* Vol Flow Compensation with TAMAX = [select value
from 0.5 to 1.0]

2. Set Auto Calcs to Off via Doppler Mode-->Modify Auto
Calcs-->Off.

3. Select a folder in Doppler Mode-->select a calculation
folder-->select Show All.

4. Select Volume Flow. You'll notice that TAMAX is
automatically selected.

NOTE: Ensure that you have placed the caliper in the spectral
window when selecting the Volume Flow measurement.

5. Trace the TAMAX. The system prompts you to “Mark the
first point on the spectral doppler.” Press Set.

6. The system prompts you to “Trace the velocity spectrum
boundary.” Press Set.

NOTE: You can back up while tracing the TAMAX by using the
Trackball.

7. Trace the vessel diameter. The system prompts you to
“Mark first point of vessel diameter for volume flow
calculation.” Press Set.

8. The system prompts you to “Mark last point of vessel
diameter for volume flow calculation.” Press Set.

9. The Volume Flow is calculated in ml/min.
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Volume Flow - Auto Calc

7-60

NOTE:

You can perform an automatic Volume Flow measurement using
TAMEAN or using the TAMAX and a Volume Flow coefficient.

1.

To perform the Volume Flow measurement using the
TAMEAN, in Utility-->Measure-->Advanced, select the
following:

 Trace = Auto
* Vol Flow Method = TAMEAN

OR, to perform the Volume Flow measurement using the
TAMAX plus a Volume Flow coefficient compensation,
select the following:

+ Trace = Auto

* Vol Flow Method = TAMAX [if you use TAMAX, you
MUST also select a Volume Flow coefficient for use with
TAMAX.]

* Vol Flow Compensation with TAMAX = [select value
from 0.5 to 1.0]

Set Auto Calcs to Live via Doppler Mode-->Modify Auto
Calcs-->Live.

Perform the scan.

Select Volume Flow via Doppler Mode-->Modify Auto

Calcs-->VOLUME FLOW. The system prompts you through
the measurement.

Take vessel diameter for volume flow calculation. Set the
first cursor.

Mark last point of vessel diameter for volume flow
calculation. Press Set.

The calculation automatically completes the Volume Flow
measurements as ml/min.

If you change the TAMAX coefficient, the Volume Flow is
automatically adjusted when in Auto Calcs (but not in
Manual Calcs).
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Flow Volume (FV)

Flow Volume estimates the volume of blood that flows through a
vessel per unit time. It is derived from a vessel's cross-sectional
diameter obtained from the B-Mode portion of the image and the
mean velocity of flow in the vessel obtained from the Doppler
portion of the image. It is measured in milliliters. When the FV
measurement is made, FVO is automatically calculated.

To measure flow volume:

1. Select FV from Doppler Touch Panel.

2. Place the dotted horizontal line caliper at each of the time
base on the Doppler spectrum.

» If Trace Auto is selected, the waveform is automatically
traced.

+ If Trace Auto is not selected, manually trace the desired
portion of the waveform.

The caliper moves to the B-Mode area.

3. Use the Ellipse or Trace method to measure the
circumference and area of the vessel.

The flow volume (FV) is calculated and displayed in
milliliters. The flow volume output (FVO) is also calculated
and displayed in milliliters/minute.

Flow Volume Output (FVO)

This measurement is used to measure the flow volume output in
a vessel on the Doppler spectrum. It is measured in milliliters/
minute. When the FVO measurement is made, FV is
automatically calculated.
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Auto vs. Manual Calculations

The same calculations can be performed using either manual or
auto calcs.

Manual Calcs
To perform manual calcs:

1. To turn Auto Calcs off and perform manual measurements,
choose Auto Calcs -> OFF on the PW tab of the Touch
Panel.

2. After obtaining a waveform, press Measure. Choose the
appropriate vessel folder or calculation. The system walks
you through the measurement.

NOTE: To program which calculations are done under manual calcs
when using measurement folders for measuring specific
vessels, press the Utility key. Select Measure -> Doppler and
program your manual calcs (Auto Calcs OFF). Each vessel must
be programmed individually and saved after each change.
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Auto Calcs

To perform auto calcs:

1.

Ensure that the auto calcs function is on by choosing Auto
Calcs -> Frozen or Live on the Doppler tab of the Touch
Panel.

» Live: Auto calculation activates when the system is in
real-time.

* Frozen: Auto calculation activates when you press
Freeze.

+  Off

After obtaining a waveform, press Measure. Choose the
appropriate vessel folder, side and location. The
measurements that are pre-programmed are performed
automatically and entered in the worksheet.

To modify auto calcs:

1.
2.
3.

Select Modify Auto Calcs on the Touch Panel.
Choose the measurements to be performed with this preset.
To save these measurements:

» If this is a temporary change, press Return.
+ If this is a permanent change, select Save as default.

The measurements are saved and can be performed with
the auto calcs function.
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Edit Auto Calcs

NOTE:

NOTE:

NOTE:

NOTE:

NOTE:

7-64

Auto Calcs can be edited after taking an Auto Trace
measurement.

1.

After taking an Auto Calc with a trace, select the
measurement result on the result window. The Edit Trace
menu window appears.

If the system cannot take the trace data correctly from the
image, Edit Trace does not work.

Select Edit Trace. The first caliper (manual trace caliper)
appears on the center of the image. Use the Trackball to
move the caliper on the trace line to the start point.

To cancel Edit Trace at this time, press Clear, Scan, or
Freeze.

Press Set to fix the first caliper. The second caliper appears.
Edit the trace manually using the second caliper.

The Ellipse control is used to edit the trace.

When pressing the Clear key once at this time, the second
caliper disappears and the first caliper appears in the center
of the image.

If you press Scan or Freeze at this time, the caliper is
automatically fixed and the result window updates.

Press Set to fix the second caliper. The trace and the result
window are updated. The data is retaken from the trace and
updated.

While in Edit Trace, Cursor Select is disabled.
The trace data (TAMAX and TAMEAN) is updated, but the

other selections (e.g. PS, ED) are not updated by trace. The
points can be edited using Cursor Select if needed.

Repeat Edit Trace as needed.
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Modify Auto Calcs

When you select this key, the Modify Calculation menu is
displayed as below. In this menu, you select parameters to
display in the Auto Vascular Calculation window. Only
parameters that can be used by the calculation are displayed.

Select Save as Default to save the selected parameters as the
default calculations for this application.

Select Return to return to the previous Touch Panel screen.

If you select PV, all selected parameters are turned off. When
you deselect PV, the system returns to the previously selected
calculation.

Figure 7-23. Modify Auto Calculation Menu (Page1)
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M-Mode Measurements

Basic measurements that can be taken in the M-Mode portion of
the display are:

+ Tissue Depth (Distance)

* Time Interval

+ Time Interval and Velocity

f CAUTION DO NOT perform a depth measurement using 4D probes.

NOTE: The following instructions assume that you do the following:
1. In the B-Mode part of the display, scan the anatomy you
want to measure.
2. Go to the M-Mode part of the display.
3. Press Freeze.

Tissue depth

Tissue depth measurement in M-Mode functions the same as
distance measurement in B-Mode. It measures the vertical
distance between calipers.

1. Press Measure once; an active caliper with a vertical and
horizontal dotted line displays.

2. To position the active caliper at the most anterior point you
want to measure, move the Trackball.

3. To fix the start point, press Set.

The system fixes the first caliper and displays a second
active caliper.

4. To position the second caliper at the most posterior point
you want to measure, move the Trackball.

5. To complete the measurement, press Set.

The system displays the vertical distance between the two
points in the Results Window.
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Time interval

To measure a horizontal time interval and velocity:

1.

Press Measure. Press the top Trackball key to select Time;
an active caliper with vertical and horizontal dotted lines
displays.

To position the caliper at the start point, move the Trackball.

To fix the first caliper, press Set. The system fixes the first
caliper and displays a second active caliper.

To position the second caliper at the end point, move the
Trackball.
To complete the measurement, press Set. The system

displays the time interval between the two calipers in the
Results Window.

Slope (Time interval and Velocity)

To measure time and velocity between two points:

1.

Press Measure. Press the top Trackball key to select Slope;
an active caliper with vertical and horizontal dotted lines
displays.

2. To position the active caliper at the start point, move the
Trackball.

3. To fix the start point, press Set.
The system fixes the first caliper and displays a second
active caliper.

4. To position the second caliper at the end point, move the
Trackball.

5. To complete the measurement, press Set.
The system displays time(s) and slope between the two
points in the Results Window.
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Worksheet

Introduction

The worksheet function enables the user to review, edit, delete
or print data independently of a report. All measurements and
calculations taken during the examination can be viewed at any
time using the worksheet.

As you complete measurements, the system puts measurement
data in the appropriate worksheets.

NOTE: Worksheets are not saved if the system crashes.
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To view a worksheet

To view a worksheet, select Worksheet on the Touch Panel.
OR
Select Worksheet on the measurement summary window.

The system displays the worksheet for the current study.

Figure 7-24. OB Worksheet

The OB Worksheet has three sections of information:

1. Patient data
2. Measurement information
3. Calculation information

To return to scanning, do one of the following:

» Select Worksheet.
* Press Esc.
»  Select the Exit button.
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To view a worksheet (continued)

To view a different worksheet, select the worksheet key for the
desired worksheet.

O Workshoot [ ]

o Expand

Figure 7-25. Worksheet Display Touch Panel

To view worksheet data for a particular mode, select the key for
that mode. To view a worksheet with data for more than one
mode, select Expand. When Expand is selected, it defaults to
view all measurements, noted by mode, on the worksheet.

If a worksheet has more data on a second page, to view the next
page, adjust the Page Change control.
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Worksheet

To edit a worksheet

HINTS

Change data

NOTE:

Exclude data

Some fields on the worksheet are view only, and others you
can change or select. To easily see which fields you can
change or select, move the Trackball. As the cursor moves
over a field that you can change or select, the field is
highlighted.

1. Select Worksheet from any page of the Vascular
Calculation Touch Panel.

2. Position the cursor at the field you want to change by
moving the Trackball.

The cell is highlighted. Press Set. The field backlights.

3. Type the new data in the field and move the cursor to
another place. Press Set. The new data, displayed in blue
with an asterisk, is appended to the updated value and
resultant value to indicate that it was manually entered.

The average measurements, calculations and ratios are
automatically updated to reflect the edited values.

If the user moves the cursor to the edited value and presses the
Set key once, the value returns to the original value before the
edit was made.

When the user selects a particular value on the Worksheet and
selects Exclude Value, this value is excluded from result line
and resultant value is re-calculated without this value and also
calculation values using this value is ‘blank’.

1. To position the cursor at the field you want to delete or
exclude, move the Trackball. The field is highlighted.
2. Do one of the following:

« To exclude the field, select Exclude Value.

The data in the field is not visible and is not included in
worksheet calculations.

+ Toinclude a value that you previously excluded, select
Exclude Value.
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To edit a worksheet (continued)

Delete data

7-72

For
1.

Select Worksheet from any page of the Vascular
Calculation Touch Panel Menu.

Position the cursor at the field you want to delete or exclude
by moving the Trackball.

The field is highlighted.
Select Delete Value from the Touch Panel.

Example:

If the user measured RI 4 times, the latest 3 sets of Rl
measurements are displayed in the worksheet.

Table 7-5: Example of Latest Measurements in Worksheet

Result Number #2 #3 #4
PS 0.500 0.600 0.700
ED 0.100 0.200 0.300
RI 0.800 0.667 0.571
2. Then, the user deleted PS value of #3 from the worksheet.

Then, if the user deletes the PS value in column #3 from the
worksheet, the whole set of measurements from column #3
is deleted from the worksheet and measurements from
column #1 are shifted and displayed, as below.

Table 7-6: Example of Latest Measurements in Worksheet

Result Number #1 #2 #4
PS 0.500 0.600 0.700
ED 0.100 0.200 0.300
RI 0.800 0.667 0.571
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Worksheet

To edit a worksheet (continued)

Examiner’s comment

To type a comment on a worksheet:

1. Select Examiner’s Comments. The Examiner’'s Comments
window opens.

2. Type comments about the exam.

3. To close the Examiner’'s Comments window, select
Examiner’s Comments.

2D Calculations

[EFw( D,FL.HC) Hadlock 163.53g+/-24.53g (60z+/-10z)
Examiner’s Comments

You can place Exam Comments Here]

Figure 7-26. Examiner’s comments field

Volume measurement value off

1. Select the method type Off. The value field becomes blank.

b Mode Measurements
L 5.24 cm
H 512 cm

W - cm

Vol - ml

Figure 7-27. Volume Parameter Off
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To edit a worksheet (continued)

To select a method

1. Move the cursor over the value in the method column and
press Set.

2. The pull-down menu displays. Move the cursor to select the
method and press Set. The selected method is displayed in
the column.

B Mode Measurements

BPD(Hadlock) ] 2 .94 11.47 [Min.

Figure 7-28. Pop-up menu of methods - example

Avg.: Average of the measurements taken
Max.: Maximum measurement

Min.: Minimum measurement

Last: Last measurement that was taken

hPob =

Delete All Worksheet Values
You can delete all worksheet values on a worksheet.

1. When the Worksheet is displayed on the monitor, press the
Clear key; the following warning message appears:

NAFrrairs
Warning

Figure 7-29. Delete All Warning Message

2. Select OK to delete all.

Select Cancel to cancel the deletion.
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Recording Worksheet

The worksheet can be saved as you would any ultrasound
image. Once it is displayed on the screen, it can be recorded on
the DVR, printed on the B/W printer, stored on media with the

Image Archive option, or placed on regular paper with a line
printer.
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OB Worksheet

Patient data

7-76

NOTE:

The Patient data section, at the top of the worksheet, lists
information from the Patient Data Entry screen.

You can select the following fields:

FetusNo — if this is a multi-gestational patient, you can
select the fetus in this field. You can also adjust the Fetus
selection to change the fetus.

CUA/AUA — select the ultrasound age calculation method

+ Composite Ultrasound Age (CUA) — regression
calculation

* Average Ultrasound Age (AUA) — an arithmetic average

You can select the method in this field, or adjust the Select

CUA/AUA control.

CUA/AUA is only available when you select USA OB Type in
the Utility -> System -> System Measure menu.

You can enter information in the following fields:

FetusPos — type information about the fetus position.
PLAC — type information about the placenta.
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Calculation information

This section of the worksheet provides calculation choices and
lists calculation results.

« EFW —lists the parameters used to calculate EFW. This is

followed by the calculation result.

To change which parameters are used:

a. Select this field or press Select EFW.
b. Select the desired parameters.

+ EFW GP - lists the source used to calculate EFW-GP
(growth percentile). This is followed by the growth
percentile.

To change the source:
a. Select this field or press Select GP.
b. Select the desired source.

The remaining calculation information shows ratios for several
measurements, and the Cephalic Index (ClI).

The worksheet shows if any of the ratios are out of range
(OOR). Out of range indicates one of the following:

+ The measurement is out of the normal range based on the
gestational age that is calculated from the LMP. The system
determines OOR from the ultrasound age compared to the
gestational age. The gestational age is calculated from the
last menstrual period or the estimated delivery date.

+ The measurement is outside of the range for the data used
in the calculation. That means that the measurement is
either less than or more than the range of measurements
used to determine fetal age based on the measurement.

For more information about how to use the worksheet, see
‘Worksheet’ on page 7-68 for more information.
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Vascular Worksheet

Intravessel ratio

On the Vessel Worksheet page, to calculate the Intravessel
ratio, you need a measurement of assessing pressure and
stenotic velocities.

1. Select Intrav. Ratio from the Touch Panel. The Intravessel
Ratio pop-up window displays in the header section of the
worksheet.

Figure 7-30. Intravessel Pop-up Window

2. Select the first velocity. The value displays in the window.
The value is displayed in the window.

Cancel

Figure 7-31. Intravessel ratio one
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Intravessel ratio (continued)

3. Select the second velocity.

The second value and Result value display in the window.

Figure 7-32. Intravessel ratio two

+ To save the Intravessel ratio to the Vessel Summary, move
the cursor to Save and press Set.

» To clear values, move the cursor to Clear and press Set.
+ To cancel and exit Intravessel ratio, move the cursor to
Cancel and press Set.

NOTE: Intravessel Ratio is only displayed and saved in the Vessel
Summary as Intra-Ratio.
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Vessel Summary

The Vessel Summary is designed to automatically display
measurements made at specific anatomical sites. Calculated
ratios are automatically summarized and displayed.

The Vessel Summary can be displayed at any time during the
exam by selecting Vessel Summary from the Vascular
Worksheet Touch Panel.

Figure 7-33. Vessel Summary Example

7-80 LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2



Worksheet

Vessel Summary (continued)

1. The first row, indicating Right or Left, is not displayed when
the side is not defined in the vessel. In the third column on
the second line, you select the calculations. Move the
cursor to the third column, and the pop-up menu is
displayed. The selected parameter is displayed in every
third column.

Figure 7-34. Pop-up menu

2. Vessel Name with location information.

3. Check Box. Use to select the vessel velocity for calculating
the vessel ratio (ex. ICA/CCA). You can only select one
location (position) in a vessel.

4. Result value column. This value cannot be changed or
excluded from this page.

5. Calculation name and result. ICA/CCA: The ICA/CCA ratio
selects the highest systolic ICA and CCA velocities when
calculating this ratio, and displays the velocities.
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Carotid Study

Renal Artery Study

In the configuration page for ICA/CCA ratio, you can specify
which portion of the CCA vessel (Prox, mid, distal) is chosen.
You can override the selections on the Vessel summary.

The ICA/CCA ratio is able to be configured for either systole or
diastole.

The vertebral vessel also has systole and diastole selections. In
the summary page, there is a box to select flow reversal for
vertebral flows. The choices are Ante (Antegrade), Retr
(Retrograde), and Abs (Absent).

To select the method:

Move cursor to the box and press Set. After the pop-up menu
(Blank, Ante, Retr, Abs) is displayed, select from a menu of
choices. The selected choice is displayed in the column.

The box is independent of Left and Right.

For renal arteries, you can calculate RENAL/AORTIC ratio
(RAR) based on peak systolic velocities.

You can combine the two renal summary pages, and have a
heading to separate the different measurements (main renal,
intra renal). You can scroll between the measurements. The
most commonly used, the main renal artery, is the default.

Lower Extremity Artery Study

Recording Worksheet

7-82

For the lower extremity artery, you need an intra vessel ratio
(assessing pre vs. stenotic velocities). You can specify which
(ratio is stenotic/pre).

The intra-vessel ratio needs to be available for all vascular
measurements. This appears on the worksheet only if used.

The worksheet can be saved as you would any ultrasound
image. Once it is displayed on the screen, it can be recorded on
the DVR, printed on the B/W printer, stored on media with the
Image Archive option, or placed on regular paper with a line
printer.
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Anatomical Survey

Overview
The Anatomical Survey page provides a checklist that indicates
which anatomy was imaged and its appearance.
L]
.
|
|
|
]
Figure 7-35. OB Anatomical Survey
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Overview (continued)

Figure 7-36. Abdominal Antomical Survey
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Overview (continued)

ANATOMICAL

APPE

Figure 7-37. GYN Anatomical Survey
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Editing
1. To activate the Anatomical Survey, select Anatomy on the
Worksheet Touch Panel.
2. Fill the required field.
Table 7-7:  Abdomen Anatomical Survey
Field Description
ANATOMY Enter the following information for each part of the anatomy imaged:
1. Imaged?: Check the box that you did image this part of the anatomy.
2. Appearance: If you checked the Imaged? box, indicate whether the
appearance was normal or abnormal.
You can add additional anatomy to this worksheet. Up to 9 additional items can
be added. .
Move the Trackball to the blank field.
Enter the anatomy name.
COMMENTS Free text
Table 7-8: OB Anatomical Survey
Field Description

Fetus Pos Indicate the fetal position within the uterus.

PLAC Identify the location of the placenta.

ANATOMY Enter the following information for each part of the anatomy imaged:

1. Imaged? : Check the box that you did image this part of the anatomy.

2. Appearance : If you checked the Imaged? box, indicate whether the
appearance was normal or abnormal.

You can add additional anatomy to this worksheet. Up to 9 additional items can
be added.

Move the Trackball to the blank field.

Enter the anatomy name.

BIOPHYSICAL The score is _ of 10 possible total points, depending upon the number of
parameters entered. Enter the following information to assess the fetus’s
biophysical well-being.

Movement Type 0, 1 or 2

Tone Type 0, 1 or 2

Breathing Type 0, 1 or 2

Fluid Type 0, 1 or 2
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Anatomical Survey

Table 7-8: OB Anatomical Survey (Continued)

Field Description

Reactive NST (Reactive | Type 0, 1 or 2

non-stress test)

COMMENTS Free text

Table 7-9:  GYN Anatomical Survey
Field Description

ANATOMY Enter the following information for each part of the anatomy imaged:
1. Imaged?: Check the box that you did image this part of the anatomy.
2. Appearance: If you checked the Imaged? box, indicate whether the
appearance was normal or abnormal.
You can add additional anatomy to this worksheet. Up to 9 additional items can
be added.
Move the Trackball to the blank field.
Enter the anatomy name.

COMMENTS Free text
3. Select Exit to return to the Scan screen.

Select Worksheet to return to the Worksheet.
NOTE: The patient specific contents input on the Anatomical Survey
page are returned to the factory default settings after starting a
new patient.
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Measurement and Calculation Setup

7-88

Measurements and studies are organized for typical work flows.
If you want, you can change this set up. You can specify which
studies are in each exam category, and which measurements
and calculations are in each study. You can change the
measurements that are available on the Touch Panel. The
LOGIQ P8/P9/P10 allows you to quickly and easily set up your
system so that you can work most efficiently.

This section describes how to:

Change a study to include different measurements
Add a new study or measurement

Remove a study from an exam category

Change measurement parameters

Create a measurement formula to correctly handle unit
conversions

Edit user-defined calculations
Define application-specific measurement parameters

Specify the default manual calc measurements for a
selected study or folder
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Starting Study and Measurement SetUp

You can make changes to studies and measurements in the
Measurement & Analysis screen. To open the screen:

1. On the Touch Panel, select Utility.

2. On the Touch Panel, select Measure.

3. The system displays the Measurement & Analysis screen
on the monitor display.

Refmort Scan Assistant Maragbmaging Preser Manag, Disk Encrypt

=Abdomen

Add measuremant fdd foldar

Add vessel

Factory

Figure 7-38. Measurement & Analysis screen

1. Selection menu: select exam category, study, 3. Folder or measurement: define studies and
or measurement folder/measurement. measurements. This section changes between
Folder and Measurement, depending on what
2. Measurement menu: add and delete studies you select in the Selection menu.

(folders) and measurements; select mode.
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Select the exam category

To select the exam category you want to work with:

1.

Move the cursor to the exam category at the top of the
Selection menu.

Press Set.
The system displays a list of exam categories.
Move the cursor to the desired exam category.
Press Set.

7-90

Figure 7-39. Select the exam category
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Select the study

1. Move the cursor to the current study in the Selection menu.

Figure 7-40.

2. Press Set. All study displays.

Figure 7-41. Select the study

3. Move the cursor to the desired study you want to open.
4. Press Set.
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Select a measurement folder or a measurement

1. Move the cursor to the desired measurement folder or the
desired measurement in the Selection menu.

2. Press Set.

* If you select a measurement folder, the Folder section
displays information about the selected folder.

Figure 7-42. Folder - example

* If you select a measurement, the Measurement section
displays information about the selected measurement.

Tool result Precision Method
Distance cm Aver

Figure 7-43. Measurement - example
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Select the measurement mode

In the Measurement menu, select the measurement mode which
you work with.

2D (B-Mode)
MM (M-Mode)
Dop (Doppler Mode)

Plot (Plot Mode—The measurement on the plot graph of the
TIC/QAnalysis)

SMEAN Advanced Doppler OB Table

rement-menu

Add measurement Add folder

Delete measure and folder

Factory

Edit Calc

Figure 7-44. Measurement menu
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Display/hide a folder or a measurement in the Touch Panel

7-94

The Folder section of the Measurement & Analysis screen has
two lists of folders and measurements. This is where you specify
which items go in a study or folder.

» Available folders and measurements. The list contains all
possible folders and measurements for the selected study or
folder.

* Measure & Study. The list defines where the folder or
measurement is located on the Touch Panel.

To display an item in the Touch Panel:

1. In the Measure & Study list, move the Trackball to highlight
which folder you want to put the item in, and press Set.

2. Move the Trackball to highlight an item in the Available
folders and measurements list, and press Set.

Available folders and measurements

Figure 7-45. Select the position and an item
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Display/hide a folder or a measurement in the Touch Panel

(continued)

3. Press the arrow between the lists. The item is copied to the
Measure & Study list.

Available folders and measurements = No  Measure S.. MyPage

Figure 7-46. Measure & Study list: New item added

The selected item is now displayed in the Touch Panel and
the Summary Window.

Figure 7-47. Touch Panel for measurement added
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Touch Panel positions

Each Touch Panel has 16 positions, five across and five donw.
The items in the first row across are numbered 1-4, in the
second row 5-8, and so on. Positions 1-4 are system
programmed and cannot be edited.

s and measurements = No  Measure 5., MyPage

B Mode

Ellipse

Figure 7-48. Measure & Study display with Touch Panel
positions
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Move and remove items in the Touch Panel

To move items that are in the Touch Panel, you move them in

the Measure & Study list.

1. Highlight an item in the Measure & Study list.

2. Move the cursor to the up or down arrow and press Set.
The item is displayed at the selected position in the Touch
Panel.

To remove items from the Touch Panel, you remove them from

the Measure & Study list.

1. Move the Trackball to highlight the item in the Measure &
Study list and press Set.

2. Select the X to the right of the list.

The system removes the item from the Measure & Study list

and from the Touch Panel. The item is still listed in the
Available folders and measurements list.
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Setting up an automatic measurement flow

In some cases, related measurements are putin a
measurement folder. This allows you to logically organize
measurements. It also allows you to specify that the system
automatically start each measurement in a folder, one after the
other. This is the automatic sequence feature. To use this
feature:

1. In the Folder section, select Auto sequence.

Folder

Name

Available folders and measurements re S.. MyPage
4 UTL

4 UTH

¥ UTW 3 Return

0

UTL
UTH
utTw

J Y N s NN

Figure 7-49. Measurement & Analysis screen: Auto sequence

1. Select the measurement folder 2. Put a checkmark to the Auto Sequence box
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Change the tool used to make a measurement

You can make changes to some of the measurements. For
example, Head Circumference can be measured with an ellipse,
a trace, or two distances. You can select the measurement tool
you want to use.

1. Select the measurement you want to change in Selection
menu.

2. Inthe Measurement section, select the desired tool from the
Tool list.

NOTE: If the Tool field is gray, it cannot be changed.

vanced Doppler OR Table

Add measurament Add foldar

Delete measurea

Factory Edit Calc

Pregision Method

Figure 7-50. Change the tool

NOTE: The diagram to the right of the Tool list shows the measurement
type. In the following example, ellipse is selected and the
diagram shows an ellipse.
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Adding Folders and Measurements

Adding a folder

When you add a folder, it can be a study, or a measurement
folder that includes related measurements.

Report Scan Assistant Manaphmaging B Disk Encrypt

pler OB Tobie

2
Add measurement Add falder

e folders and measurements

Figure 7-51. Measurement & Analysis: Add folder

1. In the Selection menu, select the study or folder where you
want to add the folder.

2. Select the mode in the Measurement menu.
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Adding a folder (continued)

NOTE:

NOTE:

NOTE:

In the Measurement menu section, select Add folder.

+ If you select Blank, the system adds a folder with a
name such as USERDEFSH1. It is listed in the Selection
menu.

For Generic study, you can only use Blank.

+ If you want to use an existing folder, select Insert, and
then select a folder from the list.

ADD STUDY

Blank

Figure 7-52. Add folder Window

Select the user-defined folder in the Selection menu.
You cannot change an existing folder name.

Move the Trackball to the Name field and press Set twice.
Type the name.

DO NOT use "single quotes" for a parameter name, a
measurement name, a folder name or an author name.

Add a measurement to the folder. See ‘Adding
measurement parameters’ on page 7-103
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Changing measurement parameters

correctness and accuracy of the user input formula that is

f WARNING Please remember that you are responsible for confirming the
added to your system on your behalf.

To change a measurement parameter:

1. In the Selection menu, select the measurement.

2. To change the name of the Parameter, move the Trackball
to the parameter name and press Set twice. Type a name
for the parameter.
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Adding measurement parameters

To add a measurement parameter:

1. In the Selection menu, select the measurement.
2. To change the tool used to make a measurement:

In the Measurement section of the Measurement & Analysis
screen, select the desired tool from the Tool list. Select the
arrow to display the drop-down list.

NOTE: If the Tool field is gray, it cannot be changed.

3. If necessary, check Fetus (OB only), Location (Loc), or Side:

« Fetus: If this is an OB measurement, check this box.
(Default ON).

* Location: If this measurement includes a Prox, Mid, or
Dist location, check this box.

+ Side: If this measurement includes a Left or Right side,
check this box.
4. Inthe Measurement section, move the Trackball to an
empty line at the bottom of the Parameter list. Press Set.
The system adds a parameter with a name of (Name).
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Adding measurement parameters (continued)

7-104

To change the name of the Parameter, move the Trackball
to the (Name) and press Set twice. Type a name for the
parameter.

Move the Trackball to the Tool result field, and double click
the Set key.

The Edit Formula window is displayed.

EDIT FORMULA

Functions

[

ent folder, folder, mea

Figure 7-53. Edit Formula

To create a formula:

a.
b.

In the Value Type field, select a value.
Do one of the following:

Type a formula in the Formula field.

Select formula components from the Operators,
Parameters, and Functions drop-down lists. When you
select a component, the system displays it in the
Formula field.

To test the formula, select Check.
If there are no problems, the system displays “Syntax OK!”".

If there are any problems with the formula, the system
displays an Error message in place of the Formula field
label.

When the formula is correct, select OK to save it.

The Edit Formula window closes. The formula is displayed
in the Tool result field.

LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2



Measurement and Calculation Setup

Formula Unit Conversion

When you create a formula, the system changes the calculation
result into an output unit as defined in the following table.

Table 7-10:  Formula Unit Conversion

Conversion
Unit (coefficient value)
Time
s x1
ms x1,000
min x0.0167
h x0.00027778
Ratio
% x100
Frequency
bpm or BPM x1.0
Angle
rad x1.0
deg x57.2958
grad X63.6620
Distance
cm x100
m x1
dm x10
mm x1,000
inch x39.37
feet x3.281
pixels x1
Velocity
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7-106

Table 7-10:  Formula Unit Conversion (Continued)
Conversion
Unit (coefficient value)
m/s x1
dm/s x10
cm/s x100
mm/s x1,000
inch/s x39.37
Acceleration
m/s2 x1
dm/s2 x10
cm/s2 x100
mm/s2 x1,000
inch/s2 x39.37
Area
m2 or m"2 x1
dm2 x100
cm2 or cm”2 x10,000
mm2 or mm*2 x1,000,000
inch2 x1550
Volume
m3 x1
dm3 x1,000
cm3 x1,000,000
| x1,000
dl x10,000
cl x100,000
ml x1,000,000
gallon x264,178
quart x1056.71
Volume Flow
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Measurement and Calculation Setup

Table 7-10:  Formula Unit Conversion (Continued)
Conversion
Unit (coefficient value)
m3/s x1
dm3/s x1,000
cm3/s x1,000,000
I's x1,000
di/s x10,000
clis x100,000
ml/s x1,000,000
m3/min x60
dm3/min x60,000
cm3/min x60,000,000
I/min or L/min x60,000
dl/min x600,000
cl/min x6,000,000
ml/min x60,000,000
ml/m2 x1,000,000
Pressure
mmHg x1
Pa x133.322
kPa x0.133322
bar x0.00133322
Pressure/Time
mmHg/s x1
Mass
kg x1
g x1,000
ounce x35.273962
pound x2.2046226
Others
mmHg x1
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Formula Unit Conversion (continued)

7-108

For example, when a Volume formula is created:
Vol [ml or cm3] = 0.523598*{D1}*{D2}*{D3}
(D1, D2, and D3 indicate a measurement result.)

In this case, the measurement (D1, D2, and D3) is a distance
measurement, so the measured data is a meter [m] unit
according to the above table.

To change into a milliliter, the system multiplies each
measurement value by 100. As a result, it multiplies a formula
by 1,000,000.

The standard unit of volume is a cube meter, so the system
multiplies the result by 1,000,000.

The system multiplies the calculation result by the coefficient
and converts it. To get a correct result, when you define the
formula, you must convert the coefficient itself, such as the
coefficient of 107

For example, if you want to define the following formula:

efg[g] =
107(1.5662-0.0108*{P1}+0.0468*{P2}+0.171*{D1}+0.00034*{P1
1*{P1}-0.003685*{P2}*{D1})

D1[cm]: Distance
P1[cm]: Perimeter

P2[cm]: Perimeter

LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2



Measurement and Calculation Setup

Formula Unit Conversion (continued)

The system defines the standard value of each measurement as
a meter [m]. If the unit of each measurement value of this
formula is defined as centimeter [cm], you must define the
formula as follows:

efw[g] = 107(1.5662-0.0108*(P1}*100 + 0.0468*{P2}*100 +
0.171*{D1}*100 + 0.00034*{P1}*{P1}*100*100 -
0.003685*{P2}*{D1}*100*100)

(This converts each measurement value to a centimeter [cm],
since the system standard unit is a meter [m].)

The output unit of this formula is a gram. Since the standard unit
of the system is defined as a kilogram [kg], the system multiplies
the output by 1,000.

Because the output of this formula is defined as a gram, it is
necessary to define the formula as follows.

efw[g] = 107(1.5662-0.0108*(P1}*100 + 0.0468*{P2}*100 +
0.171*{D1}*100 + 0.00034*{P1}*{P1}*100*100 -
0.003685*{P2}*{D1}*100*100)/1,000

As shown, you can obtain an exact calculation result.
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Editing Calculations

To modify user-defined calculations:

1. Select Add Measurement from the Measurement menu. The
system displays the Add Measurement window.

2. Select Blank and OK.

3. Type the appropriate name and select “Calculation” from the
Tool pull-down menu.

Parameter Tool result Precision Method

(Name) Flcaleulated

Figure 7-54. Measurement window

4. Type the parameter name.

5. Double click on the = Calculated symbol under Tool Result.
The Edit Formula window displays.

6. Select OK.
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Editing Calculations (continued)

7. In the Measurement menu section, select Edit Calc.

plar, OB Table

Add measurement Add folder

Edit Calc

Figure 7-55. Edit Calc

The Modify User CALC window displays.
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Editing Calculations (continued)

8. Inthe User Defined list, select the calculation that you want
modified, then select OK.

Selected Study

User Defined

Figure 7-56. Modify User CALC window

9. The Measure tab for user-defined calculations displays.

Double click on the equals sign symbol under Tool Result for
the desired parameter.

10. Edit the formula as needed and select OK.
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Deleting a Folder or Measurement

NOTE: You can only delete user-defined folders or measurements. You
cannot delete default system folders or measurements.

1. Select the folder or measurement in the Selection menu.

2. In the Measurement menu section, select the Trash icon
next to Delete measure and folder.
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M & A Advanced Preset

The Advanced tab allows you to specify application-specific
values for certain parameters.

1. On the monitor display, select the Advanced tab.

M [Ranead Doppler| OB Table

Figure 7-57. M&A Advanced Preset Menu

M&A Category: Display and select current exam category.
Parameter: Lists application specific parameters.
Value: Select the value for a parameter.

2. Select an exam category.

The Parameters list displays parameters for the selected
category.
3. Select a value for a parameter.

NOTE: The parameters that appear are category dependent.
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M & A Advanced Preset (continued)

Table 7-11:  M&A Advanced

Preset Parameter

Description

Absolute Value

Displays the absolute value of the Doppler Velocity measurement (On
or Off)

Default Cursor Position

Image Center/Summary Window
Select the display position of the cursor when the measurement key is
pressed.

Display Angle Correct Value On or Off
Display Sample Volume Depth On or Off
(TCD)

Display Summary Window On or Off

Doppler Default Method

Avg, Max, Min or Last

Heart Rate Cycle

1,2,3,4,5,6,7,8,9,0r10
NOTE: For Cardiac, you can select only “1”.

Keep Graphics with Cine Scroll

If you select “On”, the measurement graphics remain while in CINE
scroll. The measurement graphic redisplays on the frame where the
measurement was taken in B-Mode.

Start M&A on a Freeze (B)

Start M&A on a Freeze (M)

Start M&A on a Freeze (D)

Off: Select measurement manually on Freeze

On: Measurement menu appears automatically on Freeze.
Caliper: Measurement menu and caliper appear automatically on
Freeze.

Start M&A on a Freeze (Shear)

Off: Select measurement manually on Freeze.

On: Measurement menu appears automatically on Freeze.

Auto: If the number of scanned frame is 1, measurement starts
automatically on Freeze. Other than that, measurement does not start.

Measure Key Sequence (B/CF)

2 Sequences: Dist, Trace; Dist, Spline

2 Sequences: Dist, Open Trace: Dist, Open Spline

3 Sequences: Dist, Trace, Spline; Dist, Spline, Trace; Dist, Spline,
Intensity; Dist, Trace, Intensity; Dist, Trace, Open Trace; Dist, Spline,
Open Trace

4 Sequences: Dist, Trace, Spline, Intensity; Dist, Spline, Trace,
Intensity; Dist, Spline, Trace, Open Trace; Dist, Trace, Open Trace,
Spline

Show Result Parameters

Preview or After Set cursor:
Preview: Displays while taking the measurement.
After Set Cursor: Displays after completing the measurement.

Default Location

Off, Prox, Mid or Dist

Default Side

Left, Right or Off

RI Calc Bidirectional Flow

On or Off
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Table 7-11:  M&A Advanced (Continued)

Preset Parameter Description
RI Calc Method MD or ED
Auto Shear Measure Size Sets the Default Diameter size of the shear wave measurement circle.

Auto Shear Measure Fixed Size | On or Off

Shear Calculation Method Specify Mean or Median

* Mean averages all of the shear wave points within the measurement
circle.

» Median sorts, then selects the middle point of all points within the
measurement circle.

Shear Units Determine Folder If you have preset shear wave units via the Display Units on the Utility ->
System -> System Imaging page, then when you specify On, the unit
specified pre-selects the measurement folder. If m/s is specified as the
unit, then the Velocity folder is used; if kPa is specified as the unit, then
the Stiffness folder is used.

Show Location Select Button Both on B and Doppler, Doppler only or No Display
NOTE1: Only Abdominal, Vascular, Obstetrics and Gynecology have
this preset.

NOTEZ2: For Obstetrics and Gynecology, you can select only Doppler
only or No Display.

Show BM Folder Name on On or Off

Worksheet

Show Measure Name on On or Off

Worksheet

Show Point Velocity On or Off

Show Tissue Depth On or Off

Keep Result Window Auto, On or Off

Trace Auto or manual

Vol Flow Method TAMEAN or TAMAX

Vol Flow Compensation with If you select TAMAX as the volume flow method, then you MUST
TAMAX specify the coefficient to use. Select from 0.5 to 1.0.

Worksheet Default Display Mode/Expand (Abdominal, Small Parts, Obstetrics, Gynecology,

Urology and Pediatrics) or Worksheet Summary (Vascular)

Doppler AutoCalc Velocity Unit Velocity, Hz, Both or Auto

Default CCA location for ICA/ Prox/Mid/Dist/Off

CCA ratio Select the default location of CCA which is used for the ICA/CCA ratio.
MCA/ICA Ratio TAMAX or PS
Default ICA location for MCA/ Prox/Mid/Dist/Off
ICA ratio Select the default location of CCA which is used for the MCA/ICA ratio.
WMS Freeze Loop at ES On or Off
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Measurement and Calculation Setup

Table 7-11:

M&A Advanced (Continued)

Preset Parameter

Description

WMS Segment Model

16 segments or 18 segments

WMS Initial Scoring

Undefined or Normal

WMS Scoring Legend

ASE, European or Asian

Hip Orientation

Cranial-left or Caudal-left

Show area value while tracing

On or Off

Measure Assistant BPD Method

Outer to Inner, Outer to Outer

Restrict Breast Contour Caliper
Edit

On or Off

AutoEF processing

Off, delay 1s, delay 2s, delay 3s or delay 4s

AutoEF ROI method

Auto ROI or 3 Points

AutoEF YOYO

Play or Stop

AFI Default Color Palette

Red-Blue, Green-Yellow-Red

AFI segment model

17 segments, 18 segments

AF1 PSS/PSI Mode

PSS only, PSS&PSI
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General Measurements and Calculations

Doppler tab - Modify Calculation

The Doppler tab allows you to preset the parameters for manual
calculations.
1. On the monitor display, select the Doppler tab.

2. The following example describes how to configure the
Carotid Doppler calculations.

Select Vascular next to M&A Categories. The Vascular
measurement category is displayed.

3. Select Carotid. The available calculations are displayed in
Modify Cacls.

Report Scan Asslstant Managbmaging Preset Manag,

=Carotid

Figure 7-58. M&A Doppler Preset Menu

4. Check the desired calculations to be performed.
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Measurement and Calculation Setup

Application Measurement Preset

The Application Measurement presets allow different calculation
packages to be available under different application presets.

The presets allow you to configure the Measurement Categories
and Measurement Exam Calcs. These presets are found on the
Utility -> Application -> Measurements screen.

Settings Print Controls Imaging Controls Comments Body Patterns Measurements
Adult 7

Measurement Categories

Abdominal =

Measurement Exam Calcs

Abdomen Vein
Abdomen

Aorta

User Defined
Vascular Renal

Figure 7-59. Application Measurements Menu
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Chapter 8
Application M&A

Describes how to perform application specific
measurements and calculations.
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Application M&A

Abdomen

Overview

Abdominal measurements offer a few different types of

measurement studies. Select the desired study.

*  Generic—Common to all applications. See ‘Generic

Measurements’ on page 7-22 for more information.

* Abdomen

* Renal

* Bypass Graft

» Aorta lliac

* Vascular Renal

* Mesenteric

+ Abdomen Vein

Abdomen
Figure 8-1. Abdomen Exam Category Touch Panel
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Small Parts

Small Parts

B-Mode Measurements

The Small Parts exam category includes the following two
folders:

*  Generic—Common to all applications. See ‘Generic
Measurements’ on page 7-22 for more information.

*  Small Parts, which includes the thyroid and scrotal
measurement packages.

NOTE: If Small Parts has the Breast package option, the Breast folder
displays in the Small Parts Touch Panel.

Figure 8-2. Small Parts Exam Category Touch Panel
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Application M&A

Thyroid

Thyroid Left/Right

Isthmus AP

8-4

Each of these is a standard distance measurement. Length and
height are typically measured in the sagittal plane. Width is
measured in the transverse/axial plane.

To measure thyroid length, width, or height:

1.
2.
3.

On the Exam Calcs, select Small Parts.
Select Thyroid.

Select Lt or Rt Thyroid. Change the orientation (side), if
necessary.

Select Thyroid L, Thyroid W, or Thyroid H.
An active caliper displays.
Perform a standard distance measurement.

To measure the anterior/posterior isthmus tissue, perform a
distance measurement.
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Small Parts

Scrotal

Scrotal Left/Right

Each of these is a standard distance measurement. Length and
height are typically measured in the sagittal plane. Width is
measured in the transverse/axial plane.

To measure scrotal length, width, or height:

1.

On the Exam Calcs, select Small Parts.

2. Select Scrotal.
3. Select Lt or Rt Testicle. Change the orientation (side), if
necessary.
4. Select Testicle L, Testicle W, or Testicle H.
An active caliper displays.
5. Perform a standard distance measurement.
Epididymis
To measure the epididymis structure, perform a distance
measurement.
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Application M&A

Introduction

8-6

NOTE:

NOTE:

OB

Out of Range - If the system indicates that a measurement is
out of range (OOR), it means one of the following:

+ The measurement is out of the normal range based on the
gestational age that is calculated from the LMP. The system
determines OOR from the ultrasound age compared to the
gestational age. The gestational age is calculated from the
last menstrual period or the estimated delivery date.

* The measurement is outside of the range for the data used
in the calculation. That means that the measurement is
either less than or more than the range of measurements
used to determine fetal age based on the measurement.

Calculation formulas are listed in the Advanced Reference
Manual.

Nuchal Translucency is not available through the factory default.
To enable Nuchal Translucency, add NT to the measurement
folder in Utility -> Measure -> M&A -> Add measurement
(Insert).
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OB Type change

The LOGIQ P8/P9/P10 system includes measurements for the
following studies: USA, Europe, Tokyo, Osaka and ASUM.

Select OB Type in Utility -> System -> System Measure.

System System Backup/
Display Imaging Restore

General

Measurement

Repeat measurement © Repeat @ No ® DefaultMeasure
OB Type USA =
EFW GP Hadlock =

CUA/AUA for Hadlock ® CUA © AUA

Hadlock Table Type © Hadlock82 ® Hadlock84
EFW Formula (Europe) Hadlock =
EFW Formula (Tokyo) Tokyo -

Figure 8-3. OB Type selection

Figure 8-4. OB Type: Tokyo - example

NOTE:  ASUM studies include the following measurements:

+ ASUM: AC, BPD, and CRL
+ ASUM 2001: AC, BPD, CRL, FL, HC, HL, and OFD
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Application M&A

To Start an Obstetrics Exam

NOTE: Calculation formulas are listed in the Advanced Reference

Manual.

To begin an Obsterics exam, you enter patient data or, if the
patient data from a previous exam is saved in the system, find
the patient information.

1.

NOTE:

NOTE:

8-8

On the control panel, press Graph.
The Patient Data Entry screen is displayed.
On the Patient Data Entry screen, select New Patient.

To choose an Obstetrics exam, move the Trackball to
highlight Obstetrics, then press Set.

Do one of the following:

If the patient data is already stored in the system,
search for the data. Use the search fields in the bottom
section of the Patient Data Entry screen. For information
about how to search for patient data, see ‘Changing
Patient Information or an Exam’ on page 4-23 for more
information.

When the correct patient data is listed in the search list,
move the Trackball to highlight the patient name and
press Set. The system displays the patient data.

To change patient data, use the Trackball to move the
cursor to the field and press Set. Press Backspace to
delete the data, and then type the correct data.

If the patient data is not stored in the system, ener the
data. To enter data in a field, move the Trackball to
hightlight the field and then press Set.Use the Tab key
to move between fields. Obstetric patient fields are
listed in the following table.

For information about entering general patient data such
as Patient ID and name, see ‘Beginning an Exam’ on
page 4-2 for more information.
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To Start an Obstetrics Exam (continued)

Table 8-1:  Obstetric fields
Field Description

LMP Last Menstrual Period; enter the date that the patient started her last menstrual
period.
You must enter 4 digits for the year. When you type the month and day, the system
fills in the /. The Date Format preset chosen in Utility -> System -> General
determines the required format.

EDD by LMP Estimated Delivery Date by LMP; the system files in the date after you enter the
LMP.

GA by LMP Gestational Age by LMP; the system files in the age after you enter the LMP.

Gravida Number of pregnancies.

Para Number of births.

AB Number of abortions.

Ectopic Number of ectopic pregnancies.

Fetus # Number of fetuses; defaulty is 1. Can be 1-4.

Accession # Exam number used with hospital information system (DICOM). This is a tracking

number from the worklist.

Exam Description

Describe the type of exam.

Perf Physician

The physician who performs the exam. Choose from the list or type the name.

Ref. Physician

The physician who requested the exam. Choose from the list or type the name.

Operator

The person (not a physician) who performs the scan. Choose from the list.

NOTE:

LOGIQ P8/P9/P10 — Basic User Manual

To fill in the following information, move the Trackball to
hightlight the Detail button and press Set.
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Application M&A

To Start an Obstetrics Exam (continued)

Table 8-2: Obstetric fields: Detail

Field Description
Indications Why the patient needs the ultrasound exam.
Comments Comments about the exam.

After you complete the patient information, you can begin the
scan.

1. To change from the Patient Data Entry screen to the Scan
screen, do one of the following:
* On the keyboard, press Esc.
*  On the Touch Panel, select Scan.
* On the Control Panel, select Patient or Freeze.
* On the Control Panel, press the B-Mode key.

2. To choose the appropriate probe, select the probe icon on
the Touch Panel.

3. On the Control Panel, press Measure.

The default Obstetrics study is displayed on the Touch
Panel.

Figure 8-5. OB-General Study
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To choose a study

1. To change the study on the exam category, select Probe.

The Obstetrics exam category allows you to choose from
the following studies:

Generic

OB-1

OB-2/3
OB-General
Fetal Heart
OB/GYN Vessel

2. To select a study, select the appropriate study on the Touch
Panel.

Figure 8-6. OB Study Touch Panel

NOTE: The folders you see on the Touch Panel may be different if your
system has been customized.
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OB Measurements Performed Over Multiple Planes

Gestational Sac

8-12

To calculate the gestational sac, you make three distance
measurements in two scan planes. To display two scan planes,
press the L or R key. Get an image in each scan plane and
press Freeze.

1.

1.

Select GS; an active caliper displays.

a.

To position the active caliper at the start point, move the
Trackball.

To fix the start point, press Set.

The system fixes the first caliper and displays a second
active caliper.

To position the second active caliper at the end point,
move the Trackball.

A dotted line connects the measurement points.
To complete the measurement, press Set.

The system displays the distance value in the Results
Window and displays an active caliper.

To make the second and third distance measurement,
repeat steps a-d.

After you complete the third distance measurement, the
system displays the gestational sac measurement in the
Results Window.

To calculate the gestational sac by a one distance
measurement:

Select GS; an active caliper displays.

a.

To position the active caliper at the start point, move the
Trackball.

To fix the start point, press Set.

The system fixes the first caliper and displays a second
active caliper.

To position the second active caliper at the end point,
move the Trackball.

A dotted line connects the measurement points.
To complete the measurement, press Set.
After you complete the measurement, the system

displays the gestational sac measurement in the
Results Window.
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Amniotic Fluid Index (AFI)

NOTE:

To calculate the amniotic fluid index, you make measurements
of the four quadrants of the uterine cavity. The system adds
these four measurements together to calculate the Amniotic
Fluid Index.

The four quadrants can be measured with distance (caliper) or
circumference (circle) measurements. Press the appropriate AFI
quadrant Touch Panel key to toggle between caliper and circle.

1.

Select AFI.

The first distance measurement, AFI-Q1, is already
selected.

Make a standard distance measurement for the first
quadrant:

a. To position the active caliper at the start point, move the
Trackball.

b. To fix the start point, press Set.

The system fixes the first caliper and displays a second
active caliper.

c. To position the second active caliper at the end point,
move the Trackball.

A dotted line connects the measurement points.

d. To complete the measurement, press Set.
The system displays the distance value in the Results
Window.

When the measurement of the first quadrant is completed,
unfreeze and move to the second quadrant.

After you obtain the image, press Freeze and then
Measure.

The system prompts you to continue with the AFI
measurements. Make sure that the next quadrant has been
selected.
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Application M&A

Amniotic Fluid Index (AFI) (continued)

8-14

Perform a standard distance measurement for the second,
thrid, and fourth quadrants (see step 2).

When all four quadrants have been measured, the system
calculates the AFI total and displays it in the Results
Window.

If you unfreeze the image after doing an AFlI measurement,
the system does not delete the previous measurements.

To specify that an unassigned distance measurement be
used for an AFI measurement:

+ Select AFI.
* Press the top Trackball key.

* Move the Trackball to highlight the unassigned
distance measurement in the Results Window.

+ Select the AFI measurement on the Touch Panel.
If the fluid in a pocket is zero, set the second caliper on top
of the first one to give it a zero value.

You can measure an AFI quadrant that is zero (0) by
pressing Set twice.
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OB Calculation

SonoNT (Nuchal Translucency)

NOTE: This measurement can be adjusted and customized in the
system setup.

To measure the contour detection of the NT border:

1.

2.
3.
4

Select NT. The measurement cursor appears.
Select the fetal position (“Face Up” or “Face Down”).
Position and fix the first point P1 of the rectangular ROL.

Position and enter the second point P2 of the rectangular
ROI. The NT border detection is performed. If a valid result
is found, the borders are shown in red and the NT distance
is displayed with two crosses.

Only if the found measurement is correct according to he
guidelines, accept and confirms the result. Then it will be
stored in the report. If the system cannot detect a result, a
warning message appears.

NOTE: To edit the measurement move the trackball and/or press
Change to readjust the start and end point before accepting the
measurement.

NOTE: It is possible to select the calculation method by pressing
Method: (i-i: inner-inner or i-m:inner-middle).

Figure 8-7. SonoNT

SonoNT Measurement Detected NT Border
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Application M&A

SonoNT (Nuchal Translucency) (continued)

SonolT (Intracranial Translucency)

SonolT is a system supported measurement for Intracranial
Translucency. Starting from the routinely used midsagittal view
of the fetal face, obtained for assesment of the Nucahl
Translucency and nasal bone, the ultrasound system uses a
semi-automated mode to measure the anterior-posterior
diameter of the fourth ventricle recognizale as intracranial
translucency.

The workflow is identical with SonoNT.
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OB Graphs

Overview

OB Graphs allow you to assess fetal growth compared to a
normal growth curve. When a patient has completed two or
more ultrasound exams, you can also use the graphs to look at
fetal trending. For multi-gestational patients you can plot all
fetuses and compare the growth on the graphs.

The LOGIQ P8/P9/P10 provides the following two basic types of
graphs:

* Fetal Growth Curve graphs — show one measurement per
graph. These graphs show the normal growth curve,
positive and negative standard deviations or applicable
percentiles, and ultrasound age of the fetus using the
current measurement. For multi-gestational pregnancies,
you can view all fetuses. If previous exam data is available,
the graph can show fetal trending.

+ Fetal Growth Bar graph — shows the ultrasound age and
the gestational age based on patient data. Plots all
measurements on one graph.
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Application M&A

To View OB Graphs

To view OB graphs:

1. Press Measure.
2. Select Graph.

The system displays the OB Graph keys.

Print All Graphs

Figure 8-8. OB Graph keys on Touch Panel
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Fetal Growth Curve Graph

Origin LMP

Fetus A/1

BBT G EDD(LMP)

FetusPos PLAC

<Measurement Type>

BPD(Hadlock)

GA(LMP)

BPD

GA

[em] BPD(Hadlock)
11 .
+25D/-25D

40
[Week]

Figure 8-9. Fetal Growth Curve Graph (Single)
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The horizontal axis shows the fetal age in weeks. The system
determines this age from the data on the Patient Data Entry
screen. The vertical axis shows one of the following:

* For measurements, mm or cm

* Forratios, percent

* For fetal weight, grams

The Fetal Growth Curve Graph shows the following information
for the selected measurement:

* The normal growth curve

* The standard deviations or relevant percentiles

+ The gestational age of the fetus, using patient data (vertical
dotted line)

* Using the current ultrasound measurement data, where the
fetus is on the growth curve

8-19
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Fetal Growth Curve Graph (continued)

To select the measurement
To select which measurement you want to display on the Fetal
Growth Curve Graph, do one of the following:
» To select a specific measurement:

a. On the graph display, move the Trackball to the
Measurement Type field and press Set.

The system displays a list of measurements.

b. Move the Trackball to select the desired measurement
and press Set.
The system displays the Fetal Growth Curve Graph for
the selected measurement.

» To scroll through all Fetal Growth Curve Graphs, adjust the
Graph Change control.
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To select the age to use

To plot the fetus age, the system allows you to use the
gestational age (GA) from the LMP, or to use the composite
ultrasound age (CUA). To select, adjust the Select GA control.
The information in the left column changes between CUA and
GA(EDD), and the data may change.

To view a single or four graphs

You can view either a single Fetal Growth Curve Graph or you
can view four graphs at the same time. To select each view,
press Single or Quad to view 4 graphs at once.

Origin LMP LMP BBT G EDD(LMP)

Fetus A/1 FetusPos PLAC |

[mm] GS(Hellman) E [mm] CRL(Hadlock)

60

) Ne 100

40
30
20

10
[Week]

BPD(Hadlock) [cm] HC(Hadlock)
+25D/-2SD 35 +25D/-2SD
30
25
20
15

5
35 40 20 2 3 35 40
[wWeek] [Week]

Figure 8-10. Fetal Growth Curve Graph: Quad View

The measurement values are displayed at the bottom of the
graph.
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To change measurements in quad view
When you view four graphs simultaneously, you can select
which four you want to see. To change each graph in quad view:

1. On the graph display, use the Trackball to move the cursor
to the small box that is upper left of each graph, then press
Set.

The system displays a list of measurements.
2. Move the Trackball to select the desired measurement and
press Set.
The system displays the Fetal Growth Curve Graph for the
selected measurement.
To scroll through all Fetal Growth Curve Graphs, adjust the
Graph Change control.

The order of a quad graph view can be saved by selecting Save.
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Fetal Trending

When you have ultrasound data for more than one exam for a
patient, you can use the data to look at fetal trending on the
Fetal Growth Curve Graphs.

1. Select Graph Display and select the desired Fetal Growth
Curve Graph.
2. Select Plot Both.

The system automatically finds the data from previous

ultrasound exams, and displays it on the graph with the
present data.

Origin LMP LMP BBT G EDD(LMP)

Fetus A/1 FetusPos PLAC

<Measurement Type>

BPD(Hadlock)

BPD(Hadlock)

GA(LMP)

40
[Week]

Figure 8-11. Fetal Trending on Fetal Growth Curve Graph

The legend at the bottom of the graph shows the symbols and
colors that indicate Past and Present data.
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Fetal Trending (continued)

To manually enter past exam data
If you have data from a previous ultrasound exam that you want
to use for fetal trending, but it is not in the system, you can
manually enter the data.

1.

w

8-24

After you have registered the patient for this exam, on the
Patient Data Entry screen, in the Exam Information
(Obstetrics) section, select Past Exam.

The system displays the Input Past Exam screen. See
Figure 8-12.

Enter the data from previous exams.

To enter data on page 2, select Next.

After you enter the previous exam data, select Exit to Save.
The system saves the previous exam data. When you view
the Fetal Growth Curve Graphs, select Plot Both to view

fetal trending. The system automatically uses the data you
entered.

Cancel Exit to Save

Figure 8-12. Input Past Exam screen, page 1
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To edit patient data

When you are working with graphs, you can change or enter the
following patient data.

*+  GA(LMP) — this field is computed using the LMP date on the
Patient Data Entry screen. To change this field:

NOTE: You can only change this field on the Fetal Growth Curve
Graph in single view.

a.

Move the Trackball to the field, which is left of the
graph. To select the field, press Set.

The system displays a window with the GA weeks and
days.

To select each field, move the Trackball to the field and
press Set.

Type the correct weeks or days.
Select OK.

The system makes the following changes:

GA (LMP) is now GA (GA) and shows the age you
entered.

In the Patient Data section, the GA changes.

In the Patient Data section, The EDD (LMP) changes to
EDD(GA) and shows an updated date, using the GA
you entered.

The LMP is erased.

* FetusPos — type information about the fetus position.
* PLAC - type information about the placenta.

To return from a graph to the scan display

After viewing graphs, to return to the scan display, do one of the
following:

* On the graph display, select Exit.
*  On the Touch Panel, select Graph.
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Fetal Growth Bar Graph

The fetal growth bar graph shows current exam measurements
and the normal growth range based on the gestational age. It
shows all measurements on one graph.

To view the Fetal Growth Bar Graph:

1. Press Measure.
2. Select Graph.
3. Select Bar.

Origin LMP LMP 04/03/2019 3B GA 30w5d EDD(LMP) 01/08/2020

Fetus A/2

Growth Bar Graph

ow 10w 20w 30w 40w

BPD(Hadlock) — B 27w3d
HC(Hadlock) —nli 30w0d
AC(Hadlock) -  =EE o
FL(Hadlock) — B sowsd

Figure 8-13. Fetal Growth Bar Graph
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Fetal Growth Bar Graph (continued)

The horizontal axis shows the gestational weeks.
The red vertical line shows the gestational age using the
patient data.

The blue dotted vertical line shows the ultrasound age using
the current measurements.

The yellow x shows the ultrasound age for each
measurement.

The green rectangle shows the normal age range for the
measurement.

You cannot do fetal trending or view multiple gestation data on
the bar graph.
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OB-Multigestational
Multiple Fetus

LOGIQ P8/P9/P10 allows you to measure and report multiple
fetus development. The system can report a maximum of four
fetuses.

To enter the number of fetuses

If more than one fetus is imaged during the exam, enter the
number of fetuses in the Patient Data Entry Menu.

Figure 8-14. Fetus Number

When you start an OB exam, the system automatically fills in the

Fetus # field with 1. To change the number:

1. Move the cursor to the fetus number and press Set twice.
The number is highlighted.

2. Type the correct number and press Set.

The system displays a message to confirm that you want to
change the fetus number.

3. Select Yes.
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To identify each fetus
For measurements, calculations, and worksheet displays, the
system labels each fetus A, B, C, or D. Each fetus is identified
by a letter and the total number of fetuses. For example, fetus
A/3 is fetus A from a total of 3.

When scanning, you can enter information about the fetus

position and placenta location. You can enter the information in
the Patient Data section of the worksheets and the graphs. You
can type up to 23 characters in the FetusPos and PLAC fields.

30w5d:LMP
GA 30w5d EDD(LMP) 01/

Fetus A/2 CUA 29wAad+/- 1wod EDD(CUA) @

FetusPos | PLAC Ref.Physician Page 1/1

Figure 8-15. Patient Data section of the OB Worksheet
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To select a fetus
During measurements and calculations, to change between
fetuses, do one of the following:
* Adjust the Fetus selection.

* Move the Trackball to the Summary Window and select the
fetus.

Figure 8-16. Summary Window: Multiple fetus

You can change between fetuses at any time during the exam.

NOTE:  After you change to the next fetus, any measurements you
make are recorded and reported to that fetus. If you have any
active measurement or calculation that is not completed when
you change the fetus, the system cancels the measurement or
calculation.
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To view multiple fetuses data on graphs
You can view multiple gestation data on fetal growth curve

graphs. After you have made measurements for each fetus,
select Graph.

1. To view the graph for each fetus, do one of the following:
* Adjust the Fetus selection.

* In the Patient Data section, move the Trackball to
highlight the FetusNo field. In the list of fetuses, move
the Trackball to select the fetus you want, and press
Set.

2. To display data for multiple fetuses on the same graph,
select Fetus Compare.

Origin LMP LMP 04/03/2019 BBT GA 30w5d EDD(LMP) 01/08/2020

Fetus All FetusPos PLAC

<Measurement Type>

[gram] EFW(Hadlock)

EFW(Hadlock) 4500 [*23D/-25D

4000
GA(LMP) 30w5d

3500

3000

2500

2000

1500

1000

500

1
PRESENT:AB=

Figure 8-17. Fetal Growth Curve Graph: Fetus Compare

The legend at the bottom of the graph shows the symbols and
colors that represent each fetus.
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To compare multiple fetus data on a worksheet

With multiple fetuses, you can list and compare measurements
of the fetuses on the worksheet.

Select Worksheet, then select Fetus Compare.

Worksheet @

O fetus Compare

Figure 8-18. OB Worksheet Display Touch Panel
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To compare multiple fetus data on a worksheet (continued)

When you select Fetus Compare, the system lists the
measurement results for each fetus on the Worksheet.

Origin LMP LMP 04/03/2019 3B GA 30w5d EDD(GA) 01

Fetus Compare A B
CUA 29wad+/- 1w0d 30w0d+/- 1w0d
EDD(CUA) 01/16/2020

EFW 1543 g

BPD(Hadlock) 6.81cm 7.55¢cm
GA 27w3d 30w2d
HC(Hadlock) 27.41cm 27.95cm
GA 30wod 30w4d
OFD(HC) cm 10.17 cm
AC(Hadlock) 26.66 cm 26.14cm
GA 30w5d 30w2d
FL(Hadlock) 5.89 cm 576 cm
GA 30w5d 30w1d

Figure 8-19. Worksheet Display with Fetus Compare
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To Show Fetal Trending for Multiple Fetuses

8-34

NOTE:

When you have data for more than one exam, you can show
fetal trending and compare fetuses on one graph.

To view fetal trending for multiple fetuses:

1. Select Graph.

2. Select Fetus Compare.

3. Select Plot Both.

You can only view fetal trending for multiple fetuses in single
graph display.

The symbol key for fetal trending and multiple fetuses is shown
at the bottom of the graph.
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OB Table Editor
You can add user programmable OB tables to the system.

OB Table Settings Menu

You add OB Tables in the Measurement & Analysis menu. To
open the menu:

1. On the Touch Panel, select Utility, then select M&A.

2. Check the Exam Category on the far left of the monitor
screen. Make sure that Obstetrics is selected.

If it is not selected, select Obstetrics and continue selecting
the folders until the appropriate area is selected as to where
this new OB Table will be entered. For example, select
Obstetrics, then select OB-2/3. If there are further folders
within OB-2/3, select that appropriate folder.
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OB Table Settings Menu (continued)

3. On the monitor display, select the OB Table tab.
The system displays the OB Table settings menu.

Edit Tabls

Figure 8-20. OB Table settings

4. The OB Table settings menu lists OB Table parameters.
Specify the following parameter values as appropriate:

»  Study: Shows the study to which this measurement
table belongs.

 New/Edit: To create a new OB table, select New Table.

To edit an existing user-programmable OB table, select
Edit Table.

NOTE: You cannot edit the system’s OB Tables.
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OB Table Settings Menu (continued)

NOTE:

OB Table Template: To create a new OB table, select
the Template (1 - 7) which you want to use as the basis
of the user programmable OB Table. See ‘OB Table
Templates’ on page 8-38

To edit an existing user OB table, select the desired OB
table to edit.

Tool Type: Select the type of measurement: Distance or
Circumference.

Measure Name: Type the name of measurement that
will display on the Touch Panel.

Author Name: Type the author’s name.

Table Type: If necessary, select the Table Type: Fetal
Age or Fetal Growth.

Measure Type: Select a measurement type that can be
used to calculate EFW, for example BPD.

Measure Type is used only when calculating EFW.

NOTE: The following items are display only: Table Format, Table
Unit, SD/GP Range, and Graph Range. The system
determines these values automatically, based on the type of
OB table you are creating.

5. After specifying all parameter values, move the Trackball to
Edit Table and press Set.

The system displays the Edit Menu.

NOTE: If any of the OB table parameters are not correct, the Edit
Menu is not displayed.
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OB Table Templates

Tool Type:

» Distance: 2D Caliper
+ Circumference: 2D Ellipse, 2D Trace, 2D Caliper

Template 1
Table 8-3: Template 1 (based on Hadlock)
Template 1: SD Range Table
Fetal Age Table Table Format MEAS MEAN SD
Table Unit mm Week Week
Table Range 1SD
Graph Range 1SD
Measurement Result Value [cm]
GA [#wid]
Min [#w#d]
Max [#w#d]
Fetal Growth Table Table Format AGE MEAN SD
Table Unit Week mm Week
Others are same as above
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Template 2

Table 8-4: Template 2 (based on Tokyo)

Template 2: SD Range Table

Fetal Age Table Table Format MEAS MEAN SD
Table Unit mm Day Day
Table Range 1SD
Graph Range 1SD

Measurement Result Value [cm]
GA [#w#d]
SD: day(+/-)
EDD (Date)
GA-Min [#w#d]
GA-Max [#w#d]

Fetal Growth Table Table Format AGE MEAN SD
Table Unit Day mm Day
Others are same as above
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Template 3
Table 8-5: Template 3 (based on Osaka)
Template 3: SD Table
Fetal Age Table Table Format MEAS MEAN SD
Table Unit mm Day mm
Table Range 1SD
Graph Range 1SD
Measurement Result Value [cm]
GA [#wid]
SD: sd=(mv-pv)/sd
EDD (Date)
GA-Min [#wi#d]
GA-Max [#wi#d]
Fetal Growth Table Table Format AGE MEAN SD
Table Unit Day mm Day
Others are same as above
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Template 4
Table 8-6: Template 4 (based on several European tables)
Template 4: 5%-95% Table

Fetal Age Table Table Format MEAS MEAN SD
Table Unit mm WeekDay mm
Table Range 5%:95%
Graph Range 5%:95%

Measurement Result Value [cm]
GA [#wi#d]
GP [%]
GP is calculated by Fetal Growth Table. If you did not edit Growth Table,
GP is not calculated by the system,
EDD (Date)
GA-Min [#wid]
GA-Max [#w#d]

Fetal Growth Table Table Format AGE MEAN SD
Table Unit WeekDay mm Day
Table Range 5%:95%
Graph Range 5%:95%
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Template 5
Table 8-7: Template 5 (based on several European tables)
Template 5: 5% - 95% Table

Fetal Age Table Table Format MEAS MEAN SD
Table Unit mm WeekDay mm
Table Range 1SD
Graph Range 5%:95%

Measurement Result Value [cm]
GA [#w#d]
GP [%]

GP is calculated by Fetal Growth Table. If you did not edit Growth Table,
GP is not calculated by the system,

Fetal Growth Table

EDD (Date)

GA-Min [#wi#d]

GA-Max [#w#d]

Table Format AGE MEAN MAX
Table Unit WeekDay mm mm
Table Range 1SD

Graph Range 5%:95%

8-42
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Template 6
Table 8-8: Template 6 (based on several European tables)
Template 6: 10% - 90% Table

Fetal Age Table Table Format MEAS MIN MEAN SD
Table Unit mm WeekDay WeekDay WeekDay
Table Range 10%-90%
Graph Range 10%-90%

Measurement Result Value [cm]
GA [#w#d]
GP [%]
GP is calculated by Fetal Growth Table. If you did not edit Growth Table, GP is
not calculated by the system,
EDD (Date)
GA-Min [#witd]
GA-Max [#w#d]

Fetal Growth Table Table Format AGE MEAN MAX SD
Table Unit WeekDay mm mm mm
Table Range 10%-90%
Graph Range 10%-90%
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Template 7

Table 8-9:

Template 7 (Based on several european tables)

Template 7: 10% - 90% Table

Fetal Age Table Table Format MEAS MEAN SD
Table Unit mm WeekDay mm
Table Range 1SD
Graph Range 10%:90%

Measurement Result Value [cm]
GA [#w#d]
GP [%]

GP is calculated by Fetal Growth Table. If you did not edit Growth Table,
GP is not calculated by the system,

Fetal Growth Table

EDD (Date)

GA-Min [#wi#d]

GA-Max [#w#d]

Table Format AGE MEAN MAX
Table Unit WeekDay mm mm
Table Range 1SD

Graph Range 10%:90%

8-44
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OB Table Edit Menu

The data you enter in the OB Table Edit Menu depends on
whether the table type is Fetal Age or Fetal Growth.

Fetal Age Table
If you are creating or editing a Fetal Age table, the OB Table Edit

Menu is as follows:
ME&A Advanced Dcpp!er@@gﬁ'ﬂ&

Measure Author

Parameters

Min 10 Max 200 Interval

Cancel Exit To Save

Figure 8-21. OB Table Edit Menu: Fetal Age Table
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Complete the field
1. Input value to Min, Max and Interval of the Parameters field.
The system automatically fills in the MEAS column.
Input value to the columns of MEAN and SD.
NOTE: To move between the fields in the table, use the up, down,
left, and right arrow keys.

NOTE: You must enter a minimum of two rows of data. Any lines
with a blank cell are not saved.

To save the Table Data, move the Trackball to Exit to Save
and press Set. If you want cancel this table, move the
Trackball to Cancel and press Set.
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Fetal Growth Table
If you are creating or editing a Fetal Growth table, the OB Table
Edit Menu is as follows:

M&A Advanced Doppl

Measure

Parameters

Min Max Interval

MEAN

mm

Cancel Exit To Save

Figure 8-22. OB Table Edit Menu: Fetal Growth Table

Complete the field
1. Input value to the required columns.

NOTE: To move between the fields in the table, use the up, down,
left, and right arrow keys.

NOTE: You must enter a minimum of two rows of data. Any lines
with a blank cell are not saved.

2. To save the Table Data, move the Trackball to Exit to Save
and press Set. If you want cancel this table, move the
Trackball to Cancel and press Set.

After you complete the OB table, it is now available for the
selected study. To use the measurement, you must assignitto a
Touch Panel. See ‘Measurement and Calculation Setup’ on
page 7-88 for more information.
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EFW for OB User Table/Formula Editor

EFW Table Editor
You can edit an EFW Formula at the OB Table Editor.

1. Select Utility -> Measure -> OB Table.
2. Select the appropriate parameters and press Edit Table.
*  New/Edit: Select “New Table”
+ OB Table Template: Select appropriate template.
* Tool Type: Select “Weight”
* Measure Name: Enter measurement name.
*  Author Name: Enter author’s name.
» Table Type: Select “Fetal Age”

Edit-Tabia

Figure 8-23. OB Table Tab Screen

8-48 LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2



OB

EFW Table Editor (continued)
3. Edit the table data and press Exit To Save.

M&A Advanced Doppler (OB Tablel

Measure Author

Parameters

Interval

Exit To Save

Figure 8-24. OB Table Editor Screen
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EFW Formula Editor

1. Select the M&A tab and select Edit Calc. The Modify User
CALC window displays.

Select the user table previously added from the User
Defined pull-down menu and press OK.

cad Doppler 'O Table

Add folder

Figure 8-25. Modify User CALC window
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EFW Formula Editor (continued)
2. Double click the “Calculated” button for the EFW parameter.

anced Dappler 'O8 Tabla
LI

Add measirement Adid folder

Figure 8-26. M&A Tab Screen
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EFW Formula Editor (continued)
3. The EDIT FORMULA window displays. Edit the formula and
select OK.

Figure 8-27. EDIT FORMULA window

NOTE: When you edit a formula, be careful of the following points.

+ If you want to calculate EFW by centimeter, add “ *100 ” to
the {parameter}.
* If EFW is calculated in grams, add “ /1000 “ to the formula.

or example,
107(1.56{AC[Hadlock]}*100+0.08*{FL[Hadlock]}*100)/1000
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GYN

Introduction

The Gynecology exam category includes the following three
studies:

* Generic. This study is common to all exam categories. See
‘Generic Measurements’ on page 7-22 for more information.

* General Gynecology. This study includes uterine, ovarian,
ovarian follicle, and endometrium measurements.

*+ OB/GYN Vessel. This study includes the following vessels:
uterine, ovarian, umbilical, middle cerebral artery, aorta,
placenta, and descending aorta.

NOTE: The calculation formulas are listed in the Advanced Reference
Manual.
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B-Mode Measurements

8-54

In B-Mode, you make the measurements in the General
Gynecology study. These measurements include:

Uterine length, width, and height
Ovarian length, width, and height
Ovarian follicle

Cervix

Endometrium thickness

Fibroid

Figure 8-28. General Gynecology study
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Follicle measurements

You can make left and right ovary follicle measurements from
one, two, or three distances.

To select the left or right, adjust the Side selection.

Endometrium thickness

To measure the endometrium thickness, make one distance
measurement.

1.

Select Endometrium; an active caliper displays.

2. To position the active caliper at the start point, move the
Trackball.

3. To fix the start point, press Set.
The system fixes the first caliper and displays a second
active caliper.

4. To position the second active caliper at the end point, move
the Trackball.
A dotted line connects the measurement points.

5. To complete the measurement, press Set.
The system displays the endometrium thickness in the
Results Window.
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Ovary length, width, and height

You can measure the length, width, and height of the left and
right ovaries. Each measurement is a typical distance
measurement made in the appropriate scan plane.

Typically, length and height are measured on the sagittal plane
while the width is measured on the axial/transverse plane.

To measure ovarian length, width, or height:
Scan the patient's right or left ovary in the appropriate plane.
To select left or right, adjust the Side selection.

Select the OV folder, then select OV L, OV W, or OV H.
Perform a standard distance measurement.

Poobnp-~

Uterus length, width, and height

Each of these is a standard distance measurement. Typically,
length and height are measured on the sagittal plane while the
width is measured on the axial/transverse plane.

To measure uterus length, width, or height:

1. Scan the patient in the appropriate scan plane.

2. Select the UT folder, then select UT L, UT W, or UT H.
An active caliper displays.

3. Perform a standard distance measurement.

Cervix measurements

You can make cervix measurements from one distance or spline
trace.
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Cardiac

Overview

Cardiology measurements offer two different types of

measurement studies, Generic and Cardiac.

Figure 8-29. Touch Panel - Cardiac Exam Calc
*  Generic—Common to all applications. See ‘Generic
Measurements’ on page 7-22 for more information.

* Cardiac — This study includes all cardiac measurements.
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Naming Format for Cardiac Measurements

When you make a measurement, on the Touch Panel you select
the abbreviation for the measurement. Most abbreviations are
made using acronyms. The following table lists acronyms used
for naming cardiac measurements.

Table 8-10: Cardiology Abbreviations

Acronym Name
% STIVS % Interventricular Shortening
A Area
Acc Acceleration
AccT Flow Acceleration Time
ALS Aortic Leaflet Separation
Ann Annulus
Ao Aorta
AR Aortic Regurg
Asc Ascending
ASD Atrial Septal Defect
AV Aortic Valve
AV Cusp Aortic Valve Cusp Separation
AVA Aortic Valve Area
AV-A Aortic Valve Area by Continuity Equation
BSA Body Surface Area
Cl Cardiac Index
CcO Cardiac Output
d Diastolic
D Diameter
Dec Deceleration
DecT Deceleration Time
Desc Descending
Dur Duration
EdV End Diastolic Volume
EF Ejection Fraction
EPSS E-Point-to-Septum Separation
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Table 8-10:  Cardiology Abbreviations (Continued)

Acronym Name

EsV End Systolic Volume

ET Ejection Time

FS Fractional Shortening

FV Flow Volume

FVI Flow Velocity Integral

HR Heart Rate

IVRT IsoVolumetric Relaxation Time

IVS Interventricular Septum

L Length

LA Left Atrium

LAA Left Atrium Area

LAD Left Atrium Diameter

LPA Left Pulmonary Artery

Lv Left Ventricle

LVA Left Ventricular Area

LVID Left Ventricle Internal Diameter

LvVL Left Ventricle Length

LVM Left Ventricular Mass

LVPW Left Ventricle Posterior Wall

ML Medial to Lateral

MPA Main Pulmonary Artery

MR Mitral Regurgitation

MV Mitral Valve

MVcf Mean Velocity Circumferential Fiber Shortening

MVO Mitral Valve Orifice

oT Oultflow Tract

P Papillary Muscles

PA Pulmonary Artery

PAP Pulmonary Artery Pressure

PDA Patent Ductus Arterosis
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Table 8-10:  Cardiology Abbreviations (Continued)

Acronym Name
PEP Pre-Ejection Period
PFO Patent Foramen Ovale
PG Pressure Gradient
PHT Pressure Half Time
Pl Pulmonary Insufficiency
PISA Proximal Isovelocity Surface Area
PR Pulmonic Regurgitation
PV Pulmonic Valve
PV-A Pulmonic Valve Area by Continuity Equation
PVein Pulmonary Vein
PW Posterior Wall
Qp Pulmonic Flow or CO
Qs Systemic Flow or CO
RA Right Atrium
RAA Right Atrium Area
Rad Radius
RAD Right Atrium Diameter
RPA Right Pulmonary Artery
RV Right Ventricle
RVA Right Ventricle Area
RVAW RIght Ventricle Anterior Wall
RVD Right Ventricle Diameter
RVID Right Ventricle Internal Diameter
RVL Right Ventricle LEngth
RVOT Right Ventricle Outflow Tract
s Systolic
Sl Stroke Index
ST Shortening
SV Stroke Volume
SVi Stroke Volume Index
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Table 8-10:  Cardiology Abbreviations (Continued)

Acronym Name

T Time

TA Tricuspid Annulus

TAML Tricuspid Annulus Medial to Lateral

TR Tricuspid Regurgitation

TV Tricuspid Valve

TVA Tricuspid Valve Area

Vcf Velocity Circumferential Fiber Shortening

Vel Velocity

VET Valve Ejection Time

Vmax Maximum Velocity

Vmean Mean Velocity

VSD Ventricular Septal Defect

VTI Velocity Time Integral
In this manual, the abbreviation for each measurement is listed
in parenthesis after the measurement, as follows:
* Aortic Root Diameter (Ao Diam)
+ Left Ventricle Posterior Wall Thickness, Diastolic (LVPWAd)
For example, to measure the Aortic Root Diameter, you select
Ao Diam on the Touch Panel.
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Cardiac Doppler Measurements

E/e’ Ratio

8-62

NOTE:

The ratio of early transmitral velocity to early diastolic velocity of
the mitral annulus (E/e’) is measured in Doppler Mode and TVD
mode.

1. First, measure MV E/A Velocity to get “E”.
2. Measure €.
The system displays “e” in place of “e’” on the Touch Panel.

3. The system calculates E/e’ ratio automatically.
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Vascular

Introduction

Vascular measurements offer several different types of
measurement studies:

Carotid

Figure 8-30. Vascular Exam Category Touch Panel

*  Generic — Common to all applications. See ‘Generic
Measurements’ on page 7-22 for more information.

» Carotid

* LEA (Lower Extremity Artery)

* LEV (Lower Extremity Vein)

+ TCD (Trans Cranial Doppler)

*  UEA (Upper Extremity Artery)

* UEV (Upper Extremity Vein)

* Renal

* Bypass Graft

* UEV (Upper Extremity Vein) Map
* LEV (Lower Extremity Vein) Map
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Introduction (continued)

A vascular study is a group of particular vessels. You can
customize the vessel exam calcs in the configuration menu. See
‘Measurement and Calculation Setup’ on page 7-88 for more
information.

When you use Auto Vascular calculation, you use the vessel
keys on the Touch Panel to post-assign vascular calculations.
When you are not using Auto Vascular calculation, the vessel
key is used for manual measurement.

Naming format for vessels

When you want to measure a vessel, on the Touch Panel you
select the folder for the vessel. Many vessel folders are labeled
with an abbreviation. The following table lists abbreviations used
for naming vascular vessels.

Table 8-11:  Vascular Vessel Abbreviations

Acronym Name
ACA Anterior Cerebral Artery
Acc RA Accessory Renal Artery
AComA Anterior Communicating Artery
Anast Anastomosis
ArcA Arcuate Artery
ATA Anterior Tibial Artery
ATV Anterior Tibial Vein
AVF Arteriovenous Fistula
Axill Axillary Artery
Axill V Axillary Vein
Basilar Basilar Artery
Bas V Basilic Vein
BasV Antecub Basilic Vein Antecubital Fossa
BIF IMT Bifurcation Intima Media Thickness
Brac V Brachial Vein
CA Celiac Artery
CCA Common Carotid Artery
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Table 8-11:  Vascular Vessel Abbreviations

Acronym Name
Ceph V Cephalic Vein
Ceph V Antecub Cephalic Vein Antecubital
CFA Common Femoral Artery
CFV Common Femoral Vein
CHA Common Hepatic Artery
Com Femoral Common Femoral Artery
CIA Common lliac Artery
Clv Common lliac Vein
DFA Deep Femoral Artery
DFV Deep Femoral Vein
DPA Dorsalis Pedis Artery
ECA External Carotid Artery
EIA External lliac Artery
EIV External lliac Vein
Fr. Branch Frontal Branchr
FV Femoral Vein
GDA Gastroduodenal Artery
GR Graft
GSV Greater Saphenous Vein
HA Hepatic Artery
Hilar A Hilar Artery
HV Hepatic Vein
IIA Internal lliac Artery
v Internal lliac Vein
ICA Internal Carotid Artery (Transcranial Doppler)
ICA Interior Carotid Artery (Carotid Artery)
Vv Internal Jugular Vein
IMA Inferior Mesenteric Artery
IMT Intima Media Thickness
MV Inferior Mesenteric Vein
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Table 8-11:  Vascular Vessel Abbreviations

Acronym Name
Inn Innominate
Int. Lobular A InterLobular A
IvC Inferior Vena Cava
LSV Lesser Saphenous Vein
MCA Middle Cerebral Artery
Mcub V Median Cubital Vein
Mid Hep V Middle Hepatic Vein
MPV Main Portal Vein
MRA Main Renal Artery
Par. Branch Parietal Branch
PCA Posterior Cerebral Artery
PComA Posterior Communicating Artery
Peron Peroneal
POP Popliteal
Pseudo False Artery (aneurysm)
PTA Posterior Tibial Artery
PTV Posterior Tibial Vein
PV Portal Vein
RA Renal or Radial Artery
RV Renal or Radial Vein
SA Splenic Artery

Sap Fem Junc

Sapheno-Femoral Junction

Seg. A Segmental Artery
SFA Superficial-Femoral Artery
SMA Superior Mesenteric Artery
SMV Superior Mesenteric Vein
SSV Small Saphenous Vein
STA Superficial Temporal Artery
SUBC Subclavian Artery
SUBCV Subclavian Vein
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Table 8-11:  Vascular Vessel Abbreviations

Acronym Name
SV Splenic Vein
SV Pop Junc Small Saphenopopliteal Junction
TCD Transcranial Doppler
TIPS Transjugular Intrahepatic Portal Systemic Shunt
UA Ulnar Artery
uv Ulnar Vein
VERT Vertebral Artery
VES Vessel
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IMT Measurement

NOTE:

You can measure the average of the intima media thickness for
use as the index of arterial sclerosis.

IMT can be measured both on the posterior and the anterior
walls of the vessel.

Due to the physical properties of ultrasound imaging, the
posterior IMT measurement is generally more accurate than the
anterior IMT measurement.

IMT Measurement - Auto

Auto IMT automatically measures the thickness of the Intima
Media on the far and near vessel walls. Near Wall IMT is the
distance between the trailing edges of the adventitia and intima;
the Far Wall IMT is the distance between the leading edges of
the adventitia and intima.

Set up the parameters you want to record on the worksheet on
the Utility -> Measure -> M&A page while are in the Carotid
application. Select CCA/ICA/BIF -> IMT Far/Near -> Parameter
(Average, Max, Min, Standard Deviation, Points of Distance).

8-68

Figure 8-31. Configuring Auto IMT
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IMT Measurement - Auto (continued)

In the Vascular Carotid application, the Auto IMT measurement
is available.

IMT Far

Figure 8-32. Auto IMT Touch Panel

The following controls are available.

Table 8-12:  Auto IMT Touch Panel Descripion

Parameter Description
Worksheet Select to view the Worksheet
IMT Far Select to begin the Far Field IMT measurement
IMT Near Select to begin the Near Field IMT measurement.
AP Anterior Posterior
Trans Transverse

Length/Offset Rotary

Push to save Length/Offset as a preset

-40/+40 Length. At zero, you can freely adjust the length, but only vertically.
Press key to save value as default.

Offset distance, -20 (Left) / +20 (Right)

Overall / IMT Trace Fit/
Intima

Adjusts (remeasures) the IMT automatically measured by the system.

Rt /Lt Side

Select Left / Right Side.

Cursor Select

Allows you to update cursor placement.
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IMT Measurement - Auto (continued)

8-70

To measure the IMT,

1.
2.
3.

In the Carotid application, press Freeze, press Measure.
Position the crsor, then select IMT Far.

Use the Trackball to set the length.

Or

Use the Length / Offset controlon the Touch Panel to set
the length and offset distance. The Offset key controls how
far away from he vertical line the measurement starts.
Length is the length of he tool itself. If set to zero, you can
adjust it anywhere on the image.

Press Set.

You can eiher adjust the trace prior to pressing the Print key
or press the Print key to store the image which also saves
the measurement to the Worksheet.

To adjust the trace, use the Overall IMT Trace Fit Intima
control on the Touch Panel. The Trace fir (up/down) adjusts
the inter luminal line whereas the overall (rotate) adjusts
both IMT lines.

o — 1}

Lt Prox CCA IMT F Avg 0.52 rnmi
Lt Prox CCAIMT F Max 0.64 II'III'Ii
Lt Prox CCAIMT F Points 193

2 Lt Prox CCAIMT N Avg 0.56 mm

Lt Prox CCAIMT N Max 0.67 mm
Lt Prox CCA IMT N Points 71

Figure 8-33. Example of Auto IMT Far Measurement
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IMT Measurement - Auto (continued)

NOTE:

5. Position the cursor, then select IMT Near.
6. Use the Trackball to set the length.

Or

Use the Length / Offset controlon the Touch Panel to set
the length and offset distance.

Press Set. “Store image to accept IMT measurement”
displays in the message area. If the traces fit both layers of
the wall, approve the measurement by pressing the Print
key to store the image.

To adjust the trace prior to pressing the Print key, use the
IMT Trace Fit control on the Touch Panel. The measurement
is saved to the Worksheet.

Since the IMT measurements are semi-automatic, the
operator has to approve the detection by visual inspection
before storing the results in the worksheet and report.

IMT Measurement - Manual

Before you measure the IMT, add the IMT measurement to
the Carotid folder via the Measurement & Analysis screen
(by selecting one of the three types of IMT measurements
under Add Measurement in the M&A screen).

* IMT: Three vertical lines are parallel. Place the start
point on the line and place the end point anywhere.

* IMT2: Each vertical line can be rotated with the Ellipse
control. You must place the start and end points on the
line.

* 5mm Scale: The horizontal line can be rotated with the
Ellipse control. A maximum of 20 distance values which
produce one average value can be taken. The number
of distance values is specified when adding the
measurement in the M&A screen.

IMT and IMT2 have three kinds of measurements:

s IMT --+/IMT2 --+: Measure from right to left.

e IMT -+-/IMT -+-: First measure at the center, then right
and left are last.

*  IMT+--/IMT2 --+: Measure from left to right.
Acquire a longitudinal scan of the carotid artery and
optimize the image. Then press Freeze.

Scroll to an end-diastolic frame where the intima layer is
clearly visible.
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IMT Measurement - Manual (continued)

4. Press Measure, then select IMT1, IMT2 or 5mm scale. An
active caliper displays.

0.0 mmy
0.0 mm
Ave 0.0 mm

Figure 8-34. IMT caliper (Example)

5. Use the Trackball to move the caliper and the Ellipse
control to adjust the angle. Press Set to fix the caliper.

NOTE: The interval of the vertical line for IMT1 and IMT2 is 1cm
and for the 5mm scale is 5mm.
6. Measure the thickness of three points for IMT1 and IMT2.
OR

Measure the thickness of the specified number of points for
the 5mm scale.

NOTE: The caliper moves to the next point automatically.
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IMT Measurement - Manual (continued)

7. After you complete the measurement, the system calculates
the average automatically.

Figure 8-35. IMT Measurement
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Plaque Score Tool

1. Before you measure, add Plaque Score to the Carotid folder
at the Utility -> Measure -> Measurement & Analysis screen
(by selecting 2D Plaque Score under Add Measurement in
the M&A screen).

Label the parameters you want measured:

Distance value (up to 20)

Sum (greater or equal to 1.1 mm)
Count (greater or equal to 1.1 mm)
Maximum value of each area
Average value

Average value of each area

2. Scan the carotid artery and press Freeze. Display dual
images to measure across split screen images.

3. Press Measure and select Plaque Score Tool. An active
caliper, one horizontal line and five vertical lines display. The
interval of the vertical lines are 1.5 cm.

Figure 8-36. Plaque score example

4. Use the Trackball to move the caliper and the Ellipse
control to adjust the angle. Press Set to fix the caliper.
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Plaque Score Tool (continued)

5. Measure the thickness (up to twenty times) on any place as
necessary.

Count  1.00

Figure 8-37. Plaque Score Example 2

6. The system displays the measurement result.

Figure 8-38. Plaque Score Example 3

NOTE: Only calculates the value larger than 1.1mm.

7. Double click the Set key to finish the measurement.
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Auto Vascular Calculation

Auto Vascular Calculation enables the LOGIQ P8/P9/P10 to
detect and identify a cardiac cycle. It allows you to assign
measurements and calculations during live timeline imaging,
while the image is frozen, or in CINE. Peak values are detected
for venous flow.

During cardiac cycle detection, the system identifies the cardiac
cycle using calipers, vertical bars, and/or highlighting of timeline
data. Use of identifiers is based on measurements and
calculations selected by an operator for the current application.
The system may place calipers at early systolic peak, peak
systole, minimum diastole and end diastole. Vertical bars may
also be placed to indicate the beginning and end of the cardiac
cycle. The peak and/or mean trace may be highlighted. You can
edit the cardiac cycle identified by the system or select a
different cardiac cycle.

You can select the calculations to be displayed in the M&A
Result window during live scanning or on a frozen image. These
calculations are displayed at the top of M&A Result Window
located adjacent to the image. These calculations are
presettable by application which means you can set up the
default calculations to be displayed for each application.

Activating Auto Vascular Calculation

To activate Auto Vascular Calculation, select Auto Calc from
Live (calculations displayed on the real-time image), or Freeze
(calculations displayed on the frozen image).

To deactivate Auto Vascular calculation, select Off.

Auto Calcs

| Live

Figure 8-39. Auto Calculation Touch Panel key
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Setting up Auto Vascular Calculation Parameters

+ Selecting Auto Trace

You can select to have a continuous auto trace of the max or
mean velocities.

» Select Max or Mean using the Trace Method Touch
Panel pull-down menu.

» Selecting Trace Direction

Trace Direction lets you use peak timeline data above,
below, or composite (above and below) the baseline.

+ Select Positive, Negative or Both to set the peak
timeline data.

 Modify Calculation

a. Select the Modify Calcs Touch Panel key.
The Modify Calculation menu is displayed.

b. Select which measurements and calculations are to be
displayed in the Auto Vascular calculation window.

You can select the following parameter: PS, ED, MD,
HR, TAMAX, PI, RI, Accel, PS/ED, ED/PS, AT, Volume
Flow, PV.
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Auto Vascular Calculation Exam

1. Preset the system.
2. Perform the scan and press Freeze.
3. Activate Auto Vascular Calculation.

The system performs a calculation automatically.

Figure 8-40. Auto Vascular Calculation
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Auto Vascular Calculation Exam (continued)

The Auto Vascular calculation is assigned to particular vessel
measurements.
1. Press Measure to display the Measurement menu.

2. Select the location of the vessel (Prox, Mid, or Dist) and
Side (Right or Left).

3. Select the desired vessel name from the Touch Panel.
Selected vessel measurements are automatically assigned

with the Auto Vascular calculation. The results are then
displayed in the Results Window.

Figure 8-41. Assigned Vessel

NOTE: When you want to cancel the assignment, you can use the
Cancel Transfer Touch Panel key. See ‘Cancel Transfer’ on
page 7-38 for more information.
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Auto Vascular Calculation (continued)

8-80

NOTE:

NOTE:

During the course of an exam, the cardiac cycle may be
indicated between two yellow bars; the peak trace and the mean
trace may appear in green; calculation indicators appear on the
spectral trace as a caliper identifier (these vary, depending on
the selected calculation in the Results Window).

The right-most, most complete cycle is typically chosen to be the
selected cardiac cycle. You can select a different cardiac cycle.

To select a different cardiac cycle:
*  Move through CINE memory with the Trackball until the
desired cardiac cycle is selected by the system.

You need several good cycles in front of the new cardiac
cycle for this to be successful. Oftentimes, this is
problematic near a freeze bar.

» Use the Cycle Select control to cycle to a different cardiac
cycle.

You need several good cycles in front of the new cardiac cycle
for this to be successful. Oftentimes, this is problematic near a
freeze bar.

To move the systole or diastole position:

* Use the Cursor Select control to move the start systole
position or the end diastole position.
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Manual Vascular Calculation

You can perform the following calculations manually when Auto
Doppler Calculation is not activated.
1. Press Measure.

If necessary, you can select another Exam Calc and then
select parameters from Modify Calculation.

2. Select the location of the vessel (Prox, Mid, or Dist) and
Side (Right or Left).

3. Select the desired vessel folder.
The Measurement menu is displayed.

Figure 8-42. Measurement Menu Example

4. Make the required measurements according to the system,
or select your preferred measurements.
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To select vascular measurements

Your system is set up to show the measurements that you
usually make for each vessel. To make a measurement that is
not shown for the selected vessel:

1. Select the folder for the vessel you want to measure.

Figure 8-43. Aorta folder - example

2. Select Show All.

The system displays all possible vessel measurements.
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To select vascular measurements (continued)

3. Select the desired measurement.

@ worksheet Show All Return

FLOW VOLUME

Figure 8-44. Show All measurements

NOTE: The following instructions assume that you first scan the patient
and then press Freeze.
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Urology

Introduction

Urology measurements offer three different types of
measurement studies:

*  Generic—Common to all applications. See ‘Generic
Measurements’ on page 7-22 for more information.

*  Urology

» Pelvic Floor. See ‘Pelvic Floor Measurements’ on page 8-89
for more information.

NOTE: Bladder(0.7) Vol, Bladder Vol, Post Void Vol, Prostate Vol, Renal
Vol, Renal (0.8) Vol and Volume can be displayed on the Touch
Panel if preset at the Ultility -> Measure screen.

8-84 LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2



Urology

Bladder Volume

This calculation uses a standard distance measurement. Length
is typically measured in the sagittal plane. Width and height are
measured in the axial plane.

Bladder |

Figure 8-45. Bladder Volume Touch Panel
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Renal Volume

This calculation uses a standard distance measurement. Length
is typically measured in the sagittal plane. Width and height are
measured in the axial plane.

Figure 8-46. Renal Volume Touch Panel
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Prostate Volume

This calculation uses a standard distance measurement. Length
is typically measured in the sagittal plane. Width and height are
measured in the axial plane.

Figure 8-47. Prostate Volume Touch Panel
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Prostate Volume (continued)

PSA Measurement

If you enter the value of PSA (Prostatic Specific Antigen) and
PPSA Coefficient at the Urology Patient screen, PSAD and
PPSA are automatically calculated.

The values are displayed on the Worksheet and Report (if set
appropriately on the Report Designer page).

Figure 8-48. Urology Patient Screen

1 Prostate L 294 cm
2 ProstateH 2.89 cm|
3 Prostate W 2.14 cm|

Prostate Vol 9.50 m||
PSAD

PPSA(1)
PPSA(2)

Figure 8-49. Measurement result window

PSAD: Prostatic Specific Antigen (PSA) Density — defined as:
PSAD = PSA/Volume

PPSA: Predicted Prostate Specific Antigen — defined as: PPSA
= Volume x PPSA Coefficient
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Pelvic Floor Measurements

Pelvic floor measurements can be performed in the Pelvic Floor
study. The measurements are located in the Exam Calc folder in
the Urology preset.

Figure 8-50. Pelvic Floor Study Touch Panel

BN (Bladder Neck) Rest

Obtain an image with the patient at rest (relaxed).

1. Create a straight line (zero or baseline) to line up with the
inferior/posterior of symphysis pubis bone.

2. Once the baseline is positioned, a caliper appears. Position
the caliper at the anterior margin of the bladder neck. A
positive number displays since the caliper is placed below
the baseline.

3. A distance is calculated in millimeters.
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Pelvic Floor Measurements (continued)

BN (Bladder Neck) Stress

Obtain an image after the patient performs the Valsalva
maneuver.

1.

Create a straight line (zero or baseline) to line up with the
inferior/posterior of symphysis pubis bone.

Once the baseline is positioned, a caliper appears. Position
the caliper at the anterior margin of the bladder neck.

If the bladder neck is below the baseline, the Bladder Neck
Stress is a positive number. If the bladder neck is above the
baseline (closer to the transducer face), the number is
negative.

BN (Bladder Neck) Descent

The Bladder Neck Descent is a calculation that should be
calculated after measuring the Bladder Neck Rest and Bladder
Neck Stress.

BND = Bladder Neck Rest - Bladder Neck Stress

NOTE: If the Bladder Neck Stress is a negative nhumber, it becomes
positive and is added to the bladder neck rest measurement.

DWT (Detrusor Wall Thickening)

Three distance measurements of the bladder wall dome are
calculated into a mean dimension and displayed in millimeters.

UT (Uterine) Descent Max

8-90

Create a straight line (zero or baseline) to line up with the
inferior/posterior margin of symphysis pubis bone.

Measure using a 2-caliper dimension to the inferior position
of the uterus in a stress image and display in millimeters
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Pelvic Floor Measurements (continued)

Rect Amp Des Max (Rectal Ampulla Descent Max)

1. Create a straight line (zero or baseline) to line up with the
inferior/posterior margin of symphysis pubis bone.

2. Measure using a 2-caliper dimension to the inferior position
of the rectal ampulla in a stress image and displayed in
millimeters

Rectocele (Depth and Width)

Two 2-caliper diameter measurements to measure depth and
width of the rectocele. Displayed in millimeters.

Lev Hiat Stress (Levator Hiatus Stress)

Two 2-caliper diameter measurements and calculate an area
displayed as cm squared.

Residual Urine

Two 2-caliper diameter measurements calculate as:

(x) times (y) times 5.9 minus 14.9 equals Residual Volume
displayed in ml.
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Pediatrics

Overview

Pediatrics measurements offer two different types of

measurement studies:

*  Generic. The Generic Calculations study is common to all
applications. See ‘Generic Measurements’ on page 7-22 for
more information.

+ Pediatric Hip (PedHip).

Figure 8-51. Touch Panel - Pediatrics Exam Calcs
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Pediatrics Hip

Figure 8-52. B-Mode Measurement Touch Panel — PedHip
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Hip Dysplasia Measurement

The HIP calculation assists in assessing the development of the
infant hip. In this calculation, three straight lines are
superimposed on the image and aligned with the anatomical
features. The two angles are computed, displayed, and can be
used by the physician in making a diagnosis.

The three lines are:'

1. The baseline connects the osseous acetabulum convexity to
the point where the joint capsule and the perichondrium
unite with the iliac bone.

2. The inclination line connects the osseous convexity to
labrum acetabulare.

3. The Acetabulum roof line connects the lower edge of the
osilium to the osseous convexity.

The a (Alpha) angle is the supplement of the angle between 1
and 3. It characterizes the osseous convexity. The 3 (Beta)
angle is the angle between lines 1 and 2. It characterizes the
bone supplementing additional roofing by the cartilaginous
convexity.

Figure 8-53. Hip Dysplasia

Anatomical Landmarks

a. llium d. Bony Roof
b. lliac Bone e. Cartilaginous acetabular roof
c. Labrum f. Femoral Head

'Source: R GRAF, Journal of Pediatric Orthopedics, 4:
735-740(1984)
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Hip Dysplasia Measurement (continued)

To make a Hip Dysplasia measurement:

1.

From the Touch Panel, select either the right or left side
(orientation) and then select Beta Alpha HIP.

A horizontal dotted line displays.

2. To place the baseline, move the Trackball. Position the
crosshairs edge at the osseous convexity of the ilium.

3. To rotate or change inclination, adjust the Ellipse control or
Hip Rotate.

4. To fix the baseline, press Set.
The system displays a second dotted line at an angle.

5. To place the line along the inclination line of the osseous
convexity to labrum acetabulare, move the Trackball.

6. To rotate or change inclination, adjust the Ellipse control or
Hip Rotate.

7. To fix the second measurement line, press Set.
The system displays a third dotted line at an angle.

8. To place the caliper along the acetabular roof line, move the
Trackball.

9. To rotate or change inclination, adjust the Ellipse control or
Hip Rotate.

10. To fix the third measurement line and complete
measurement, press Set.
The system displays the hip measurements (o and B) in the
Results Window.
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Alpha HIP

8-96

The Alpha HIP measurement measures the angle between the
iliac baseline and the bony roof line. To make an Alpha HIP
measurement:

1.

From the Touch Panel, select either the right or left side
(orientation) and then select Alpha HIP.

A horizontal dotted line displays.

To place the baseline, move the Trackball. Position the
crosshairs edge at the osseous convexity of the ilium.

To rotate or change inclination, adjust the Ellipse control or
Hip Rotate.

To fix the baseline, press Set.
The system displays a second dotted line at an angle.

To place the caliper along the acetabular roof line, move the
Trackball.

To rotate or change inclination, adjust the Ellipse control or
Hip Rotate.

To fix the second measurement line, press Set.

The system displays the alpha hip measurement (o) in the
Results Window.

LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2



Pediatrics

d:D Ratio Measurement

The d:D Ratio measurement measures the percentage of the
femoral head coverage under the bony roof. To make this
measurement:

1.

From the Touch Panel, select either the right or left side
(orientation) and then select d:D Ratio.

A horizontal dotted line displays.

2. Use the Trackball to place the baseline along the ilium.
Position the crosshairs edge at the osseous convexity of the
ilium.

3. Use the Ellipse control to adjust or change inclination or Hip
Rotate.

4. Press Set to fix the baseline.

5. The system displays a circle representing the femoral head.
Use the Trackball to position the circle.

6. Use the Ellipse control to size the femoral head
circumference.

7. Press Set to fix the femoral head circumference.

The system displays the d:D ratio for the femoral head in the
Results Window.
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Chapter 9

Recording images

Describes how to record images.
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Getting Set Up to Record Images

Overview

A typical workflow for connectivity might be as follows (this setup
varies by each user setup):

1.

o

© © N O

9-2

Select the dataflow, worklist for example.
Start a new exam. Select the patient.
Perform the patient scan.

Store images as multi-frame CINE Loops and Raw DICOM
data via the P1 key.

Store secondary capture for DICOM print via P2 key.
Store images to the color printer or B/W printer via P3 key.
Check the DICOM Job Spooler via F4 to verify delivery.
End the exam.

Permanently store images via the Patient menu to
permanent storage.
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Overview (continued)

NOTE:

During an examination, the operator stores data, images and
cineloops for immediate purposes. The LOGIQ P8/P9/P10
includes an integrated patient archiving system for data and
image storage.

The LOGIQ P8/P9/P10 enables also storing of data and images
to external databases (Network Server, removable media).

Dataflow combines archive, data, DICOM, and onboard records
into one coherent workflow. Destination devices are configured
and assigned to the print keys. You select the appropriate
dataflow (Portable, etc.) according to your requirements. You
manage the patient database (local, shared, or via a worklist
broker).

* DO NOT use the internal hard drive for long-term image
storage. Daily backup is recommended. External storage
media is recommended for image archive.

DICOM images are stored to external media storage
devices separately from patient data, which also needs to be
backed up to a dedicated database-formatted external
storage media.

+ If working off-line with a dataflow pointing to a DICOM
server, the images stored during the examination may have
to be manually resent in the DICOM spooler when
reconnecting the unit. Resend all jobs that failed or are on
hold.

In addition, stored images and cineloops can be saved to a
removable media in the standard formats JPEG, MPEG, AVI
and DICOM.

* You need to set up a process for locating images stored to
external storage media for easy recall

*+ GE IS NOT responsible for lost data if you do not follow
suggested back-up procedures. GE WILL NOT aid in the
recovery of lost data.

Refer to the Customizing Your System chapter for instructions
on setting up your system’s connectivity.
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Adding Devices

To add a destination device (printer, worklist server, etc.) to this
system, see ‘Device’ on page 10-90 .

To verify a DICOM device, see ‘Device’ on page 10-90 .

Adding a Dataflow
To add a new dataflow to this system, see ‘Dataflow’ on
page 10-105 .

Adding Devices to a Print Button
To add devices/dataflows to a print button, see ‘Button’ on
page 10-107 .

Formatting Removable Media

To format removable media, see ‘Formatting removable media’
on page 10-110 .
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Storing Images and Cineloops

NOTE:

Storing an image

NOTE:

Images and cineloops that are stored during a current
examination are displayed as thumbnails on the clipboard.

When an image is stored, all the additional information that is
displayed is saved with it (i.e. probe and application selected,
image setting, annotations or measurements).

See for detailed settings related storing image/Cine.

The image archive is set by the dataflow selected (See for more
information.)

When you want to print/store an image, the P1 is most
commonly used for the primary destination and internal hard
drive.

The recalled split screen cannot be edited.

To store an image,

1. While scanning, press Freeze.
2. Scroll through the cine Loop and select the desired image.
3. Press the appropriate Print key.

The selected image is stored (per your preset instructions)
and a thumbnail is displayed on the clipboard.

LOGIQ P8/P9/P10 numbers the images which are saved in the
Local Archive (Instance Number). But Instance Number may
change or get duplicated when adding/deleting images to the
exam. So for identification, the recommendation is to use
Content Date/Content Time on the DICOM server instead of
Instance Number.
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Storing a cine loop

9-6

NOTE:

A cine loop is a sequence of images recorded over a certain
time frame. The stored cine Loops are displayed chronologically
on the clipboard.

Cine loops can be stored at any time during scanning. You can
choose to preview the cine loop before storage and save the
cine loop directly, as described below.

The system can be configured to perform either

*  Prospective clip: The system begins storing cine from when
you press the Print button, based on the Time Span setting.

+ Retrospective clip: The system stores cine predetermined
time before you press the Print button, based on the Time
Span setting.

Refer to ‘Retrospective Cine/Prospective Cine’ on page 9-9
about the setting.

LOGIQ P8/P9/P10 numbers the images which are saved in the
Local Archive (Instance Number). But Instance Number may
change or get duplicated when adding/deleting images to the
exam. So for identification, the recommendation is to use
Content Date/Content Time on the DICOM server instead of
Instance Number.

LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2



Storing Images and Cineloops

Previewing and Storing a CINE Loop

6.
7.

While scanning, press Freeze.
Move the Trackball to activate Cine.

Use the trackball or Frame by Frame to scroll through the
acquisition and find the sequence of interest.

Press Start Frame or End Frame to set the corresponding
cineloop boundary to the current frame as necessary.

Rotate Start Frame and End Frame to trim or expand the
cineloop boundaries.

Press Run/Stop to run the cineloop and then press the print
key to store the cineloop.

Cine loops stored on the clipboard are indicated with a
movie strip icon.

Press Run/Stop again to stop the cine loop.
Press Freeze to return to live scanning.

Depending on whether the system has been configured to
enable or disable “Preview Loop before store” (see ‘Print
Controls’ on page 10-68 ), the following procedures enable the
cine loop to be stored directly.

Storing a cine loop without Preview

If “Preview Loop before store” is disabled,

1.

While scanning, press the appropriate print key.

2. The last valid cine loop is stored in the archive and a movie
clip thumbnail is displayed on the clipboard.
3. Scanning resumes immediately.
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Recording images

Storing a cine loop with Preview

Preview

9-8

NOTE:

If “Preview Loop before store” is enabled,

1.

2.
3.
4

While scanning, press the appropriate print key.
The last valid cine loop is previewed.

Adjust the cine loop, as necessary.

Press the appropriate print key.

The movie clip thumbnail is displayed on the clipboard.

Loop Preview can now be enabled independently for Time
-Based Store, ECG-Based Store, and Mark CINE. This is useful
for setting preview preferences based on the application.

The Contrast Time Span setting overrides the Time Span when
in Contrast Mode.
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Storing Images and Cineloops

Retrospective Cine/Prospective Cine

Sattings

Figure 9-1. Print Control

Retrospective CINE

When you select to store a cine loop retrospectively, the system
stores cine for a specified time before you press the Print
Button.

1. Set Live Store P1 - P6 to “Retrospective Clip” via Utility ->
Application -> Print controls.

2. Specify the recording time in Time-Based Store or
ECG-Based Store.

3. Press Save.

Prospective CINE

When you select to store a cine loop prospectively, the system
begins storing cine from when you press the Print button.

1. SetLive Store P1 - P6 to “Prospective Clip”.

2. Specify the recording time in Time-Based Store or
ECG-Based Store.

3. Press Save.

NOTE: The CINE gauge turns green when a Prospective CINE Clip is

pending.
NOTE: You can cancel Prospective Store by pressing Freeze/Unfreeze
or by changing Modes.
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Recording images

Review images in archive

There are two ways to access to archived images:

* Review the images from a selected examination.

+ Select images from the Active Image screen displaying all
the images sorted by examination for the actual patient
record.

NOTE: The recalled split screen cannot be edited.

Review the patient exam/image

To review the patient exam,

1. Move the cursor to the patient in the Patient View and
double-click. Exam View displays.
or

Move the cursor to the patient and select Exam View tab or
Review. Exam View Displays.

2. Move the cursor to the desired exam and double-click.

3. Active Images screen displays. Move the cursor to the
image and double click or press Review.

4. The review screen displays. Select the image from
clipboard.

NOTE: See ‘Clipboard’ on page 9-16 for more information.
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Review images in archive

Active Images

Active Images displays the images of the exam.

NOTE: CINE loops are not played interactively as you view the active
images on the Patient screen.

Figure 9-2. Active Images Screen

1. Select the exam which includes the image to review.

2. Select Active Images.

3. Select the image and press Review or double click on the
image. The image is displayed.
If you select 2 - 4 images and select Review, the archived
images are displayed in the split screen.

NOTE: If the size of an image is larger than 2GB, the image does not
display on the Active Image screen. Take care when you scan a
long CINE Loop, such as in Contrast.
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Recording images

Active Images (continued)

Table 9-1:  Active Images

Parameters Description
Delete Images To delete selected images, select the image in the active screen, then select
Delete Selected Images/ “Delete” on the monitor display or “Delete Selected Images” on the Touch
Delete All Temp. Images Panel.

To delete all images, select the image, then select “Delete All Temp.
Images” on the Touch Panel.

Permanent Store Select the images which you want save to the Local hard disk drive.

Standard Print To print an image,

1. Select the image you want to print from the Active Images screen. You
can print one (1) image per sheet or 2x3 images per sheet.

2. Press Standard Print.

NOTE: If the printer is not assigned to the button, you will get a message

telling you to Check Printer Button Configuration.

NOTE: There is no warning to let you know that the printer is not functioning.

Check the printer.

You need to configure the printer to the Standard Print button via Utility -->

Connectivity --> Button.

SaveAs Images Refer to "SaveAs’ Images’ on page 9-24 for the detail.

You can select the multiple images collectively in Active Image screen which
you want save by SaveAs.

NOTE: We suggest that you save the images page by page with 'SaveAs’
Images in Active Images. It takes time if you have many images or raw data.

Select Images/Select All « To select one or multiple image, place the cursor on the image and press
Unselect All Set.

* To select all images, press Select all on the Touch Panel.

* To deselect images, press Deselect all on the Touch Panel.

Send To Refer to ‘Send To (Send the image to the DICOM Device)’ on page 13-388
for the detail.

Note: “Send To” button is not displayed in Active Images menu and the
Touch Panel if the patient is not selected.

Analyzing Images

To analyze the archived images, select the image, then select
Review. The archived images is displayed with the date and
time of archival.

To compare the analyzed image to a live image, press L/IR. Now
both the archived and live images appear on the monitor display.
Unfreeze the live image area.
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Review images in archive

Image History

Image History displays the images of each exam in
chronological order of the patient.

1. Select the patient.

2. Select Image History.

3. Select the appropriate button which shows the old exam by
date and storage location. ‘Active Exam’ is displayed on the
button.

Figure 9-3. Image History Screen

4. Move the cursor to the required image for review.

5. Select Review. The selected image (maximum of 4 images)
is displayed.
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Recording images

Image History (continued)

If the image data is saved on a disk and you do not insert the
disk when displaying the Image History page, a triangle icon
displays instead of a thumbnail.

Place the cursor on the icon. The disk name displays under the
preview window. Insert the appropriate disk.

a. Name of the disk displayed under the preview window
b. Raw data B-Mode image
c. Raw data Color image
d. Image which does not have raw data (screen capture
image)
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Review images in archive

Image History (continued)

Viewing two different studies from the same patient

To view images side-by-side from two different studies on the
same patient,

1.

Select the patient.

2. Go to the Image History page.
3. Select the first image.
4. Select the next image from the other exam.
5. Press Review.
LOGIQ P8/P9/P10 — Basic User Manual 9-15

Direction 5841298-1EN Rev. 2



Recording images

Clipboard

The clipboard displays thumbnail images of the acquired data
for the current exam. Images from other exams are not
displayed on the current patient’s clipboard.

NOTE: If you have unsaved images in the clipboard and change the
exam, the dialogue “You have unstored images. They will be
saved to your current exam” displays. The unsaved images are
saved to the current exam.

All of the images can be viewed in the Active Images screen or
in the Image History screen, available from the display or from
the Patient menu.

Figure 9-4. Clipboard example
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Clipboard

Clipboard icon

Figure 9-5. Side clipboard icon

1. Number of Images in Exam

The number of images in an exam is tracked on the bottom
of these Monitor Display Controls.

2. Thumbnail Size
Place the cursor on one of the Thumbnail size box icons and

press Set.
3. Prev/Next Image
4. Save As

5. Delete recalled image / Delete last image

Saving the image /cine to the Clipboard

The active image/cine is stored and placed on the clipboard
when you press the print key (this assumes that you have
already set up a print key to do this). The clipboard contains
preview images with enough resolution to clearly indicate the
contents of the image. CINE Loops are indicated by a movie clip
icon.

The clipboard fills from left to right, starting in the left-hand
corner. Once the top row is full, the second row starts to fill.
Once both rows are full, the next image stored starts to fill a
‘third’ row (the first row disappears from the clipboard display,
with the second row now becoming the first row, and the third
row now becoming the second row).
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Recording images

Previewing Clipboard Images

1.
2.

Select the Pointer key to obtain a cursor arrow.

Move the Trackball to position the pointer over the
clipboard image you want to recall.

An enlarged preview of the image is displayed on the
left-hand side of the monitor.

Recalling Images from the Clipboard

To recall images from the clipboard,

1.
2.

Select the Pointer key to obtain a cursor arrow.

Move the Trackball to position the pointer over the
clipboard image you want to recall.

Press Set to recall the image.

Press the left/right arrow of Menu icon to move to the
previous/next image.

To delete an image from the clipboard

9-18

If in images live, press Freeze.
Select the Pointer key to obtain a cursor arrow.

Place the cursor on the clipboard image you want to delete,
then press Set to select the image.

Place the cursor on the Delete icon and press Set.

A warning message is displayed asking the user to confirm
the action to perform.

Select Yes.
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Save As

Overview

Images and cineloops can be saved to a removable media or
Network storage to View on a Windows PC in the following
standard formats:

« Still images: JPEG, DICOM and RawDICOM (Raw data +
DICOM)

+ Cineloops: WMV, AVI, DICOM and RawDICOM (Raw data +
DICOM)

Images can also be stored as MPEG format as described on
‘MPEGvue’ on page 9-48 .

LOGIQ P8/P9/P10 — Basic User Manual 9-19
Direction 5841298-1EN Rev. 2



Recording images

SaveAs

9-20

NOTE:

NOTE:

NOTE:

To save images to the media:

1.

Insert the media into the drive or connect the USB drive to
the system.

If you have not formatted the media, the media will be
formatted when you select Save As.

On the scan screen, press the left Set key. The arrow cursor
displays.

Place the cursor on the image or CINE Loop in the clipboard

to be saved and press Set. The image displays on the
screen.

Select SaveAs in the lower, right-hand corner of the screen.
The system menu displays.

If you save the image as an .avi file, run the CINE Loop
before you select SaveAs.

You cannot save a 2D cineloop image as a .jpeqg file.

Select Save As. The Save As menu appears.
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Save As

SaveAs (continued)

6. Select the media from the Save in Archive pull-down menu.
7. Folder name: You can create the folder for the saved file.
+ Default is blank (The folder is not created)
* Max 32 characters
NOTE: You cannot edit the folder name when the folder is opened.
8. File Name: The name of the file is automatically filled in, but
you can type a file name as well.
* Max 64 characters
NOTE: DO NOT use the following special characters when saving
images: !, @, #, %, %, " & % (). .55 <> 2/~ L1 {}
and Yen sign.
9. Store: Select Image only or Secondary capture.
* Image only: Saves only the ultrasound image area
* Secondary capture: Saves the ultrasound image area,
title bar, and scan information area. Not available for
DICOM or RawDICOM images.
NOTE: If you select “WMV” for Save as type, Secondary capture is
disabled.
10. Compression: Specify Compression.
*+  None
+ Rle
+  Jpeg
+ Jpeg2000
NOTE: If you select “WMV” for Save as type, Compression is
disabled.
11. Quality: Specify image quality (between 10-100). A high
quality setting gives a lower compression.
NOTE: If you select “WMV” for Save as type, Quality is disabled.
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Recording images

SaveAs (continued)

9-22

NOTE:

NOTE:
NOTE:

12.

Save as type: Select one of the following.

+ RawDICOM: saves the still image or CINE Loop in both

GE raw format and DICOM format.

* DICOM: saves the still image or CINE Loop in pure
DICOM format.

* AVI: Saves the CINE Loop in avi format.
Store “Image Only” is available if you select AVI for
Type.
+ JPEG: Saves the still image in jpeg format.
« JPEG2000: Saves the still image in jpeg2000 format.
+  WMV: Saves in Windows Media Format.

WMV type is only available with CINE loop image.

The Save button is disabled when you select “AllFiles”.
Select each Save as type when you want to save data.

If you want to see all data saved onto the HDD, select
“AllFiles(.*)". All the data names display in the window.

13. Press Save.

The images are saved directly to the USB drives or Network
storage whenever you press Save.

If you select “For Transfer to CD/DVD”, the images are
saved to the HDD buffer.

If free space of the destination is not enough to save all
selected images, then warning dialog appears.

If the same file name exists in the destination, the
warning dialog displays.

OK: Overwrite file and continue to save selected
images.

Cancel: Cancel.

14. Repeat this step for as many images/clips you want to save.
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SaveAs (continued)

15.

16.

17.

After you have added all of the images/loops you want to
save and are ready to write to the media, transfer all the
images at the same time. Press Save As--> Transfer To CD/
DVD.

A progress bar lets you know that the “Media transfer is in
progress.”

If total transfer size is bigger than CD/DVD free space size,
then only the files that can be copied to CD/DVD are
transferred. After the copy is finished, a warning dialog
displays showing the total required file size and transferred
file size. Press OK, insert a new CD/DVD, and press
Transfer to CD/DVD again.

If you do not want to save the image to CD/DVD, select
“Delete Files for Transfer’ All images are deleted.

Press F3 to eject the media. Select CD/DVD Recordable or
USB drive. Select Yes and Verify files for CD/DVD. This
compares the expected number of files with the actual
number of files on the media. The files are also checked to
ensure that they are readable.

NOTE: The Report Save As feature is somewhat different. As soon as
you select to save a report, the report is saved.

NOTE:  If you save 3D image as an AVI file, an annotation text “COMP”
appeatrs at the top of the saved image which represents the
compressed image.

NOTE: Time line image can be saved as multi frames image with
SaveAs. 3D images can't be saved with WMV format.

Table 9-2: Save As Formats
.avi format .wmyv format MPEGvue in Data Transfer
B, B+CF Multi frames Multi frames Multi frames
B+Dopploer Single frame Multi frames Single frame
B+M Single frame Multi frames Single frame
3D Multi frames N/A Single frame
NOTE: Verify the saved image works correctly on the Windows PC. If

the image does not work, please save it again on the LOGIQ P8/

PY9/P10.
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Recording images

'SaveAs’ Images

You can select the images at one time which you want store by
SaveAs in the Active Image screen.

Features are almost the same as the SaveAs feature. See ‘Save
As’ on page 9-19 for more information.

NOTE: We suggest that you save the images page by page with
‘SaveAs’ Images in Active Images. It takes time if you have
many images or raw data.

NOTE:  Ifthe image has a filmstrip icon, this indicates a CINE Loop,
which gets saved as a .wmv file; single images are saved as a
Jjpeg file.

NOTE: ‘SaveAs’ Images function doesn't support images which are
query/retrieved.

1. Inthe Active Images screen, place the cursor on the image
or CINE Loop to be saved and press Set. You can select
multi images with multi pages.

2. Press ’SaveAs’ Images on the monitor display or the Touch
Panel. The SaveAs menu appears.
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Save As

’SaveAs’ Images (continued)

3. Ensure that Jpeg&WMYV is selected, then press Save.

NOTE: If you are saving to USB, images are transferred as soon as
you press Save; if you are saving via Transfer to CD/DVD,
you need to save images to the hard drive, then images are
transferred when you select Transfer to CD/DVD. See
below.

Notes on Transfer to CD/DVD

Transfer to CD/DVD transfers all saved files on the hard drive
buffer to CD/DVD.

To Transfer saved files to CD/DVD,

1. After you have added all of the images/loops you want to
save and are ready to write to the CD/DVD, transfer all the
images at the same time. Press Save As--> Transfer To CD/
DVD.

A progress bar lets you know that the “Media transfer is in
progress.”

If total transfer size is bigger than CD/DVD free space size,
then only the files that can be copied to CD/DVD are
transferred. After the copy is finished, the warning dialog
displays. Warning dialog shows total required file size and
transferred file size. Press OK and you need to change CD/
DVD and press Transfer to CD/DVD again.

2. If you do not want to save the image to CD/DVD, select
“Delete Files for Transfer’ All images are deleted.

3. Press F3 to eject.
NOTE: Verify the saved image works correctly on the Windows PC. If

the image/loop do not work, please repeat the Save operation
again on the LOGIQ P8/P9/P10.
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Storing Images with More Resolution

To store images with more resolution than is available with the
JPEG selection, select Save As and select AVI as the Save As
Type. You can save single images as .avi files.

Table 9-3:  Store Options

Image Type Store as Image Only Store as Secondary Capture
CINE Loop Gives you a loop of just the image (no | Gives you a single image of the video
title bar and scan information). area. DO NOT DO THIS BECAUSE
YOU DO NOT KNOW WHICH IMAGE
FROM THE LOOP THAT YOU ARE
GETTING.
Still Image Gives you a single image (no title bar Gives you a single image of the video
and scan information). area.
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Backup and Restore

Overview

NOTE:

Backup and Restore

The backup and restore procedures described in this section are
divided into two parts. The first part describes procedures to
backup and restore patient data. The second part describes
procedures to backup and restore system and user-defined
configurations.

The Backup/Restore function enables the user to:

+ Copy/Restore the patient archive.

+ Copy/Restore the system configuration. The Copy/Restore
system configuration feature enables the user to configure
several units with identical presets, providing that the units
have the same software version.

Depending on the system, you can use either a CD-R, DVD-R,
USB Flash Drive, or USB Hard Disk for system backup/restore.
For the sake of simplicity, we have used the CD-R in the
following examples.

The system ONLY supports CD-R / DVD-R and DOES NOT
support CD-RW / DVD+R.
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Overview (continued)

WARNING GE is not responsible for lost data if the suggested backup
procedures are not followed and will not aid in the recovery of
lost data.

WARNING The LOGIQ P8/P9/P10 is not intended to be used as a storage
device; backup of the Patient and Image Database is your
institution’s responsibility. GE is NOT responsible for any lost
patient information or for lost images.

>

WARNING The systgm crash can cause the HDD co_rruption. The HDD is
not considered a permanent storage device. Backup data on a
regular basis.

>

CAUTION To minimize accidental loss of data, perform EZBackup and
Backup on a regular basis.

>

1. First, perform EZBackup to save the images.

2. Next, perform Backup at Utility -> System -> Backup/
Restore. Enable the following checkboxes under Backup:
+ Patient Archive
* Report Archive
* User defined configuration
+ Service
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Overview (continued)

CAUTION Archived data is managed at the individual sites. Performing
data backup (to any device) is recommended.

CAUTION Make sure to verify the media after writing of data, such as
EZBackup, SaveAs or Export.

Verifying media requires additional time, which varies
depending on the amount of data backed up or exported.

CAUTION Before deleting a patient or image from the patient screen,
make sure you have saved the data by EZBackup/Backup or
Export and verify that the media transfer of data was
successful.
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Backup and Restore

9-30

NOTE:

To minimize accidental loss of data, perform backup of the
patient archives stored on the local hard drive DAILY as
described in this section. Use a formatted Backup/Restore disk
to back up patient archives from the hard drive, using the
backup procedure described in this section. Data from the
Backup/Restore disk may be restored to the local hard drive
using the restore procedure.

To perform backup and restore procedures, you must login with
administrator privileges.
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Backup procedure

Back up patient data AFTER you've archived (via EZBackup)
images so that the pointers to the patient’s images reflect that
the images have been moved to removable media and are no
longer on the hard drive.

1. Insert media into the drive or USB device into a USB port.

2. In the patient screen, select the dataflow Local Archive - Int.
HD.

3. On the Touch Panel, press Utility.

4. On the Utility Touch Panel, press System.

5. On the monitor display, select Backup/Restore.
The Backup/Restore screen is displayed.

General =t 7 pscipherals l-.. e &t Config
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Backup procedure (continued)

9-32

NOTE:

10.

In the Backup list,

+ Select Patient Archive and Report Archive to backup
the patient records.

+ Select User Defined Configuration to copy system
settings and user presets.

The detailed section of this menu decouples the user
defined configuration above. This allows you to selectively
restore what you want to restore across multiple machines.
Specify where to save data in the media field.

Select Backup.

The system performs the backup. As it proceeds, status
information is displayed on the Backup/Restore screen.

At the end of the process, the Backup completed message
is displayed on the monitor.

Press Eject (F3) for eject media/disconnect USB device.

Make sure to physically label the media. An identification of
the system should also be noted on the media and a backup
log should be kept.

File the media in a safe place.
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Restore procedure

CAUTION The restore procedure overwrites the existing database on the
local hard drive. Make sure to insert the correct media.

You cannot restore the data between systems with different
software versions.

CAUTION To avoid the risk of overwriting the local patient and report
archives, DO NOT check Patient Archive when restoring
user-defined configurations.

1. On the Touch Panel, press Utility.

2. On the Utility Touch Panel, press System.

3. On the monitor display, select Backup/Restore.
The Backup/Restore screen is displayed.

General : Peripherals GT Config

blc Key
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Restore procedure (continued)

4. In the Restore list,

» Select Patient Archive and Report Archive to restore
the patient archive.

+ Select User Defined Configuration to restore all
system settings and user presets.
or

One or several system configuration items to restore
parts of the Detailed Restore of User Defined.

5. In the Media field, select the appropriate Source device.
6. Select Restore.

The system performs the restore. As it proceeds, status
information is displayed on the Backup/Restore screen.

7. The LOGIQ P8/P9/P10 restarts automatically when Restore
is done.
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Backup and restore strategy: patient data

To minimize accidental loss of data, perform backup of the
patient archives stored on the local hard drive DAILY as
described in this section. Use a formatted Backup/Restore disk
to back up patient archives from the hard drive, using the
backup procedure described in this section. Data from the
Backup/Restore disk may be restored to the local hard drive
using the restore procedure.

CAUTION The restore procedure overwrites the existing database on the
local hard drive.

NOTE: To perform backup and restore procedures, you must login with
administrator privileges.

Preset synchronization

The procedure for preset synchronization of several scanners is
as follow:

1. Make a backup of the user-defined configurations on a
removable media from a fully configured LOGIQ P8/P9/P10
system.

2. Restore user-defined configurations from the removable
media to another LOGIQ P8/P9/P10 system (you can

restore all the user-defined presets or select specific presets
to restore via Detailed Restore).
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EZBackup

Overview

EZBackup allows you to manage hard disk space while
maintaining the patient database on the scanner, as well as to
back up the patient database and images.

+ EZBackup: Copy the data from the local HDD to the
removable media.

PLEASE READ THIS

Ensure that you have established a data management protocol
for your office/institution. You MUST manage the backup media
by keeping a log and by creating a media filing system.

Generally speaking, you should back up the system when you
have 10 GB of images to back up.

You should assign the person who is in charge of performing
the backups. Backups will vary by the volume of your work. You
need to track how long it takes your office/institution to get to
10 GB, and set the back-up parameters accordingly.

Your office/institution needs to determine your backup strategy,
for instance, backup weekly and move monthly. It should be an
easy strategy to perform and to remember. And follow this
same strategy/schedule consistently.

It's also useful to keep your more recent information on the
hard drive since it's easier to recall that way.

When a backup is cancelled the system completes backing up
the current media and then cancels the operation.

Only cancel the backup in case of an emergency. The system
completes backing up the current media and then cancels the
operation.

9-36 LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2



EZBackup

Overview (continued)

é WARNING

WARNING

>

ﬁ WARNING

ﬁ WARNING

ﬁ WARNING

LOGIQ P8/P9/P10 is not intended to be used as a storage
device; backup of the Patient and Image Database is the
responsibility of the end user. GE is NOT responsible for any
lost patient information or for lost images. Loss of image data
may require a rescan.

The system crash can cause the HDD corruption. The HDD is
not considered a permanent storage device. Backup data on a
regular basis. Loss of image data may require a rescan.

When EZBackup requires more space for backup, a message
appears when the first disk is full. If you select “Cancel” to stop
the backup procedure and later try EZBackup again, all the
data may not be backed up.

Select “Full Backup” on the first EZBackup wizard screen if the
last time you were performing EZBackup you selected
“Cancel”. Failure to follow these instructions could result in loss
of patient data.

DO NOT turn off the power while EZBackup is running. THe
data may be lost. It may take several hours for EZBackup to
finish, depending on the amount of data being backed up.

The following may give the impression of a lockup, but
EZBackup is continuing in the background.

* The progress bar does not move.

+ The screen may become white.
* THe hourglass icon keep turning.

EZBackup does not back up the exams which were previously
backed up once by EZBackup or Export. If you want to back up
those exams by EZBackup again, select “Full Backup Option®
on the EZBackup wizard. Failure to follow these instructions
could result in loss of patient data.

LOGIQ P8/P9/P10 — Basic User Manual 9-37
Direction 5841298-1EN Rev. 2



Recording images

Overview (continued)

f CAUTION
f CAUTION

NOTE:
NOTE:

NOTE:
NOTE:

NOTE:

NOTE:

NOTE:

9-38

NEVER restore the patient archive from media made previous
to the last move.

“Archived” information is saved to each exam during
EZBackup. When you perform EZBackup, the system backs up
the exams except for the archived exam.

EZBackup saves data as RAW data. If you import data to the
system, you can modify the image data.

To display exported Raw DICOM images on a PC, you need the
dedicated viewer.

When backing up reports using EZBackup, use the USB HDD.

EZBackup cannot span a single image across two (2) or more
media. Therefore, if EZBackup encounters an image that is
greater than the capacity of the media, it skips the oversized
image.

EZBackup does not store images to media in sequential order.
Instead it maximizes the most amount of images per media.

If the system locks up during the media auto format process,
shutdown the system by holding down the power button and
boot it up again. After the system is up, replace the media to a
new one and execute EZBackup again. To avoid data loss, do
not reuse the failed media for any other function.

If you try exporting a previously backed-up exam, the message
“Can’t Find Source file” displays. The image data had already
been removed from the hard disk drive with EZBackup.
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Perform EZBackup

NOTE:

NOTE:

NOTE:

NOTE:

Basically, when you perform the EZBackup procedure, you
connect USB HDD if applicable; the system backs up the
images (or reports), and creates a reference between the patient
database and the media’s volume.

EZBackup can take up to 20 minutes (or longer, depending on
the size of the backup). Make sure to schedule this at the same
time daily, when no patients are scheduled.

1.

Prepare unformatted media or the USB HDD before starting
EZBackup.

BEFORE starting the EZBackup, select “Unlock All” in Utility
--> Admin --> Logon.

Specify the EZBackup setup on the Utility --> System -->
Backup/Restore page.

To start the EZBackup procedure, go to the Patient menu
and select EZBackup. The EZBackup Wizard starts.

If you use the USB HDD, some wizards and the pop-up
messages DO NOT appear.

Verify the information on the first page of the EZBackup
Wizard, then press Next.

Full backup options display on the first page of the
EZBackup wizard. If you want to backup all of the exams in
the range (even if the exam was previously backed up,
check this option).

If you uncheck this option, the system only backs up exams
which have not yet been backed up.

EZBackup does not back up the exams which were
previously backed up once by EZBackup or Export.

If you update an exam which is already backed up, the
exam is also backed up.
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Perform EZBackup (continued)

NOTE:

5. Verify the information on the EZBackup Wizard, Page 2. The

backup may span multiple media. This page tells you how
many media you need to do this backup. After you have
gathered the media (allow for one extra media, just in case),
you are ready to begin the backup. Press Next.

Free Space/Total Size: tells you the size of the data you
have selected to store/and the total size of the USB Hard
Drive storage media. If the storage capacity of the USB HD
is insufficient, you will see the message, “Selected Location
does not have enough free space.”

This message appears if you press Next without inserting
the backup media: “Please insert a blank media...”. Insert
the media and continue.

A pop-up message appears that provides you with the
media label. Label the media, then insert the media. Press
OK.

a. Ensure that you label the media with not only the
volume name indicated on the Insert Media Message,
but with the name of the LOGIQ P8/P9/P10 system
where this backup procedure was done.

b. Update the EZBackup log with this information the
volume information and the location of the media.

c. After the backup has been completed, file the media.

Table 9-4:

Typical EZBackup Log

Date

Scanner ID
Name

Backup
Images Y/N

Reminder
Dialog
Interval Days

Media Label
(and Scanner
ID)

9-40

NOTE:

The status menu appears. When the backup/move has
been completed, press Next.

When/if you need to insert the next media, a message
appears providing you with the media label. Label the
media, then insert the next media and press OK.
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Perform EZBackup (continued)

8. When the backup is complete, the completed wizard page
appears. Press Finish.

9. Do a patient archive after each EZBackup.

We recommend attaching the patient list to the EZBackup
media. Insert the media and select DICOM CD Read from
the Patient Screen for dataflow (if you use a USB drive,
select DICOM USB Drive Read). Select any patient and
press the left Set key to print the patient list on the digital
printer for each CD/DVD.

NOTE: Use Import to restore EZBackup images.
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To Review EZBacked Up/EZMoved Images

You can review backed up media via the Patient Menu, Import,
and the DICOM Read dataflow.

If you review an EZMoved image,

1. Select the patient on the Patient Menu (on the same system
where the backup was performed).

2. Insert the media volume indicated on the Patient Menu.

3. View the exam from the media.

NOTE: You may need to insert a media volume prior to or after the
recommended media.

NOTE:  Ifthe patient is split over multiple media, images on the previous
or next media are displayed as triangles.

NOTE: To view the whole patient on the system, use Import, from as
many media as you have for that patient. However, take care not
to import studies over existing studies; duplicate or missing
images may result. Delete the existing exam first.
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Overview

Data Transfer

The user can select and access the Exam Transfer services
from the Exam Data Transfer screen.

Import
Export
Worklist
MPEGvue

Q/R (Query/Retrieve) See ‘DICOM’ on page 13-370 for
more information.

NOTE: Ensure that all patients are exported or backed up BEFORE
deleting them.
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Export/Import

NOTE:
NOTE:

NOTE:

NOTE:

NOTE:

Exporting Data

NOTE:

9-44

To move exams from one Ultrasound system to another system
or to back up/retrieve exam information, you need to export/
import exam information.

Both database information and images are exported. No data is
deleted from the local archive when exporting data.

Export/Import patient records may take more than ten (10)
minutes. Please allow sufficient time to export/import patients.

You MUST verify the media you use BEFORE performing
Export/Import. You must do this once each session. If you
encounter problems, eject the media and then re-insert the
media; then try the Export/Import again.

Import/Export has only upward compatibility. For example, you
can import data from a R1.x.x system to the current system. But
you cannot import data from the current system to a R1.x.x
system.

It is STRONGLY recommended that you verify files on Eject
when using Export.

To export an exam(s) to a compatible Ultrasound system:

1. Format and label the removable media. Answer Yes/OK to
the messages.

The system formats the unformatted CD-R/DVD-R
automatically when you select Export on the data transfer
screen.

2. Press Patient and select Data Transfer.

The Data Transfer screen is displayed. Select Export.

4. “Local Archive-Int.HD” displays on the Transfer From
pull-down menu and the patient list included in the Local
Archive displays.

w
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Exporting Data (continued)

NOTE:

NOTE:

Select the destination at the Transfer To pull-down menu.

Select the patient(s) to export by using the Transfer From
search field (the upper field).

You can use Windows commands to select more than one
patient.

To select a consecutive list of patients, click the cursor on
the first name, move the cursor to the last name, then press
and hold down the Shift+right Set key to select all the
names.

To select a non-consecutive list of patients, click the cursor
at the first name, move the cursor to the next name, then
press and hold down the Ctrl+right Set key, move the cursor
to the next name, then press and hold down the Ctrl+right
Set key again, etc.

You can also search for patients via the Search key and
string.
Or, use Select All to select all patient.

You need to use your best judgment when moving patients’
images. If there are lots of images or loops, then only move
a few patients at a time.

Press Transfer. The progress bar displays during the
transfer.

Press F3 to eject the media. Specify that you want to finalize
the media.

After performing an Export, the system reflects that this
operation was successfully completed; however, it is
ALWAYS a good idea to verify that there was no corruption
to the backup/export media during this process.

To verify that the data was successfully transferred to the
media, Press F3, then select “Finalize” --> “Yes and Verify
Files.” If there was any corruption to the media during an
operation, the message, “An error occurred on the last disk.
Please discard it and start over.” appears. In this case,
please redo the operation with new media.

To display exported DICOM or Raw DICOM images on a PC,
you need the dedicated viewer.
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Importing Data

To import an exam(s) to another Ultrasound system:

1.

ok~ wbd

9.

At the other Ultrasound system, insert the media.

Press Patient and select Data Transfer.

The Data Transfer screen displays. Press Import.

Select the media from the Transfer From pull-down menu.

The Transfer From search field shows the patients available
for import from the removable media you just loaded onto
the system.

Select the patient(s) or the exam(s) from the list to be
imported.

Press Transfer. The progress bar displays during the
transfer.

Please wait for the patient information to be copied to this
Ultrasound system. Informational messages appear while
the import is taking place.

Press F3 to eject the media.

NOTE: Use Import to restore EZBacked up and/or EZ Moved images.

NOTE: You can retrieve from the media to the Local HDD, playback, or
process exam information on the system as Raw Data.

DICOM Import
You can import the graphics which has DICOM DIR from CD/
DVD/USB.
CAUTION If the following message displays, there is a possibility that
Import may not work properly ("Data detected is not LOGIQ P8/
P9/P10. Measurements and RawData will not transfer.")
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Worklist (Search and retrieve the Patient/Exam information)

NOTE:

NOTE:

NOTE:

NOTE:

NOTE:

Before you retrieve data from the Worklist server, make sure
that default IP address is input in the Default Gateway field in
Utility -> Connectivity -> TCP/IP.

You need to select the patient prior to sending images to a
PACS.

1.

Press Patient and select Data Transfer. The Data Transfer
screen displays.

Select Worklist. The patient/exam list in the Local Archive
displays in the Transfer To section.

Only “Local Archive - Int. HD” is enabled for Transfer To.

The Worklist used last time is displayed on the monitor
display. Press Refresh to refresh the list or select another
Worklist server from the Transfer From pull-down menu.

The worklist server is configured in the Utility screen.
Multiple servers are able to be configured.

You can configure whether the auto-refresh worklist has
been enabled/disabled in the Utility screen. The system
automatically refreshes the list when the exam data transfer
accesses the Worklist server or changes the Worklist
server.

Select the patient(s) or the exam(s) from the list.

Press Transfer. The progress bar displays during the
transfer.
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MPEGvue
You can see the exam data on the Windows PC by using
MPEGvue.
f CAUTION DO NOT transfer more than 50 patients at one time.

CAUTION DO NOT use lossy compression images, such as JPG or
MPEG images, for diagnosis.

CAUTION MPEGvue function is NOT compatible with other LOGIQ series
products. Do NOT share the same USB Drive for MPEGvue
between LOGIQ P8/P9/P10 and other LOGIQ series products.

NOTE: If you want to label the removable media, format it before use.
The system formats the unformatted CD-R/DVD-R automatically
when you select MPEGvue on the data transfer screen.

1. Insert the removable media or the USB drive.

2. Select Patient and select Data Transfer. The Data Transfer
screen displays.

3. Select MPEGvue. The Patient list, which has images in the
Local Archive, displays in the Transfer From section.

Start the media formatting automatically except USB HDD.
Label the media with “YYYYMMDD_#".

NOTE: Only “Local Archive - Int. HD” is enabled for the Transfer
From.

4. Select the media from the Transfer To pull-down menu.

NOTE: Select Removable CD Archive if you use CD-R or DVD-R.
5. Select the patient(s) or the exam(s) from the list.

NOTE: If you press Clear in the Transfer From and Transfer To
section, all the search criteria clears and the list is refreshed
accordingly.

NOTE: Trying to save 3D loops using MPEGvue, the 3D loops are

saved as still images. Use “Save As” to save 3D loops.
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MPEGvue (continued)

6. Press Transfer. The progress bar displays during the

transfer.

Displays the check mark in the Copi... field of the completed
patient.

When the message “Not enough free space” displays during
MPEGvue,

« CD-R/DVD-R: Please insert new media.

+ USB HDD/USB Flash Drive: Backup the current data in
the USB device to the other media to make space on
the USB device.

If the following dialogue and message displays during
MPEGvue, reduce the number of exams to gain space, and
perform MPEGvue once again to new media (CD-R/DVD-R)
or USB device.
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MPEGvue (continued)

7. When the transfer is completed, press Exit to return to the
scan screen and then eject the media.

NOTE: The capacity of media (number of patients) and the writing
time depends on the data size of each patient. If you try to
save an image larger than 1GB using MPEGvue, it may take
a few hours to save the image.

NOTE:  Before you read the media on the PC, finalize the media on the
LOGIQ P8/P9/P10.

NOTE: Measurement graphics from the exam performed on the system
are maintained with the MPEG exam.

CAUTION DO NOT use “Verify” when ejecting the CD/DVD if you
transferred multiple patients to the media using MPEGVue.
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MPEGvue (continued)

On your PC

An MPEG exam can be read from a PC. Do the following to
install the MPEGVue Player Software App onto your PC.

1.
2.

No ok

Ensure that you are set up to be an Administrator on the PC.

Insert the Media, open up an Explorer window, and navigate
to the MPEGVuePlayerAutorun application executable.
Double click on it.

The MPEGVue Player 64-bit Setup wizard opens. Press
Next.

Accept the suggested Destination Folder by pressing Next.
Press Install to start the installation.

Wait while MPEGVue is being installed.

After the MPEGVue installation has completed, press
Finish.

From the Windows’ main screen, select and double click on
the MPEGVue application.

Double click on the patient's exam. Detailed instructions for
using MPEGVue can be found in the Using MPEGVue
section.
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MPEGvue (continued)

You can see the exam data on the Windows PC by using
MPEGvue.

NOTE:  Select “MPEG4 Windows Media Format (*.wmv)” when you
save the Cine image from CD/DVD to the HDD while reviewing it
on your PC.

NOTE: Measurement graphics from the exam performed on the system
are maintained with the MPEG exam.
1. Toread MPEG exams stored on a CD-R/DVD-R:
* Insert the MPEGVue CD-R/DVD-R in the computer CD
drive. The MPEGVue Patient list is displayed.
To read MPEGVue exams stored on other media:

* Insert the media containing the MPEG exams and
double-click on the file Start. MPEGvue.bat. The
MPEGVue Patient list is displayed.

Help

BomDate | BdhDate: | kusges |

Figure 9-8. Patient list

a. Open: Open anywhere on the PC.

b. View Exam: Open the selected exam (or double click on
the patient name)

c. Open folder: Open a folder of the inserted media which
contains images (e.g.:
G:\ESTORE\31_1_2013_20_2 22 917\Images)

2. Select the desired examination date to display the images.
The MPEGVue screen is displayed.
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MPEGvue (continued)

Figure 9-9. MPEGvue screen on the Windows PC

Save image as .wmyv, .bmp, jpeg, or WMV
Open folder

Display full screen

Slide Show

Brightness/Contrast/Gain

Selected image

Cineloop

Single frame image

ONDOTA LN~
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9.

10.
1.
12.
13.
14.
15.

Play

Stop

Pause

Stop forward/backward

Display previous/next image

Close

Clipboard: select the image to display
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MPEGvue (continued)

Slide show
You can change the time interval of Slide show in Customize ->
Options.
T lerval {Seconds) &
1 S Sede Shaw from the Baginning
m::e-ocomnm | Actorssticaty Seincted ~
ke D 3
Curert AV Audic Compressor  Mecrasolt ADPCM
(o [ e ]
Figure 9-10. Slide show setting
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Intended Use

External drives

Removable media can be used for the following purposes:

Long-term image storage: the final destination of the
images, after they are moved out of the system hard disk by
using the EZBackup/EZMove (see ‘EZBackup’ on page 9-36
).

Backup of patient database and system configuration
presets (see ‘System Backup and Restore Preset Menu’ on
page 10-19)

Export to copy a set of patient records to a third party
DICOM review station.

MPEGVue: review exported images on a Windows
computer (see ‘MPEGvue’ on page 9-48 ).

Copy of system configuration presets between to units using
the Backup/Restore feature (see ‘Preset synchronization’ on
page 9-35).

SaveAs: Save images as JPEG, WMV, AVI, DICOM and
RawDICOM for review on a standard Windows computer.
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Supported removable media

The following removable media are supported:
+ CD-R

+ DVD-R

+ USB Flash Drive

+ USB external hard disk drive

If CD/DVD is used it is recommended to use Archive Grade or
Medical Grade CD/DVD.

No matter which media is used, it is always highly
recommended to make a backup of the media, which is the
responsibility of the customer.

Keeping your media disc in an original media case or caddy all
the time will prevent it from becoming dirty or damaged.
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DVD Drive (Option)

The DVD drive (Option) is located at the top of the cabinet.

You can use these to perform software upgrades, image
archiving and service diagnostics.

You can use the following media for the multi-drive:
*  CD-R (maximum writing speed: 48x)
+ DVD-R (maximum writing speed: 16x)

CAUTION DO NOT use or attempt to format CD-RW, DVD+R, DVD+RW
or DVD-RW on the LOGIQ P8/P9/P10 DVD Multi-Drive.

CAUTION Due to the variety of disk types, we cannot guarantee that
every media is available.

Recommendation concerning CD and DVD handling

To avoid data loss, never touch the recordable surface of a disk.
Handle the disk only by the outer edge. Do not place it face
down on a hard surface. Fingerprints or scratches will make the
disk unusable. Before usage, verify that the disk surface has no
visible scratches. If there are any scratches, do NOT use the
disk.
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Insert a media

Insert a media with the eject button on the DVD drive.

the media is placed in the right position. If the media is not

f CAUTION When you put a media into the DVD drive, please make sure
placed in the right position, the media may be damaged.

during system operation. Mechanical damage may occur if

f CAUTION Make sure that the Disk tray is securely placed in each device
other objects hit the tray.
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Eject a media

1. To eject a media, always press F3. DO NOT use the eject
button on the drive.

2. The Eject device menu is displayed. Select CD/DVD
Recordable.

3. When ejecting a media, you are prompted if you wish to
finalize the disk. If you do not finalize the disk, you can add
files to the media at a later time. However, you may not be
able to view the files stored on this disk with a standard PC.
Finalizing a media, allows you to view these files using most
standard PCs.

To verify that the data was successfully transferred to the
media, Press F3, then select “Finalize” --> “Yes and Verify
Files.” If there was a corruption to the media during an
operation, the message, “An error occurred on the last disk.
Please discard it and start over.” appears. In this case,
please redo the operation with new media.

NOTE: When you press F3 with a blank media inside the DVD
drive, the finalization menu displays. You can select “Yes” or
“Yes and Verify Files”, but the system ejects the media
without doing anything.
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USB Hard Disk Drive and USB Flash Drive

Cautions and Warnings

WARNING DO NOT use the USB_ Hard Disk Drive for patient storgge. The
USB HDD is not considered a permanent storage device.

>

If you connect the USB HDD to a virus-infected computer, the
USB HDD may also be infected with a computer virus.

CAUTION DO NOT plug in TWO Bus-powered USB Drives at the same
time.
CAUTION If a problem occurs while exporting to the USB-HDD, such as a

>

crash, the export may not have completed. Try again with a
smaller number of patients.

CAUTION Disconnect the USB HDD when performing EZMove on the
system.
CAUTION DO NOT use “Select All” when you export the patient data to
the USB-HDD.
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Cautions and Warnings (continued)

NOTE: Do not insert USB Memory devices (hard drives or flash drives)
that contain multiple partitions into the scanner. Use single
partitioned USB Drives.

NOTE:  Some USB memory device manufacturers allow for executable
partitions or ship pre-formatted new USB memory devices with
multiple partitions pre-configured. BEFORE inserting any
memory device into the scanner, insert it into a PC or MAC to
verify that there is only a single partition. If multiple partitions
exist, contact the USB manufacturer for the steps in reformatting
the memory to a single partition.
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USB Ports

Above the Touch Panel

You can use the USB3.0 port for USB Storage (USB Hard Disk
Drive and USB Flash Drive).

On the rear panel

Figure 9-11. USB port

You can use the USB2.0 port on the rear panel for:

9-62

Footswitch

PC Printer with isolation USB

A5 Printer

Card reader

USB Storage (USB-HDD and USB Flash Device)
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On the Monitor
You can use the USB2.0 port on the Monitor.

Figure 9-12. USB port on HD Display
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Eject a USB Flash Drive/lUSB HDD

9-64

NOTE:
NOTE:

To eject a removable media, always press F3. DO NOT use
the eject button on the drive.

The Eject device menu is displayed. Select the relevant
media.

Select USB Drive from the pull-down menu to disconnect
the USB Drive. Disconnect the USB drive after the success
dialogue is displayed.

Remove the USB Drive from the USB port.

If the unsuccessful dialogue is displayed, retry after a while.

Verify is NOT available on Flash Drives or Hard Disk Drive
media.
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MPEGvue (Data Transfer)

é CAUTION

To transfer a patient/exam to the USB Flash Drive or USB HDD,

1.
2.

Insert the USB Drive into the front USB port.

On the Patient menu, select Data Transfer, then
MPEGvue. Specify USB Drive in the transfer To: pull-down
menu. Select the patient/exam you want to transfer. Press
Transfer.

When the transfer has been completed, press Eject (F3).

After transferring images to a USB Drive using MPEGVue,
verify that the images have actually transferred to the USB
drive.

Backup/Restore
To Backup/Restore to/from a USB Flash Drive or USB HDD,
1. Insert the USB Drive into the front USB port.
2. Press Utility--> Backup/Restore. Select the USB Drive as
the media.
3. Follow instructions for Backup/Restore. See ‘Backup and
Restore’ on page 9-27 for more information.
4. When the Backup has been completed, press Eject (F3).
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SaveAs

NOTE:

NOTE:

Direct SaveAs

9-66

NOTE:

See ‘Save As’ on page 9-19 for more information.
To save images to the USB Flash Drive or USB HDD,

1.
2.
3.

Insert the USB Drive into the front USB port.
Select the image(s) to be saved.

Select Save As menu in the lower, right-hand corner of the
screen. Select the USB Drive as the archive media.

Specify: Image only or Secondary Capture, type of
compression, quality, and image save format (Raw DICOM,
DICOM, Jpeg, or WMV).

Press Save. When the images have been saved, press
Eject (F3).

If you perform the SaveAs function to the USB drive (:\Export)
by RawDICOM format and review the data on your PC, the title
of the data appears as
“\GEMS_IMG\2006_0Oct\08(date)\xxxxx(PatientID)”.

You can save the image directly to the USB Drive just by
pressing a Print key.

“Direct SaveAs” doesn't supports WMV type.

1.
2.

® N o oA

Insert the USB Drive into the USB port.

Select Save As from the pull-down menu in Utility ->
Connectivity -> Service. Press Add.

Select Save As in the list. Rename it in the Name field if
needed.

Select USB Drive in the Destination field.

Verify the service.

Press Save.

Assign Save As to the appropriate print key in Button tab.
Display the image on the monitor and press the print key.
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Export/Import

To export/import exams using the USB Flash Drive or USB
HDD,

NOTE: Before you export exams to the USB HDD, check “Export to
USB HDD: Create DICOMDIR” in Utility -> Connectivity ->
Miscellaneous. If you uncheck this parameter, you must import
the data to review.

1. Insert the USB Drive into the front USB port.

2. On the Patient menu, select Data Transfer, then Export/
Import. Specify USB Drive in the transfer To: pull-down
menu. Select the patient/exam you want to transfer. Press
Transfer.

3. When Export/Import has completed, press F3.

EZBackup (USB HDD only)

1. Select “USB Drive” on the Utility -> Backup/Restore ->
EZBackup/Move -> Media.

2. Follow instructions for EZBackup. See ‘EZBackup’ on
page 9-36 for more information.

3. When EZBackup has completed, press F3.

NOTE: “Media capacity for estimate (MB)” in Utility -> System ->
Backup/Restore -> EZBackup and EZMove are not effective
when the Media is “USB HDD”. It only applies to the CD and
DVD.
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USB Quick Save

USB Quick Save easily sends images to a USB flash drive or
Network Storage.

The images are stored either in .jpg or .avi format.

USB Quick Save Setup

In Utility -> Connectivity -> Service, select USB Quick Save.
With this selected, the Properties' Destination drop down
selections are either USB Key or Network Storage. USB Key is
to store images on the USB flash drive whereas Network
Storage is to store images on the network storage.

NOTE: For using the USB Quick Save service as Network Storage, the
Network Storage service must already be configured.

Figure 9-13. Service USB Quick Save
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USB Quick Save Setup (continued)

Assigning USB The USB Quick Save service can also be assigned to the Print
Quick Save to Print keys via the Utility -> Connectivity -> Button preset menu as
Keys described in Chapter 16.

Figure 9-14. Assigning USB Quick Save to Print Keys
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Network Storage Service

You can save patient data/images to the PC directly with the
following functions, if you select Network Storage Service.

« Save As
*  Export/Import
« MPEGvue

+ DICOM Read

NOTE: DO NOT share the folder used for Export/Import with other
ultrasound systems. It causes loss of data if two or more
systems access to the same folder. Please create the unique
folder for each system.

NOTE: Before you export patient data/images using Network Storage,
check “Export to Network Storage: Create DICOMDIR” in Ultility
-> Connectivity -> Miscellaneous. If you uncheck this parameter,
you must import the data to review.

may not be listed in the To list. Make sure to confirm on the

f CAUTION After MPEGVue to Network Storage, the MPEGVue patient
destination to storage whether the copy of data succeeded.

Potential risk

+ Patient/Image data might not be sent at all with inaccurate
network configuration.

+ Patient/Image data might be lost by disconnecting the
network.

+ Patient/Image data might be damaged by unstable network/
data coupling.

+ Patient/Image data might be mixed up by network/data
coupling.

+ Patient/Image data might be sent to wrong destination if
network configuration is not inaccurate.

* The system might be attacked by a virus and vulnerable
infection.

* Network is not connected by IP address conflict.
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LOGIQ P8/P9/P10 Setup

NOTE: Create a Share folder on your PC on the network before
continuing with this setup.

1. Select Utility -> Connectivity -> Device.
2. Select Add.

3. Type the computer name in the Name field and Static IP
address in the IP Address field.

NOTE: Only use alphanumeric characters for the name.

NOTE: If you change Static IP Address after export, you cannot
import patient data/image. In this case, type previous IP
address again before import.

TCP/IP Device Service Data

Allow Trusted (Configured) Devices Only

MyComputer
NewDevice

ping €@

Properties
Name NewDevice
IP Address 3.35.110.111

Figure 9-15. Network Storage Service Setup - Device
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LOGIQ P8/P9/P10 Setup (continued)

NOTE:

NOTE:

Setup on your PC

9-72

Select Ping to verify the icon changes smiley face appears.

5. Select Service.

Select the Network Service from the pull-down menu.
Select Add.

Specify the properties for this service.

Name: Enter unique name that identifies this service.
Do not use the same name for any other Service or
device.

Password: Enter the password used for logging onto the
PC.

User name: Enter the user name used for logging onto
the PC.

Shared Dir: Enter the Share name of the folder.
Only use alphameric characters for the Shared Dir.

Select Save and select Verify to verify the icon changes
(smiley face appears).

It takes a long time to access Network Storage Service
by the condition of the network.

Check with your network administrator about the LAN
connection and setting method of the shared folder.
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Other Printing Options

Setting up Digital Peripherals

NOTE:

You set up digital peripherals from the Utility --> System -->
Peripherals menu.

Following printers can be connected to the power outlet supplied
by the system.

*  BW Printer: UP-D898
+ Color Printer: HP Universal Printing PCL6

Printing using a standard printing service overrides the
orientation and N-up feature of the printer preferences. Printer
preferences are set up in the printer folder (via Utility --> System
--> Peripherals. Select Properties under Standard Printer
Properties).
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Digital Printer Setup

9-74

There are two steps to do when setting up a digital printer:
1) follow the procedure below for each printer, then 2) set up
specific properties for each printer (specific instructions are
provided for each printer following this section).

Follow this procedure for each printer:

1.

2.

Select Utility--> Connectivity--> Service. Add the Standard
Print service. Select the printer from the Printer pull-down
Properties menu. For the UP-D898 printer, select “Portrait”
as orientation.

Type the printer name in the Name field. This name is used
on the Button screen. After you select the printer from the
Printer pull-down Properties menu again, it turns white.
Press Save.

Select Button. Select the appropriate print key (Print1,
Print2...) from the Physical Print Buttons section. Select the
printer from the MyComputer column and press >> to move
it to the Printflow View column. Press Save.
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HP Universal Printing PCL6 Instructions

Follow these steps to set up the paper size of HP Universal
Printing PCL6 printer.
1. Press Utility-->System-->Peripherals. Select the HP

Universal Printing PCL6 from the pull-down menu under
Standard Printer Properties. Click Properties.

Standard Printer Properties

HP Universal Printing PCL6 =

Properties

Figure 9-16. Properties
2. Select Properties from Printer pull-down menu.

7 Sony UP-DBIBDC - Use Printer Offfine
Printer Document View
Document Name

_lalx]

| Status

| Owner | Pages | size

| Submitted

Figure 9-17. Properties

3. Click Printing Preferences at the bottom of Properties
Window.
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Figure 9-18. Printing Preferences

4. Select Paper Size. Press Apply. Press OK.
5. Press Save, then Exit.
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Setting up the Off-Line Paper Printer

You can connect an off-line paper printer via the USB
connection (need USB Isolator).

Plug in devices to the USB isolator. Then insert a cable of USB
isolator to the USB port located at the rear of the system WHILE
the LOGIQ P8/P9/P10 is NOT powered up.

the system WHILE the LOGIQ P8/P9/P10 is NOT powered up.
If you plug in a device while the LOGIQ P8/P9/P10 is powered
on, your system may become unusable.

f CAUTION ONLY plug in devices to the USB ports located at the rear of

CAUTION DO NOT place an off-line paper printer inside the patient
environment. This assures compliance to leakage current.

A [ cD e b
. £ RN
Q. Py
}’ E : \\ 25m
f 3
1 | |
Vo XA
1.5m _1.5m
f” _________ f b
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1 1.5m)
4 ==p :
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Figure 9-19. Patient Environment
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Setting up the off-line paper printer

9-78

NOTE:

NOTE:

NOTE:

The printer driver is customized for the LOGIQ P8/P9/P10 at the
factory; you do not need to change the settings.

Connect the printer to the USB port.

2. Select Utility--> Connectivity--> Service. Add the

Standard Print service.

Button Remevable Madia

Figure 9-20. Connectivity -> Service Screen

Select the printer from the Printer pull-down Properties
menu.

After selecting the printer, the field turns white.

Set the following parameters in Properties: Rows, Columns,
Orientation, and Right Margin.

*  Rows=3

+ Columns=2

*  Orientation=Portrait

* Right Margin (mm)=10

Type the printer name in the Name field.

This name is used on the Button screen.
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Setting up the off-line paper printer (continued)

6. Press Save, then select the Button tab.

7. Select the appropriate print key (Print1, Print2...) from the
Physical Print Buttons section.

8. Select the printer from the MyComputer column and press
“>>" to move it to the Printflow View column.

Figure 9-21. Connectivity -> Button Screen

9. If you want to assign this printer to the Standard Print Button
on the Active Image Screen, select this printer at the Active
Image Printer section.

10. Press Save.

NOTE:  Adjust the rows, columns, and margins as necessary to obtain
the image size and quality that you find acceptable.
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Setting up the Printer to Print Reports and Patient List Print

To set up the Off-Line Printer to print reports and Patient List
Print,

1. Press Utility--> System--> Peripherals and select Printers
under Setup.

2. Select the printer from Default Printer pull-down menu.

Figure 9-22. Report Printer Setup

3. Press Save.
4. Press Print on the Report screen to print the report.
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Chapter 10

Customizing Your System

Describes how to create system, user, and exam
presets.
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Customizing Your System

Overview

10-2

Presets

Preset Menus provide the following functionality:

System presets. View and update general system
configuration settings, measurement and analysis settings,
and video settings; backup and restore data and
configuration files.

Imaging presets. View and update exam and imaging
parameters.

Comment library presets. Set up comment libraries by
application.

Body Pattern library presets. Set up body pattern libraries
by application.

Application and User Defined presets. Configure
application- and user-specific settings.

User Specific. Configure My Desktop. Refer to Chapter 3
“Monitor Display” for more information.

3D/4D. Real-time 4D and Static 3D scanning.

Connectivity Setup. Define connection and communication
setup, Tricefy, including exam dataflow information.

Measurement and Analysis presets. Customize exam
studies, create measurements, set up manual sequencing,
and create OB Tables. Refer to Chapter 7 “General
Measurement and Calculations” for more information.

Reports Presets. Allows you to edit the report template,
diagnosis codes, and report comments.
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Presets

Overview (continued)

Administration presets. Perform system administrator
activities such as setting up user IDs logon formats and
Data Encryption.

Scan Assistant. Create, import/export, and manage Scan
Assistant programs.

Image Preset Manager. Activates the Image Preset
Manager to create, edit, import, and export user imaging
presets.

Search. You can search for a parameter on the Utility pages
(Measure, Reports, and Service pages cannot be
searched.)

Test patterns. Helps configure system settings.
Service. Activates the Service Browser.
Scan Screen

Activate the scan screen so that you can adjust the monitor.

* Room Profile. Change Brightness and Contrast of main
display when set to User Defined.

* Color Profile. Control Color temperature.
+  Gamma

To access these functions, select the Utility tab on the Touch
Panel, then select the appropriate Touch Panel key.
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Overview (continued)

10-4

In addition, you can adjust the following via the rotaries located
beneath the Touch Panel.

Master Volume. Select to adjust the system volume, e.g.,
Doppler volume.

Effects Volume. Select to adjust the system notifications,
e.g., Touch Panel pushes, Print sounds, etc.

Keyboard Lock. Select to lock the Operator Panel controls
in order to clean the system.

Brightness/Contrast. Adjust the monitor brightness/
contrast.

User-adjustable when Room Profile is set to “User Defined.

Touch Panel Light/Button Light. Select to adjust the
backlighting on the Operator Panel and the Touch Panel.
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Overview

System Presets

System presets allows you to view or change the following
parameters

General — Location, Date/Time, Patient Info, Key Usage,
and Utility configuration

System Display - Presets related to the monitor display
format.

System Imaging — CINE Loop Store, Cardiac, Biopsy
Guides, and Image Control and Display configuration

System Measure — Measurement, Cursor, and Results
Window configuration

Backup/Restore — Backup, Media, EZBackup/EZMove,
Restore, Detailed Restore of User Defined

Peripherals — DVR, Print and Store Options, and Setup
configuration

User Configurable Key — BT keys, User Defined keys,
Keyboard keys

About — System software, patent, and image information

Licenses — Licenses for software used on the LOGIQ P8/
P9/P10.
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Changing system parameters

10-6

To change system parameters:

1.
2.

On the Touch Panel, select Utility.
On the Touch Panel, select System.
The System screen is displayed.

On the monitor display, move the Trackball to select the tab
that has the information you want to change.

Select values for the parameters you want to change.

To save the changes, select the Save button. Select Exit to
return to scanning. In some cases, you may need to reboot
the system for the change to take effect.
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System/General Preset Menu

The System/General screen allows you to specify hospital name
and system date and time.

Licenses

Diatey/ Time |

Figure 10-1. System/General Preset Menu

Table 10-1:  Location

Preset Parameter Description
Hospital Type the institution’s name.
Department Type the institution’s department name.

Machine Description (1&2) | Type the machine name.

Preset Region (restart Select region (None, Americas, Asia, Europe or Japan, LATAM or PoC).
needed)

Dedicated Preset (restart Select the either Vet preset or not Vet preset (Gen)

needed)

Language (restart needed) | Select the appropriate language from the drop-down list.

Note: If you select Japanese (JPN) or Chinese(CHN), only the warning and
status messages and touch panel are displayed in Japanese. You can not
type in Japanese or Chinese.

Units Select metric or US units of measurement.
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Table 10-1:  Location

Preset Parameter

Description

Regional Options (restart
needed)

Select to set up the keyboard.

Table 10-2: Date and Time

Preset Parameter

Description

Time Format

Select the time format: 12 Hr. AM/PM or 24 Hr.

Date Format

Select the date format: dd/mm/yyyy, mm/dd/yyyy, or yyyy/mm/dd.

Default Century

Select the default century for the system to use.

Date/Time (restart needed)

Select to display the Date/Time Properties window, to specify the system
date, time, time zone, and to auto adjust for daylight savings time.

Table 10-3: General User Interface

Preset Parameter

Description

Color Level (restart
needed)

Select System Color according to the condition of the room.

Table 10-4: Title Bar

Preset Parameter

Description

Hide Patient Data

When set to Always, patient information is removed from the scanning screen
Title bar and when storing images; or you can set this to remove patient
information only when storing the image (On Store); or Never.

Note: Upon recall of images with measurements, Dual image, V Nav, the
DICOM image is recalled. In this case, there is no patient data burned into
the DICOM image. If you DO NOT want this to occur, set this to Never.

Font Size (restart needed)

Select to display patient information in the title bar using a small, medium, or
Extra large font size. You need to reboot the system for this change to take
effect.

Table 10-5:  Trackball

Preset Parameter

Description

Speed

Set how fast you want the Trackball to move while performing actions such
as tracing the anatomy. 0=Slow; 20=Very Fast

Acceleration

Set how fast you want to trackball to move across the display. 0, 1, and 2 with
0 being the slowest acceleration.

10-8
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Table 10-6: Key Usage

Preset Parameter

Description

Run Fast Key speed

Select the maximum value of the key interval when running Fast Key.

Swap Print1/Freeze Key
(restart needed)

Swap the control between Print 1 and Freeze key.

Enable Virtual Keyboard

If checked, the Virtual Keyboard appears automatically when selected on the
Patient screen.

Auto Hide Delay Time for Off, 6, 8, 12, 16.
Virtual Keyboard (sec)
Table 10-7:  Utility
Preset Parameter Description

Prompt for Save on Exit

If selected, the system prompts you to save data when you select exit without
saving.

Utility Font Size

Select the font size you want to use to view the Utility menus: Small, Medium,
or Large.

Table 10-8: Scan Assistant

Preset Parameter

Description

Auto Selection

Off, Category, or Description.

» Off. The Scan Assistant selection on the Patient screen is completely
manual. It will say “None” when starting a new patient and you can make a
selection manually if desired.

» Category. Scan Assistant uses the combination of exam category (Abd,
OB, etc.) and the currently-selected user to automatically select a Scan
Assistant program. It chooses the same program that was used the last
time this combination of exam category and user. The user can manually
override this auto selection.

* Description. Scan Assistant uses the combination of the exam description
(often auto fills in if the patient was selected from the worklist) and the
currently selected user to automatically select a Scan Assistant program. It
will choose the same program that was used the last time this combination
of exam description and user was selected. The user can manually override
this auto selection. If the exam description is blank then it will do the auto
selection based on Category as described in the previous paragraph.

Always Use Doppler
Cursor

Use the Doppler Cursor when you activate Scan Assistant.

Table 10-9:  Smart Start (Start Assistant)
Preset Parameter Description
Use Smart Start (Start Checked to use Smart Start (Start Assistant) by default.
Assistant)
Edit Mappings Select to open Smart Start (Start Assistant) Mapping Editor.
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Table 10-10:  Touch TGC

Preset Parameter Description

Auto Hide Delay Time for Off, 6, 8, 121, 16.
Deigital TGC (sec)

Categery dependent user Check to select.
defined digital TGC

Save the TGC curve when Check to select.
Oversrite Preset

Table 10-11:  Extend Battery for Scanning

Preset Parameter Description
Auto Switch to Power Select 10, 30 minutes or 1 hour for automatically switching to Power Saving
Saving Mode mode after the time specified on battery operation.

Select “Never” to never switch to Power Saving mode.
Select “Always” to always switch to Power Saving mode.
(Extended battery option is required).

Table 10-12:  Extended Battery for Scanning/Power Assistant

Preset Parameter Description
Battery Low Warning with If checked, the system plays a beep sound when the battery capacity is low.
Sound
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System/System Display Preset Menu

The System/System Display screen allows you to specify
parameters for Image Display.

User
Configurable Key

System System Backup/

General i Measure Rectore Peripherals GT Con

Image Display Use Wide Screen for...

Image Display Area Default Dual Screen

Image size (probe selection required) Default = DualView (Simultaneous)
= Contrast DualView

Side Panel Content LOGIQ\
Side Clipboard QAnalysis
My Desktop Display format Horizontal Timeline
Measurement Summary Sincle Imase Off =

5 =1 =

Clipboard

Preview Image ™

Display

) i Horizontal Scale
Show Zoom Referenc v

L=
Bottom Clipboard Off = PW Velocity Un

Bottom Clipboard Auto Dimming On = Sample Volume Length
Side Clipboard Auto Dimming On = Shear Elasto Display Units m/s =
Configuration Application (reboot required) Shear Stiffness and Velocity Measurement
Abdomen @ Shear Elasto Color Map Red as Hard =
Bbstetics Strain Elasto Color Map Blue as Hard =
Image Parameter Size (restart needed) Small -
Highlight Image Parameter Changes W
Vascular Live/Freeze Indicator &
Urology Enable DICOM grayscale display mode (GSDF)
Pediatrics Room Profile LastUsed =
Small Parts
PoC

Figure 10-2. System/System Display Preset Menu

Table 10-13:  Image Display

Preset Parameter Description
Image Display Area Select Image Display Area Size: Default, Large, Extra Large
Image size (probe Select Default, Medium or Large.

selection required)

Table 10-14: Side Panel Content

Preset Parameter Description

Side Clipboard Display On/Off.

My Desktop

Measurement Summary
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Table 10-15:  Clipboard

Preset Parameter Description
Review Image Display On/Off
Show Zoom Reference
Image
Bottom Clipboard Display On (Always display)/ Off (Never display)/ Auto (Display whenever
there is no side clipboard)
Bottom Clipboard Auto On/Off
Dimming When the windows pointer is moved over the clipboard area, the pointer is
undimmed.
Side Clipboard Auto
Dimming
Table 10-16:  Configuration Application (requires reboot)
Preset Parameter Description
Abdomen Display On/Off in the Model Screen
Obstetrics
Gynecology
Cardiology
Vascular
Urology
Pediatrics
Small Parts
PoC
Table 10-17:  Use Wide Screen for...
Preset Parameter Description
Dual Screen Automatically switch to Wide Screen when in Dual Screen.
DualView (Simultaneous) Automatically switch to Wide Screen when in Simultaneous DualView
Screen.
Contrast DualView Automatically switch to Wide Screen when in Contrast DualView Screen.
LOGIQView Automatically switch to Wide Screen when in LOGIQView.
QAnalysis Automatically switch to Wide Screen when in QAnalysis. Side by Side
Timeline automatically switches to wide screen when in Timeline mode.
Display Format Horizontal Side by Side Timeline automatically switches to wide screen when in
Timeline Timeline mode.
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Table 10-17:

Use Wide Screen for... (Continued)

Preset Parameter

Description

Single Image

On/Off/Auto
Auto turns on wide screen if 2D image exceeds width of non wide screen
image area.

Table 10-18: Display

Preset Parameter

Description

Horizontal Scale

Select to display width markers.

TGC Display

Select to display TGC curve.

PW Velocity Units in cm/s

Select to change scale on timeline from centimeters per second to meters
per second.

Shear Elasto Display Units

Select m/s or kPa.

Shear Stiffness and
Velocity Measurement

Select to take both Stiffness and Velocity measurement.

Shear Elasto Color Map

Select Red as Hard or Blue as Hard.

Strain Elasto Color Map

Select Red as Hard or Blue as Hard.

UGAP Display Units

Select dB/cm/Mhz or db/m

Image Parameter Size
(restart needed)

Choose Small, Medium, Large, or Extra Large. Must reboot the system.

Highlight Image Parameter
Changes

Select if you want the display to indicate which controls you adjusted by
highlighting the new value on the display.

Live/Freeze Indicator

Display On/Off.

Enable DICOM grayscale
display mode (GSDF)

Enable On/Off.
Adjust Gamma curve on DICOM GSDF.

Room profile

Enable Last used/.
Adjust Room Profile.
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System/System Imaging Preset Menu

The System/System Imaging screen allows you to specify
Biopsy Guides, VNav Brackets, Compare Assistant and Imaging
Control.

User
Configurable Key

Genera S i Paripherals

Figure 10-3. System/System Imaging Preset Menu

Table 10-19: Biopsy Guides

Preset Parameter Description
Show Center Line Displays center biopsy guideline.
Show Outer Lines Displays outer biopsy guidelines.
Enable 0.5cm markers Activates biopsy depth markers every 0.5cm.

Show Biopsy Mark on CFM | Displays the Biopsy Guideline on the image while in Simultaneous Mode.
Simultaneous Mode

Show Biopsy Mark on Dual Displays the Biopsy Guideline on the image while in Dual View Mode.
View Mode

Show Biopsy Circle Select to display a guide circle control on the monitor and Trackball key
during Biopsy.

Table 10-20: Controls

Preset Parameter Description

Auto Invert on Linear Steer | When selected, for auto calcs, automatically inverts the timeline if needed
when using ASO.

Auto Invert on ASO Automatically inverts the spectrum with ASO.
Link Color/Doppler Invert When selected, the Doppler timeline scale inverts along with the color ROI.
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Table 10-20:  Controls (Continued)

Preset Parameter

Description

Use Right/Left Depth
Joystick for performing
Steer

When selected, Right/Left Depth Joystick activates for performing Steer.

Audio Volume

Adjusts the Doppler audio volume via a drop-down menu (for example,
O=softer; 20=louder).

Auto Freeze Time (probe
selection required)

Select 10, 30 or 60 minutes to freeze the image automatically after the time
specified of inactivity or Never to never freeze the image automatically.

Countdown Time For
Contrast (Sec)

Specify time for the Contrast Clock to countdown during a contrast study,
0 (off), 3, and 5 seconds.

Reverse Depth Control

Changes key direction for the Depth control.

Reverse Steer Controls

Changes key direction for the Steer controls.

Turn Off CrossXBeam for
LOGIQView (non-linear
probe)

Deactivates CrossXBeam when you activate LOGIQView.

3D Postprocessing when
reloading

When selected, the system re-processes the recalled 3D CINE Loop.

Doppler Scroll Priority

Set to 2D, Doppler, or Last Live Mode.

Start Doppler in Update

Select to allow the B/CF image to continue live while the PW image is frozen
in triplex.

Default Rotation

Select 0 or 180 to default rotation image.

B-Mode rotary adjusts the
gain of the active mode

If checked, use B rotary as the active tab mode gain rotary.

MyPage 1 column 2/3
assignment (requires
reboot)

Depending on the user's configuration, First page of MyPage has one or two
columns of body patterns or comments.

MyPage 2 column 2/3
assignment (requires
reboot)

Depending on the user's configuration, Seconde page of MyPage has one or
two columns of body patterns or comments.

LOGIQ P8/P9/P10 — Basic User Manual
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Customizing Your System

System/System Measure Preset Menu

Show Individual G

The System/System Measure screen allows you to specify
measurement parameters such as the type of default OB
measurements and calculations. You can also define cursor and
Results Window default functionality.

Aot Licenses

Figure 10-4. System/System Measure Preset Menu

Table 10-21: Measurement

Preset Parameter

Description

Repeat Measurement

Select No, Repeat, DefaultMeas

No = After you take a measurement, you have to touch a Touch Panel key or
Trackball key to start another measurement.

Repeat = After you take a measurement, the system automatically starts the
same measurement again.

DefaultMeas = After you take a measurement, the system automatically
starts a default measurement based on the current scanning mode (B-Mode
= basic length measurement, M-Mode = basic length measurement, Doppler
Mode = velocity measurement except after a volume flow calculation).

OB Type Select which OB measurements and calculations studies to use: USA,
Europe, Tokyo, Osaka, or ASUM.

EFW GP Select the source used to calculate EFW-GP Estimated Fetal Weight-Growth
Percentile)

CUA/AUA for Hadlock Select to use CUA (Composite Ultrasound Age) or AUA (Average Ultrasound
Age) as the default

Hadlock Table Type Select Hadlock 82 or Hadlock 84 tables

EFW Formula (Europe)

Select the source used to calculate EFW (Europe) (Estimated Fetal Weight),
Shepard, Merz, Hadlock, German, Rich

EFW Formula (Tokyo)

Select the source used to calculate EFW (Tokyo) (Estimated Fetal Weight)

10-16
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System Presets

Table 10-21:

Measurement (Continued)

Preset Parameter

Description

Add 1 week to EDD

Select to add additional week to estimated date of delivery

OB Graph Display

Select Single or Quad for displaying OB Graphs.

OB Graph Single Display

Select Last Meas or EFW Single OB Graph displayed by default.

Fix Caliper by Print key

Select to use the Print key like the Set key.

NOTE: If you select this during a generic volume measurement, the print key
does not function like the Set key, but instead ends the measurement
sequence and initiates the volume calculation based on the number of
measurements taken so far.

LV Study using straight line

Sets straight line as the default for 2D LV studies.

Side selections of Rt, Lt
and Off

Select to use “Rt, Lt and Off” for Side Selection. When not selected, displays
only “Rtand Lt".

Dual Caliper on
Simultaneous

Select to enable Dual Caliper on Simultaneous.

Map Cycle to Select
Trackball Key

Map “AutoCalc cycle select” to Left/Right Set key.

Table 10-22: Cursor

Preset Parameter

Description

Cursor Type

Select whether to mark measurements with numbers or symbols.

Cursor Size

Specify 12x12 or 9x9.

Cursor Line Display

If selected, after you press Set to complete a measurement, the cursor line is
displayed. If not selected, after you press Set to complete a measurement,
only the cursor number or symbol is displayed.

Cursor Ellipse Cross Line
Display

Check box to display the cross line in Ellipse.

D Manual Trace Cross
Line Display

Check box to display the cross line with the caliper.

Cursor Position

Select 1st Cursor, 2nd Cursor, or Image Center.

Color When Set (reboot)

Select white, yellow, bright red, or orange.

Cursor is Displayed when
Trackball is Moved

The active cursor does not display until you move the Trackball. This
assumes the following presets are set: Repeat Measurement, Repeat,
Default Measurement, and Cursor.

Table 10-23:  Worksheet (USA/ASUM)

Preset Parameter

Description

Show Individual Growth
Percentiles

Check to display individual growth percentiles on the Worksheet.

LOGIQ P8/P9/P10 — Basic User Manual
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Customizing Your System

Table 10-23:

Worksheet (USA/ASUM)

Preset Parameter

Description

OB Range Type

Selections: Min-Max, Standard Deviation.

Table 10-24: Results Window

Preset Parameter

Description

Result Window Mode
Depend

Select this if you want the measurement result window to be repositioned,
depending on the mode.

Result Window Position
X[0-800]

You can set the coordinates for the measurement result window when you do
not have the result window set to be mode dependent. This is the X
coordinate (left/right)

Result Window Position
Y[0-600]

You can set the coordinates for the measurement result window when you do
not have the result window set to be mode dependent. This is the Y
coordinate (up/down)

Result Window Select the Result Window location on the Monitor Display: Left-Bottom,

Location-2D Left-Top, Right-Bottom, Right-Top, Extreme Right-Top, or Extreme
Right-Bottom.

Result Window Select the Result Window location: Left-Bottom, Left-Top, Right-Bottom,

Location-Timeline

Right-Top, Extreme Right-Top, or Extreme Right-Bottom.

Result Window Format

Select Wide or Narrow.

Font Color (restart needed)

Select White, Off White, Yellow, Bright Red or Orange (reboots the system)

Font Size (restart needed)

Select mini, small, medium, large, or extra large (reboots the system)
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System Presets

System Backup and Restore Preset Menu

General . _ ¥ 4 Peripherals

Configur

Backup

Restore

Figure 10-5. System/Backup/Restore Preset Menu

Table 10-25: Backup

Preset Parameter Description
Patient Archive Select to back up patient data.
Report Archive Select to back up report data.

User Defined Configuration | Select to back up the user-defined configuration settings.

Service Select to back up Service (iLing and Network) settings.

Backup Select to begin the backup.

Table 10-26: Media

Preset Parameter Description
Media Select media type to use for backup and restore.
LOGIQ P8/P9/P10 — Basic User Manual 10-19

Direction 5841298-1EN Rev. 2



Customizing Your System

System Backup and Restore Preset Menu (continued)

Table 10-27: EZBackup

Preset Parameter

Description

Reminder Dialog Interval
days

Specify the number of days after the last backup that you want the system to
prompt you to perform an EZBackup procedure (only for moving images).

Enable Reminder Dialog

Select to activate the EZBackup reminder pop-up dialog.

Media

Select media type.

Table 10-28: Restore

Preset Parameter

Description

Patient Archive

Select to restore patient data.

Report Archive

Select to restore report data.

User Defined Configuration

Select to restore the user-defined configuration settings.

Service

Select to restore service iLing and Network settings.
CAUTION: DO NOT restore service presets on to a different LOGIQ P8/P9/
P10 system. Only restore service presets to the same system.

Restore

Select to begin the restore process for the selected configuration files.

NOTE:

10-20

The detailed section of this menu allows you to restore one area
at a time from the user defined configuration. This allows you to
selectively restore what you want to restore across multiple
machines. Check the box(es) you want to restore, insert the
appropriate media, and press Restore.

When you restore backup data from the Ultility menu, the
LOGIQ P8/P9/P10 application usually restarts automatically
when the restoring is complete.
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System Presets

System Backup and Restore Preset Menu (continued)

Table 10-29: Detailed Restore

Preset Parameter

Description

Imaging Presets

Select to restore imaging presets.

Connectivity Configuration

Select to restore connectivity configurations.

Measurement
Configuration

Select to restore measurement configurations.

Comment/Body Pattern
Libraries

Select to restore comment and body pattern configurations.

Protocol Template

Select to restore Protocol Template.

Report Templates (Same
software version only)

Select to restore Report templates.

3D/4D

Select to restore 3D.

Fast Key

Select to restore Fast Key.

Utility-->Application
Presets

Select to restore Utility--> Application presets.

Custom Programs

Select to restore Scan Assistant programs.

All Others Select to restore all other configurations not listed in the Detailed Restore
section. This includes parameters defined on the System preset menus.
Restore Select to begin the restore process for the selected configuration files.
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Customizing Your System

System/Peripherals Preset Menu

The System/Peripherals screen allows you to specify
parameters for the DVR and printers.

System
Display

System
Imaging

System
Measure

Backup/

General
Restore

Peripherals.

DVR Standard Printer Properties
Media (restart needed) DVD =
DVD Format (restart needed) NTSC =

Send Ta OneNote 2016
Properties
Picture Quality (restart needed)
USB Video Codec (restart needed)
USB Video Size (restart needed) Full

Default Printer
Follow Me Print(GEUK)

DVD Chapter Record Interval (sec) 15 = Setup

USB Playback Skip Interval (sec) 15 = Puint Bull Seveen
Enable Video Invert @

Print and Store Options

Removable Media

Figure 10-6. System/Peripherals Preset Menu

Table 10-30: DVR

Preset Parameter

Description

Media (restart needed)

Select recording media: Media: DVD or USB storage.

DVD Format (restart
needed)

Select DVD video format: NTSC or PAL.

Picture Quality (restart
needed)

Select from SP, HQ, SP, or EP.

USB Video Codec (restart
needed)

Select from MPEG2 or H264.

USB Video Size (restart
needed)

Select from Normal or Full.

DVD Chapter Record
Interval (sec.)

Select the Interval of automatic chaptering for DVD recording from 15, 30, 60
and 120 seconds.

USB Playback Skip
Interval (sec.)

Select the Interval of time skipping for USB playback from 15, 30, 60 and 120
seconds.
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System Presets

System/Peripherals Preset Menu (continued)

Print and Store Options. Press Print and Store Options to go to
the Utility --> Connectivity --> Miscellaneous setup page.

Removable Media. Press Removable Media to go to the Utility
--> Connectivity --> Removable Media page.

Table 10-31:  Printer Setup

Preset Parameter

Description

Standard Printer
Properties: [Printer] and
Properties, and Default
Printer

Select to add an additional standard printer via the USB serial port and to
configure digital printers. This activates the Windows Add Printer wizard.
NOTE: Most printer drivers are available via Windows; however, newer
printers may require you to load the manufacturer-supplied print driver (must
be on CD-ROM). Refer to the Basic Service Manual for more information.

Print Full Screen

Select for the standard printer to print the full screen.

Enable Video Invert

Select for the standard printer to print black on white rather than white on
black.
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Customizing Your System

System/User Configurable Key

This feature assigns functionality, that are invoked from the
Touch Panel or windows controls, to the keys on the operator
panel so that be able to invoke with single action.

Figure 10-7. User Configurable Key Preset Menu
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System Presets

System/User Configurable Key (continued)

Figure 10-8. Programmable Operator Panel Controls

Table 10-32:  User Configurable Keys

Preset Parameter Description

1-7 User Defined Hard Key | The following functionality is available: Table 10-32 User Defined Hard Key

8 - User Defined Touch The following functionality is available : Table 10-33: User Defined Touch
Button Buttons

9 - User Defined Trackball Specify which controls you want to be used on the Trackball:

Set Key * B/B-Flow/Contrast: Focus or Frequency

» CF/TVI/PDI: AUto or Steer or Scale
* PW/CW/TVD: Auto or Baseline or Scale
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Customizing Your System

System/User Configurable Key (continued)

To move and replace a BT Feature key cap,

1. Insert the flat blade of a screwdriver into the hole on the
upper side of the key cap and lift it up to remove it.

Figure 10-9. Remove the key cap

2. Repeat for each key, to match how you have configured the
BT Feature keys.

3. Replace the key caps by positioning it and pushing down on
the key cap until it clicks into place.
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System Presets

User Defined Hard keys and User Defined Touch Buttons

User Defined Hard keys and User Defined Touch Buttons can be
programmed as one of the following functions:

Table 10-33:  User Defined Hard Key

Preset Parameter Description
No Function No function.
Elasto You can arrange the order of BT key on the control panel as you have
programmed in the Utility page.
LOGIQView
3D/4D
Contrast
LOGIQApps
B-flow
UGAP Turn on/off UGAP mode
Hepatic Assistant Turn on/off Hepatic Assistant mode
Reverse Turn on/off Reverse the image.
MarkCine Turn on/off Mark Cine.
CHI Turn on/off CHI mode.
Reset Reset all the parameters.
My Page Turn on/off MyPage preset.
CF Turn on/off CF mode
PDI Turn on/off PDI mode.
Ccw Turn on/off CW mode.
B Steer+ Turn on/off B Steer+
Biopsy Kit Biopsy Guideline Display/change biopsy guide line.
Biplane Switch screen layout between Single Plane and Bi Plane.
ECG on/off Turn on/off ECG.
Print2 Assign Print 2
Print3 Assign Print 3.
Print4 Assign Print 4.
Print5 Assign Print 5.
Print6 Assign Print 6.
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Customizing Your System

Table 10-33:  User Defined Hard Key

Preset Parameter

Description

Video Turn on/off Video tab.
Worksheet Go to Worksheet page.
MyTrainer Go to My Trainer Plus page.
Active Image Go to Active Images Screen.

Auto Dop. Calc

Turn on/off Auto Calcs in Doppler mode.

Auto SoS

Adjust Automated Speed of Sound.

Button Probe Enable/
Disable

Enable/Disable Button Probe

Center Line Turn on/off center line.
Clear Saved Clear all measurements in the selected measurement category. Display the
Measurements Confirmation dialogue before delete data.

Compare Assistant

Turn on/off Compare Assistant.

Full Timeline Turn on/off full timeline mode.
HDColor Turn on/off BFHDC mode.
Image Size Change Image size.

Report Go to Report page.

Room Profile

Switch room profile setting.

SaveAs Go to SaveAs Screen.
TIC Analysis / Qanalysis Turn on/off TIC Analysis / Qanalysis.
TVI Turn on/off TVI mode.

Toggle Image Display Area

Toggle current display area and extra large area.

Touch Control

Turn on/off Touch Control mode.

Volume Navigation

Turn on/off VN mode.

Worklist

Go to Worklist page.

Table 10-34:  User Defined Touch Buttons
Preset Parameter Description
No Function No function.
Reverse Turn on/off Reverse the image.
MarkCine Turn on/off Mark Cine.
CHI Turn on/off CHI mode
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Table 10-34: User Defined Touch Buttons

Preset Parameter Description
Reset Reset all the parameters.
My Page Turn on/off MyPage preset.
Biopsy Kit Biopsy Guideline Display/change biopsy guide line.
ECG on/off Turn on/off ECG.
Print2 Assign Print 2
Print3 Assign Print 3.
Print4 Assign Print 4.
Print5 Assign Print 5.
Print6 Assign Print 6.
Video Turn on/off Video tab.
Worklist Go to Worksheet page.
B-flow Turn on/off B-flow mode.
MyTrainer Go to My Trainer Plus page.
Touch Control Turn on/off Touch Control mode.
LOGIQ P8/P9/P10 — Basic User Manual 10-29

Direction 5841298-1EN Rev. 2



Customizing Your System

System/About Preset Menu

The System/About screen lists information about the system

software.

Syslein
Display

General

Figure 10-10. System/About Preset Menu

Table 10-35: Software

Preset Parameter

Description

Software Version

The current software version on this system.

System Revision

The current revision of the software version on this system.

Software Part Number

The software part number.

Build View The software build view.
Build Date The software build date.
Table 10-36: Patents
Preset Parameter Description

Patents

Lists system patents.

Table 10-37: System Image

Preset Parameter

Description

Image Part Number

The image part number (ghost part number).

Image Date

The image date (ghost date).
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MyPage Presets

Overview

MyPage Presets

MyPage screens allow you to specify comment, measurement,
body pattern, and functions options, to define libraries, and
assign comment, measurement, body pattern, and some special
functions.

The MyPage allows you to:

* Arrange, Create and Edit MyPage presets on the touch
panel

measurements on the 1st column touch panel screen
comments on the 2nd column touch panel screen
body patterns on the 3rd column touch panel screen

some special functions on the 4th column touch panel
screen

NOTE: The user can be set up to use the body patterns column
instead of the comment column. The 2nd and 3rd columns
are body pattern lines. Press Utility -> System -> System
Imaging -> in Controls -> MyPage column 2/3 assignment
(requires reboot) preset, select the “Two Body Pattern
Column” and MyPage 1 column 2/3 assignment (requires
reboot) preset, select the “Two Body Pattern Column®.
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Customizing Your System

Overview (continued)

NOTE: The user can be set up to use the comment column instead
of the body pattern column. The 2nd and 3rd columns are
comment lines. Press Utility -> System -> System
Imaging -> in Controls -> MyPage column 2/3 assignment
(requires reboot) preset, select the “Two Comment Column”.

Figure 10-11. MyPage 1 Preset

My Page

Figure 10-12. MyPage 2 Preset
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MyPage Presets

Measurement column in MyPage Preset

Measurement on the 1st column of MyPage screens allow you
to studies and measurements, and assign studies and
measurements libraries in the 2D (B-Mode) to applications.The
measurement and Studies are listed in the library in the order in
which they display on MyPage the touch panel. For each library,
you can define MyPage touch panel displays of comments (1st
Column), with 5 measurements on each MyPage touch panel.

NOTE: To program on the 1st column of MyPage screens, See
‘Measurement and Calculation Setup’ on page 7-18 for more
information.
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Comment column in MyPage Preset

NOTE:

Comment column of MyPage screens allow you to specify
comment text and pointer options, to define comment libraries,
and assign comment libraries to applications. On comment
column of MyPage, you can change and create body pattern
libraries. A comment library is a list of body patterns that are
associated with a specific application. The comments are listed
in the library in the order in which they display on MyPage the
touch panel. For each library, you can define MyPage touch
panel displays of comments column, with 5 comments or 10
comments each on MyPage touch panel.

To program comment column of MyPage screens,See
‘Comments Libraries Presets’ on page 10-43 for more
information.

Body pattern column in MyPage Preset

10-34

NOTE:

Body pattern column of MyPage screens allow you to specify
body pattern text, to define body pattern libraries, and assign
body pattern libraries to applications. On body pattern column of
MyPage, you can change and create body pattern libraries. A
body pattern library is a list of body patterns that are associated
with a specific application. The body patterns are listed in the
library in the order in which they display on MyPage the touch
panel. For each library, you can define MyPage touch panel
displays of body patterns Column, with 5 body patterns or 10
body patterns on each MyPage touch panel.

To program body pattern column of MyPage screens, See ‘Body
Patterns Presets’ on page 10-56 for more information.
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MyPage Presets

Function column in MyPage Preset

Function on the 4th column of MyPage screens allow you to
specify some function.On Function on the 4th column of
MyPage, you can change function. The functions are listed in
the order in which they display on MyPage the touch panel. For
each functions, you can define MyPage touch panel displays of
function (4th Column), with 4 functions on each MyPage touch

panel.

Some special function Keys in MyPage can be programmed as
one of the following functions:

Table 10-38:
Function Description
Help Access Online help / user manual.
Arrow Annotation arrow.
Biopsy Kit Biopsy Guideline Display/change biop

Create Macro

Creates a Macro.

ECG on/off

Turn on/off ECG.

Eject

Eject media.

Spooler

Activates DICOM Job Spooler screen.

Create a Fast Key

Creates a Fast Key.

Play a Fast Key

Plays a Fast Key.

Home

Move annotation cursor to home position

Set Home

Set current annotation cursor position as the
new home position

Text1/Text2

Switch between user text annotation overlays

Grab Last

Activate the last selected data for edit.

Word Delete

Erase word associated with comment cursor.

MyTrainer

Active the MyTariner

NOTE: To program on the 4th column of MyPage screens, Go to Ulility
-> System -> User Configurable Key -> MyPage 1 User Defined
Function Key and MyPage 2 User Defined Function Key
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Imaging Presets

Overview
Imaging screens allow you to specify parameters for the
following:
*  B-Mode (B)
+ Color Flow Mode (CF)
* Power Doppler Imaging (PDI)
» Elastography (ELASTO)
+ UGAP
*+  M-Mode (M)
* Anatomical M-Mode (AMM)
*  Pulse Wave Mode (PW)
+ Continuous Wave Mode (CW)
* Harmonics (HAR)
* B-Flow (BF)
*  B-Flow Color (BFC)
*  B-Flow HD Color (BFHDC)
+ Contrast Reference (Ref)
+ Contrast (CON)
+ Tissue Velocity Imaging (TVI)
+ Tissue Velocity Doppler (TVD)
* Auto Sweep
+ General
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Imaging Presets

Overview (continued)

Figure 10-13. Imaging - Example

1. Model/application dependent setup parameters
2. Probe dependent setup parameters
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Changing imaging presets

10-38

NOTE:

NOTE:

To change imaging presets:

1. On the Touch Panel, select Utility.
2. On the Touch Panel, select Imaging.
The system displays the Imaging screens.

Figure 10-14. Example: B-Mode Preset

3. Inthe row across the top of the screen, select the mode.

The system displays two sets of parameters and settings.
The left column lists all settings for the exam (for example,
Abdomen). The right column lists settings that apply only to
the exam and probe combination.

4. Inthe Preset list, select the exam.

5. Inthe Probe list, select the probe.

6. To change a parameter, do one of the following:
+ Select the value from a list
+ Select one value from a choice of two or more buttons
» Select or clear a check box

7. After changing the parameters, to save the changes, select
the Save button.

When you Save changes to imaging parameters, the system
saves changes to all modes, not just the mode currently
displayed.

If you have problems with imaging, you can return parameters
back to the original settings. Select the exam, probe, and mode,
and then select Reload Factory Defaults. The system returns the
selected parameters to the original settings.

For information about the specific parameters, refer to Chapter 5
Optimizing the Image.
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Imaging Presets

General

Figure 10-15. General Presets

Default probe per application

The Default Probe per Application Configuration feature enables
to specify a default probe for a particular application. Each time
an application is activated, the default probe for that application
is also activated if connected to the system.

1. To specify a default probe per application, select Utility -->
Imaging --> General.

2. Select the default probe from the Configuration for Selected
Application only pull-down menu.

Settings

* All Probes (General)
+ Simultaneous
* Automatically Retain Field of View
If selected, the system automatically activates the
Retain Field of View control when a field of view setting

is changed. If not selected, you can activate the Retain
Field of View manually from the Model Touch Panel.

» Configuration for Selected Application only

Select Probe which you want configure.
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Default mode and application per probe

10-40

NOTE:

The Default Application per Probe Configuration feature enables
to specify a default application for a particular probe. Each time
that probe is loaded, the default application is activated.

1. To specify a default application per probe, select Utility -->
Imaging --> General.

2. Select the default application from the Configuration for
Selected Probe only pull-down menu.

Settings

+ Assign the following options per application and probe.

Default Mode: B-Mode or Harmonic

Default Elasto: Shear or Strain

CF/PDI Button: CF or PDI

BF/BFC Button: HAR or BF or BFC or BFHDC
Acoustic Output (%)

Enable B Steer+

Show Center Maker

Show Center line

+ ECG

ECG Display
Sync Mode

»  Configuration for Selected Probe only

Select the application which you want configure.

If you use the user-defined preset as default preset, re-select
the preset in Utility whenever you overwrite the user-defined

preset.
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Imaging Presets

Probe Button

NOTE:

Button probe allows user to assign functions as they wish and
use the system without touching touch panel or front panels.
(Only applicable with special probes, for example. L4-12t)

The following menu allows you to customize the buttons on the
probe for different controls.

When the system is in PoC mode, the menu in “General” tab is
only effective. The General Tab allows the user to configure the
4 Button controls.

Holding a button for few seconds displays button probe helper.

To customize probe buttons, select one of the selections
available in the Imaging menu. (The following menu is only
available from the Imaging menu with the L4-12t probe
selected.)

FetalEcho - L4-12t (General)
User Defined Probe Button 1 B Mode
User Defined Probe Button 2 Color Mode

User Defined Probe Button 3 PW Mode
User Defined Probe Button 4 M Mode

Figure 10-16. Assigning different functions to the probe
buttons
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Probe Button (continued)

f CAUTION Button ‘1’ may not be usable with out of plane needle guides.
HINTS Holding a button for few seconds shows button probe helper.

2 (-)Focus Po..

B T S e
virtual, L.on..

Figure 10-17. Button Probe Helper

HINTS Holding two buttons (for example, button 1 and 2 / button 3 and
4) for a few seconds disables the probe button function. You
can activate the probe button again by holding down two
buttons. The system also shows the current probe button
status on the status bar.
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Comments Libraries Presets

Overview

Comment screens allow you to specify comment text and
pointer options, to define comment libraries, and assign
comment libraries to applications.

Comments Libraries/Libraries Preset Menu

On the comments Libraries tab, you can change and create
comment libraries. A comment library is a list of comments that
are associated with a specific application. The comments are
listed in the library in the order in which they display on the
Touch Panel. For each library, you can define two Touch Panel
displays of comments (Page1 and Page2), with 16 comments on
each Touch Panel.

For each library, you can define one or two column display of
comments (MyPage), with 5 comments or 10 comments on each
My Page Touch Panel.

NOTE: The user can be set up to use the body patterns column instead
of the comment column. The 2nd and 3rd columns are body
pattern lines. Press Utility -> System -> System Imaging -> in
Controls -> MyPage 1 column 2/3 assignment (requires reboot)
preset and MyPage 2 column 2/3 assignment (requires reboot)
preset, select the "Two Body Pattern Column”.
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Comments Libraries/Libraries Preset Menu (continued)

Figure 10-18. Comment Libraries Preset Menu

Table 10-39: Libraries

Preset Parameter Description
Library The name of the comment library.
Paging The first (or second) Touch Panel page of comments for the selected library.
Small List Fields where you define a small list.
Reload Factory Defaults Select to reload factory defaults.
User Defined Library The name of a new comment library that you want to create/delete.
Copy from Existing You can add to or delete from the selection of comments.
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Defining Comments

In the Library field, select the library you want.

The system displays all comments for the library. You can
have two Touch Panel displays of comments for each
library. The comments are listed in the order that they are
shown on the Touch Panel when you use comments.

To change or add an comment, select the comment or blank
location and press Set, then do one of the following:

+  Type the comment.

+ Select the comment in the Copy from Existing list, and
press Set.

3. To save the changes, select the Save button.

Creating a new comments library

In the User Defined Library field, type a name for the library,
then select Create.

The system creates a new library.
Enter comments as described in step 2 above.
To save the changes, select the Save button.
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Deleting a user defined library

Creating a small list

NOTE:

10-46

Select the library name which you want to delete from the
pull-down menu.

Press Delete.
Press Save to save the changes.

A small list is a list of up to three comments attached to one
comment location on the Touch Panel. You can use a small list
to group similar comments, such as those indicating a probe
location. For example, you can specify that a small list include
the following comments: Long, Transverse, and Coronal. To
make comments easier to use, you can define the small list in
the same location in each comment library.

To define a small list:

1.

Move the Trackball to the comment field on Page1 or
Page2 where you want to create a small list, and press Set.

Move the Trackball to the first field in the Small List section,
and press Set.

To enter comments in the fields in the Small List section,
select the field and press Set, then do one of the following:
+  Type the comment

+ Select the comment in the Copy from Existing list, and
press Set twice.

You can enter up to three comments. When you enter an
comment in the first field of the Small List section, the
selected comment field on Page1 or Page2 changes to
SMALL LIST.

To save the changes, select the Save button.
The small list can be displayed as a pop-up window or as a

toggle field. The Small List Operation field on the Comment
tab allows you to specify how it is displayed.
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Comments Libraries/Comments Preset Menu

On the Comments tab, you specify text and pointer options.

Libraries E VT ations Mapping

Exit Search Cancel

Figure 10-19. Comment/Comments Preset Menu

Table 10-40: Text

Preset Parameter

Description

Text Font Size

Specify the font size. The font size increases as the number increases.

Text color (Text1 and
Text2)

Select the color for comment Text1 and Text2.

Text Boundary

Select Group Move or Word Wrapping.

Small List Operation

Select whether you want small list options to display in a pop-up window or
by a toggle function.

Enable Type Over Mode

Select to type over existing comments. Position the cursor over the text to be
changed, then start typing.

Reset Small List

Select to indicate that small lists should not be reset to the first item.

Automatically Set Text

If selected, the system sets the comment at the cursor position automatically

when text entry is complete.
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Table 10-41:  Arrow

Preset Parameter

Description

Arrow Length Select the default pointer length.
Arrow Size Select the default pointer size.
Keep Arrow Angle Keep the angle of arrow pointer head until next change.
Table 10-42:  General
Preset Parameter Description

Retain while entering or
leaving timeline mode

If selected, the system keeps the comment(s) on the monitor display when
you enter or leave timeline mode.

TextOverlay in Multiple
Image

When selected, and you select the F8 key to hide or show comments, if you
are in multiple image, the system hides the text in both images. When
cleared, the system only hides the text for the active image.

TextOverlay sequence

You can specify to display Text1, Text2, or both. This allows you to have
some comments that do not change during the exam while allowing you to
change other comments. Toggle the F8 key to cycle through the 3 Text1/
Text12 states.

Erase When the image is
unfrozen

Deletes comments when you unfreeze the image. If you check this
parameter, Text2 automatically erase when you unfreeze the image.

Erase When the probe or
application is changed

Deletes annotations when you change the application or probe.

Replace Undo Rotary with
B Focus Rotary

If selected, the Focal Zone Number and Position can be adjusted using the
Annotation Touch Panel. The Undo Rotary control changes to B Focus
Rotary.

Clear Non Active Image
Comments

If selected, comments from the non-activated images are automatically

cleared when entering dual or quad image screen.

10-48

After you change comment options, select Save to save the
changes.
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Comments Libraries/Applications Preset Menu

The Comments Libraries/Applications tab is a link to the
Applications preset menu. The Applications preset screen
allows you to specify which libraries belong to an application.
You also specify which is the default library that displays when
you use comments.

Libraries Comments Applications Mapping

Figure 10-20. Applications/Comments Link

The Applications/Comments screen can be accessed through
either the Comments Libraries or Applications Touch Panel key.

Figure 10-21. Applications/Comments Preset Menu
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Specifying which libraries belong to an application

1.  On the Comments tab, in the Preset field, select the
application.

2. Inthe Library Group Tabs fields, select the libraries for this
application. You can select up to six libraries.

3. Inthe Default Library Group field, select the default library
you want the system to display when you use comments.

NOTE: When you use comments, the default library is displayed. To
use other libraries for the application, press the tab for the
library.

4. To save the changes, select the Save button.

Table 10-43:  Applications

Preset Parameter Description
Preset The name of the application preset.
Tabs A list of libraries for the application. You can select up to six libraries.
Default Tab The default library that the system displays when you use comments.
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Using comments from a library

To use comments, press the Comment key on the Control
Panel. Comments are then displayed on the Touch Panel.

To select a comment library, press the appropriate tab (e.g. the
tabs are OB23 and OB23_1).

Figure 10-22. OB 2/3 Comments Touch Panel
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Comments Libraries/Mapping Preset Menu

The system uses the annotation/body pattern information
associated with the image to automatically assign the segment/
position qualifier of the breast lesion.

On the Mapping tab, you add/delete/reset the user-defined
mapping for the qualifier.

Librarios Commeants

notation to Lo

Figure 10-23. Comment/Mapping Preset Menu

Table 10-44: Mapping preset

Preset Parameter Description
Annotation to Location Add/Delete/Reset the use-defined mapping annotation for the qualifier for
Conversion Breast.

» Add: Add the use-defined mapping annotation
* Delete: Delete selected user-defined mapping.
* Reset: Reload factory default mappings to the selected qualifier.

Use Auto Positioning Configure a mapping of annotation and body pattern to location (Position and
Segment) mappings.

Note: This is effective only against the following body pattern: Breast4 Lt/Rt,
Breast5 Lt/Rt, Breast6 Lt/Rt, Breast7 Lt/Rt, Breast8 Lt/Rt

After you change Mapping options, select Save to save the
changes.
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Comments Libraries/Mapping Preset Menu (continued)

For example,

Select Qualifier “12 O’clock” from the pull-down menu.
Type the mapping annotation “12”, and press Add.
Check “Use Auto Positioning”.

In Utility-> Body Pattern-> Libraries, select SMLP from
pull-down menu.

Pobnp-=

5. Select an empty cell of the Library table.
6. Select Breast4_Rtin Copy from Existing and press Add.
7. Press Save and Exit.
8. Scan the patient.
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Comments Libraries/Mapping Preset Menu (continued)

9. Type “Right Breast 12 Zone 1" as Comment on the image.

10. Activate Breast measurement and select Lesion folder from
the Touch Panel for add Lesion1.

Position Rotary is set 12 O’clock, Segment Rotary is set A,
and “12 O’clock A” displays as measurement name
automatically.

NOTE: The system assigns “” to position qualifier if the value is not
found in the annotation or body pattern information
associated with the image.

Figure 10-24. Annotation Example
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Comments Libraries/Mapping Preset Menu (continued)

11. Select the frame for Lesion 2.

12. Select Breast4 Rt as Body pattern on the image and locate
the probe mark in the appropriate position.

13. Activate Breast measurement and select Lesion folder from
the Touch Panel.

14. Position Rotary and Segment Rotary is set automatically
associated with the position and segment of the probe mark.

Figure 10-25. Body Pattern Example
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Body Patterns Presets

Overview

Body patterns screens allow you to specify body pattern options,
to define body pattern libraries, and assign body pattern
libraries.

Body Pattern Libraries/Libraries Preset Menu

On the Body Patterns Libraries tab, you can change and create
body pattern libraries. A body pattern library is a list of body
patterns that are associated with a specific application. The
body patterns are listed in the library in the order in which they
display on the Touch Panel. For each library, you can define two
Touch Panel displays of body patterns (Page1 and Page2), with
16 body patterns on each Touch Panel.

For each library, you can define one or two column displays of
body patterns (MyPage), with 5 comments or 10 comments on
each MyPage Touch Panel.

NOTE: The user can be set up to use the comment column instead of
the body pattern column. The 2nd and 3rd columns are
comment lines. Press Utility -> System -> System Imaging -> in
Controls -> MyPage 1 column 2/3 assignment (requires reboot)
preset and MyPage 2 column 2/3 assignment (requires reboot)
preset, select the "Two Comment Column”.
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Body Pattern Libraries/Libraries Preset Menu (continued)

Libraries Body Patterns

ttern in MyFage

Figure 10-26. Body Patterns Libraries Preset Menu

Table 10-45: Body Patterns Libraries

Preset Parameter Description
Library The name of the body pattern application library.
Reload Factory Defaults Select to reload factory defaults.
Body Pattern Image Displays the image of the currently selected body pattern.
User Defined The name of a new body pattern application library that you want to create.

Libraries-Create

User Defined Allows the selection of the user defined library to be deleted.
Libraries-Delete

Copy from Existing A list of body patterns you can use to create an application library.
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Defining body patterns

NOTE:

3.

In the Library field, select the application library you want.

The system displays all body patterns for the library. You
can have two Touch Panel displays of body patterns for
each library. The body patterns are listed in the order that
they are shown on the Touch Panel.

To change or add a body pattern, select the body pattern or
blank location and press Set, then do one of the following:

* Type the body pattern name.
+ Select the body pattern in the Copy from Existing list,
and press Set.

When you select a body pattern name in a Touch Panel
location or in the Copy from Existing list, the system
displays the pattern in the lower left corner of the
screen.

To save the changes, select the Save button.

Creating a new body pattern library

10-58

In the User Defined Libraries field, type a name for the
library, then select Create.

The system creates a new library.
Enter body patterns as described in step 2 above.
To save the changes, select the Save button.
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Body Pattern Libraries/Body Patterns Preset Menu

On the Body Patterns tab, you specify body pattern options.

Libraries Body Patterns Applications

Body Patterns
Erase when the probe or application is changed ¥
Era
Copyto a ipleimage ¥
ody pattern background ® Transparent @ Opaque
Use Zoom Rotary knob to select body pattern
Body pattern knob: Recall On None

Body pattern knob: Recall Off None

Figure 10-27. Body Patterns General Preset Menu

After you change body pattern options, select Save to save the
changes.

Table 10-46: Body Patterns

Preset Parameter Description
Erase When the probe or If checked, when you change probes or applications, the system erases the
application is changed body pattern.
Erase When the image is If checked, when you unfreeze the image, the system erases the body
unfrozen pattern.
Copy to active side in If checked, when you use dual B-Mode, the system copies the body pattern
multiple image to the active side of the dual image.
Body pattern background Select whether you want the body pattern background to be Transparent or

Opaque.

Use Zoom Rotary knob to If selected, you can scroll through the body patterns with the Zoom control.

select Body pattern

Body Pattern knob Recall When the image is recalled, Body pattern knob works as below.

On Body Pattern on: Activate Body Pattern by press or move Up/Down/Left/
Right the Body Pattern knob.

U/D: Body Pattern On, L/R: Prev/Next image: Move Body Pattern knob Up
and Down to Body Pattern On, Move left recalls previous image, move right
recalls next image.

Prev/Next image: Move up and left recall previous image, move down and
right recall next image.

None: Activate Body Pattern by press the Body Pattern knob.
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Table 10-46: Body Patterns (Continued)

Preset Parameter Description
Body Pattern knob Recall When the image is not recalled, Body pattern knob works as below
Off Body Pattern on: Activate Body Pattern by press or move Up/Down/Left/

Right the Body Pattern knob.

U/D: Body Pattern On, L/R: Prev/Next image: Move Body Pattern knob Up
and Down to Body Pattern On, Move left recalls previous image, move right
recalls next image.

Prev/Next image: Move up and left recall previous image, move down and
right recall next image.

None: Activate Body Pattern by press the Body Pattern knob.
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Body Pattern Libraries/Applications Preset Menu

The Body Patterns Library/Applications tab is a link to the
Applications preset menu. The Body Patterns Applications tab
allows you to select body pattern application libraries. You also
specify which is the default library that displays when you use
body patterns.

Libraries Body Patterns Applications

Applications \ Body Patterns

Figure 10-28. Applications/Body Patterns Link

The Applications/Body Patterns screen can be accessed
through either the Body Pattern Libraries or Applications Touch
Panel keys.

Settings Print Controls Imaging Controls Comments Body Patterns Measurements

Breast -
Touch Panel
LELS
BREAST = SMLP >
Default Tab
BREAST >

Body Patterns Libraries

Figure 10-29. Body Patterns Applications Preset Menu

Table 10-47: Applications

Preset Parameter Description
Preset Defines the Body Pattern option.
Tabs A list of body pattern applications.
Default Tab The default library that the system displays when you use body patterns.
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Selecting body pattern application libraries

1. Onthe Body Patterns tab, in the Preset field, select the body
pattern.

2. Inthe Library Group Tabs fields, select the application
libraries for Body Patterns. You can select up to six libraries.

3. Inthe Default Library Group field, select the default
application library you want the system to display when you
use body patterns.

NOTE: When you use body patterns, the default library is displayed.
To use other application libraries, press the tab for the
library.

4. To save the changes, select the Save button.
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Using body pattern application libraries

See the following Body Patterns Small Parts Touch Panel.

Figure 10-30. Body Patterns Small Parts Touch Panel

To select a body pattern library, select the tabs (for example,
ABD or OB).

To select body patterns, use the Ellipse/Body Pattern control
on the Control Panel.
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Application Presets

Overview

Application Presets allow you to configure the
application-specific settings (presets).

Settings

Print Controls Imaging Controls Commaents Body Patterns Measuremaents

Protocol
| Tab
plate P opical 4x Label Area

Video

o Tab &

Figure 10-31. Application Settings Preset Menu

Table 10-48: Preset

Preset Parameter Description

Preset Select the application that you want to specify the presets. Along with the
various applications available on the system, there are four user-defined
application presets that can be set.

Table 10-49: Image Control and Display

Preset Parameter Description
Show kHz scale When selected, displays the kHz scale on the left side of the Doppler
spectrum.
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Table 10-49:

Image Control and Display

Preset Parameter

Description

Show Doppler Rate

When selected, displays the Doppler rate (mm/s) below the Doppler
spectrum.

Anatomical Angle
Correction

Select to keep the angle constant with regard to the anatomy.

Join Dual Image for Linear

Select to place linear probe dual images directly next to each other.

Hide Mode Cursor Key

Select to unmap (hide) the Mode Cursor key, which normally appears on the
left Trackball key during live scanning in B-Mode or Color Flow Modes.

Map AutoSweep Key

The following functions are able to be assigned to the right Set key: None,
Preview, Acquire.

Horizontal Display for
Biplane

Select to display Biplane images of BE9CS-D probe horizontally.

Table 10-50:

Auto Zoom Linear Probe Images at Shallow Depth

Preset Parameter

Description

Single Screen

Automatically zoom linear probe images at a shallow depth on a single
screen.

Dual Screen and DualView

Automatically zoom linear probe images at a shallow depth on the dual and
DualView screen.

Virtual Convex

Automatically zoom linear probes at a shallow depth when you activate
Virtual Convex.

Table 10-51:

When Entering Dual Image

Preset Parameter

Description

Duplicate Frozen Image to
Opposite Side

When entering Dual Image, duplicate the frozen image to the opposite side.

Duplicate Live Image to
Opposite Side

When entering Dual Image, duplicate the live image to the opposite side.

Table 10-52: Patient Info

Preset Parameter

Description

Titlebar Line 1

Select the patient information to display on the scanning screen Title bar.

Titlebar Line 2

Select the patient information to display on the scanning screen Title bar.

Titlebar Line 3

Select the patient information to display on the scanning screen Title bar.
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Table 10-53: Comments

Preset Parameter

Description

Active function at Freeze

Select None, Body Pattern, or Comments. If Body Pattern or Comment is
selected, the Body Pattern or Comment is activated automatically when
freezing the system.

Table 10-54: Footswitch

Preset Parameter

Description

Left, Middle, Right

Specify from the following for each footswitch pedal: No Function, Record/
Pause, Freeze, Next Heartcycle, Previous Heartcycle, Print 1,2,3,4, Update,
Next Step (Scan Assistant), Previous Step (Scan Assistant), Scan Assistant
Pause/Resume, or Mark Cine.

Table 10-55:  Protocol

Preset Parameter

Description

Show Protocol Tab

Check to display the Protocol Tab on the Touch Panel.

Template

Select the default stress echo template: Bicycle Normal, Bicycle Sporty,
Contrast Pharmacological, Pharmacological 4x4, Pharmacological 8x5,
Exercise 2x4, Exercise 2x4 B, Pharmacological US 4x4

Table 10-56: ECG

Preset Parameter

Description

Show ECG Tab

Check to display the ECG Tab on the Touch Panel.

Table 10-57: ELASTO

Preset Parameter

Description

Show Quality Bar

Check to display a Quality Bar for Elastography. The more bars, the better
the quality. As the quality increases, the bars go from red, to yellow, to green.

Show Quality Graph

Off, Small, Medium, Large
Select Off (No elasto quality graph is displayed in the image) or Small,
Medium or Large for display size of Quality Graph.

Table 10-58: Shear

Preset Parameter

Description

Show Quality Bar

Check to display Quality Bar.

Table 10-59: AutoSweep

Preset Parameter

Description

Show AutoSweep Tab

If selected, display the AutoSweep Tab on the Touch Panel.

10-66

LOGIQ P8/P9/P10 — Basic User Manual
Direction 5841298-1EN Rev. 2




Application Presets

Table 10-60: Video

Preset Parameter Description

Show Video Tab Check to display a Video tab on the Touch Panel.

Table 10-61: Label Area

Preset Parameter Description

Show Label If selected, the system displays the User Label in the Preview Window at the
left-bottom of the monitor.

Label 1-8 User Labels have eight text lines.
Each User Label is limited 50 characters.
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Print Controls

You have to set parameters with each application.

Live Store

tim

sed Store

Figure 10-32. Print Control

Table 10-62: Preset

Preset Parameter Description

Preset Select Application from pull-down menu. You can set Time span for each
application.

Table 10-63: Live Store

Preset Parameter Description

P1, P2, P3, P4, P5, P6 Select the behavior of Print key during live scan from Prospective Clip,
Retrospective Clip, Single image only or None for each print key.

None: Store a still image when you press P-key during Freeze.
Prospective clip: The system begins storing cine from when you press the
Print button, based on the Time Span setting.

Retrospective clip: The system stores cine predetermined time before you
press the Print button, based on the Time Span setting.

Single image only: Store a still image during live scan each time you press
P-Key.

Table 10-64: Time-Based Store

Preset Parameter Description
Time span [s] Select the number of seconds of CINE Loop storage. The default is 3
seconds.
3D/4D Time span (s) Select the number of seconds of CINE Loop storage while in 3D/4D.
Contrast Time span [s] Select the number of seconds of CINE Loop storage while in Contrast.
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Table 10-64:

Time-Based Store (Continued)

Preset Parameter

Description

Preview loop before store

When selected, allows you to review cine loops before storage.

Segment prospective loops
longer than time span

When selected, the system divides cine automatically which take a longer

time than Time span you have programmed. Specify length of Clip (15, 30, or

45 seconds, Off, or Max).

Table 10-65: ECG-Based Store

Preset Parameter

Description

Time before heart cycle
[ms]

Sets the storage time span before R-wave of the first heart cycle.

Time after heart cycle [ms]

Sets the storage time span after R-wave of the last heart cycle.

Number of heart cycles

Select the number of heart cycles to store. (Must be de-selected for single
frame.)

Preview loop before store

When selected, allows you to review cine loops before storage.

Table 10-66: Mark Cine

Preset Parameter

Description

Enable Mark Cine Control

Lets you mark where you want the CINE Loop to start (prospective CINE).

Preview Loop Longer
than...(s)

When selected, allows you to review cine loops before storage for loops
longer than selected time frame (in seconds).
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Imaging Controls

You can select which controls you want to be available via the
Touch Panel during a clinical scan. When you select Preset-->
Application and Control Mode--> Clinical, deselect the controls
you DO NOT want to appear while scanning in this clinical
application.

NOTE: If you select Research, all controls appear.

Figure 10-33. Imaging Controls
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